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Introduction 
Welcome to PrintSmith™ Vision. PrintSmith™ Vision is a browser-based print management system for 
commercial printers, trade printers, copy shops, and quick printers. To help you run your business efficiently and 
profitably, PrintSmith Vision combines estimating, invoicing, billing, point of sale, and accounts receivable in a 
single product. 

PrintSmith Vision supports commercial printers, trade printers, copy shops, and quick printers. It provides the 
features needed in commercial printing (like support for web presses, digital presses, and large format presses) 
without requiring that you use or understand features that do not apply to your business. As your business grows 
and changes, however, PrintSmith Vision is flexible enough and powerful enough to grow with you. 

Contact Information 
ePS Support 

Web Site: https://communities.efi.com 
US Phone: 1.855.334.4HLP 
UK Phone: +44 (0) 800.783.2737 
EU Phone: +49.2102.745.4500     

E-Mail: printsmith.support@efi.com 
 

Regular USA Service Desk hours are 8:00 am to 5:00 pm Mountain Standard Time, Monday – Friday. 

Regular European Service Desk hours are 9:00 am to 5:15 pm Greenwich Mean Time (British Summer Time 
during summer), Monday – Friday. 

Note For problems involving infrastructure (i.e., computers, networks, operating systems, backup software, 
printers, third-party software, etc.), contact the appropriate vendor. ePS cannot support these types of 
issues. 

  

https://communities.efi.com/
mailto:printsmith.support@efi.com
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Overview of Key PrintSmith Vision Features 
Estimates and Invoices 
Estimates are quotes you give to prospective customers indicating what you will charge for the work they want 
you to perform. 

Invoices show the actual price of the job and then serve as a bill for the work you performed. 

Note  Because estimates and invoices in PrintSmith Vision are so similar, this manual often uses the 
term document to refer to them. 

An estimate or invoice may include more than one job, and typically also includes some charges related to the 
work involved, for example, a charge for design work, ink, cutting, or boxes. 

In many situations, estimates are unnecessary. If you know you have the job, you can just create an invoice for 
the customer. For complex work, however, estimates help you determine an accurate selling price as well as 
give you a way of submitting bids based on different quantities and different stock. If the customer accepts your 
quote, you convert the estimate to an invoice, meaning the estimate is won; If the customer rejects the quote, the 
estimate is archived (as part of the customer’s estimate history) and considered a loss. 

Tip  For small simple jobs, you can use POS (point of sale) in PrintSmith Vision to record a sale and 
print out a cash register style receipt. In this case, you typically bypass invoices altogether since 
the cost of preparing the invoice could exceed the amount of the order.  

The content of estimates and invoices is very similar, as is the procedure for creating them. Estimates and 
invoices each have their own numbering system, however, and they are handled differently in the system. 

Warning  If you use pre-printed forms for your estimates or invoices, they should not be numbered; 
PrintSmith Vision automatically assigns numbers to both estimates and invoices. 

Accurate estimating is a key part of the sales cycle. In PrintSmith Vision, you can create a simple quote quickly, 
as well as perform sophisticated estimating when you are bidding for jobs. 

PrintSmith Vision comes with a completely defined pricing system with definitions and functions for everything 
from prepress to packaging. This pricing system can be adapted to your business, so you are not defining the 
system from scratch. 

You can price products, services, or materials using any combination of pricing methods such as flat rate, cost 
plus markup and/or rate, hourly rates, variable markups, and price lists. You can use the pre-press and bindery 
charges supplied by ePS, adapt them, or create your own. Likewise, you can use or adapt the stock, press, 
digital definitions, and price schedules supplied by ePS or create your own. 

Estimating History 
The Estimate History window provides a record of the estimate activity for each customer or prospect. Estimate 
History enables you to answer questions about past estimates, determine when a particular estimate was 
entered, see whether an order was won or lost, or open an old estimate and re-use its information in a new 
estimate or invoice. 

Cash Register 
If your shop does walk-in business that does not require invoices, you record the work and payment for it in the 
Cash Register window. You can use this window for any work that does not require an invoice. 

Cash Register in PrintSmith Vision provides all the functions you normally expect of a dedicated cash register. 
You can enter sales and payments, keep a record of each transaction, print receipts, process credit cards, and 
open a cash drawer. 

Note Integrated credit card processing, cash drawer, and receipt printer are optional purchases. 
Because the cash register is part of PrintSmith Vision rather than a dedicated machine, PrintSmith Vision can 
provide a detailed breakdown of each transaction by date/time, the person who performed it, what was done, and 
the account to which the transaction was posted. If you have an external cash register, you can use POS to enter 
the totals from the register into PrintSmith Vision; this information then becomes part of the detailed sales 
analysis that is typically performed each day. 
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Even if you have no need for a cash register, the cash register program serves as a link between estimating and 
accounts receivable by tracking each estimate and the status of all jobs in progress and those awaiting pickup or 
delivery. When an invoice is delivered to a customer and picked up in PrintSmith Vision, it is automatically posted 
to accounts receivable and added to the full account history for each customer. 

Post Payments 
When you post invoices and charge them to an account you are creating an account receivable for that account. 
When the customer pays what was charged, you must apply the payments against the invoices, so they are 
recorded as Accounts Receivable receipts. This process reconciles the money you received with the money that 
was due (as recorded in your invoices). In PrintSmith Vision this is known as posting payments. 

Why posting payments is important 
A common mistake when first getting started with PrintSmith Vision is to enter payments while picking up 
invoices without applying them to invoices. This has some undesirable side effects: 

• Invoices that were paid are still shown as open and may cause the account to become past due 
when it really is not. 

• Customers may not understand statements that include invoices they think they paid. 

• The receipt is considered “on account,” and is not included as a taxable cash receipt in Accounts 
Receivable. 

Journal Entries 
A Journal Entry is a new transaction that counteracts or reverses the original transaction. Journal entries result in 
debit or credit memos. They are used to adjust the total due on an invoice, add or remove tax from an invoice 
after posting, write off bad debts, adjust account balances, and so on. 

Register Tape 
PrintSmith Vision keeps a detailed record of all transactions for each sales “day” on an electronic register tape. A 
sales day ends when you perform a closeout, and a new tape is started. The register tape records significant 
events such as deposits, document voids, posted payments, finance charges, and journal entries. When you 
post transactions in the Cash Register window, they are recorded in the register tape. 

Closeout 
A Closeout in PrintSmith Vision is the process of summarizing the sales and accounting activity for a day or 
month. They can also be set up to do manually or automatic. 

Pending Documents 
When you first create a new document, PrintSmith Vision puts it on the pending list. This list includes all the 
“active” invoices and estimates in your shop and is displayed in the Pending Documents window. This window is 
your “command center” in PrintSmith Vision for working with active documents. 

Eventually, each document in the Pending Documents window is removed as follows: 

• You convert estimates to invoices if you get the job, or void (cancel) or archive them if you do not 
get the job. You can track archived estimates in Estimate History. 

• When work on invoices is completed, you pick up the invoices and indicate they were paid. You 
can track picked up and paid invoices in the history that PrintSmith keeps track. 

The documents in estimate or account history are “locked” since they form part of the audit trail PrintSmith Vision 
maintains. All details in the document are retained, however, and you can copy these documents to new 
estimates or invoices. You can update the pricing with the latest prices when you copy a document, but all the 
descriptive information and notes you made on the job (the location and condition of the artwork, special pricing 
instructions, and so on) are retained. 
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Web Product Templates 
Web products templates are set up under the Template section. You can create web product templates and 
map them to Market Direct StoreFront products. When your customer purchases an MDSF product, the 
information from that mapped template is used to create an invoice document. 

Purchase Orders and PO History 
Many jobs require items such as paper or ink that you must purchase. To help you manage the purchasing 
process, you can create purchase orders in PrintSmith Vision for the kinds of supplies or outside services 
that you typically need for the jobs you produce. Purchase orders can be created in the Invoice window and 
in PO History. 

The PO History window will show you the current and closed purchase orders. Here you can view a specific 
purchase order and modify or change the status.  

Work in Progress 
The Work in Progress window displays the open jobs or documents. There are several options to filter the 
documents including those that are outsourced and for Fiery production. You can set up new filters or use 
the ones already set up based on the due date. The jobs and documents can be set up by color to identify 
past due, pickup ready, hold, or those with a firm wanted by date. 

From here you can access the jobs and documents and see the details. You can also send jobs to Fiery 
production if that is part of your workflow. 

The Work in Progress window, as the name suggests, enables you to track your orders – as represented by 
the invoices and estimates on the pending list – in various ways. 

Accounts 
Accounts are a key part of your PrintSmith Vision system. Invoices are assigned and posted to accounts, 
payments are made for accounts, account histories are tracked, and sales statistics are kept for each 
account. 

In PrintSmith Vision, you can define accounts for both prospects and customers. Prospects have not yet 
done business with you, but you hope to turn them into customers. Customers have done business with 
you, and invoices have been created for them. Once you create an invoice for a prospect, that prospect is 
automatically converted to a customer. If customers become inactive, they can be turned into prospects 
again. 

Contacts 
Contacts are the people associated with an account, for example, those who receive statements or invoices 
or to whom you send promotional mailings. An account may have a single contact or may have many; it 
depends on the account. 

Account History 
The Account History window provides a historical record of all accounting activity for a customer or 
prospect and is a powerful tool for managing your business. For example, you can use the history to 
answer specific questions about payments, determine when a particular order was placed, examine the 
unpaid (open) invoices on the account, print a detailed account activity report, and open an old invoice so 
you can copy it (and re-use it). 

Stock Definitions 
The Stock Definitions window gives you a stock list where you can view a list of all of the stock. It includes 
stock that is in inventory as well as stock that is registered with MDSF. You can also enter the information 
about your stock using the Stock Definitions window. That would include specifications, pricing, definition, 
and inventory.  
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Stock Import 
The Stock Import feature allows you to import stock definitions and update prices from an electronic price 
catalog from a vendor. 

Generating Statements 
Statements are optional but are an extremely important part of Accounts Receivable. You can review the 
status of accounts by aging them and apply finance charges as necessary. Typically, you generate 
statements at regular intervals (such as monthly) so that you can let customers know of their outstanding 
balances. You can either print or e-mail statements. 

Ordering Stock 
PrintSmith Vision includes several features to help you order stock and track what you ordered. You can 
keep track of all the stocks that need to be ordered, as well as keep track of placed and received stock 
orders. You can also create purchase orders for your stock orders. When an order is received, inventories 
for the stock are automatically adjusted (if you track inventory for the stock). 

Report Manager 
Report Manager is a separately licensed tool that is fully integrated with PrintSmith Vision and available 
from the Reports menu. You can use Report Manager to do the following: 

• Replace one of the standard PrintSmith Vision reports with one of your own reports. 

• Add and run custom reports. 

Account Aging 
The purpose of account aging is to determine the status of customer accounts and warn you of accounts 
that may need collection action. An accurate gauge of your receivables is essential to running a healthy 
business. 

Account Ranking 
The Account Ranking report is that it lists accounts by different criteria, for example, by balance, number of 
orders, or sales. You can save these rankings, so they are available elsewhere in PrintSmith, for example, 
on the Sales Info section in the customer Accounts window (AR (Account Receivable) > Accounts). 

Sales Tax Table 
In order to properly calculate and report your sales taxes, you need to set up tax tables in PrintSmith Vision to 
define your tax rates. Where you sell determines how many tax tables you need. 

Cash Drawer Status 
The Cash Drawer Status window is set up to aid in balancing your accounts and sales. 

PrintSmith Vision: ePS-Hosted vs Customer-Hosted 
PrintSmith Vision can either be hosted by ePS (cloud-based) or hosted by you at your facility. 

ePS-hosted 
When ePS hosts PrintSmith Vision for you, PrintSmith Vision is installed on a server in the ePS hosting 
center, not in your facility. This cloud-based option means that ePS takes care of the hardware and 
software infrastructure for you, as well as the installation of PrintSmith Vision, updates, backups, and so on. 
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Customer-hosted 
If you are hosting PrintSmith Vision, the PrintSmith Vision server is at your facility, so you control the 
hardware and software infrastructure and are responsible for installing and updating PrintSmith Vision, 
performing backups, and so on. 

Most PrintSmith Vision procedures are the same whether ePS is hosting PrintSmith Vision or you are 
hosting it, but some procedures are different, and some apply only to ePS-hosted or only to customer-
hosted installations. PrintSmith Vision - EFI-Hosted Guide explains what is different in ePS-hosted 
installations. If ePS is hosting PrintSmith Vision, be sure to use this guide together with other guides like 
this PrintSmith Vision User Guide. Other guides will indicate when a feature or procedure applies only to 
customer-hosted installations (not ePS-hosted). 
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PrintSmith Vision Basics 
How PrintSmith Vision Works 

The computer where PrintSmith Vision and its database are installed is known as the server. If ePS is 
hosting PrintSmith Vision for you, the server is in the ePS hosting center; if you are hosting PrintSmith 
Vision, the server is at your location. 

To run PrintSmith Vision, you use a browser from a client computer. For information about supported browsers 
and client computers, see the PrintSmith Vision Release Notes or the PrintSmith Vision - Installation and Upgrade 
Guide. 

Important  When PrintSmith Vision is customer-hosted, the server computer must be configured not to go to 
sleep. If the server goes to sleep, users who are running PrintSmith Vision from other computers 
will get a “server down” message and will be unable to use PrintSmith Vision while the server is in 
sleep mode.  

 When PrintSmith Vision is customer-hosted, you can also run PrintSmith Vision from the server 
itself. 

Logging to PrintSmith Vision 
The procedure for starting PrintSmith Vision is slightly different when you are hosting PrintSmith Vision yourself 
(see below) versus when ePS hosts it. For more details, see the PrintSmith Vision - Installation and Upgrade 
Guide. 

1. In the address bar of your browser, enter your PrintSmith Vision URL.  

The PrintSmith Vision login window opens. (This assumes the license was already activated as 
described in the PrintSmith Vision - Installation and Upgrade Guide. You cannot log in until your license 
is activated.)  

2. Enter the User Name and Password you were given by your system administrator.  

 
3. Select the Language in which you want to login to the PrintSmith Vision application. 

4. Click Login. The PrintSmith Vision home page window opens. 
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Exiting PrintSmith Vision  
1. After you finish your work in PrintSmith Vision, always log off by clicking Logout in the user profile 

menu.  

  
Note  If you have a record open in PrintSmith Vision (for example, you are looking at a customer 

account), and you close the browser window without logging off, the record remains in a 
locked state so other users cannot open it. For more information, see “Record Locks”.  

2. Close the browser window. 

PrintSmith Vision Home Page 
This window opens automatically when you start PrintSmith Vision. The home page contains the Quick Access 
panel that provides shortcuts to your most common tasks in PrintSmith Vision. The home page also provides a 
view of the status of orders taken by the logged-in user or for the entire plant.  

The PrintSmith Vision home page includes: 

• Estimate, invoice totals, and total orders for the previous day and current day. 

• Year to date and month to date totals of orders, sales, and journal entries. 

• Lists of invoices due today, overdue, and optional custom field. A list of estimates still in a pending 
state, with the ability to open and review them. When an estimate is open, you can convert it to an 
invoice so you can go ahead and produce the job and bill the customer. 

• A log of the communication that has taken place with customers, with the ability to follow up on issues. 

• Estimate and invoice totals for the previous day and current day. 
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• Quick access to other applications. 

Navigation 
PrintSmith Vision home page includes a menu panel on the left side of the window. When you select an item in 
the menu panel, the corresponding details window is displayed to the right of the pane. A menu panel may have 
items organized into groups so you can find items more easily.  

This menu panel is displayed at all times and allows you to navigate the different PrintSmith Vision 
programs. 

 

Keyboard Shortcuts 
If you like to use the keyboard to accomplish tasks, several keyboard shortcuts are available. A keyboard 
shortcut is a combination of keys that you press at the same time, for example, CTRL+C means you press 
the CTRL key and c at the same time. 
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User Preferences 
You can modify the shortcuts that are displayed in the quick access panel by changing their location in the panel 
or removing them from the panel completely. To do this, use the User Preferences window that can be 
accessed by clicking your user profile. 

 
User Preferences consist of two sections: Menu Configuration and Summary Configuration. 

 

• To change the sequence or to show/hide menu items in the Quick Access panel, use the Menu 
Configuration section. Drag the menu items to change their sequence and use the slider to remove 
items from the panel. 

• Select the Expand the Estimate/Invoice Summary option in the Summary Configuration section to 
expand the collapsed sections when you access the Estimate Summary or Invoice Summary windows.  

Change Password 
As administrator, you control access to PrintSmith Vision for all users. PrintSmith Vision is shipped with a pre-
defined admin user, designed to be used by the system administrator at your company. As a first step in 
establishing security, you should change the admin password (ePS provides an initial password). 

All PrintSmith Vision users can change their own passwords at any time by selecting Profile > Change 
Password. 

1. Select your profile on the top-right corner and then click My Profile. 

2. Click Edit to update general information. 
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3. Click Change Password to change your password. 

 
4. Enter your new password and click Save.  

Record Lock 
The Record Lock window enables you to view the records that have been locked and makes locked records 
available to users again. 

PrintSmith Vision allows multiple activities to take place on the system at the same time. As a result, users who 
are working at the same time may try to change the same information. To prevent this from happening, 
PrintSmith Vision locks records when certain events occur, for example, when a user is changing information. 

If a record is locked, and you try to open it, PrintSmith Vision informs you that the record is already in use and 
identifies the login name of the person who has the record open. When the other user finishes work on the 
record, it is unlocked and becomes available to other users. Typically, the time a record is locked is so short that 
you are not aware of it. At times, however, records may be locked for longer periods.  

For example: 

• When a document is opened, it remains locked until the document window is closed. 

• When a pickup is being processed in the cash register, both the invoice being picked up and the 
associated account are locked until the process is complete. 

If a record is left locked accidentally (typically because a user closed the browser window without logging off) or 
is left locked for some other reason, you can unlock the record if you have permission to do so. (Typically, this is 
a task performed by an administrator.) 

1. To unlock a record, select Profile > Record Lock. 

 
2. For Unlock locked records of, select Currently logged in user (yourself), User Name, or All 

users. If you selected User Name, enter the name of the user.  

3. Click Unlock. 
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Quick Access Panel Features 
The Quick Access panel provides shortcuts to your most commonly used tasks. You can control the information 
that is displayed in the Quick Access panel.  

Select the Show only My Records option to display the information corresponding to currently logged-in user. If 
this option is cleared, then the information is displayed for the entire shop. Each widget title indicates if you are 
viewing the information for the entire shop or the logged-in user. 

 
Customize Mode enables you to change the placement of the Quick Access items and widgets. You can also 
remove items by clicking X that is displayed in the customize mode. 

 
Add/Remove Options allows you hide or show the items in the Quick Access panel and the widgets. The 
number of items displayed in the Quick Access panel is limited to 18.  
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Reset Default enables you to revert to the default settings. 

In addition to the Customize Mode and the Add Remove Options, you can remove individual widgets by selecting 
the Remove Widget option.  

 

Note If you have made changes to Quick Access panel, the changes will still be in effect after an update. If a 
user does not have permission for a feature, it is still displayed but grayed out. 

Using the Quick Access Panel 
To get the Quick Access panel ready for use, you must do the following necessary steps: 

• Set your Quick Access panel preferences. 

• Decide which access groups should have permission to view the Quick Access panel. 

• Understand the Taken by field. 

Setting you Quick Access panel references 

1. In PrintSmith Vision, navigate to Preferences > Settings. 

2. Under System, click Dashboard.  

3. In the Dashboard page, set the preferences to control some aspects of the dashboard on the 
PrintSmith Vision home page.  

 
a) Select the Show follow up count at user login check box to remind the users after 

every login that they have some number of items to follow up. 

When this check box is selected and if you have follow-up items that are either due today 
or past due, a red flag is displayed by the bell icon on the PrintSmith Vision home page. 
This indicates the user that they have messages to review. 

 
b) To omit tax from the totals, select the Exclude tax from Sales and Journal Entries 

check box. By default, the sales and journal entry numbers in the dashboard include tax.  

Defined in 
Production 
Locations 
Table 
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c) My Location pane on the PrintSmith Vision home page lists all the invoices with jobs 
currently in the location that was selected in the Pickup drop-down field. 

When the location of a job is set to the location defined in the Dashboard preferences, the 
invoice will be listed in the My Location pane. 

4. Click Save. 

Accessing the Quick Access panel 

You can control access to the Quick Access panel through Security settings.  

1. In PrintSmith Vision, navigate to Admin > Security Set up. 

2. In the Security Setup window, any user who is part of an access group with Help > Quick Access 
Panel command selected can open and view the Quick Access panel.  

3. To prevent the users in a particular access group from seeing YTD and MTD total order, sales, and 
journal entry numbers, do not select the Help > Dashboard Show Sales Values command in the. As a 
result, dashes instead of numbers are displayed. 

Note Users who do not have permission to review a document, that is the Invoice > Review Any Document 
command is not selected, will not be able to open a document from the Pending list as well as are 
prevented from opening a document from the PrintSmith Vision home page. 

Understanding the Taken by field 

When you create an estimate or invoice, the Taken by field in the Account Information tab is automatically set to 
your user (login) name, but this field can be edited. 

Note The Taken by field is case insensitive (Dhina and dhina are the same). 
When you open Quick Access, the orders that you see are those that you took – they have your username in the 
Taken by field. You can, however, see orders taken by all other users (but not specific users) by clicking Show 
All in some of the panes of PrintSmith Vision home page. 

Web orders, for example, orders coming from Market Direct StoreFront and Four51 are not taken by a particular 
user. When you are integrated with Market Direct StoreFront or Four51, ePS recommends that you set the 
Taken by field to the user (perhaps admin) who is most likely to want to track these Web orders. Whoever opens 
the Web orders, can edit the Taken by field in the Account Information tab and enter a different username there. 

Home Page Contents 
Some information in the PrintSmith Vision home page applies to the logged in user (whose name is in the Taken 
by field in the Account Information window). In the descriptions of the home page that follow, “you” refers to the 
currently logged in user. Other information on the home page applies to the entire shop. You can view your own 
information (for example, see orders that you have taken) or view information for the entire shop, but you cannot 
view information for another user. Likewise, another user cannot see your information. 

Tip The home page is updated automatically every 5 minutes. 
The sections that follow describe the different parts and features of the PrintSmith Vision home page. 

 

Total Widget 
The Total Widget summarizes the estimates and invoices that were created on the previous and current day, as 
well as year-to-date and month-to-date totals for orders, sales, and journal entries. It shows those that came from 
the shop and those that came in over the web. 

Notes Unless you selected the Exclude tax from Sales and Journal Entries check box in the 
Dashboard preferences, the Sales and Journal Entries numbers include tax. 

   The totals exclude any voided estimates or invoices. 
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Estimates 
The Estimates section shows the total dollar amount of the estimates that were created on the previous 
day and the current day. The number of estimates is shown in parentheses. 

Invoices 
The Invoices section shows the total dollar amount of the estimates that were created so far on the previous 
day and current day. The number of estimates is shown in parentheses. 

Total Orders 
The Total Orders columns provide information about invoices that were created for orders. Total Orders include 
invoices that are still on the pending list, as well as invoices that were picked up. Total Orders do not include 
voided invoices. 

If you do not have permission to see company sales numbers, dashes are displayed instead of numbers under 
Total Orders. 

Sales 
The Sales columns provide information about all the invoices that were picked up (meaning invoices that were 
charged or paid for by cash, check, or credit card). 

Note Unless the Exclude tax from Sales and Journal Entries check box is selected in the Dashboard 
preferences, the sales numbers include tax. 

• The “This Year” column shows the total dollar amount of invoices picked up so far during the 
current year. (The current year is based on the fiscal year set in your Business Calendar 
preferences.) 

• The “This Month” column (for example, MTD Mar-16) shows the total dollar amount of invoices 
picked up so far during the current month. 

Journal Entries 
The Journal Entries columns provide information about journal entries that were recorded and posted. These 
numbers may be negative. Voided journal entries are not included. 

Note  Unless the Exclude tax from Sales and Journal Entries check box is selected in the Dashboard 
preferences the Journal Entries numbers include tax. 

 

• The “This Year” column shows the total dollar amount of journal entries posted so far during the 
current year. (The current year is based on the fiscal year set in your Business Calendar 
preferences.) 

• The “This Month” column (for example, MTD Mar-16) shows the total dollar amount of journal 
entries posted so far during the current month by the shop as a whole and by you. 

If you do not have permission to see company sales numbers, dashes are displayed instead of numbers under 
Journal Entries. 

Notes  The sum of the Sales and Journal Entries numbers represents actual sales for the period. 
 The displayed information for each widget depends on if you have selected “Show only my Records” or 

not. 
Due Today Widget 
To help you track what needs to be done today, the Due Today widget lists invoices that are due today. 
The total number of the invoices due today is shown at the top of the page. 
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• If the list is long, click Show All to open a window that shows all your invoices that are due today. 

This will open Pending Documents in a new window and display the invoices. 

• To open an invoice and review its details, click Invoice#. 

Overdue Widget 
The Overdue widget lists all your invoices that have a due date in the past. The total number of these late 
invoices is shown at the top of the pane. 

 
Note  If an invoice is due today at 12:00 PM, it will be considered overdue any time after 12:00 PM, but it will 

still be listed in the Due Today pane. 

• If the list is long, click Show All and the pending documents window will display in a new window all 
overdue invoices. 

• To open an invoice and review its details, click the Invoice#. 

My Location Widget 
The My Location widget lists all your invoices that have jobs in that location. The total number of these 
invoices is shown at the top of the pane. The Item# column identifies the job in the invoice that is in that 
location. 

 
Note For invoices to be listed in the My Location pane, the location of a job in an invoice must be set to the 

location specified in your Dashboard preferences. 
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The title of this pane will match the name of the location you selected in your Dashboard preferences, for 
example, if the location is Proofing, the title of the pane will be On Proofing. 

Pending Estimates Widget 
The Pending Estimates pane lists all your active estimates – these are quotes that either were not yet accepted 
by customers or were accepted but have not been converted to invoices yet. The value of those estimates is 
displayed at the top of the tab. 

If a customer accepts an estimate and gives you the go-ahead to proceed with the job, you can open the 
estimate from the dashboard and convert it to an invoice. An invoice includes the agreed-upon price and details 
of the work to be performed and then serves as a bill for this work. 

 

If the list is long, click Show All to open a Pending Documents window that shows all your pending estimates. 
From the Pending Documents window, you can open and edit an estimate. 

• To open an estimate and review or edit its details from the Pending Estimates pane, click the Estimate 
number. 

• To convert an estimate to an invoice when the customer has accepted your quote: 

1. Click the Estimate number to open the estimate. 

2. Make any necessary changes to the estimate. For example, if the estimate includes multiple 
quantities, select the one the customer wants. 

3. In the Estimate Summary tab, click Convert to Invoice. 

4. When asked about recalculating the document, click Yes to ensure the invoice has the latest 
pricing information. 

5. When the Invoice window opens, make any necessary changes, and click Confirm. 

6. Click Save to save the invoice. 

Customer Log Widget 
The Customer Log widget lists all customer issues that you logged with a follow-up date of today or in the past. 

 
Tip You can log entries and enter follow-up reminders in the Notify Customer window. This window can be 

opened by clicking the Notify button in the following windows in PrintSmith Vision: Pending Documents, 
Account History, Work in Progress, Post Payments, and Journal Entry.  
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Defining Sales Tax or Value Added Tax 
About Taxes in PrintSmith Vision 

In order to properly calculate and report your sales taxes, you need to set up tax tables in PrintSmith Vision to 
define your tax rates. If you do not charge and collect sales tax, you should ensure that no (zero) tax is being 
calculated. 

Where you sell determines how many tax tables you need. For example, if your business sells exclusively in a 
single tax jurisdiction, you only need one tax table. If, however, your business sells in multiple tax jurisdictions, or 
is international, you need to account for all these different taxes by setting up several tax tables. For example, 
international customers may require tax on tax and variable tax rates. Canada has a GST/HST tax. Chile also 
has special tax verification procedures. You must account for all these different tax situations. 

Default Tax Table 
One tax table is always identified as the default tax table. This may be the only tax table you use. If, however, 
you have multiple tax tables, the default tax table should typically be for your most commonly used sales tax. The 
default tax table is automatically used for all taxable customers and invoices unless another tax table is assigned 
to an account or invoice. 

Product-Level Taxation 
In some locations, tax is based on the type of product you are selling, for example, brochure versus business 
card. 

Line-Item Taxation 
You may find it necessary to tax individual line-items in an invoice independently. For example, in some tax 
jurisdictions an item that involves just labor (such as folding) may be taxed differently from an item that involves 
both labor and materials (such as printing). In addition, jobs in an invoice may be delivered to different locations 
that are subject to different taxes. When using line-item taxation you can have up to five different tax tables per 
invoice.  

Setting Up the Sales Tax Table 
ePS recommends that you start by defining your default tax table. This may be the only tax table you need, but if 
you plan to define additional tax tables, use the default tax table for your most commonly-used sales tax. 

 
1. Select Pricing > Sales Tax. The Sales Tax window opens with no tax table displayed. 

2. To add a new tax, click the Add button. The Add Sales Tax window opens and you can define the tax 
in this window. 

3. In the Table field, enter the name of the tax table. The tax name should be unique. 

Tip  Any tax table can be your default tax table; in the Sales Tax window, just select the radio 
button in Default column you want to be the default table. You can also name the default tax 
table whatever you want, although Default as the name makes the purpose of the table clear. 

4. Enter an abbreviation for the tax table. It should be unique. 

5. If necessary, set the Min Taxable Amount.  

6. Check any of the other options for that tax table. 



30 • Productivity Suite | PrintSmith Vision User Guide 

 

 

• Tax Shipping 

Select this check box if you need to tax the amount you are charging for shipping (which is 
common in Canada). When the Tax Shipping check box is selected, all the check boxes in the 
Ship column are selected automatically so that all the tax elements in the table are used to 
calculate taxes on shipping. 

• Separate Shipping 

If you want to choose which tax elements to apply to shipping, select the Separate Shipping check 
box and then clear the check boxes in the Ship column for the tax elements you do not want to use 
in the calculation. Select this check box if you want to show the shipping tax for line item. 

• Tax on Tax 

Select this check box if one tax must be applied to another. Normally, the rates in the tax table are 
added together to produce the effective tax rate. If you select the Tax on Tax check box, the 
effective tax rate is calculated differently. Suppose the first tax rate is 8% and the second rate is 
2%. In this case, the 2% rate is applied to the 8% rate. An additional 0.16% (2% of 8%) is therefore 
added to the effective tax rate, and the result is 10.16%. 

• Build Tax in Price 

(For future use) Select this check box if you want to hide the tax in the price for items and never 
show it separately. 

• Round Tax up 

Select this check box if you want to round up all the tax rates in the table. Generally, this check box 
should be cleared. The only case where ePS recommends selecting the Round Tax up check box 
is in the state of Florida which has a sales taxing system that uses a table to look up actual tax 
amounts instead of calculating with a formula. The closest PrintSmith Vision could get to matching 
their system by formula exactly (based on the unofficial recommendation of the State of Florida tax 
departments) is to round up all taxes. 

7. Enter one or more tax elements. For example, you may need to account for both a city and state tax. 
The tax elements result in the Effective Tax Rate. Each tax element consists of Description and Tax 
Rate fields as well as Ship and Show check boxes to control whether the tax is applied to shipping 
and/or is identified on an invoice, estimate, or receipt.  

Tax Elements are set up in Table Editor > Data List.  

 

a. In the Add Sales Tax window, click  to add a tax element. Once a tax element is set up in the 
table, it is available to use in the Sales Tax program. 

b. In the Description column, select the name of the tax element. (These are defined in the Tax 
Tables Elements table; use Table Editor to maintain this table.)  

c. Enter the Tax Rate as a percentage (up to three decimal places).  

d. Select the check box in the Ship column if the tax should be applied to shipping. This check box is 
available only if the Tax Shipping and Separate Shipping check boxes are selected. 

e. Select the check box in the Show column if you want the tax shown on invoices and estimates, as 
well as on receipts for cash register transactions. 

Note To remove a tax element, click the Delete icon in the Action column. 
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8. Verify the Effective Tax Rate. This rate is calculated based on the tax elements you entered. If this rate 
is not correct, adjust the tax elements. You can add multiple tax elements to the table. 

9. If you no longer want to use a particular tax table, select the Disable check box . You cannot disable 
the default tax table, however. 

10. Click Save to save the tax table. 

Notes You can use the + button to add additional tax jurisdictions to the tax table.  
 In many places in PrintSmith Vision you will see Tax Table set to Use Parent Tax Table. This means 

that the tax table assigned to the customer account is being used, unless this was overridden in the 
invoice, parent job, or cash register. 

Editing Tax Tables 
If the tax rate changes, for example, the state sales tax increases, you can edit the tax table to change the rate. 

When you make a change to a tax table that affects the tax calculation, PrintSmith Vision creates a new version 
of the tax table but leaves the original intact and lists it in the Historic Data section in the Sales Tax window. 

 
You cannot edit historic tax tables. If you select a historic tax table, you will get a warning that you are viewing 
historic data. To go back to the latest tax table, select the Switch to Current Tax Table button. 

 

Tax Exemptions 
If some customers or orders are not subject to sales tax, ePS does not recommend that you set up tax 
tables with tax rates of 0% to handle these tax-exempt accounts or documents. 

Note  If you set up tax table with a 0% tax rate, the amounts are still considered taxable even though no tax is 
calculated. This makes sales analysis less accurate because the sales are considered taxable, except 
at a zero-tax rate. 

Instead, for an account, select the Tax Exempt check box on the Credit/Tax Control tab in the Accounts 
window. 
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For a document, select the No Tax check box in the document Total section. For more information, see Price 
Information in the Estimating chapter. 

 

Including More Than One Tax Element on a Document 
When a tax includes more than one element and you want to include all the tax element in documents, select the 
check box of each element in the Show column in the Sales Tax window. For example, you may want to break 
down the tax by state and city. The Show column also affects printed receipts. Any additional taxes that do not 
have Show selected are grouped together in the standard tax amount. 

 

Hiding Taxes in Prices 
If you do not want to break out the tax, but want to include it in your prices in the documents that customers see, 
do the following: 

1. In your document preferences: 
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a. Select Reports > Report Manager. The Report Manager window opens. 

b. Click the Document Preferences tab. 

c. Click the Format Name that you want to use. 

d. Click the Page tab and select the Remove tax line check box. 

e. Click the Body tab and select the Hide tax in line items check box. 

f. Click Save. 

2. In your receipt preferences: 

a. Select Preferences > Settings > POS > Receipt. 

b. Select the Hide tax in line items check box so that receipts have the tax hidden in the price. 

c. Click Save. 

Using Product-Level Taxation 
In some locations, tax is based on the type of product you are selling, for example, brochure versus business 
card. To accommodate this type of taxation, you can associate tax tables with product types as described next. 

Setting up Product-Level Taxation 
1. Use Pricing > Sales Tax to define the tax tables for products that require different taxation. For 

example, you may need one tax table for brochures and another for posters. 

2. Select Table Editor > Data List and select Products in the Table Name column. The Table 
Editor: Products window opens. 

3. By default, the Tax Table column for a product in the Products table is set to Use Parent Tax 
Table. This means that the tax table associated with the estimate or invoice will be used for the 
product. 

4. To use a different tax table for a product, select it in the Tax Table column. 

  
5. Repeat step 3 for all the products that require separate taxation. 

Note  The Key (Alpha) field in the Products table is required only if you are using the e-commerce 
API (separately licensed) and want to assign or use a product type (category) when importing 
or exporting invoices. The value in this field must be unique, but it can be anything you want. 
For information about this API, see the PrintSmith Vision – e-Commerce API Integration 
Guide. 

6. Click Save. 

Taking Advantage of Product-Level Taxation 
When you add a job to an estimate or invoice and select a Product for the job, the tax associated with the 
product (in the Products table) is automatically set in the Tax Table field. 

The tax rate defined in the tax table is then applied to the subtotal of the invoice. 
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Unless you are also using line-item taxation, only one tax table can be associated with an estimate or invoice. If 
you have multiple jobs on a single estimate or invoice, they cannot be for products that are associated with 
different tax tables. What this means: 

• When you add a job to an estimate or invoice for a product that has an associated tax table, that tax 
table is used for the entire estimate or invoice. 

Note If you then try to change the tax table at the estimate/invoice level (in the Total section, the 
system will prevent you. If you want to apply a different tax table to the invoice, you must change 
Tax Table for the job in the estimate/invoice to Use Parent Tax Table. 

• After you add one job to an estimate or invoice for a product that has an associated tax table, you 
cannot add more jobs for products with different tax tables. The Tax Table field for those jobs must be 
set to Use Parent Tax Table (which means the job inherits that tax table from the estimate or invoice). 

Line-Item Taxation 
You may find it necessary to tax individual line items in an invoice independently. For example, in some tax 
jurisdictions an item that involves just labor (such as folding) may be taxed differently from an item that involves 
both labor and materials (such as printing). In addition, jobs in an invoice may be delivered to different locations 
that are subject to different taxes (such as county or city tax in addition to state tax). When using line-item 
taxation you can have up to five different tax tables per invoice. 

Important  Before enabling and using line-item taxation, read the following sections to make sure you 
understand how line-item taxation works and find out if it is a good solution for your business. 

Warning     Once you enable line-item taxes you cannot disable it. 

Enabling Line-Item Taxation 
To take advantage of line-item taxation: 

1. Navigate to Preferences > Settings > System. 

2. In the Behavior tab, select the Enable line-item taxes check box and click Save.  
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Taking Advantage of Line-Item Taxation 
When line-item taxation is enabled, you can indicate that a tax table should be “inherited” from its parent (which 
is the default behavior) or you can select a different tax table (so it is not the same as the parent). Whenever a 
Tax Table field is set to Use Parent Tax Table, the tax table is inherited. The order of inheritance is as follows: 
customer account > invoice/estimate > jobs > job charges (or sub jobs in a multi-part job). If you select different 
tax tables for items in an invoice, they are taxed differently from their “parents.” 

When line-item taxation is enabled, you can do the following: 

• Have up to five different tax tables per invoice. 

• In the Total section for an invoice, select a tax table to apply against the invoice, as well as any of its 
charges or jobs that have Tax Table set to Use Parent Tax Table. 

• Select a specific tax table for a job in an invoice. This tax table will also apply to any job charges or 
parts of a multi-part job that have Tax Table set to Use Parent Tax Table. 

Hiding Line-Item Tax  
You have an option to not display the line-item tax amount on the Invoice Summary tab. This can be set-up 
Preferences > Settings > System > HTML View. 
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Estimating 
Estimates are quotes you give to prospective customers indicating what you will charge for the work they want 
you to perform. An estimate may include more than one job, and typically also includes some charges related to 
the work involved, for example, a charge for design work, ink, cutting, or boxes. You can create a new estimate 
from a new job, account history, job templates, or templates. 

Creating Estimates 
From the New Estimate window, you can create estimates. From this window, you can identify the customer, 
contact, and choose how you want to create the estimate. Several of the options and steps to create an estimate 
are the same for creating an invoice. 

You can start to create an estimate by selecting a customer by either entering the customer’s name or by 
selecting the customer from the Choose Customer drop-down list. By default, accounts and contacts are 
displayed. You can also determine if you want to display prospect. 

Prospects have not yet done business with you, but you hope to turn them into customers. Customers have done 
business with you, and invoices have been created for them. Once you create an invoice for a prospect, that 
prospect is automatically converted to a customer. If customers become inactive, they can be turned into 
prospects again. 

Tip The content of estimates and invoices is very similar, as is the procedure for creating them. 
This section provides the details of creating an estimate or invoice from scratch. 

1. In the Quick Access panel, click Create Estimate. 

2. In the New Estimate window, select a customer for whom you are creating the document from the 
Choose Customer field.  

You can search for a customer based on account number, phone number, or email address using the 
search code prefixes. You can identify the type of account by the symbol next to the customer name in 
the drop-down list. 

 
• When searching with Account + Contact selected and Prospects unselected, you will only see 

Accounts.  

• With Account + Contact unselected, and Prospects selected, you will only search Prospects. 

• With both selected, you will search for both Accounts and Prospects. 

3. The application will automatically enter the default contact person, but you can choose a different 
contact from the Contact Person drop-down list. 

 
4. Under the Create From field, choose the process you want to use to create the estimate. 
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There are different options for creating a new estimate depending on your preference settings. Under 
Preferences > Settings > HTML View, you have an option to select Template Category View. With this 
unchecked, you will see the options of creating an estimate from a new job, account history, job 
templates or (invoice/estimating) templates. With Template Category View selected, the options will 
change to a new job, account history or template. When you select a job method, a list of Product 
Templates is displayed that you can use to find a template. See “Creating Template Categories” for 
more information.  

5. After selecting how you want to create a job, select a job pricing method from the Job Method field. For 
details about creating jobs, see Creating Jobs (Job Methods). 

Note The pricing methods that are available as selections and their names are controlled by 
preferences (Preferences > Estimator > Pricing Method). You may want to change the name 
of the pricing method so that it makes sense to your company. For example, you may want to 
change Printing to Offset, Outside Services to Outsourced or Buyouts, or Color to Digital 
Color. What you see in your job method therefore may not match some of the examples in 
this manual. In addition, if you activated and customized any of the “Merch” pricing methods, 
they will also be available as job method selections. 

6. Click Next. This will take you to the Job Details tab of the Estimate window where you can enter the 
information about the job. The Job Details tab displays details specific to the job method you selected. 
You should always review the information in this window, provide any missing information, and make 
any necessary corrections.  Often you do not need to make any changes to the account information. 

7. In the Job Details tab, start the process of adding a job to the estimate or invoice and click Confirm on 
the to save the job.  

8. The Estimate Summary tab provides a summary of the job that you added. Save the estimate or 
invoice by clicking Save.  

Until an estimate is saved, the following message is displayed at the top of the Estimate window. 
Ensure that you save the estimate after any modification. 

 
After the estimate has been saved successfully, you can convert it to an invoice. 

 
When you save an estimate or invoice, it is assigned a unique number and listed in the Pending 
Documents window where you manage orders that come into your shop. In addition, the customer 
account is updated to reflect any changes in the sales statistics caused by the new estimate.  

Why use customer accounts? 
ePS strongly recommends that you associate a customer account with most of the documents that you create. 
Not only does a customer account include key information such as name, address, and phone number, but it is 
also used to determine if an invoice exceeds the customer’s credit limit. In addition, the account determines 
whether a deposit is needed, what type of payment is acceptable, whether a PO is required, or if an automatic 
discount should be applied to the order. The tax table (which may change the tax rate), tax code, and tax status 
are also based on the assigned account. The customer account can even affect special instructions on job 
tickets and documents. 

When customers use your services, you want them to continue using your services. If you set up an account for 
them, you can examine their history, mark them as inactive, and market to them. The history that PrintSmith 
Vision maintains also helps you identify customers who only use you as a source for quotes and never send you 
any orders. You can find out why you never get their orders and decide whether you want to continue giving 
them estimates. 
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For all these reasons, the walk-in account should be used just for customers you never expect to see again. If 
you start using the walk-in account for repeat business, you will have history for the walk-in account, not for 
individual customers. 

In addition, you could end up with history for the same customer in both the walk-in account and a customer 
account. Imagine that you select the walk-in account when creating an invoice for Bob’s Hardware and enter the 
customer’s name and address directly into the invoice. Later, you create a customer account named Bob’s 
Hardware and create more invoices. Now you have several invoices for Bob’s Hardware, but one is for the walk-
in account and the rest are for the Bob’s Hardware account. If you try to pick up all the invoices at once, 
PrintSmith Vision does not let you since invoices being picked up together must all belong to the same account. 
Worse, if you pick up just the walk-in invoice, it will not show up in Bob Hardware’s history — it is in the history 
for the walk-in account. 

Tip  To reduce this type of problem, ePS recommends that after you create a document for a new customer 
using the walk-in account, you use Create Account from Document in the Invoice Summary tab to 
create an account for that customer. Doing so also greatly reduces the number of documents assigned 
to the walk-in account. If an account already exists, and the document was created using the walk-in 
account, select the correct account from the Account drop-down field. 

For one-time business, you can select the walk-in account (displayed as <<< WALK-IN >>>). If necessary, you 
can always use the information you entered for a walk-in customer to create a new customer account. 

Note  ePS strongly recommends that you use the walk-in account only for one-time business. If you select the 
walk-in account for many different customers, you will find it very difficult to track history effectively. 

Create Jobs (Job Methods) 
A job in an estimate or invoice identifies the work that is required to complete an order for a customer, as well as 
calculates the price to be charged for the work. A job could be 1,500 flyers on an offset press, 500 color copies, 
10 large format banners, or sewing that requires the services of an outside vendor.  

Note  In addition to including jobs, estimates and invoices typically include charges, which are value added 
products and services such as design, cutting, or folding. 

The amount of information you must provide about a job depends on the type of job you are creating, also known 
as the job pricing method. Each pricing method is designed to handle a particular kind of job. This document will 
list some of the different job methods and how they are set up.  

General Procedure for Creating a Job 
The procedure that follows summarizes the process of creating a job with details about different types of jobs. 

1. To add a job to an invoice or estimate, do one of the following: 

• Under the Create From field of the New Estimate or Invoice window, select Create New Job to 
create a new job or click Job Templates to create a job based on a template.  

 
• In the Job Details tab of an Estimate or Invoice window, click New Item to add a new job. 
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2. After selecting how you want to create a job, select a job pricing method from the Job Method field.  

Note  The pricing methods that are available as selections and their names are controlled by 
preferences (Configuration > Preferences > Settings > Estimator > Pricing Method). What you 
see may therefore not match some of the examples. 

Each pricing method is designed to handle a particular kind of job. The job method determines the 
properties of the job and how its price is calculated.  

• Printing for an offset job on a standard sheet-fed press.  

• Roll Fed for a job on an offset web press.  

• B&W for a black-and-white job on a copier or digital press.  

• Color for a color job on a copier or digital press.  

• Large Format for a wide-format digital job.  

• Signage for wide-format digital job 

• Charges Only for an order that includes just setup or finishing charges (no printing).  

• Blank for pricing a job for blank stock.  

• List for a job based on a price list.  

• Outside Services for a job that is sent to another vendor.  

• Merchandise for any other kind of job that is not accounted for by one of the other pricing 
methods.  

• Multi-Part Job for a job that includes sub-jobs.  

• Free Style to just produce an invoice for jobs. 

3. Click Next. This opens the Job Details tab of the Estimate/Invoice window. 

Other fields that are displayed depend on the job pricing method you selected. Complete the fields as 
described for the type of job you are creating. 

4. Select the stock you want to use for the job and select the copier. 

5. Add setup and finishing charges to the job. 

6. Do any of the following as necessary:  

• Add content files (digital assets) to the job.  

• (Invoices only) Produce a job ticket if the job is part of an invoice.  

• Create labels for cartons.  

• Review production data. 

7. Once the information has been entered, click Confirm to save the job information. 

Important Selecting Confirm does not save the estimate. You must use the save button on the 
estimate summary screen. 

8. Review the account information and the entire job from the Account Information and Estimate 
Summary tabs.  

9. Click Save. 
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Printing Job 
The Printing job method is for offset jobs that are printed on a sheet-fed press. These jobs are based on sheet- 
fed press definitions. 

1. Follow the general procedure for creating a job and select Printing as the job method. (Your 
company may use a different name for this job method.) 

2. In the Job Details tab, select the product. In the Product field, select the type of product the job 
represents. (You can use Table Editor to define product types.) 

Note If Product Type for Job is selected in the Mandatory Field preferences, the Product field is 
outline in red. You must select a Product before you can save the job. 

3. If necessary, change the settings of the Brokered or Finished options. (Brokered is 
automatically selected if you create a job based on the outside service pricing method.) Identify if 
the job is Finished. 

4. If you are using Tracker, in the Location field, select the area where the job takes place. 

5. In the Copier field, select the press. This is the press configuration that will be used to determine 
the price of the job. Select the correct press definition for the job. (Your choice affects the price of 
the job.) The press specifications will be compared to the stock selected and you will receive a 
warning if the stock size does not match the press. 

6. Enter a Description for the job. 

7. If this job uses a stock, select the Stock drop-down field. You can also use the Stock Picker icon to 
select a stock. In the Stock Picker window that opens, select the stock you want to use for the job and 
then click Confirm. When you select the stock, the Parent Size field will be automatically filled in 
from the stock information. 

8. If the stock requires a special order, click Special Order and complete the Stock Definitions window 
with information about the special stock. The Special check box is automatically selected for such stock. 

  
9. If the stock will be supplied, select the Supplied check box, and select the stock; the cost of the stock is 

deducted from the price of the job. 

10. Complete the Run Size, Finish Size, Folded Size, and UP/ON fields. An image of the layout will 
be displayed with this information. 

 
Note The UP and ON fields are calculated automatically based on the settings in the Paper 

Calculator window but you can change them as required. UP indicates how many images fit 
on the run sheet. ON indicates how many unique images (originals) you have. Again, if you 
are producing one kind of flyer this should be set to 1. 

11. In the Original Sheets field, enter the number of originals involved. Original Sheets can also be the 
number of versions if, for example, you are producing four different variations of a flyer. If, however, you 
are producing one kind of flyer from one original, you should leave Original Sheets set to 1. 

12. The Press field shows the number of impressions needed to get a finished quantity and is 
calculated by dividing Quantity by the number UP. (If the Press total cannot be divided evenly by 
the UP number, it is rounded up.) Change the number in the Press field, if necessary, but keep 
in mind that PrintSmith Vision will then change the number in the Quantity field. 
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13. Enter ink information. You can identify the number of colors, passes, and washes for the front and 
back of the material.  

a. For Colors, specify the number of colors to be printed on the front and back. The 
default is 1, but for multi-color jobs, enter the number of colors. 

b. For Passes, specify the number of runs that are needed for the number of colors 
specified. Initially, Passes is based on the number of color heads in the selected press. If 
you need to run one color twice, you can change the number of passes as long as it is 
higher than the minimum number of passes. (This is considered an override.) 

Note Labor and run time are based on the number of passes, not the number of colors. Charges 
are based on the number of colors, not the number of passes. 

c. For Washes, enter the number of press washes for each side of the job. The number 
of washes (on both sides) is multiplied by the wash rate in the press definition and 
added to the price of the job. 

d. Click the Ink field and select (or enter) up to six colors. (The available selections come 
from the Ink Color table, which you maintain with Table Editor.) 

Note For CMYK, enter each color in a separate field (four fields altogether). When you select 
an ink here, it is not billed. To include the ink in the job price, you must add ink charges. 

 
You can type in a PMS ink in the small box displayed in the line. That ink will be displayed in 
the short cut menu and selecting the plus sign will enter that ink in the line. 

14. Enter the Run Method. Often only one option will be available based on the press and stock. 

15. Complete the fields on the right side of the Job Details window. In the Quantity field, enter the 
quantity.  

To specify multiple quantities, the + Add Quantity button. See “Specifying more than one quantity for 
a job” for more information. 

16. Enter the Overs/Unders quantity, if applicable. If you want to charge for the difference between the 
ordered quantity and the quantity actually delivered, in the Overs/Unders field, enter a positive 
number if the delivered quantity is over the ordered one or a negative number if it is under. Overs 
and unders typically apply only to jobs with large quantities involved. 

Note The total price of the job (including all charges) is divided by the quantity ordered to get a unit 
price. The unit price is then multiplied by the quantity entered in the Overs/Unders field. This is 
added to the job price and the total job price. 

17. The In Sets of field typically applies when carbonless or NCR stock is being used for the job, and 
indicates the number of sheets in a set, for example, for 3-part NCR, enter 3 in the In Sets of 
field. Otherwise, this field is not used. 

Tip For an item like pads, enter the total number of items in the Quantity field. For example, if you 
need 100 pads of 25 pages, you would enter 2500 in the Quantity field and 1 in the Sheets 
field. You would then use charge definitions to make the pads themselves. 

18. Add any setup and finishing charges to the job. You can add the Charges to the job clicking the Add 
New button.  
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Note When you are adding charges or modifying any existing charges, make sure to click the 

Confirm button to save the charges to the job.  
19. Finishing operations (such as bindery) may have some associated waste, such items are listed in 

the Waste section. As you add charges to the job, any associated waste is calculated and added 
to the Bindery Waste field. If necessary, enter a different number in the Bindery Waste field, but 
avoid doing this until you have added all finishing charges to the job. 

Note When a finishing charge is defined in sets, the waste is the number of sets (not sheets) that 
are spoiled. 

20. In the Est Waste field, enter the number of sheets you expect to lose during the production process to 
get the required number (Quantity) of good prints.  

21. Click Confirm to add the job. 

Job Details Options 
There are several command options available when you create a job. 

Special Order 
If the stock requires a special order, click the Special Order icon, and complete the stock definitions window with 
information about the stock.  

 
If the stock for the job is not part of your inventory, then you can select the option for Special Order. This enables 
you to specify special-order material. In the Stock Details window, you can enter all the material specifications.  

For more information about the various fields in this window, see “General Information about a Stock”. 

1. Click the Special Order icon in the Job Details tab. The Special - Create New Stock window opens.  

2. In the Stock Details tab, enter the specifications of the stock, for example, select the type of stock, and 
enter the Vendor, Name, Color, and so on.  

3. If you want to add the special-order stock into Stock Definition for re-use, then enable the “Use in 
future” option. 
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4. After completing the Stock Details tab, enter cost information for different quantities in the 
Price/Quantity tab.  

 
5. Select Done when you are complete, and the information is copied to the job detail screen.  

Stock Picker 
If you want to see the full list of stock, click the Stock Picker icon.  

 
You can view all of the stocks in inventory from the Stock Picker list. You can use the fields in the header to filter 
the stocks. For example, if you only want to see 80# stock, enter 80 in the field below Weight. Select the stock 
you want to use for the job and Click the Confirm button. The stock information will be entered automatically in 
the Job Detail tab. 

For more information about finding and selecting stocks, see “Stock List Window”. 

You can customize the Stock Picker window by going to the Customize Columns option and selecting the 
columns you want to see and in the order you want to see them. 
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Paper Calculator 
You can define the layout of the job using Paper Calculator. You may not need the paper calculator in all cases. 
The Paper Calculator will enable you to determine the amount of parent sheets needed and the material cost. 
You enter the specifications, and the system will calculate the amount of material needed for the job. 

 

Using the Paper Calculator 

Although not an imposition tool, Paper Calculator lets you specify certain aspects of the layout such as bleeds, 
gutters, and white space. Paper Calculator also shows you the number of sheets out and the number of cuts for 
any combination of parent, run, and finished sheet sizes.  
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Although you can provide this information for each job, you can create paper templates for your standard layouts 
and re-use them in future jobs. 

• To use the same layouts for many of your jobs, click Save as Template, provide a name for the 
template, and click Save. You can use this template to avoid having to make the same selections in the 
Paper Calculator window each time you create a job with the same layout.  

• When you are finished, be sure to click Confirm. The Confirm button does not save the estimate. To 
save the estimate you must select the Save button on the Estimate Summary tab. 

Changing settings in Paper Calculator 

• When you open the Paper Calculator window opens after you select a stock for a job, the 
window already includes some information about the dimensions of the stock. Otherwise, you 
must provide this information. Always check the run and finish sizes and make sure other layout 
settings are as you want them. 

Note The default settings of certain fields in the Paper Calculator window are controlled by your 
paper calculator preferences, but you can change them when using the Paper Calculator for a 
particular job. 

• The settings and features in the Paper Calculator window include the following: 

• If you have created paper templates, click the Paper Template dropdown list to locate and 
select a template for the job. The Template Name field then shows the template you selected. 

• Parent Size: The size you purchased. 

• Run Size: The size of the paper that goes through the machine. Change this by selecting a 
different size or entering a size. 

• Finish Size: The final size of the paper after the job is done. Change this by selecting a 
different size or entering a size. 

• Selecting the slide bar will display the options for the following elements. 
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• Grip Edge / Gap: Enable this option to include a gripper edge. This is the amount of space 
required on one feed edge of the run sheet for the press to pick up the paper. You may be able to 
ignore this setting due to the placement of the image on the page. The size of the grip edge usually 
comes from the press definition but may come from your Paper Calculator preferences. You can, 
however, change the grip edge/gap in the Paper Calculator window for an individual job. 

• Folio Edge: Enable this option to include a folio edge. This is the amount of space that is 
reserved on an edge of the run sheet for a multi-part job. The folio edge is used when folding 
signatures to offset the imposed image and to leave one edge of the folded signature overhanging 
the other. If both the gripper and folio use the same edge, the larger of the two is used (they are not 
added together), and the edge is displayed half in red and half in green. 

• Color Bar: Enable this option to include a color bar opposite the gripper edge. 

• White Space: Enable this option if you want to define a part of the run sheet as unusable and 
have control over the page layout. 

• Gutter: Enable this option to include a space between multiple images on a sheet. The first value 
is the vertical gutter; the second is the horizontal gutter. 

• Bleed: Enable this option to include bleeds. A bleed extends the printed image beyond the edge 
of a page. This overlap is then trimmed to produce the final printed piece. Bleeds generally 
increase the number of cuts because the bleed must be trimmed off each finish sheet in addition to 
any cuts needed to separate each sheet. 

You can specify a different bleed for each edge, but generally the same bleed is used for all sides. 
Bleeds are shown as blue borders around each sheet and are added to any gutter that is specified. 

• Select the appropriate check box for the following items as needed. 

• Work and Tumble: Select this check box to change the cut-out diagram for tumbling by 
showing two gripper edges. (The Work & Turn label in the Job window then changes to 
Work & Tumble.) Except for a possible change in the number of sheets out due to the 
additional gripper edge, no other change to pricing is made as a result of selecting the Work 
and Tumble check box. 

• Back Trim, Parent: Select this check box if you consistently trim the edges from all four sides 
of the parent sheet. This effectively adds four cuts to the parent cut and centers the run 
sheets in the parent sheet. 

• Trim Four Sides: Select this check box to center the image by trimming the edges from all 
four sides of the run sheet. This typically results in the best ink coverage. 

• Disable FSC options: Select this check box if a stock is tracked for chain of custody (such 
as FSC certification), but the customer did not request a certified stock, and therefore you 
want to omit the chain of custody information from the document. 

• Print Options: Select what you want included when you print the cut diagram and indicate whether 
you want to attach the cut diagram to the job ticket. Click Print Template on the top-right to print the 
cut diagram. 

• Run to Finish Grain: If necessary, change this from Neither (where a best fit strategy is used 
without any sheet rotation) to Match Grain (sheets are never rotated to improve the number 
of sheets out) or Swing/Combination (sheets may be rotated to maximize the number of 
sheets that can be cut out). 

Note Sizes are defined in the Dimension table which you can edit with Table Editor. 

• The area on the right shows the cut diagram. Select Parent & Finish; Parent & Run; or Run & 
Finish to change what is displayed. 

Carton Labels 
You can create labels for the containers that hold the finished job. You can also define the format of these labels.  

Note  You must save the estimate from the Estimate Summary tab before you can print labels. 
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Creating Carton Labels 

1. In the Job Details tab, click Carton Label. The Carton Labels window opens. 

Note You must save the job before you can access the Carton Labels window. 
2. If necessary, in the Label Format field, select a different format. Carton Labels is automatically 

selected as the Label Format. You can edit label formats by clicking Edit Label Format. 

3. Complete the fields related to quantities and numbering: 

a. Enter the total number of items to be shipped in the Total Qty field. 

b. Enter the number of Items Per Box. 

c. Enter Number of Boxes for which you want to print labels. Typically, this is the only number 
you have to specify in this window. 

d. Enter a starting number, if it is other than 1, as well as an ending number in the N0. Start to 
End field. 

e. If you have a partial sheet of labels and you need to skip over them to the first good label, 
enter the number in the Labels to Skip field. 

4. In the Label Text field, enter any additional information to print on the label. 

5. Select to print Today’s Date or End Date. Else, select No Date to not print the date on the labels. 

6. Select the information that you want to include on the label, for example, Job Description or Estimated 
Weight. 

7. Enter the information on how you want the labels to print. 

8. Click Print after you specify all the carton label information. 

 

Defining, editing, or deleting label formats 

You can define, edit, or delete the formats for carton labels. PrintSmith comes with a few pre-defined formats for 
labels. You can modify these formats or create as many additional formats as you need using the Define Label 
Format button. 
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To define a label format 

1. In the Job Details tab, click Carton Label. The Carton Labels window opens. 

2. Click the Define New Label Template icon.  

Note This window is also used for defining, editing, and deleting shipping. 
3. Enter a Label Name. 

4. Specify the label details. 

5. Click Confirm. 

To edit or delete an existing format: 
1. In the Job Details tab, click Carton Label. The Carton Labels window opens. 

2. From the Label Format drop-down field, select the label format that you want to edit or delete. 

3. Click the Edit label template icon. 

4. If you are editing the format, make your changes; if you want to delete the format, click Delete and 
then click Yes to confirm the deletion. 

5. Click Confirm. 

Production Data 
You can review production data from the Job Details tab. Here you can review production and pricing 
information for the job. The information displayed in this window comes from your pricing definitions and 
should not be changed except under special circumstances. The information that is displayed also depends 
on the job pricing method. For example, outside service or merchandise jobs have far less data than 
printing or large format jobs. 

Note  You can prevent an individual user from opening the Production Data window with a security setting 
(select Configuration > Admin > Security Setup and disable Job Production Data). 

 

Reviewing the Production Data information  

1. In the Job Details tab, click Production Data. The Production Data window opens. 

2. Review the information in the window: 
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Parent Size - The size of the purchased sheet. This is taken from the selected stock. (For large 
format jobs, this is Roll Width, not Parent Size.) 

Parent Costs - Your price for the Parent Size sheet for the number of sheets shown in the Per 
field. (For large format jobs, this is for square area.) 

Requires (Parent Sheets) - The number of parent sheets (or other unit) required to run the order. 
(This cannot be changed.) 

Press - The press definition selected for the job. (For B&W, color, and large format jobs, this is 
Copier – the digital definition used for the job.) (This cannot be changed.) 

Out - The number of Press/Run Size sheets that you can get out of a given parent sheet. (You can 
override this number, but if you do, PrintSmith Vision cannot generate a cutout diagram.) 

Press/Run Size - The dimensions of the sheet being run. 

Production Run - The number of impressions per run. (This cannot be changed.)  

Sheets Purchased - The number of sheets purchased for the job. (If the selected stock has a 
minimum quantity, this number may be higher than the actual sheets required for the job. The cost 
of the additional paper is included in the job if the Charge Customer for Entire Order check box 
is selected in the stock definition.) (This cannot be changed.) 

Press Speed – The speed of the press. This is expressed in Impressions/minute. (For B&W, color, 
and large format jobs this is Copier Speed.) 

Markup - The markup on the stock (your gross profit on the stock). 

Labor Rate/Markup - The labor rate and labor markup used for the press. 

Setup, Run, Washup, Total Time - The time to set up the press and the time required for washup 
apply only to jobs based on press definitions. The run time is based on information in a press or 
digital definition. 

  
Job Price - This area of the Production Data window breaks down the job price: 

Name Description 

Stock The Cost, Markup, and Price breakdowns for the stock for the job. 
Labor The Cost, Markup, and Price breakdowns for the labor for the job. 

Itemized Markup The total markup charges (if any) attached to the job. Markups are calculated 
separately after all other charges are calculated so they are based on the 
most current prices and exclude invoice level charges or customer discounts. 

Other Markup The total of all charges attached to the job that are not markups. 

Production The total charged for washups. (For jobs not based on press definitions, you 
can use the field to add any additional production fees for which you do not 
already have a charge, for example, a delivery fee to an outside vendor.) 

Target Adjust For offset jobs where you have a price list if you price the job differently than 
the price list the difference will be displayed in Target Adjust. 

Job Price The total of all the prices shown in the window (unless the job price was 
overridden). 
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Estimator Checklist 
PrintSmith Vision includes an “estimator checklist” so you can review the entire job – from specification creation 
to production – in one place. To access this, click Estimator Checklist in the Job Details tab. The estimator 
check list has two sections, one for the item list and the other for the items table. 

One checklist is opened for each job in a document. The Item List shows general information about the job and 
the Items Table provides details of the items that make up the job. Items that are red and underlined indicate 
conflicting information or information that was overridden and warn you to follow up. 
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Generate Price List 
Once the details are entered you can create a price list. This is used for customers that are not sure of the 
quantity they want to order. 

 
Production Dates  
The date fields can be used in custom reports. You can use Table Editor to change the field titles in the 
Production Dates table.  

Digital Assets 
If the customer provides you with a digital content file, for example, artwork or a PDF, you can add it to a job. In 
PrintSmith Vision, such files are known as digital assets.  

1. Click the Digital Assets icon to add the file. The Add Digital Assets window opens. 

2. Click Upload Files to locate and include the file. 

After you upload, the name of that file is displayed. 

3. To preview a file, select it and click the Preview icon.  

4. To remove an existing file from the job, select it and click the Delete icon. 

 
5. After you add a content file to a job, the Digital Assets icon in the Job Details tab displays the number of 

files attached to the job. 

 

Job Notes 
Job notes are added to the job but are not seen by customers.  

1. When in the Job Details tab, click the Job Notes icon. The Job Ticket Notes window opens. 
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2. If the customer account includes notes, they are automatically displayed. Edit or enter notes as 
necessary. 

3. Click Add Time Stamp to put the date and time along with the notes.  

 
4. Click Confirm. 

 
The Job Notes icon in the Job Details tab displays a red dot indicating that the job has a note. These 
notes are automatically added to the job ticket. 

Multi Quantity 
If you want to see the effects of different quantities for a job in an estimate (to help you with the bidding process), 
you can do one of the following:  

• Specify additional quantities, but not change any job specifications.  

• Specify additional quantities and have the option of changing job specifications for each quantity.  

You can specify an unlimited number of additional quantities and have the option of changing job specifications 
for each quantity. 

Specifying multiple quantities with same job specifications 

Use the Add Multi Quantity icon in the Estimate Summary tab when you want to generate prices for additional 
quantities for a job and do not need to change any of the job specifications. 

1. When creating a job in an estimate, in the Estimate Summary tab, hover over the job for which you want 
to add multiple quantities. 

2. Click Add Multiple Quantity from the various options that are listed for the selected job. 
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3. In the Multi Quantity window, enter the quantities for which you want to see prices in the Quantity field. 

The prices include discounts and any invoice-level charges. Click the + sign at the end of the first row to 
add multiple quantities. 

 
Note If you have multiple quantities for a job, you can change the sequence of the lines by clicking 

and dragging the description. 
4. Click Done to add the additional quantities. The Estimate Summary tab now inlcudes multiple 

quantities. 

 

Specifying multiple quantities with different job specifications 

If you want to specify different quantities for a job or want the ability to change job specifications for different 
quantities, use the Add Quantity button in the Job Details tab as follows: 

1. When creating a job in an estimate: 

a. In the Job Details tab, enter the first quantity in the Quantity field. 

b. Provide other information about the job. 

c. Click the Confirm button. 

2. For the next quantity in the same job: 

a. Click + Add Quantity button. 
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b. In the new tab that opens, enter the next quantity in the Quantity field. 

c. Change other information about the job as necessary. 

d. Click the Confirm button. 

3. Repeat Step 2 for each quantity you want to estimate.  

4. The Qty Options area lists the multiple quantities that are specified for a job and displays 
corresponding job details in separate tabs. Click the one you want to open and possibly modify. 

 
5. When an estimate includes a job with multiple quantities specified, the Estimate Summary tab lists the 

various quantities. You can select a quantity and print to produce a report for a customer based on the 
selected quantity and its associated parameters.  

 
The printed estimate includes details for the selected quantity (1,500 in the figure below) and 
summarizes the prices for the other quantities (1,000, 2,000, and 2,500 in the figure below). 
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Roll Fed Job 
The Roll Fed job method is for jobs that are printed on an offset web press, for example, a newsletter printed in 
four colors on two sides. These jobs are based on roll-fed press definitions. 

Roll-fed jobs are identical to printing jobs (see above), with these exceptions: 

• Roll Width is the width of the entire roll of stock. This comes from the stock definition and cannot be 
changed. 

• The Cutoff field specifies the circumference of the physical cylinder on the press, for example, 11 
inches. This comes from the press definition. 

• By definition, there is only one pass on a roll-fed press, so Passes is always set to 1. 
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B&W or Color Job 
The B&W and Color job methods are for black-and-white and color jobs. Much of the information for such jobs 
comes from the digital definition and stock definition selected for the job. For many jobs, a description and the 
number of copies ordered is all that is required to price the job. 

1. Follow the general procedure for creating a job and select B&W or Color as the job method. 
(Your company may use different names for these job methods.) In the Job Details tab, complete 
the fields such as select a stock, press, and make any necessary changes in the Paper Calculator 
window. 

2. In the Description field in the Job Details tab, enter a name for the job, for example, Color 
Business Cards. 

3. The Copier field defaults to the digital definition associated with the stock (if any) or your default 
B&W or color digital definition depending on whether you are creating a B&W or color job. Select 
the correct digital definition for the job. 

4. The stock information and dimensions should be correct based on your stock selection and the 
information you provided in the Paper Calculator window. If you need to change stock, click Stock 
Picker. 

5. Select the number of sides to be printed as Simplex or Duplex in the Print field. 

6. In the Original Sheets field, enter the number of originals or number of versions (see examples below). 

Note In certain kinds of jobs (such as booklets), sheets are equivalent to leaves. When entering a 
value in the Original Sheets field for jobs like these, keep in mind that you are always 
describing the finished product. 

Example 1: In a job for a set of single-sided copies, Original Sheets is the number of originals. If 
you are making 100 copies of 10 pages, Original Sheets would be set to 10. (If the job is double-
sided, Original Sheets would be set to 5.) 

Example 2: In a job for four different versions of a single-sided flyer, Original Sheets is the number 
of versions so should be set to 4. 

Example 3: In a job for a 100-page comb-bound booklet, Duplex would be selected, and Original 
Sheets would be set to 50. 

Example 4: In a job for a 16-page booklet which is the result of folding the paper in half and 
saddle-stitching, Duplex would be selected, and Original Sheets would be set to 4. (4 double-
sided sheets folded in half and saddle-stitched result in a 16-page booklet.) 

7. The UP and ON fields are automatically calculated but change them as necessary. UP indicates 
how many images fit on the run sheet. ON indicates how many unique images (originals) you 
have. For example, if you are producing business cards with four different names, ON should be 
set to 4. 

Quantity divided by the number UP results in the value in the Copies field (which may be 
rounded up). Change the value in the Copies field, if necessary, but keep in mind that 
PrintSmith Vision will then change the Quantity number. 

8. In the Quantity field, enter the job quantity.  

9. If you want to charge for the difference between the quantity ordered and the quantity actually delivered, 
in the Overs/Unders field, enter a positive number if the delivered quantity is over the ordered one or a 
negative number if it is under. Overs and unders typically apply only to jobs with large quantities 
involved. 

Note  The total price of the job (including all charges) is divided by quantity to get a unit price. The 
unit price is then multiplied by the quantity entered in the Overs/Unders field. This is added to 
the job price and the total job price. 

10. The In Sets Of field typically applies when carbonless or NCR stock is being used for the job, and 
indicates the number of sheets in a set, for example, for 3-part NCR, enter 3 in the In Sets Of field. 
Otherwise, this field is not used. 
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Tip For an item like pads, enter the total number of items in the Quantity field. For example, if you 
need 100 pads of 25 pages, you would enter 2500 in the Quantity field and 1 in the Sheets 
field. You would then use charge definitions to make the pads themselves. 

11. Add any setup and finishing charges to the job. For example, if you are folding and stitching the 
job, add a folding charge and a stitching charge. 

12. Finishing operations (such as bindery) may have some associated waste. As you add finishing 
charges to the job, any associated waste is calculated and added to the Bindery Waste field. If 
necessary, enter a different number in the Bindery Waste field, but avoid doing this until you have 
added all finishing charges to the job. 

Note When a finishing charge is defined in sets, the waste is the number of sets (not sheets) that 
are spoiled. 

13. In the Est Waste field, enter the number of sheets you expect to lose during the production 
process to get the required number (Quantity) of good prints. Normally, Est Waste is set to 0, but 
you can override it (if you have permission to do so). 

Note Usually, waste is added to the run length. This affects the estimated run time for the job and 
the amount of labor. When labor is a factor in calculating the price, the price changes to 
reflect this. If the stock cost is part of the price calculation in the digital definition (the Stock 
Price is field is either set to marked up Stock Cost or set to from Copier 1, 2, or 3 in Stock 
Definition), waste is included in the price. 

14. Click Confirm to save the job. 

  

Add/Modify Special Pages 
You may have pages that are different than the rest of the pages. It could be some color pages where the rest 
are black and white, or it may be an insert. 

Here you can define the special pages and add them to the job. 
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1. Click the Add/Modify Special Pages button on the Job Details tab. The Special Pages window opens. 

2. Enter the page numbers for the special pages. 

3. Select the type of pages and enter a description. 

4. Select the stock type and the stock color. 

5. Select the sides as Simplex or Duplex. 

6. Selecting Print Services enables you to enter some specific printing services.  

7. After completing the fields, click the Add button. 

  

Large Format Job 
The Large Format job method is for jobs that are printed on a wide-format digital press. These jobs are based on 
large-format digital definitions. 

Large-format jobs are almost identical to B &W and color jobs, with these exceptions: 

• The stock selections (in the Stock Picker window) are limited to stocks used for large-format work. 

• The Cutoff is the length of the stock used for the job. 

• The Est Waste field is for specifying the number of prints (not square area) that you expect to waste to 
get the required number of good prints. 

• The Copier field defaults to the digital definition associated with the stock (if any) or your default large-
format digital definition. If necessary, select a different large-format digital definition for the job. 
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Signage Job  
The Signage job pricing method is for jobs that use large format press definition and print on a large format 
digital press. Signage method can be used for jobs such as large banners for advertising, billboards, or posters. 

The Signage method includes a new UI for simplified workflow that is suitable for large format jobs. The UI 
contains only those options related to large format jobs. 

Note  By default, the Signage pricing method is not enabled. In order to create a Signage job, you must 
enable the Signage method in the Pricing Method page of Preference settings.  

Signage jobs are almost similar to the Large Format jobs, with the following additional features:  

• Quantity and square area pricing: Calculate the price of Signage jobs based on the area and quantity 
ordered. See Large Format Pricing Methods for more information 

• Paper calculator for Signage: Specify certain aspects of the layout such as bleeds and white space 
that are specific to Signage jobs. See Preferences for more information. 

• Unit: Enter the unit of measurement as in Feet, Meter, Inch, Millimeter, or Centimeter.  

• Ink charges: Define the ink pricing based on the percentage of coverage. You can add specific prices 
for a custom ink set, so the same set can be used for multiple devices. See Creating Digital Definitions 
for more information. 

• Auto rotate for best fit: Flip the finish size to get more out of the sheet or if grain is an issue. This is 
used to get more out of the roll by rotating it by 180 degrees.  

• Auto calculate Cutoff: Automatically calculate the length of the stock for a job that you are running 
through the large format device. This is calculated based on the finish size of the length of the job. 

• Estimate based on finished size: Estimate the number of tiles used for the signage job. When you 
print a signage job across multiple sheets of stock, each sheet is called a Tile. 
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In the figure above, using the Quantity and Square area pricing method, the job price to create 1 signage banner 
of 36” x 60” is obtained from matrix as $80.00. 

Note  When the Quantity and Square area pricing method is selected in a job, the Unit Per Side value will not 
be accurate if the job contains Wastage, Originals, or Duplex option. However, the job price calculation 
is accurate. 

Charges Only Job 
The Charges Only job method is for jobs that consist of just setup or finishing charges, for example, design work.  

1. Follow the general procedure for creating a job and select Charges Only as the job method. 

2. In the Description field, enter a name for the job, for example, Design and Consulting. 

3. If you plan to add more than one job aware charge, in the Quantity field, enter the job quantity. This 
quantity is then used automatically in all the job aware charges. Otherwise, leave the Quantity field set 
to 0. 

4. In the Notes field enter any comments to explain the job. 

5. Add the charges to the job. 

6. Click Confirm to save the job.  
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Job for Blank Stock 
The Blank job method is for selling blank stock. The prices for blank stock are taken from the Pricing for 
Blank Sheets area on the Pricing tab in the Stock Definitions window. 

  
Note Blank stock pricing is based on the Blank Stock Pricing quantity and markups in your Stocks and Sizes 

preferences and the costs in the stock. 
PrintSmith Vision uses the blank sheet pricing to calculate a unit price and then multiplies this by the quantity 
ordered for the job. 

To create a job for blank stock: 

1. Follow the general procedure for creating a job and select Blank as the job method. Then select a stock 
and make any necessary changes in the Paper Calculator window. 

2. In the Description field, enter the name for the job. 

3. In the Quantity field, enter the quantity. The Price is calculated according to the blank stock pricing in 
the stock definition. 

4. Click Confirm to save the job. 



62 • Productivity Suite | PrintSmith Vision User Guide 

 

 

   

List Based Job 
The List job method is for print jobs based on list pricing. List prices are tables of quantities and either 
numbers of colors or numbers of passes through the press. PrintSmith Vision includes some list price 
schedules to get you started. You can change the contents of the schedules or delete them as long as at 
least one is left. (There must always be at least one predefined price schedule.) 

Note List pricing is useful if you need to match another pricing system or a printed price list exactly, but you 
do have to enter and change the prices manually. 

If you use Crouser pricing, see the guide PrintSmith Vision - Crouser Pricing. Crouser list price schedules 
work very much like the standard list price schedules described here except that you cannot edit or delete 
them. 

If you create jobs based on list pricing, you can (but do not have to) assign price list schedules to stock 
definitions. When you select a stock for a list-based job, and the stock has a list price schedule associated 
with it, that list price is used for the job. Otherwise, PrintSmith Vision warns you that the default price 
schedule will be used. You should then select a list price for the job. 

Before you can create jobs based on list pricing, you must create your list price schedules or review and 
adapt the predefined price list schedules. 

Creating List Price Schedules 

The List Price Schedule method is for print jobs based on list pricing. 

1. Select Pricing > List Price Schedules. The List Price Schedules window opens. 

2. To create a list price based on quantities (copies) and number of colors, click the +Color button 
(New Color Schedule).  

Alternatively, to create a list price schedule based on quantity and number of passes through the 
press, click +Pass button (New Pass Schedule).  

3. To complete the price list information: 

a. In the Name field, enter a descriptive name for the schedule. 

b. By default, the price list is based on the ordered quantity, but if necessary, select one of the 
following in the Method field: 

• Use press sheets – the run quantity of sheets through the press. 
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• Use press sheets and bindery waste – all the paper running through the press. 

• Use ordered quantity per sheet (originals) – the ordered quantity for each original, for 
example, 25 business cards for each name. 

  
4. Enter your quantities and prices in the table. Note that the fields below the table are used for 

whatever additional increment that you specify; +1000 in the example below. 

 
5. Click Save. 

Modifying list price schedules 

ePS recommends that you review the pre-defined list price schedules and adapt them to your needs. 

1. Select Pricing > List Price Schedules. The List Price Schedules window opens. 

2. Select the list price schedule you want to review or edit from the List Price Scheduler drop-down 
list. 

3. Edit the schedule as necessary and click Save. 

Copying list price schedules 

1. Select Pricing > List Price Schedules. The List Price Schedules window opens. 



64 • Productivity Suite | PrintSmith Vision User Guide 

 

 

2. Select the list price schedule you want to copy from the List Price Scheduler drop-down list. 

3. Select the Duplicate button in the upper right-hand corner of the window and provide a name for 
the new List Price Schedule. 

4. Edit the schedule as necessary and click Save. 

Deleting list price schedules 

You can delete any list price schedule, but the system must always include at least one list price schedule so 
that a default exists. 

1. Select Pricing > List Price Schedules. The List Price Schedules window opens. 

2. Select the list price you want to delete from the List Price Scheduler drop-down list and click the 
Delete icon. 

3. Click Yes to confirm the deletion. 

Assigning list price schedules to stocks 

When you use list pricing as the job method, your stock definitions can be (but do not have to be) associated with 
list price schedules. When a list price schedule is associated with a stock that you select for a list-based job, the 
list price schedule is used to price the job. If the selected stock does not have an assigned list price schedule, 
you are warned that the default list price schedule will be used for a list-based job; you can then select a list price 
schedule for the job. 

Note The default list price schedule is the first one listed in the List Price Schedules window. 
To assign list price schedules to stocks: 

1. Open a stock in the Stock Definitions window. 

2. Click the Definitions tab. 

3. In the Select Schedule drop-down list and make your choice.  

4. Save the stock definition. 

Creating jobs based on list price schedules 

When you select List as the job method, a list price schedule must also be selected. If the stock you select for 
the job is associated with a list price schedule (see above), that schedule is used (although you can change it). 
Otherwise, you must select a schedule while creating the job. 

1. Follow the general procedure for creating a job and select List as the job method.  

2. In the Job Details tab, enter a name for the job in the Description field. 

3. Select the stock. If you were warned that the default list price schedule will be used, select a 
different schedule. 

4. In the Quantity field, enter the quantity ordered. If the schedule is based on colors, the initial 
calculated price is based on one color on the front. For passes through the press, the price is 
based on one pass. 

5. For a schedule based on colors, enter the number of colors on the front and back as shown in 
the figure below. (If the schedule is based on passes, enter the number of passes as 
necessary.) The price of the job is automatically updated based on the information in the list price 
schedule selected for the job. 

6. Click Confirm. 
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Outside Service Job 
The Outside Services job method is for jobs that you send out to other vendors, not do in-house. Such jobs are 
also known as brokered or vended jobs. An outside service job is marked up according to your outside services 
markup preference (Preferences > Settings > Estimator > Markups). You can always adjust the markup as 
market conditions change. 

Note Jobs are not identified as outside service jobs on estimates or invoices so your customers will not know 
these jobs were sent out. 

If purchase orders are enabled in your system, you can create a purchase order for the outside service. 

1. Follow the general procedure for creating a job and select Outside Services as the job method. 
(This may have a different name in your shop.) 

2. In the Job Details tab, enter a name for the job in the Description field, for example, Design Work 
for Spring Promotion. 

3. In the Vendor field, select the vendor you are using. (Use Table Editor to maintain your list of 
vendors in the Vendor table.) 

4. In the Notes field enter any comments to explain the job. These notes are for the outside service 
(vendor) and are not shown to the customer unless you select the Include Notes check box. 

5. In the Quantity field, enter the number ordered. 

6. Do one of the following: 

• In the Unit Cost field, enter the cost of one unit of the item you are having done. The system 
then calculates the Total Cost by multiplying Unit Cost by Quantity. 

• Enter the Total Cost. (No Unit Cost is calculated in this case.) 

Note Price is Total Cost multiplied by Markup. 
7. Click Confirm to save the job. 

Note If you activated any of the five Merch pricing methods (in the Pricing Method preferences), 
they work just like the Outside Services method. Typically, the Merch pricing methods are 
used to group outside services by different sales categories.  
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Merchandise Job 
The Merchandise job method is for any kind of work that is not accounted for by one of the other job 
methods. A merchandise job is marked up according to your merchandise markup preference (Preferences 
> Settings > Estimator > Markups). 

1. Follow the general procedure for creating a job and select Merchandise as the job method. (This may 
have a different name at your shop.) 

2. In the Job Details tab, enter a name for the job in the Description field. 

3. If applicable, in the Vendor field, select the vendor you are using. (Use Table Editor to maintain your list 
of vendors in the Vendor table.) 

4. In the Notes field enter any comments to explain the job. These notes are not shown to the 
customer unless you select the Include Notes check box. 

5. In the Quantity field, enter the number required.  

6. In the Unit Cost field, enter the cost of one unit of the item you are selling. 

Note Total Cost is the Unit Cost multiplied by the Quantity, and the Price is Total Cost multiplied by 
the Markup. 

7. If necessary, add charges to the job. 

8. Click Confirm to save the job. 

 

Multi Part Job 
The Multi-part Job pricing method is for complex jobs that include sub-jobs. For example, you have an order for 
a booklet that has a cover and a number of inside pages. The cover might be a process color job on coated stock 
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while the inside pages might be photocopied. The cover may need negatives, stripping, plates, scoring, and so 
on, while the inside pages are a simple copy job. Since the jobs are related, you want to keep them together. 

Some charges would apply to the entire job (for example, collating or binding) while others (for example, 
embossing the cover) would apply just to the cover job.  

Similarly, you might have an order for an unusual banner that involves three separate jobs: printing the 
banner itself, sending it out to be sewn, and sending it out for installation. 

After you select the Multi-part Job pricing method, you first provide some general information about the 
overall job, after which you add the individual jobs that make up the parts of the overall job. 

To create a multi-part job: 

1. Follow the general procedure for creating a job and select Multi-part Job as the job method. 

2. In the Job Details tab, provide information about the overall job. In the Product field, select the type 
of product the job represents. (You can use Table Editor to define product types in the Products 
table.) 

Note If Product Type for Job is selected in the Mandatory Field preferences, the Product field is 
outline in red. You must select a Product before you can save the job. 

3. If necessary, change the settings of the Brokered or Finished check boxes. (Brokered is 
automatically selected if you create a job based on the outside service pricing method.) Identify if 
the job is Finished 

4. If you are using Tracker, in the Location field, select the area where the job takes place. 

5. In the Job Comment field, enter any notes about the job. 

6. Enter the description. The job method will default to the Description field, but it can be edited, 
removed or added. 

7. Enter notes about the job. You can check the box to have notes included in documentation and 
invoice. 

8. In the Quantity field, enter the quantity ordered.  

9. If the Product you select for a job is associated with a specific tax table (in the Products table), the 
Tax Table field is (with some exceptions) set to that tax table. 

10. Add any setup and finishing charges that apply to the entire job, for example, collating the booklet or 
binding it. 

Note When a finishing charge is defined in sets, the waste is the number of sets (not sheets) that 
are spoiled. 

11. Add the sub-jobs: 

a. Each part of the multi-part job can be of different job method and can be defined when you create 
the part. Click the Add Part button to add each part to the job. This will take you to the Add Job 
window where you can select the job method for that part.  

 
b. Select a Job Method and click Next. This opens the Job Parts tab. Provide the job information as 

usual. 
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c. Add any charges that apply to the sub-job. 

d. Click Confirm. 

13 After adding the sub-job, click the Job Details tab or the Go to Job Details button.  

 
This will take you back to the multi-job details page where you can see all of the job parts. You can then 
repeat these steps for each additional sub-job. All the sub-jobs are listed under Job Parts. 
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14. To modify a sub-job, click it under Job Parts, and make the necessary changes in the Job Parts tab.  

15. To remove a sub-job, select it under Job Parts and click the Delete icon in the Job Parts tab. (To delete 
the entire job including all its parts, click the Delete icon in the Job Details tab.)  

Note As you complete each job part, be sure and select Confirm. This will add the job charges to 
the multi-part job. 

16. Click Confirm to save the entire multi-part job.   

Lines and Inches  
The Lines & Inches job method is for rubber stamps and is based on information in the rubber stamps pricing 
table. PrintSmith Vision provides initial values in this table, but you should edit them, so the pricing is what you 
want. 

Editing the rubber stamp pricing table (Stamp Schedule) 

The rubber stamp pricing table contains prices based on the number of lines of text on a stamp and the width of 
the stamp in inches. The numbers of inches and lines in this table are always whole numbers, but you can enter 
fractional amounts when creating a job, for example, 2.5 lines or 6.25 inches. In this case, the next largest value 
in the schedule is used to find the price, for example, 3 lines or 7 inches. 

1. In the PrintSmith Vision, click Pricing > Stamp Schedule. The Rubber Stamp Schedule window 
opens. 

2. The horizontal column represents the lines, and the vertical column represents the number of 
inches. If necessary, change the number of inches in the top row and the number of lines in the 
leftmost column. (These are always whole numbers.) The last column represents an additional inch, 
and the last row is for additional lines. 

 
3. Edit the prices for the various combinations of lines and inches. 

4. In the boxes at the bottom of each column, enter the price for each additional line above the last line in 
the table. Suppose the last line (19) is 56.60 for 3 inches, and the price for each additional line is 2.95. If 
the job specifies 21 lines and 2 inches, the price would be 62.50 to account for the additional two lines.  

5. Click Save. 

Note You cannot duplicate, edit, and/or delete the Stamp Schedule. You can only save the Stamp 
Schedule. 
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Creating jobs based on lines and inches  

1. Follow the general procedure for creating a job and select Lines & Inches as the job method.  

2. In the Description field, enter a name for the job, for example, Commemorative Stamp. 

3. If applicable, in the Vendor field, select the vendor you are using. (Use Table Editor to maintain your list 
of vendors in the Vendor table.)  

4. Complete the Number of Lines and Number of Inches fields. (These are required so the price can be 
found in the rubber stamp price table.) You can enter fractional values, but they are rounded up when 
the price is looked up in the table.  

5. In the Quantity field, enter the number of stamps required. 

6. If necessary, add charges to the job. 

7. Click Confirm to save the job. 

 

Free Style Job 
There may be times when you do not need a job ticket or estimate and just want to produce an invoice for the 
customer. For a free style job all you enter is the job description, quantity, and price. 
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Creating a Job from Account History 
When you select Account History in the New Estimate/Invoice window, a list of historical invoices or historical 
estimates is displayed for the selected account. This is helpful for reprint jobs where the price may or may not 
have changed.  

Note For walk-in customers you will also see a column for account name. 
1. In the Quick Access panel, click Create Estimate or Create Invoice. The New Estimate or Invoice window 

opens 

2. In the Choose Customer field, select an account from which you are creating the job.  

3. Under the Create From field, select Account History. Information from the historical estimates/invoices 
is listed for the selected customer. 

You can narrow the search by using the fields at the top of the header to filter the jobs from the posted date, 
invoice or estimate number, description, cost, or sales rep. 

 
4. Select the job that you want to use and then click Next. The Estimate Summary tab opens. If the prices 

have changed since the invoice or estimate was originally created, you have an option to update the price 
definitions by clicking Yes in the notification message as shown below: 

 
5. The quantity defaults from the original estimate or invoice but you can change it in the Qty column. The 

price will be automatically recalculated based on the new quantity. If required, select a product from the 
drop-down list.  

 
If you want to make changes to the job, select the Job Details tab. For more information on the Job Details 
tab, see Creating Jobs section on the job method that is appropriate.  

6. After you are done with your changes, click Save. 



72 • Productivity Suite | PrintSmith Vision User Guide 

 

 

Create Job from Templates 
If you create an estimate or invoice that you anticipate using for multiple customers, you can create a template 
using the information in the estimate or invoice. The template includes everything in the document except dates 
and the customer account. For example, if you frequently sell letterhead, you could create a document for the 
work involved in creating the letterhead, save it as a template, and use the template for any customer who wants 
such letterhead. As a result, you avoid entering the same information over and over again. 

If you create a job and anticipate using it in many orders, create a job template. A job template consists of a 
single job and all of the setup and finishing charges for that job.  

When you create an estimate or an invoice, there are two views with different options that you can select under 
the Create From field in the New Estimate/Invoice window. If you choose to use template categories, then you 
only see the options of Create New Job, Account History and Templates. If you do not use the template 
categories, then in addition to the three options, you also have the Job Templates option.   

   
Note  The Template Category View checkbox is available in Preferences > Settings > System > HTML 

View. Without the Template Category View option, you can choose either Job Templates or Templates. 
For either one, you can select invoice or estimate templates. 

When you select Job Templates, you can select any of the job methods and then the templates related to that 
job method are listed. Templates can be associated with particular customer accounts (on the Settings tab in the 
Accounts window). This facilitates the process of selecting a template when working with a particular account. 
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When you select Template, then the template categories are listed. You can select to show all templates or 
select a specific category to view the templates for that category. 

 
Note  You can create a template category from the template list or when you create a template from an 

estimate on the estimate summary screen. 

Creating templates  

1. After you enter all the information about a job, click the Save as Template icon in the Estimate 
Summary tab to create a job or an estimate template.  

2. In the Template Name field, enter a descriptive name for the template (for example, Standard Cover or 
Poster 24 x 18) so the template is easy to find later.  

3. Click Create. 

 

Using job templates  

To base a new job on a template, follow this procedure:  

1. In the New Estimate window, select Job Templates from the Create From field. A list of all the available 
templates is displayed. 

2. Choose a template based on which you want to create a job and click Next.  

You can sort the list of templates differently by clicking a column heading. If necessary, use the Filter 
fields to narrow down the list of templates by Name, Product Type, Job Method, Account, Created By, 
or Modified Date. 

3. When asked about updating the pricing using current information, click Yes to update it (recommended); 
otherwise, click No. 

4. Make any necessary changes to the job. In particular, edit the quantity for the job.  

5. Click Save. 

Note If you want to make changes to a job template, go to Configuration > Template List.  
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Account Information Tab 
You should always review the information in the Account Information tab, provide any missing information, and 
make any necessary corrections. 

Note If any account or contact fields are required (as specified in the Mandatory Field preferences), you must 
provide this information before continuing. This applies to the walk-in account, too. If there is a red box 
around the field, it indicates that there is some missing information.  

  
1. You can review or change the account information when working on an estimate or invoice: click the 

Account Information tab. You can identify the status of the account and the types of payments that will 
be accepted for that account. 

2. Review the Invoice Address; if necessary, click the Edit icon to change it. Doing so changes the 
address only in the document, not in the customer account. 

Note  You can change the account name and address if the Can change address on ALL 
documents option is selected in the Estimator Behavior preferences (Preferences > 
Settings > Estimator > Estimator Behavior). 

3. The Contact Person section includes information about the invoice contact from the selected account. 
If necessary, do one of the following: 

• Select a different contact in the Contact List field.  

• To change the contact information, click the Edit icon in the Contact Person section.  

 
• If the contact you want to specify is not in the Contact List, add one by clicking the Add new 

contact icon and complete the Contact Person window. This new contact is added to the 
customer account when you save the document.  

Select the “Show Contact Prefix and Suffix on Account Information tab” in Preference > 
Settings > HTML View to edit the prefix and suffix information for a contact in an invoice. Note that 
the “Show Contact Prefix and Suffix on Account Information tab” option is not selected by default in 
the preference settings. 
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Select Use as Temporary Contact to use the contact information as temporary contact. 

Note A temporary contact is not added to the customer account.  
4. Under Shipping, select the address you want to use for shipping. (This is then reflected on the delivery 

ticket.) Select the contact list option if there are other contacts already set up. To enter a new shipping 
address, select the option of Other and click the Edit icon to provide the address. 

5. Complete the Internal Purpose section: 

a. The Taken by field identifies the person who created the document (based on the username 
entered to log into PrintSmith Vision). If necessary, change this name. 

Note For better job tracking always log in as yourself; do not share your login with other users. 
b. If you had selected an account for the document, the name of the sales representative 

associated with the account is displayed in the Sales Rep field. If necessary, select a 
different representative. 

c. If necessary, in the Hold field, select a hold state if the job needs to be held or the customer is 
on credit hold.  

d. If necessary, select a Lead Source.  

Note When you convert an estimate to an invoice the selection in the Lead Source field is kept; 
if you copy the document to a new invoice or estimate, the value is not kept. 

e. If necessary, in the Proofreader field, enter the name of the person doing the proofing. 

If any information is missing, a warning will be displayed and the area for the missing information is outlined in 
red. 

Note Until the missing information is filled, you cannot switch to another tab. 

Estimate Summary Tab 
The Estimate Summary tab includes several features and provides details of the items that make up the 
estimate. 
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Add Free Style Item 
Free Style items can be added in a situation where a customer is ready to place an order but does not want to 
wait while all the information is being entered to create a job. This is helpful for basic jobs such as stationery 
where you know the price and the specification. You can provide the customer with an invoice and then later fill 
in the job specification. In this situation, you can select Add Free Style Item in the Estimate Summary tab. 

To add a Free Style Item to an estimate: 

1. Click Add Free Style Item. A new row is added to the Estimating table.  

2. Select the Product and enter a Description for the free style item. 

3. Enter a Quantity and total amount for the item in the Item Total column. The unit price will be 
calculated from the quantity ordered and total cost. 

4. Select if Item Tax is to be applied and click Save to save the estimate. Now, the Convert to Job button 
is displayed.  

 
5. The price of the free style job is automatically locked. To make changes to the free style item you have 

to unlock it by clicking the lock symbol. 

6. Click the Convert to Job button to convert the free style item to a job. This opens the Job Details tab. 

7. In the Job Details tab, you can change the job method and add the required job information, you can 
also mark the job has Finished and Brokered. You can also add charges to the job. 

Note You cannot add charges to a free style job before converting it to a job. However, once the job 
is converted, you can add the charges. 

Add Job 
The Add Job option enables you to add a job to the estimate. Selecting this option opens the Add Job window 
where you can select how you want to add a job and then create the job as usual.  

For more information, see “Creating Jobs”. After adding the job, it will be reflected in the total estimate. 

Add Charges 
When a press or stock definition that you select for a job has charges associated with it, those charges are 
automatically added as part of the job.  

You can also add charges directly to a job or document (estimate/invoice). When charges are added to a job, 
they are known as job-level charges; when charges are added to a document without being attached to a job, 
they are known as invoice-level charges.  

Almost any charge can be added to any job or document. The single exception is a markup charge. Invoice 
markup charges can only be added to documents, while the other types of markup charges can only be added to 
jobs. 
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Note When you are adding charges or modifying any existing charges, make sure to click on Confirm button 
and Done button to save the charges to the Estimate. 

Adding charges to an estimate/invoice  

1. In the Estimate/Invoice Summary tab, click Add Charge. The Invoice Charges window opens. Charges 
that were already assigned to the document are listed.  

2. In the Add New Charge field, select the charge you want to add. The details of the selected charge are 
displayed. Some information may be preset, but often you have to provide some information such as a 
quantity or time so the price can be calculated. 

3. If necessary, change the setting of the following check boxes:  

• Finished  

Clear this check box to identify charges with incomplete pricing.  

• Brokered  

Select this check box to identify charges for work that is sent out for production.  

• Display Quantity  

Select this check box to include the charge quantity in the document. 

• Hidden  

Select this check box to hide the charge in the printed document. 

• Hide Price  

Select this check box to include the charge in the printed document but hide its price. 

4. If you are including the charge on the printed document and want to change its description, enter the 
change in the Description field. (This does not change the description of the charge definition itself.)  

5. To include information for production staff (or the customer), enter it in the Notes field. The notes are 
not included in the printed document unless you select the Show Notes check box.  

6. If the charge requires additional information for the price to be calculated, for example, a quantity or 
time, enter this information.  

7. If necessary, change the Tax Table.  

8. Click Add Charge to add the charge. It is now added to the Estimating table.  

9. Repeat steps for each charge you want to add. Then click Done. 
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Adding charges to a job  

You can add charges to a job as follows:  

1. When in the Job Details tab, click the Add New button in the Charges section. 

 
The Job Charges window opens. 

2. Select and add a charge. The procedure for adding a charge to a job is the same as for adding it to a 
document (invoice/estimate). Complete steps as described in “Adding charges to a document” above. 

In the Job Details tab, the charges you added are listed under Charges. (To remove a charge, click the 
delete icon displayed at the end of row for each charge.)  

Note  The letter P indicates Press level charge in the image below. 

 

Managing charges in documents 

After you add charges to a job or to a document, the charges are always listed in the Estimate Summary tab. 
You can do any of the following: 

• Review and/or modify a charge by clicking the Edit icon that is displayed when you hover over the 
charge. You can change the description of the charge. You can also change the price and quantity. 

 
• Remove a charge by clicking the Delete icon for that charge.  

• Copy a charge within a document by clicking the Duplicate icon.   

• Rearrange the order in which the charges are listed on the document by dragging the description.  
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Create Account from a Document 
This is only available with Walk-In accounts. When you have an estimate or invoice from a Walk-In account and 
want to convert it as a new account, you can use the Create Account from a Document option. You must have 
a company name and+ address for this account. 

Save as Template 
If you create a job or an estimate and anticipate using it in again you can create a job or an estimate template. A 
job template consists of a single job and all the setup and finishing charges for that job. An estimate template 
contains all of the information from the original estimate. Templates can be used many times. Using the Save as 
Template option, you can create an estimate from a template and then add changes to that estimate as 
required. 

  
To save a job or an estimate as a template: 

1. In the Estimate Summary tab of an estimate, click the Save as Template icon. The Create a Template 
window opens. 

2.  Select if you are creating an estimate or a job template. 

3. Enter the template name and select the template category. 

4. Click Create to save the job or estimate as a template. 

You can also create templates for multi-part jobs. In this case, the template contains the overall job, its charges, 
and the parts (jobs) that make up the overall job, as well as their charges. For any repetitive jobs, templates save 
time and reduce errors. For more information about a creating job using a template see, Create Job from 
Templates. 

Copy to New Estimate/Invoice 
If you want to create a similar estimate or invoice, you can open the document and select Copy to New 
Estimate or Copy to New Invoice and then modify the copy. This option allows you to copy the entire 
estimate/invoice over to a new estimate/invoice. You can save much time and effort by copying an old invoice or 
an estimate to a new one and updating the quantities and pricing.  

When you copy a document, the order date is automatically updated to the current date. PrintSmith Vision keeps 
track of the number of the document from which you copied the new document. This number is displayed in the 
Source section of the Estimate Summary tab so that you can find the item that was filed by the original number. 
In addition, when a document is copied, the current tax status of the customer account is copied to the new 
document. If the account is not taxable at the time the document is copied, it is not taxed.  

To copy an estimate/invoice to a new estimate/invoice: 

1. In the Estimate/Invoice Summary tab of an estimate/invoice, click the Copy.. icon. The Copy to New 
Estimate and Copy to New Invoice buttons are displayed. By default, all the jobs in the selected 
estimate/invoice are selected to be copied to the new estimate/invoice. You can unselect the jobs that 
you do not want to copy to the new document. 
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2. Click Copy to New Invoice or Copy to New Estimate to copy the information from the open document 
to a new document.  

 
3. When asked if you want to use the latest pricing information and recalculate the entire document, click 

Yes or No. (Typically you will want to update the pricing.)  

Note PrintSmith Vision will not change the price if you overrode it or if you locked pricing.  
4. Edit the document and its jobs (especially the quantity) as necessary and save your changes. You will 

get a warning if you have not saved prior to copying. 

Email Estimate/Invoice 
To email an estimate: 

1. In the Estimate Summary tab of an estimate, click the Email Estimate icon. The Email window opens 
with a preset message. Selecting this option will first save the estimate if it is not already saved and 
then opens an Email window.  

2. Fill in the recipients and subject fields.  

 
3. Make any changes to the body of the message and click Send.  

Note The body of the e-mail is defined in Configuration > Email Template preferences. 

Estimate/Invoice Notes 
When you are working on an estimate or invoice, you can use the note pad to record notes related to an order. 
For example, if you are taking an order over the phone, you may want to jot down some notes so you can 
complete the document later. Similarly, if you purchased stock at a special discount and passed some of the 
savings onto the customer, you could record this. If the customer placed the same order again, and the stock is 
priced normally, the customer might question the price. The note you recorded would remind you of the reason 
for the price difference. In addition, if you lock prices, you may want to note the reason for doing so.  

Note You can change information on the note pad even if a document is locked.  
Except for the wanted by date (entered in the When field), none of the information you enter on the note pad is 
used in the document, but you can use the note pad to guide you in creating the job. The notes are saved with 
the document so you can return to them later when you have time.  

To record notes: 
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1. In the Estimate/Invoice Summary tab of an estimate/invoice, click the Estimate Notes icon. The Note 
Pad window opens. 

2. Enter or modify information in the note fields: Who, Phone, What, How Many, What Size, Paper, 
Notes, and When. (When corresponds to the wanted by date.)  

3. If you want the note pad to open automatically whenever you open the document, enable the Show 
Note Pad when document opens option.  

 
4. Click Confirm.  

Job Notes Attached 
You can identify if a job level note is attached to a job from the Invoice or Estimate Summary tab. If a job ticket 
note is added a job, a star (*) symbol is displayed in the line item on the Invoice or Estimate Summary tab to 
indicate that there are specific jobs in the order that require job level attention. You can avoid navigating to the 
Job Details tab to notice that there are notes in the job.  

 

Print Estimate/Invoice 
You can print the contents of an estimate by clicking the Print button. Select the format (document preference) 
you want to use for all the documents while printing. 
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Note Estimate must be saved before printing. You can also print from the Pending Documents window. 

Change Account 
You can change the account for an estimate. If you need to change the account: 

Click the Account drop-down field and select the new account. You can also type in part of the name. 

Note You can change the account only from the Account Information or Invoice/Summary tab. You must have 
permission to change the account. 

Special Instructions 
In the Special Instructions field, enter comments intended for the customer, for example, a reminder to supply 
artwork. These instructions are printed on the estimate.  

 

Sales Categories 
The Sales Categories section summarizes the sales categories associated with the jobs and charges in the 
estimate. It shows the estimate/invoice sales breakdown for each sales category. 

   
Note The total for the sales categories comes from the estimate/invoice Item Total and not the Total that 

could include taxes, discounts, or markup. 

Dates 
In the Estimate Summary section, provide the dates (and times where applicable) in the Ordered Date through 
Reorder Date fields by clicking the field and selecting date in the calendar or entering the date in the format 
mm/dd/yyyy. 
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• In the Ordered Date field, PrintSmith Vision automatically enters the date you are creating the 
document. Change this if necessary. 

• If a proof is part of the job, enter the date it is due in the Need Proof by field.  

• PrintSmith Vision automatically sets the Deliver On date to the Wanted By date. Change this if 
necessary and enter a time if you want. 

Note The meaning of the Deliver On date depends on your company. For example, it may be the 
date you need to ship the job, so it reaches the customer by the Wanted By date. 

• If you expect the job to be reordered, in the Reorder Date field, enter the date you expect this to occur. 

• If the number of days specified in the Normal due date (days) field in your Estimator Behavior 
preferences is not 0, PrintSmith Vision automatically calculates the Wanted By date (taking your work 
days into account in its calculations). Change this if necessary and enter a time if you want. 

• Select the Firm option if the date in the Wanted By field is the exact date the customer wants the 
order. 

• In the Ship via field, select the delivery method. (Use Table Editor to maintain your delivery methods in 
the Ship Via table.) 

•  If files provided by the customer should be saved, select the File Originals option. The default setting 
of this option comes from the account (on the Settings tab). 

 
• If you are creating an invoice, and have a purchase order number, enter in the PO # field.  

When the PO number is mandatory then the field is highlighted so that you can enter the data, Warning 
is not displayed when an invoice is saved. However, when you pick up the invoice, the following 
warning message is displayed: 

“Orders for this customer require a Purchase Order. Please enter a PO#.” 

• If you selected an account, and the customer is tax-exempt, the Resale # field shows the tax exemption 
ID or license number selected. If a walk-in is tax exempt, enter the tax exemption ID. 

Note  The Expense Code field is used if you are integrated with Market Direct StoreFront and an 
accounting code was used as the payment method. 

Price Information 
The Total area in the bottom right corner of the Estimate/Invoice Summary tab summarizes various totals 
including discount, shipping, and sales tax. You can review the details behind this summary, as well as enter a 
shipping amount, enter or change a customer discount percentage, change the tax status, select a different tax 
table and tax code, or lock prices. (You cannot change any prices directly except for shipping. 

To change a customer discount percentage, select a different tax table and tax code click (+) plus sign after 
label. 
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In the Estimate/Invoice Summary tab of an estimate or invoice, there are several options in the price information 
section. 

• You can add a discount or markup by selecting the plus sign next to the label. It can be entered as a 
percentage or a fixed amount.  

If the account had a one-time discount defined, and you indicated you wanted to apply it when you 
created the document, the discount is shown in the Discount Amt field, and the Apply one-time 
discount check box is selected. If no discount was defined, enter one now if you want.  

 
Note Discounts are defined on the Credit/Tax Control tab in the Accounts window.  

Similarly, if the customer account has a Discount Percent or Discount Dollars defined, this 
information is reflected in the Discount field of the Total section. Enter a different discount percentage or 
amount if necessary. If required, select Markup and specify the values. 

• Net Sub is calculated as Item Total + Discount/Markup. 

• If necessary, in the Shipping field, enter an additional shipping amount for the document. Shipping may 
or may not be taxed depending on how the assigned tax table is configured. Charges assigned to the 
shipping sales category are totaled separately in the Shipping Charges field. Generally, it is better to 
add a separate charge for shipping than to manually enter a shipping amount here. 

• You can add or change a Sales tax by selecting the plus sign. The Tax Table field identifies the tax 
table in use in the document. By default, the tax table assigned to the customer account is selected. If 
necessary, select a different tax table for the document. 

 
• Select the No Tax check box if no tax should be calculated for the document. (The initial setting of the 

check box matches the Tax Exempt setting in the customer account. If no account is assigned to the 
document, the No Tax check box is cleared so the document is taxable.) Selecting the No Tax check 
box will result in zero tax for the invoice/estimate. 

If the customer is taxable, you can still identify which lines are to be taxed and which are not.  
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Note At charge level, you have to open the charge and check if it is taxable. 

• If you have multiple tax tables for an invoice, it can be identified on the Invoice Summary tab.  

 
They will be identified separately on the printed invoice. 

 

• Click the three-dots ellipsis to use more options. 

 
• Shipping Charges shows the total of all items assigned to the shipping sales category. This 

amount does not include the amount in the Shipping field in this window. Shipping charges are 
taxed according to the taxable state of each charge, while tax on the amount in the Shipping field 
is determined by the tax table assigned to the estimate/invoice.  

• You can view the Finished, Notified, and Picked Up dates for each estimate/invoice. These fields 
are not editable and can be used for future reference. 

• Enable the Royalty Exempt option if royalty payments do not apply to the invoice. (The initial 
setting of the check box matches the setting of the Royalty Exempt check box on the Credit/Tax 
Control tab in the Accounts window.)  
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Note  The Royalty Exempt option is always displayed but can only be selected or cleared by a 
member of the owner or system admin access groups. 

• Enable the Lock Prices option to lock the prices for all items in the estimate or invoice. You can 
unlock the price for all items by unselecting this option. When the price is locked it, a lock symbol is 
displayed for each line item. See “Locking Prices” for more information. 

• Click Recalculate Price to update each job and charge in the document with the latest pricing 
information and then recalculate the totals.  

Locking Prices 
If you want to prevent the prices in a document from being updated or changed, you can lock them. You may 
want to do this if you commit to a firm price on a job. You can still change production details without affecting the 
locked price. You can also add a new charge to a locked document (which will affect the amount due), as well as 
unlock individual items to change their prices if necessary.  

Notes  You determine who can lock prices with Configuration > Admin > Security Setup. (The security 
for this feature is controlled with Lock Prices under Invoice.)  

To lock prices: 

1. Click the three-dots ellipsis displayed in the Total section of the Summary/Invoice Summary tab.  

2. Enable the Lock Prices option. In the document window, lock icons are displayed to the left of the 
Description column.  

 
3. If you need to change the price on a job or charge, click the lock icon to unlock the job or charge.  

 
4. You can then change the price. To re-lock the item, click the icon again.  

Note the following when you lock documents:  

• You can edit the quantity of a locked element without any effect on price.  

• New jobs created in a locked document are initially locked. If you cannot unlock pricing, any new job 
has a price of zero. For a price to be other than zero, you must unlock the job or invoice.  

• Historical documents retain the setting of the Locked Prices option. If you are basing a new document 
on a locked one in history, and want to update the pricing, just clear the Lock Prices option in the Total 
section and click Recalculate, and the invoice is recalculated. The locked prices are replaced with 
current prices.  

• If you delete a preset charge on a price-locked document, it gets deleted, but the price is retained. 
Although it is grayed out and shown with a line through it, the price is still included in the document 
totals. 

Costing Tab 
Cost is the amount you spend to produce the order; price is the amount you charge your customer. The 
difference is your profit. 

Although PrintSmith Vision does not require you to enter your costs, without that you will not be able to 
determine where you are making (or losing) money. 
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You define costs in your pricing definitions: 

• For charges, costs are entered in the Costing tab of the Charge Definitions window. 

• For digital definitions, costs are entered in the Cost section of the Digital Definitions window. 

• For stocks, costs are entered on the Pricing tab in the Stock Definitions window. 

Note ePS recommends that you build most of your profit into labor rather than having very high stock 
markups to compensate for a printing labor rate that is too low. 

You can change costs in a locked document (one that is in history). 

After you select charges, stock, and a press or printer for an order, the costs associated with your selections are 
calculated as estimated costs. If you use Tracker, it will calculate actual costs for you; otherwise, you can enter 
the actual costs manually if they differ from the estimates. You can review the estimated and actual costs in the 
Costing tab. 

To review or enter actual costs 
1. In the Estimate Summary tab, click Costing.  

2. Review the costs. The estimated cost, actual cost (once the job is complete), the difference, (selling) 
price and (job margins) is displayed for each line item. 

3. If you know the actual cost, then click the Actual column and enter the actual cost. Blue identifies 
costs that you entered. Red alerts you that an item was priced below cost. The margin will 
automatically recalculate. 

Click the down-arrow next to the charge to view the additional charges associated with the item. 
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Invoicing 
Creating Invoices 

Invoices show the actual price of the job and then serve as a bill for the work you performed.  

Note  Because estimates and invoices in PrintSmith Vision are so similar, this manual often uses the term 
document to refer to them. 

An estimate or invoice may include more than one job, and typically also includes some charges related to the 
work involved, for example, a charge for design work, ink, cutting, or boxes.  

In many situations estimates are unnecessary. If you know you have the job, you can just create an invoice for 
the customer. For complex work, however, estimates help you determine an accurate selling price as well as 
give you a way of submitting bids based on different quantities and different stock. If the customer accepts your 
quote, you convert the estimate to an invoice, meaning the estimate is won; If the customer rejects the quote, the 
estimate is archived (as part of the customer’s estimate history) and considered a loss. 

The content of estimates and invoices is very similar, as is the procedure for creating them. Estimates and 
invoices each have their own numbering system, however, and they are handled differently in the system. The 
only option that is available in invoicing but not in estimating, is the ability to print the job ticket.  

Steps for creating a new invoice is the same as creating an estimate. For information on how to create an 
invoice, see “Creating Estimates”. 

The following sections discuss some differences in the Invoice Summary tab.  

Invoice Summary Tab 
The Invoice Summary tab has several command options such as the ability to add the new invoice items that 
were not on the original invoice or not part of the job specifications. You can add a freestyle item, a job, or a 
charge. You can also copy everything to a new invoice at this level. 

Add free style, add job, add charges, save as a template, copy, email invoice, invoice notes, pricing information 
section, and print invoice are all the same as in creating an estimate. See “Estimate Summary Tab” for more 
information. 

Copying purchase orders when copying invoices 
When you copy an invoice and the invoice has purchase orders associated with it, you can choose also to copy 
some or all of the purchase orders to the new invoice. If you know you will need to purchase goods or supplies 
for the new invoice, the ability to copy the purchase orders saves you time – you can just make some minor 
changes (such as due date) and re-issue the purchase orders. 
  

1. Open an invoice with purchase orders.  

2. In the Invoice Summary tab, click the Copy.. icon and then click  Copy to New Invoice.  

When asked, update pricing if necessary (recommended). 

A message asks if you want to copy the purchase orders. 

 
3. Click Yes to copy the purchase orders along with the invoice or No to just copy the invoice. 

4. If you clicked Yes, the Purchase Order Selection window opens and lists all the purchase orders 
that were created for the invoice. 

5. To select all the purchase orders, click the top check box; to select individual purchase orders, click 
their check boxes. 
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6. Click Confirm. 

7. Click Save to save the new invoice. A message informs you that purchase orders were copied to 
the invoice. 

8. Edit the purchase orders as described in “Reviewing, editing, and copying purchase orders” and 
then print or e-mail them. 

Viewing the purchase orders created for an invoice  

You may find it useful to see a list of all the purchase orders created for an invoice. The list includes purchase 
orders for the invoice itself, purchase orders for jobs on the invoice, and purchase orders for job charges.  

When you have an invoice open with purchase orders associated with it, you can view the purchase order list.  

1. Open an invoice with purchase orders.  

2. In the Invoice Summary tab, click the Purchase Order button.  

 
The number of purchase orders associated with the invoice is listed along with Invoice button.   

3. Click  Invoice. The Purchase Order window opens and lists the first purchase order that was created for 
the invoice.  

 
4. Click the down-arrow next to the New button and then select any other purchase order associated with 

this invoice. To review, edit, or copy the purchase orders, click it. 

Raise a PO 
If you need to have an outside purchase for part of all of the job, then you can create a purchase order. You can 
create purchase orders for an invoice from the Invoice Summary tab.  

1. When the invoice for which you want to create a purchase order is open, click Raise PO for Invoices 
button in the Invoice Summary tab.  

The Purchase Order window opens with the invoice number displayed in the Document# field, and the 
Description, Quantity, and Unit Price taken from the job.  

2. Complete the purchase order as described in “Creating a Purchase Order for Stock” section of Ordering 
Stock.  
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Note, however, that you may want to:  

• Edit the Quantity for the line item if a quantity applies to the order. For example, if you are ordering 
a set of 1,000 letterhead and envelopes, you would want to indicate this.  

• Edit the Unit Price for the line item so it reflects your cost instead of the price you are charging a 
customer for the job (as calculated in the invoice).  

Notes  If you make changes to the job after creating the purchase order, those changes are not 
reflected in the purchase order, but will be reflected in any new purchase orders for the job. 

 In order for a vendor to be displayed for a purchase order the box labeled “use for 
purchasing” in the vendor record must be selected. 

 You must enter the Required By Date before you can email or print the purchase order. To 
email the purchase order, you must have an email address in the vendor record. 

You can generate multiple purchase orders for one invoice. Create the first purchase order, enter the information 
including the due date, and save it. Then you can create another purchase order by using the New button. All of 
the purchase orders for the invoice are listed and available as shown below: 

 
You can also raise a purchase order for each line item in an invoice. 

 

Tax for Purchase Order  
You can choose to have the tax displayed for the purchase orders. To enable this, go to Preferences > Settings 
> System > HTML view and check Enable tax for Purchase Order. There is a warning associated with this 
selection. 
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Now, when you open a purchase order, the tax information is displayed. 

 
You can edit the Quantity, Unit Price, and Sub Total fields. If you change the Sub Total, then the Unit Price will 
be recalculated. Similarly, if you change the Unit Price, the Sub Total will be recalculated. Finally, if you change 
the Quantity, then the Sub Total will be recalculated. 

The taxes are also displayed in the total. 

 
By default, the Ship To address for the purchase order is same as the company address. Click the Edit icon to 
edit either the Bill To or Ship To address. 

If you want to use the invoice address as the delivery address, enable the Use Invoice Delivery Address option. 

Note  When you change the delivery address while using the invoice delivery address, a warning message is 
displayed to change the invoice delivery address to the new address. 
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Print Job Ticket for Invoice 
Job tickets help with the production process. They provide job details to those responsible for producing the jobs. 
Job tickets can only be produced for invoices because invoices represent work to which the customer has 
committed.  

The information that is included in a job ticket is taken directly from the job, but you can also add special notes or 
instructions to a job ticket.  If particular job needs something done while creating a job, you can record this 
information under Special Instructions. This information is then included in the job ticket. You can, however, 
edit this information for a particular job in the Invoice Summary tab. 

Typically, you print a job ticket as the job is going into production. Before you print the ticket, you have the 
opportunity to preview it and make sure the information it includes is correct. 

Note  Before you can preview and print a job ticket, the job must be part of an invoice that has been saved at 
least once (and has an invoice number). 

To print job tickets 

1. Do one of the following:  

• To print the ticket for a single job, in the Job Details tab, click the Job Ticket icon.  

• To print the tickets for all the jobs in an invoice, in the Invoice Summary tab, click the Print Job 
Ticket for Invoice icon.  

2. Before a job ticket can be generated, it must be part of a saved invoice. If a message informs you that 
the invoice is not saved, and asks if you want to save the invoice, click Yes.  

3. The ticket opens in a preview window. (The appearance of this window depends on your browser.) 

 
4. If the ticket looks correct, print it. Otherwise, make changes to the job and repeat these steps. 
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Deposits for Invoices  
If a customer puts down a deposit on an invoice, you should record it, so it is tracked. Deposits are tracked 
differently from other receipts. Because deposits are a prepayment for work not yet performed, they are placed in 
a “deposits received” escrow account. They are tracked as receipts related to cash in the drawer and your daily 
deposit, but they are not included when calculating taxable or nontaxable receipts until the invoice to which they 
are attached is posted, resulting in “deposits applied.”  

To record a deposit for an invoice  

1. In the Invoice Summary tab, click the (+) sign next to Deposits in the pricing information section.  

 
The Deposit Entry window opens.  

2. Select Cash, Check, or Credit Card.  

3. In the Amount field, enter the amount of the deposit. Do not enter a deposit that is larger than the total 
amount due. PrintSmith Vision will not let you pick up an invoice with a credit balance. 

4. For a check, enter its number in the Ref # field.  

For a credit card:  

• If using integrated credit card processing, click the credit card icon. For information about this 
process, see the guide PrintSmith Vision - Secure Credit Card Processing.  

• If not using integrated credit card processing, select the type of card the customer is using.  

 
5. Click Confirm. 

The deposit is now shown in the pricing section of the Invoice Summary tab. 
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Note  If a receipt printer is selected in the Current Printer field (at the top of the Invoice window), a 

receipt is printed for the deposit. 
If the customer gives you another deposit later, you can record it using the same process. You can also remove 
(void) or change deposits as you like until the invoice is picked up. When the invoice is picked up, it is locked to 
prevent any further modification. 

If you end up with a deposit total that is greater than the total on the invoice, you have some options for 
correcting the problem so you can pick up the invoice:  

• You can remove an existing deposit by entering a zero as the deposit amount, removing the reference 
number (if any), picking up the invoice, and using Post Payments to enter the deposit as a payment. 
This allows you to put the remainder “on account” or apply it to another open item. This is a 
recommended method.  

• You can remove the deposit from the invoice and pick up the document using the deposit as the 
payment in the Cash Register window. Anything remaining is returned to the customer as change. This 
is also a recommended method.  

• You can change the amount on the deposit so it does not exceed the total of the invoice. This is not 
recommended because it leaves a very poor audit trail. When you change a deposit, it is removed and 
re-added. If the deposit was a check that already cleared during a daily closeout, the entire amount of 
the old deposit comes out of cash and is re-posted as a new deposit. When you perform the daily 
closeout, the check shown in PrintSmith Vision will not match the real check, and cash shown by 
PrintSmith Vision may be incorrect. 

Saving an Invoice 
The Invoice Summary tab provides a summary of the job that you added. Save the invoice by clicking Save. 
Until an invoice is saved, the following message is displayed at the top of the Invoice window. Ensure that you 
save the invoice after any modification. 

 
When you save an invoice, it is assigned a unique number and listed in the Pending Documents window where 
you manage orders that come into your shop. In addition, the customer account is updated to reflect any 
changes in the sales statistics caused by the new invoice. 

If a customer has “PO required on Invoice” checked in the Account – Setting tabs, when you save the invoice an 
alert is displayed that a purchase order is required. 

Note  Be sure to update all mandatory fields before saving the invoice. 
You have enter the customer’s purchase order number before saving. Then a message that the invoice has been 
successfully saved is displayed. 

Generate Delivery Ticket 
You can create multiple delivery tickets for each job. Also, multiple jobs from multiple invoices can be included on 
one delivery ticket. You can access the delivery ticket from the line items in the Invoice Summary tab. 
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Tip  Use the Delivery Ticket Manager to review delivery ticket history, create and modify delivery ticket 

forms, and add brokers. 
For the steps to create a delivery ticket, see “Delivery Ticket Manager”. 

The Delivery Ticket window lists all the delivery tickets associated with the job. For each ticket, you can verify 
delivery address, change the location of the item, and mark it as shipped. 
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Pending Documents 
The Pending Documents window is a “command center” for managing your active documents. These are all the 
invoices that are in production or are waiting to be picked up as well as all the estimates that were not voided 
(canceled), archived, or converted to invoices. You can control which columns are displayed in the Pending 
Documents window, the order in which the documents are displayed, and also the colors that identify certain 
kinds of information. 

Once you create a document, you need to be able to find it again. How you find it depends on the document and 
its status in the system. When you first create a new document, PrintSmith Vision puts it on the pending list. This 
list includes all of the “active” invoices and estimates in your shop and is displayed in the Pending Documents 
window.  

Eventually, each document in the Pending Documents window is removed as follows: 

• You convert estimates to invoices if you get the job, or void (cancel) or archive them if you do not get 
the job. You can track archived estimates in estimate history. 

• As work on invoices is completed, you pick up the invoices and indicate they were paid. You can track 
picked up and paid invoices in the history that PrintSmith keeps for accounts.  

Using the Pending Documents Window 
To open the Pending Documents window, click Pending Documents in the Quick Access panel. 

The Pending Documents window contains four tabs that you can use to select the type of document you want to 
view, or you can select to view all the documents. The documents can be identified visually by the icon on the 
tab and the icon to the left of the account. Each tab displays the number of documents in each category. 

Tip The number of web orders is not included in the total number of invoices. 

• Filter fields in each column header help you narrow down what is displayed and help you find the 
document you want. 

You can further filter to display documents according to their status, regardless of the tab you are using, 
use the All Type drop-down field.  

 
If you want to remove the filter settings, click the Clear Filter icon. 

• If you are looking for documents within a specific date range, you can enter the date range by selecting 
the starting date and then the ending date in the Wanted Date filter field. If you are looking for a specific 
date, the starting and ending date selected will be the same. 
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Tip Only click once when you select the date, do not double click. 

From the Pending Documents window, you can change the Wanted Date on any document without 
opening the document. You can also indicate that the wanted by date is firm. 

 
• You can control which columns are displayed in the Pending Documents window by clicking the 

Customize List icon. 

Colors identify different types of information in the Pending Documents window. PrintSmith Vision uses 
certain colors by default, but you can change them in the Customize List window.  

Each user can determine which columns are displayed, number of days of estimates to display, and the 
color indicator for invoices and estimates at different stages. 

 
Note  To keep the pending list manageable and improve performance, you can enter the number of 

days of estimates to be displayed in the Pending Documents window. 

• Click and drag columns to change the sequence of the layout. Sort the information in each column by 
clicking the up-down arrow in the column header. 
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Note  Each user defined in PrintSmith Vision can have different saved settings. For example, if 
someone with the user name (login ID) JoeC logs into PrintSmith Vision, his saved settings 
are available to him regardless of the computer or browser he is using. 

• Access the job information contained in an invoice or estimate by clicking the arrow to view the details. 

 
You can change the location of each job. The location for the estimate/invoice will reflect the latest 
location that was changed for a job. When you change the location of the estimate/invoice that location 
will be reflected in each job. To add job comments, click the Add button. 

• Clicking the Document No. in the Pending Documents window opens the estimate/invoice where you 
can make changes if needed.  

Pending Document Options 
While in the Pending Documents window, clicking the three-dots ellipsis in a document row displays few options. 
These options are different for each tab. 

Estimate Options Invoice Options 

  

Open in New Tab  
This option opens the estimate/invoice in a new tab for any modification or review. The document opens in the 
Invoice or Estimate window. 

Convert to Invoice  
This option converts the selected estimate to an invoice and opens the Invoice Summary tab.  

Notify Customer  
While in the Pending Documents window, you can click Notify Customer to look up contact information for a 
customer, log the interaction you have with the customer, and optionally indicate that follow-up is required. 
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Logging interactions in the Notify Customer window 

To log the communication, you had with the customer:  

1. In the Notify Customer window, Click the +Add New button.  

2. Select a type in the Add Activity drop-down field to categorize the kind of communication you had, for 
example, CALL or VISIT.  

3. Some default text is displayed in the Add to customer account log field. Edit this text or enter your 
own.  

Tip The selections in the Add Activity field and the default text in the Add to customer account log 
field come from the Customer Log Type table.  

4. If any follow-up is required, enable the Follow-up required option.  

5. In the Follow-up date field, enter or select the date on which you need to contact the customer.  

6. In the Follow-up by field, select the user to do the follow-up.  

7. In the Follow-up comment field, enter more details of what needs to be done.  

Tip Any default text in the Follow-up comment field comes from the Customer Log Type table.  
8. To indicate that the issue raised in a log entry was resolved, enable the Completed option.  

9. In the Date Completed field, select the date on which you resolved the issue.  

10. The Completed by field is automatically set to your user name, but if another user was responsible for 
resolving the issue, select that user.  

11. In the Action taken field, explain what was done so you have a record of it. 

12. To save the log entry, click Add. 

13. To copy, remove, or edit an entry from the log, select it in the list and click the Duplicate, Delete, or 
Edit icons. 
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You can email directly from this window by selecting the activity type as Email. 

The information that you enter in the Notify Customer window becomes part of the customer account, where you 
can review and manage it on the Log window.  

The Customer Log Type table includes the selections that are displayed in the Add Activity drop-down field in 
the Notify Customer window, as well as any default text that is displayed in the Add to customer account log 
and Follow-up comment fields. The information in this table helps to categorize log entries and save your users 
some typing. To edit this table so it includes information that is relevant to your company, go to Table Editor > 
Data List. Then search for Customer Log Type and make your changes. 

Hold Estimate  
This option enables you to select the reason for holding an order, for example, credit hold. 

 
Note The next time you open this option after putting the document on hold, you will have the option to 

release the hold. 
Lost Estimate  
Lost estimate allows you to identify the reason for the loss. 

If you may need to change the status of an estimate yourself, use the Lost Estimate option. For example, if you 
created several estimates for a job, but only used one of them, you would typically set the status of the unused 
estimates to Neutral (since they were neither won nor lost).  

To change the status of an estimate, select Lost or Neutral in the Estimate Status: field and then select the 
reason. If you select Other reason, enter your comments.  



Pending Documents | User Guide • 101 

 

 

 

The lost estimates are removed from the Pending Documents window and added to Estimate History with a 
status of Lost. 

Print Estimate  
You can print the contents of the document from the Pending Documents window. 

Void Estimate  
If you have no further use for a document in the pending list, you can void the document. Typically, you should 
only void documents that were mistakes. A voided document does not become part of a customer’s history. The 
document still exists, however, and can be retrieved by its number. Voided documents can also be opened and 
printed to give you a paper audit trail, as well as copied to a new document. To delete a document completely so 
it is no longer in the system, you must cancel the voided document. 

You can also void an invoice. When you void a document with a deposit, you are given the choice of returning 
the deposit to the customer or treating the deposit as a forfeit (you keep it). 

To void a document: 

1. From the Pending Documents window, select the document you want to void. (Make a note of its 
number so you can open it later if necessary.)  

2. Click the Void Estimate button.  

3. Click Yes to confirm that you are voiding the document. 

Archive  
If you gave a customer an estimate, but did not get the job, PrintSmith Vision recommends that you archive the 
estimate. When you do so, the estimate is removed from the pending list (helping to keep the list manageable) 
and is added to the estimate history for the customer account. An archived estimate is given the status of Lost 
(because you did not get the job) but you can change its status to Neutral in estimate history. By archiving, you 
also have a record of how many estimates a particular customer has accepted or rejected.  

To archive an estimate: 

1. From the Pending Documents window, select the document you want to archive 

2. Click the Archive Estimate button.  

3. Click Yes to confirm that you are archiving the document. 

Tip  To archive or void multiple estimates at the same time, select the estimates and click the Archive 
Estimate or Void Estimate button. 
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Pickup Order  
You pick up an invoice after an order is complete and the customer has paid for it. You can pick up more than 
one order, but they must all be for the same account. Pickup Order takes you to the Cash Register 
window. 

Note When you click Pick Up, PrintSmith Vision checks whether the tax rate on the invoice is current. If the 
rate changed since the invoice was last opened, you are warned that the tax is incorrect. If you receive 
this warning, open the document, check the tax (which is recalculated when the document opens), and 
save the document before picking it up. You can ignore the warning and pick up the document, but the 
sales tax will be incorrect. 

Ready To Pickup  
Select Ready to Pickup to indicate that an order is complete, and the invoice can be picked up. 

Delivery Ticket 
You can create delivery tickets for an invoice directly from the Pending Documents window.  

1. In the Pending Documents window, click the three-ellipsis for which you want to generate a delivery 
ticket.  

2. Click Delivery Ticket. The Delivery Ticket window opens. For information about creating delivery 
tickets, see Delivery Ticket Manager. 

Schedule Jobs 
If you use Scheduler, you can start the process of scheduling a particular invoice from the Pending Documents 
window. For information about Scheduler, see the PrintSmith Vision Scheduler Guide. 

1. In the Pending Documents window, click the three-ellipsis for the invoice that you want to add to the 
schedule. 

2. Click Schedule Jobs to open the Schedule Job window. You can then select the job and click Sync 
with Scheduler to generate tasks for the schedule, so they are added to the Schedule Board. 
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Work in Progress (WIP) 
Work in Progress contains all the jobs that are waiting for processing. The Work in Progress window helps you 
track your orders – as represented by the invoices and estimates on the pending list – in various ways. 

To open the Work in Progress window, click Work in Progress in the Quick Access panel. The Work in Progress 
window contains two views namely, WIP mode and Report mode. You can switch between these modes using 
the Switch to Report mode/Switch to WIP mode toggle button. 

WIP Mode 
In the WIP Mode, you can choose to display jobs or documents. A document may contain more than one job. 
Each job or document is displayed in the color according to its status. Each tab displays the number of items in 
each category. 

 
• Filter fields in each column header help you narrow down what is displayed and help you find the 

job/document you want. 

You can further filter to display documents according to their status, regardless of the tab you are using, 
use the All Type drop-down field.  

  
Once you have created a filter you can save and use it later. In this example, a filter was created for a 
particular customer, 1111 Football Management. Selecting “Save Filter” gives a short cut menu where 
you can name for the filter. 
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The saved filter is then available in the search field. 

 
Selecting “Manage Filters” allows you to modify or delete the saved filter. 

  
If you want to remove the filter settings, click the Clear Filter icon. 

• If you are looking for documents within a specific date range, you can enter the date range by selecting 
the starting date and then the ending date in the Wanted Date filter field. If you are looking for a specific 
date, the starting and ending date selected will be the same. 

Tip Only click once when you select the date, do not double click. 

• You can control which columns are displayed in the Work in Progress window by clicking the 
Customize List icon. 

Colors identify different types of information in the Work in Progress window. PrintSmith Vision uses 
certain colors by default, but you can change them in the Customize List window.  

Each user can determine which columns to display, identify the color for each item based on its status 
and set up other filter options. You can determine if you want to include estimates. 
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You can set up additional filters in the Customize List window. You can set up a filter based on the 
Order price you enter. You can also choose to display the orders for which you have received the 
deposit and also determine if you want to include shipping amount and tax amount in the displayed 
totals. In the case of order price amount and deposit received orders, these are available as filter 
options that you can select. If you select Include Shipping amount and Tax amount in totals, then the 
totals will change to reflect that amount. 

 
• Click and drag columns to change the sequence of the layout. Sort the information in each column by 

clicking the up-down arrow in the column header. 

Note  Each user defined in PrintSmith Vision can have different saved settings. For example, if 
someone with the user name (login ID) JoeC logs into PrintSmith Vision, his saved settings 
are available to him regardless of the computer or browser he is using. 

• Clicking the Inv#/Job# and Job Description in the Work in Progress window opens the 
estimate/invoice where you can make changes if needed.  

• If you are using Fiery and you have jobs assigned to Fiery, the Fiery Integrated tab is then visible, and 
you can select for those jobs. 

 

Work in Progress Options 
While in the Work in Progress window, clicking the three dots ellipsis in a document row displays the context 
menu options.  

 

Assign Job  
You can assign a user to the job. Selecting Assign Job displays a list of users to whom you can assign the job. 
The user name is displayed in the Assigned To column. 

Outsource 
You can mark the job as outsourced by selecting the Outsource option. This will cause the job to be marked as 
outsourced and change the number of jobs in the Outsourced tab. 
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Note  Marking a job as Outsourced does not change its pricing method and job price. 
Notify Customer  
If you contact the customer over an item listed in the Work in Progress window, use Notify Customer to log the 
interaction and, if necessary, indicate that follow-up is required: 

 
For more information about the various fields in the Notify Customer window, see “Logging interactions in the 
Notify Customer window”. 

Print Job Ticket  
You print a job ticket for the jobs in the document. Before you print the ticket, you have the opportunity to 
preview it and make sure the information it includes is correct. 

Release to Production 
If you want to release a job to production, select the Release to Production option. For information see, “Release 
a job to production, print a job tracker ticket, or assign a priority” in the PrintSmith Vision - Tracker User Guide. 

Add Digital Assets 
If you want to add a digital asset file to job, click this option. The Add Digital Assets window opens. Click 
Upload Files to locate and include the file, then click Confirm to add the file. 

 
To preview the file before adding it to a job, select it and click the Preview icon. To remove an existing file from 
the job, select it and click the Delete icon. If the job is already released to production, you cannot add or delete a 
file attached to the job. Also, for orders containing digital assets that are placed in MDSF, you can preview the 
digital assets for those jobs in the Work in Progress window. 

Note  Any user who is part of an access group with Job > Digital Assets selected in the Security Setup 
window (Admin > Security Setup) can add or delete the digital assets through the Work in Progress 
window. 

Submit to Fiery 
With Fiery integration, you can select where the job can be processed. The column “Device ID” will display the 
device ID. 
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Use the Submit to Fiery button to submit the job to fiery. 

Note If the job has already been submitted to Fiery, the Submit to Fiery option changes to Void Fiery. 
Selecting Void Fiery will cancel the job in Fiery. 

Download as PDF 
You can save the WIP list as a CSV file use the Download as CSV icon. Selecting the Download as PDF icon 
displays the Print Option window. Only the items on the screen will be printed. 

 

In the Print Option window, complete the following fields and click Print.  

• Print with Extra Space adds a blank line after each row in the PDF file. 

• Print with Job Comments adds the job notes after each row in the PDF file. 

• Repeat Headers repeats the column header on each page if the generated PDF file has multiple 
pages. 

• Open PDF in new tab opens the PDF file in new tab instead of showing the download option. 

• You have an option to select a Standard paper size or Custom if you want to specify the paper size 
and orientation.  

• If you selected Custom , enter the width and height. The Units field indicates the unit of measure to be 
used for the width and height. 

• You can also select the Orientation and Scale to be used in the PDF file. 

Report Mode 
Using the Report mode, you can select the type of report. In the Report Mode, the columns are fixed and cannot 
be customized like the WIP mode. You can still indicate the color to be used and identify items you want included 
in the reports.  

Note The maximum number of records displayed is limited to 500. 

Report Types 
Several variations of the Work in Progress report are available: 
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• Standard for a list of orders by number, customer name, title, ordered date, wanted by date, proof date, 

and total amount due. 

• Date and Time for a report very similar to the Standard report except that instead of showing the total 
due, the report shows the time of the order in addition to the date of the order. 

• Location for a list of orders by number, customer name, title, ordered date, wanted by date, name of 
user who entered the invoice (taken by), and location. (The location may have been manually entered 
or scanned.) 

• Weekly Schedule for an overview of the number and type of orders due in a week, starting on the next 
Monday. Orders due before then are listed in the Earlier column. 

• Press Schedule for a breakdown of invoices by jobs and for information about the workloads for each 
press according to the date and time jobs are wanted. 

Group By 
In the Group By drop-down field, select the group by which you want information in the report listed, for 
example, by Account or Location. You have options as to how you want the reports grouped. 

 
In this example, the grouping is by the Account. 
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Options  
In the Choose Options field, select or clear the following check boxes: 

 
• Include Invoices and Include Estimates - Select to include the Invoices and/or Estimates in the list. 

• Completed - Select this check box to include completed documents in the report. Completed 
documents are ready for pickup or delivery and are displayed in green.  

• Show Totals - Select this check box to include total and a count in the report. Subtotals depend on the 
Group By selection. For example, if you group by Due Date, the report has a total for each day.  

Note The Weekly Schedule and Press Schedule reports ignore the Show Totals check box.  

 
• On Hold - Select this check box to track invoices that are on hold and not actually in production. 

Documents that are on hold are displayed in red.  

• No Pricing - Select this check box to hide pricing information.  

• Firm Dates Only - Select this check box to include only those documents that have the Firm wanted by 
date option selected in the Invoice/Estimate Summary tab.  

  



110 • Productivity Suite | PrintSmith Vision User Guide 

 

 

Cash Register 
The Cash Register window lets you pick up invoices (signifying the work is complete) and post payments to 
Accounts Receivable. 

In PrintSmith Vision, you pick up an invoice after an order is complete and the customer has paid for it. Prior to 
pick up, an invoice is considered a “work order” that is pending and subject to change. In contrast, an invoice that 
you are picking up is considered final so should accurately describe the work performed and the price charged 
for the work. Invoices that are picked up and posted are removed from the pending list and added to the account 
history. The invoices are locked; you can no longer change them, but you can still open them and copy them to 
new invoices or estimates.  

Usually, you pick up invoices directly from the Pending Documents window since there you can just select the 
invoices you want to pick up. You can also, however, pick up an invoice from the Cash Register window if you 
know its number.  

Settings  
Customer Payment Options 
In the Cash Register window, you can only use the payment methods that have been approved for a customer. 
You can set up the type of payments that are available to a customer in the Accounts window. 

 
If you have set the customer for Cash Only, then the Cash Register window will show that as the default option. 

  

Credit Card Surcharge 
You should also set up any surcharge that you want to add when the customer pays by credit card. Select 
Preferences > Settings > Account > Credit Card Info. 

In the Credit Card Info tab, you set up surcharges for different credit cards. These can be based on what your 
credit card processor charges you. This is not considered income since it is paid to the processor. The surcharge 
will apply for all customers.  



Cash Register | User Guide • 111 

 

 

  

Receiving Payment 
1. In the Quick Access panel, click Cash Register (or select Accounting > POS > Cash Register). The 

Cash Register window opens.  

2. The first step is to identify the customer. Select the customer form the Customer field. You can enter a 
few characters of the customer’s name and the Customer field will show you those that fit. 

3. Click the Add Invoice button to add invoices that are to be paid with the payment received. 

 
Note If you know the invoice number, you can enter it manually in the Enter Invoice field. 

The Pick Invoice window displays a list of the unpaid invoices for the selected account. Use the check 
boxes on the left to identify the invoices you want added to the cash register.  

4. After the invoice selection, click the Add to Pick Up button to place the invoices in the cash register. 

 
The invoices are now placed in the Cash Register window. 
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5. Next step is to select the payment method. See the “Payment Methods” section. 

Payment Methods 
Check 
Select the Check payment method and enter the check number in the Check # field. The Amount Paying 
defaults to the total of the added invoices. 

 
After you click the Receive Payment button, select if you want to print a receipt, select the print format for the 
receipt or email the receipt. Then click the Post button. 

 
Each invoice will be printed as a separate receipt and a message that the transaction processed successfully is 
displayed. 
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Cash 
 In the Cash payment method,  depending on the country you are based, the cash is rounded to the nearest 5 
cents. You can set this in Preferences > Setting > System > International. Selecting the Use Australian cash 
register rounding option will cause the cash receipt to round to the nearest 5 cents and any difference will show 
in rounding. 

 
For example, when paying by cash 94.93 is rounded to 94.95 with .02 going to rounding. 

Credit Card 
You can use CardConnect® as your card processor. For more information on use CardConnect® see the 
document for CardConnect® Integration. CareConnect® is a third-party credit card processing company. For this 
document we will go through the steps of using a credit card regardless of the system you use to process the 
card. In the case of CardConnect® a reference number will be supplied directly to the cash receipts program. In 
other cases, you will need to enter the reference number you get from you credit card processing company. 

You can select the Credit Card type and then enter the Reference Number. To get the reference number,  go to 
your merchants account screen and make the payment. You will get a reference number or approval number that 
must be entered in Cash Register. 

   
After entering the reference number, select Receive Payment. 

If you try to process the payment before entering the card transaction reference number, a warning is displayed 
that the card will not be processed. 

Charge  
A transaction can be charged only if a customer account is selected for the transaction and the account allows 
charges. This type of transaction is called a POS charge. A POS charge commonly occurs when a regular 
customer comes in, makes a small purchase, and asks you to charge it to his or her account. It is neither cost 
effective nor efficient to create a standard invoice for a small amount. Furthermore, you do not want the account 
history full of small transactions because it makes the history less useful. To see how to set up the account to 
accept charges and to set the credit limit for the account see the Payment Options set up. 

PrintSmith Vision maintains a special balance, called the merchandise charge balance, in each account for these 
small POS charges. These charges do not appear on statements. At the end of the month or some other suitable 
occasion, you should use Post POS Charges (available in Menu list) to print a special statement composed of all 
POS charges.  
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You can set up charge accounts for customers and then you can charge the invoice to those accounts. Charge 
an account does not impact your AR, you have to post payments for the charged amount in the Post Payment 
window. 

Select Receive Payment and the Last transaction payment received window opens where you can Post the 
charge. When the customer pays their charges, use Post Payments to process that payment. 

Department Charges 
In addition to invoices, you can add department charges. These are typically items purchased that are not part of 
the job such as boxes. To create a department charge, go to Preferences > Settings > POS > Cash Register. 

  
You can create a department charge by entering a name, selecting the sales category, entering the charge for 
the item if you want, and then selecting the tax method.  

To add a Department Charge in the Cash Register window, click the Department Item button and complete the 
fields and click Add. If the price is not already defined, you have to enter the unit price and the quantity. 

  
After you have identified the method of payment and clicked the Receive Payment button, you can print or email 
a receipt and Post the payment. 

Note  Regardless of the payment method you have the option to print or email the invoice to the customer. 
You can also use the customized email and attach the invoice and receipts. 

Picking up Invoice from Cash Register  
If you want to pick up an invoice from the cash register, you must know its number.  

1. In the Cash Register window, select the Customer and click Add Invoice button. 

2. Select the invoices that you want to pick up in the Pick Invoice window. Alternatively, you can enter the 
invoice number in the Invoice # field.  

Note  Only invoices (not estimates) can be picked up and the Invoices cannot have credit balances 
(deposits larger than the amount due). 
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 If the Only post invoices marked ready preference is selected (Preferences > Settings > 
System > Behavior), an invoice must be marked complete. You mark an invoice complete by 
clicking Location in the Pending Documents window and enabling the Ready for pickup 
option. 

3. Click Add to Pick-up. The invoices are placed in the Cash Register window. If you selected multiple 
invoices, the Cash Register window reflects the total of these invoices and lists them all in  the window. 

4. Under Payment Method, click Cash, Check, Credit Card, or Charge. Note that you can only select a 
payment method that is allowed for the account. If you select Check, you must enter a check number. If 
you select Charge, after the payment is made, you will need to record it in the Post Payments window.  

 
5. PrintSmith Vision automatically calculates the amount due and displays it in the Amount Receivable 

field. If necessary, enter a different amount. For example, a customer may have given you a check for 
part of the work but wants to charge the rest. In this case you would enter two payments. If the amount 
paid exceeds the amount due, PrintSmith Vision considers that amount “Change” and removes it from 
cash balance in the cash drawer when the transaction is posted. The Charge payment method, 
however, does not let you exceed the amount due.  

6. Click Receive Payment.  

The status window opens summarizing the post.  

 
7. Click Post.  

When you post invoices in the Cash Register window you can e-mail them and/or print them. 

8. If you want to print the invoice when the transaction is posted, select the Print Receipt check box; to e-
mail the invoice, select the E-Mail Invoice check box. (You can select both.)  
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Cash Drawer Status 
The Cash Drawer Status window aids in balancing the cash register status. The process of balancing the cash 
drawer is an important verification procedure you perform in PrintSmith Vision.  

You can access the Cash Drawer Status from Accounting > Point of Sales > Cash Drawer Status. 

  
The Cash Drawer Status window calculates all of the transactions shown. If there is a difference, then the Fix 
button will be enabled, and you can use it to fix the problem. 
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Post Payments 
If you picked up and posted an invoice under Cash Receipts and charged that invoice to an account then later 
when the customer pays for that invoice, you must apply the payments against the invoices so they are recorded 
as Accounts Receivable receipts. This process reconciles the money you received with the money that was due 
(as recorded in your invoices). In PrintSmith Vision this is known as posting payments. 

Why posting payments is important 
A common mistake when first getting started with PrintSmith Vision is to enter payments while picking up 
invoices without applying them to invoices. This has some undesirable side effects: 

• Invoices that were paid are still shown as open and may cause the account to become past due 
when it really is not. 

• The list of open invoices can get long making it more difficult to find an invoice to apply payment to 
it. 

• Customers may not understand statements that include invoices they think they paid. 

• The receipt is considered “on account,” and is not included as a taxable cash receipt. 

Posting Payments 
1. Select Accounting > AR (Accounts Receivable) > Post Payments. The Post Payment window 

opens. 

2. Select an account in the Customer field. The invoices with outstanding balances for the selected 
account are listed. (Invoices that were already paid are not listed.)  

 
Note  The Journal Entry option for each invoice is for initiating journal entries from the Post 

Payments window. For information, see “Journal Entries” section. 
3. To see more detail about an invoice or to change its description, select the invoice and click Properties 

from the options icon. The History Details window opens. 
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If necessary, enter a different description of the invoice in the Description field. After you finish viewing 
details, click Save or Cancel. 

4. Under Payment Method, select Cash, Card, Check, or Draft (bank draft). If the payment was by 
check, a check number is required. If payment was by credit card or bank draft, and you are not using 
integrated credit card processing in PrintSmith Vision, a reference number is optional. If you are using 
integrated credit card processing, the Ref # field is completed automatically after the payment is 
approved. 

Note Only the payment methods you have appr oved for that customer will be available options. 
After selecting the payment method, you have several options as to how to record payments to the 
invoices. This is the same process regardless of the payment method but some of the payment 
methods require following information: 

• Payments by Cash 

Enter the amount of cash received and you can either use Auto Apply or select the individual 
invoices to which the payment is to be applied. 

• Payment by Draft 

Enter the reference number you received from the bank and then proceed to identify the invoices 
as the procedure above outlined. 

• Payment by Check 

Enter the check number and then select the invoices. 

• Payment by Credit Card 

If you are manually processing the card outside of PrintSmith Vision, you have to select the card 
type and enter the reference number that you have received from your card processor. 

If you are using USA ePay or CardConnect®, then select the Process Credit Card icon to the right 
of the reference number field. Credit Card Details window opens where you can either manually or 
automatically process the card depending on the option chosen. If you are not given a reference 
number, you have to enter one. 

5. After selecting the payment method and the invoices, click Post Payment. If the customer still has 
some amount due, the amount will default to the remainder going on account. If the customer overpaid 
on the total amount due, select how you want to handle the refund. See, “Handling Refunds”. 

6. Using the check boxes to the left of the invoices, you can select the invoices to be paid and then 
select Calculate Payment. The amount paid on the selected invoices is displayed in the Pay 
column and the total of the invoices is displayed in Amount Receivable. 

Note To select all invoices, check the box in the column header. 
7. You can enter the payment amount in the Amount Receivable field and click Auto Apply, the 

amount will be applied to the oldest invoices first. 
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8. To record a partial payment to invoices, click the Pay column for an invoice and enter the amount of 
the partial payment. Then select Calculate Payment and the total will be entered in the Amount 
Receivable field. 

 
9. To print a receipt, select the Print Receipt check box.  

10. To e-mail the invoices after posting a payment, select the E-mail Invoice check box. 

11. If you contact the customer whose information you are viewing in the Post Payments window, log the 
interaction and, if necessary, indicate that follow-up is required:  

12. Click Notify icon. Complete the field in the Notify Customer window. 

13. Review the transaction summary in the Transaction Details section on right:  

• Pay Balance: The account balance before the payment is posted.  

• Total Due: The total of all selected debit items (invoices, debit memos).  

• Tendered: The payment amount plus any selected credits.  

• Remainder: The amount of the payment that is not being applied to open invoices (Total Due minus 
Tendered).  

• Account Balance: The customer account balance. 

14. When you are satisfied with the way the payment is applied, click the Post Payment button. 

Payments for Master Accounts  
If you select a master account when posting payments, all the sub-accounts are displayed. Note that all sub-
accounts as well as the master account are locked as long as the master account is selected in the Post 
Payments window. If any items under a sub-account are in use elsewhere (and therefore locked), you cannot 
select them until they become available. If there are sub-accounts with open items (sub-accounts without open 
items are not shown), and some items are an open credit on the master account itself, you can click Auto Apply 
in the Post Payments window to pay the selected invoices. Whenever a payment or credit goes from one 
account to another, a transfer occurs, moving just enough credit to handle the payment or refund. A transfer 
entry is made in both account histories so there is a clear audit trail showing debits from one account and credits 
to another account as a result of the transfer  

Handling Refunds 
If a payment is greater than what the customer owes, the Remainder field in the Post Payments window lets you 
indicate how you want to handle the over-payment. 
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You can select one of the following in the Remainder field: 

• On Account: The overpayment is not refunded but is posted to the account as an unapplied credit. 

• Return Cash: Cash is refunded and subtracted from the cash total in the PrintSmith Vision “cash 
drawer.” 

• Write Check: A check is written. Since PrintSmith Vision does not handle check writing, it records 
only half the transaction. It adds the refunded amount to the account balance and the AR balance, 
but does not record a negative receipt. Instead, a special refund check is shown during daily 
closeout and is printed on the deposit ticket. The Daily Sales report includes a Refund Check 
category to show the total amount of refund checks during the period. 

• Credit Card Refund: A negative amount is applied to a credit card. This is recorded in the cash 
drawer credit card category and is a separate item in daily closeouts. 

• Direct Deposit: You will need to enter the reference number of the deposit. 
Note The remaining selections in the Remainder field are credit card refunds for a specific card. 

Issuing a refund for overpayment 

Problem: You receive a check from a customer to pay for a group of invoices, one of which was already 
paid. You agree to send the customer a refund check. 

Solution: 

1. In the Post Payments window, enter the amount of the check as written. 

2. Select the items that are to be paid. 

3. In the Remainder field, select Write Check. This refunds the amount of the overpayment with a 
check, which you must write later. (Checks are not written in PrintSmith Vision.) 

4. Click Post. 

Alternatively, if your customer agrees, you can leave the overpayment on account and apply it to later sales; this 
is the recommended method as no special action is required. You can access the screen to make journal entries 
from here, or you can use the quick buttons on the left of the screen, or go to Accounting > AR (Account 
Receivable) > Journal Entries. 

For more information on making journal entries see the “Journal Entries” section. 

The section on the lower left-hand corner of the screen gives you the option of printing a receipt or emailing the 
invoice. You can select the format to be use. 
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Issuing a refund on a paid invoice 

Problem: You receive a complaint from a customer about an order for which the customer already paid and 
agree to refund part or all of the order by sending the customer a check. 

Solution: 

1. In the Post Payments window, select the invoice that you are refunding and then select Journal Entry 
from the options icon.  

2. Make the appropriate correction and click OK. The Post Payments window opens, and both the invoice 
and journal entry are highlighted. 

3. In the Remainder field, select Write Check. 

4. Click Post. 
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Accounts 
About Customer Accounts 

In PrintSmith Vision, you can define accounts for both prospects and customers. Prospects have not yet done 
business with you, but you hope to turn them into customers. Customers have done business with you, and 
invoices have been created for them. Once you create an invoice for a prospect, that prospect is automatically 
converted to a customer. If customers become inactive, they can be turned into prospects again. 

Accounts are a key part of your PrintSmith Vision system. Invoices are assigned and posted to accounts, 
payments are made for accounts, account histories are tracked, and sales statistics are kept for each account. 

Tip The terms customer and account are often used interchangeably in PrintSmith Vision. 
In addition, each account has contacts associated with it. An account may have a single contact person or 
different people. For example, one contact may receive invoices, and another receive statements. You can 
always add a contact while you are setting up an account, but you can also manage contacts independently of 
accounts and provide additional information about the contacts.  

About Master Accounts 
Master accounts are very useful if you do business with several departments or locations at one company or 
organization but need to send the statements to a central location for payment. You can track each of the 
departments or locations with a separate account and then tie them together through a master account for billing 
purposes. For example, you do business with the London, San Francisco, and Santiago offices of a company 
named SuperPromos, but all payment comes from SuperPromos Corporate. In this case you would set up four 
accounts: SuperPromos Corporate would be the master account and the SuperPromos London, SuperPromos 
San Francisco, and SuperPromos Santiago sub-accounts would all be linked to the SuperPromos Corporate 
master account. All orders and order history will be tracked for each sub-account, but billing statements will be 
sent to the master account with a breakdown for each sub-account. 

Note A master account is created like any other account; nothing in the account settings identify it as a 
master account. When you create sub-accounts, however, you link them to the master account using 
Master Account Selection in the Accounts window. This is how a master account is established. 

General Guidelines for Working with Accounts 
When setting up accounts for prospects and customers, keep the following in mind: 

• To get started, you only need to create accounts for customers that have an outstanding account 
balance; add other customers later as needed. 

• The creation of a customer or a prospect is the same, you identify them on the Marketing tab. 

• You can create any number of accounts for a single customer, as long as the name on the account is 
unique – the accounts can all have the same address (or no address at all). 

• When you create accounts for a large customer who requires centralized billing and therefore a master 
account, create the master account first and then create the sub-accounts that are linked to the master 
account. For more information, see About Master Accounts. 

• Although not required, you should create accounts for all your regular customers even if you do not plan 
to extend them credit. 

• PrintSmith Vision has a special <Walk-in> account for occasional or walk-in business, but you can use it 
any way you see fit. Avoid changing the walk-in account to a charge account. Whenever you extend 
credit to a customer, always set up an account and assign any pending documents for the customer to 
this account (instead of using the walk-in account). 

• The <Walk-in> account should not be changed. You can use the <Walk-in> account for all one-time 
transactions or for transactions with customers who do not have an account in PrintSmith Vision. 

• PrintSmith Vision recommends that you create a few special accounts: one for in-house printing and 
one for “junk” transactions (tax adjustments and so on) that you do not want to clutter up other 
accounts. 
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• Multiple users can work with accounts at the same time, but if one user opens an account, it is locked 
so other users cannot work with it. When an account is locked, and you try to open it, a message 
informs you it is unavailable. 

Understanding the Accounts Window 

You manage the information about your customer accounts in the Accounts window. To open this window, click 
Accounts in the Quick Access panel or select AR (Accounts Receivable) > Accounts. The Accounts picker 
window displays all of accounts including the prospects and contacts. You can search for any account using the 
search fields in the column header. You can also save your filter criteria. 

To open an account, select the account and click the account name. You can customize the columns to be 
displayed in the list using the Customize List option. Some of the columns cannot be removed and they will be 
grayed out. 

Selecting one or more accounts using the check box to the left of the account number enables you to delete 
multiple accounts or sync them with MDSF. Accounts that have been synced with MDSF can be identified by the 
globe symbol to the left of the check box.  

Using selectors, you can display only those accounts that have been synced with MDSF or just those not MDSF 
registered. 

You can also click the three-dots ellipsis in each account row to delete, sync an account with MDSF, or add a 
contact to the account. 

 

Creating Accounts 
The process of creating an account for a prospect and a customer is identical, except that you identify the 
account as a prospect or customer account. 

Tip  In addition to creating accounts as described below, you can also import them into PrintSmith. 

General procedure for creating accounts  
1. Click Accounts in the Quick Access panel (or select AR (Account Receivable) > Accounts). The 

Accounts picker/list window opens.  

2. Click the +Create Account button and the Create Account window opens. (After you save an 
account, the window title changes to the account number and name.) 

Note A master account is a centralized billing account (such as a university) with associated sub-
accounts (such as university departments). All statements are sent to the master account, but 
the sub-accounts do their own ordering, have their own order history, and so on. You create a 
master account just like any other account – it is not identified as a master account in the 
account set up. When you create the sub-accounts, however, you link them to the account 
you want to serve as the master account. This is how a master account is established. 

3. Enter Account Name. 

Note In the Account Name field, enter a unique name for the account (up to 255 characters). If the 
account is for a person, enter the last name first, for example, Smith, John, so it is easy to find 
in the alphabetical list of accounts, but enter the name in the address fields as John Smith so 
that John Smith is the name on invoices and statements. 
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Tip You can change the name of any account at any time, except for the <<<WALK-IN>>> 
account. 

4. Select the Account Type. 

This controls what type of payment is accepted for the account. When you create a new account, 
Account Type is automatically set to Cash/Check/Credit Card, but you can change this as 
necessary. 

Type  Description 

Full Deposit When an invoice is opened or saved with a balance due, you are 
reminded that this customer must pay in advance. Payments can be 
made with cash, checks, or credit cards. 

Cash Only The customer must pay with cash. Checks and credit cards are not 
accepted, and charges are not allowed. 

Cash/Check/Credit 
Card 

The customer must pay with cash, check, or credit care, charges are not 
allowed. 

Charge Account The customer may charge the amount to the account, but can also use 
any other payment type, for example, cash or credit card. 

Credit Card on File For a trusted customer, a credit card that is on file can be accepted 
when picking up an invoice. You can select this option only if you are 
using integrated credit card processing in PrintSmith Vision. For 
information, see the guide to PrintSmith Vision Credit Card Integration 
Guide. 

5. Select Account Status. 

Ignore Account Status when you are setting up your PrintSmith Vision system. By default, the 
account that you set up are considered New. The status information is updated automatically when 
account aging takes place. Typically, account can be a certain number of days past due according 
to three aging classifications with standard values of 30, 60 and 90 days. You can change these 
aging classifications as needed with the aging periods preferences. On a case-by-case basis, you 
may need to change the account status as follows. 

Status  Description 

New When an account is first created, and has never been aged, it is 
considered a new account. 

Current An account is current if all amounts owed are within the allowable limits. 
Past Due The account has open items picked up more than 30 days ago. (The 

number of days may be different if you changed it in your Aging Period 
preferences.) 

Delinquent  The account has open items picked up more than 60 days ago. (The 
number of days may be different if you changed it in your Aging Period 
preferences.) 

Inactive As of the last aging, the customer was inactive for the period specified in 
your credit/default preference. Invoices or payments all cause the 
customer to be active again. 

Frozen The account aging process can automatically freeze accounts with 
open items picked up more than 90 days ago. Once an account is 
frozen, no more invoices can be created, and no charges can be 
accepted. An account is normally unfrozen manually, or automatically 
during the aging process. A frozen account will still be displayed in the 
list of accounts but if it is selected, message is displayed identifying it as 
a frozen account. The account will need to have the status changed if 
you want to create an estimate or you must have Admin access. 

Note You cannot copy an invoice from a frozen account. 
6. In the Sales Rep field, select a sales representative for the account. (Use Table Editor to maintain the 

list of the representatives in the Sales Rep table.) The sales representative is used elsewhere in 
PrintSmith Vision, for example, when you create an estimate or invoice for the account. 
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7. Enter the account information in the Contact and Address, Credit/Tax Control, Settings, and 
Marketing tabs. For more information about these tabs, see the sections below. 

8. Click Save to save the account. 

The account number is assigned automatically when you save a new account, and which you cannot 
change. 

9. Repeat this process for each customer and prospect. 

Contact & Address Tab 
Use the Contact & Address tab in the Accounts window to provide general information about the customer. For 
example: company name, invoice and statement addresses, and associated contact information.  

  
Each account can have two separate addresses: invoice and statement (billing). The invoice address is copied to 
an estimate or invoice when you select an account for the document. When printed, documents can include 
either an invoice or statement address (or both). Likewise, either address can be included on statements. 

Note Any required fields (as specified in the Mandatory Field preferences) are outlined in red. You must 
complete these fields before you can save an account. 

You can create a customer account without any contacts, but PrintSmith Vision strongly recommends that you 
always create at least one contact at the same time as you create the customer account. Once a contact is 
assigned to a customer, the customer must always have an assigned contact, but you can change the contact. 
You just cannot change an account so that it no longer has a contact assigned. You can create additional 
contacts later. 

 Tip If you plan to e-mail documents (for example, invoices, estimates, or statements) from PrintSmith 
Vision, make sure all contacts include an e-mail address. 
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1. If there is a central phone number for the customer, enter it in the Main Switchboard Number field. 

2. The External Accounting ID can be used as a reference for an identification such as a CRM. 

3. If you are using an external system (such as an accounting package), in the External Ref # field, enter 
the account ID from the other system. You can search for customers by this reference number, and you 
can also include the number on documents, job tickets, and statements. 

4. In the Invoice Address section, the name you entered for the Account Name field for the account is 
displayed automatically in the Company field in the Invoice address. If necessary, change the name. 

Tip You can use Table Editor to maintain information in the City, State, Zip, and Country tables so 
that this information can be selected instead of typed. You can also start typing part of a city, 
state, zip code, or country in one of these fields, and the selections will be filtered. For 
example, type ba in the City field to see all cities (in the City table) that begin with ba. 

5. Enter the address for invoices and click Done. 

6. In the Statements Address section, , the name you entered for the Account Name field for the 
account is displayed automatically in the Company field in the Statements address. If the statement 
address is the same as the invoice address, the invoice address is automatically used for both. If a 
different address is required for statements, you can make changes before you click Done. After clicking 
Done, you can still edit any of the information by clicking the Edit button. 

7. Enter the address for Statements and click Done. 

8. Under Invoice Contact, add invoice contact information. The contact is automatically assigned to the 
account as the default invoice contact. The contact is also now listed in the Contact List field. 

Note On an existing account if you search for a contact you must search by last name. 
9. Click Done. 

10. Enter the information on the Statement Contact. If the statement contact is the same as the invoice 
contact, the invoice contact is automatically used for both. You can change the information in the 
Statement Contact if it is different. 

11. Click Done. 

12. To add another contact to the account, click the Add Contact button, complete the Create Contact 
window, and click Save. 

Note You can add another contact only after you have saved the account. 

Credit/Tax Control Tab 
Use the Credit/Tax Control tab in the Customer Accounts window to set credit limits, finance charges, 
discounts, and so on. 
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1. Under the Credits section, enter the maximum amount the account can charge to the account in 

the Credit Limit field. 

By default, the system credit limit is used. (You set the system limit in Preference > Settings and under 
Accounting, in the Credit/Defaults section.)  

2. In the Due days from posting field, enter the number of days to add to the current date to 
calculate a due date for an invoice that is picked up and posted in the cash register. If you do 
not provide a value here, PrintSmith Vision uses the value (if any) in the No. of days due before 
field in the Estimator Printing preferences.  

3. In the Monthly Finance Charge Pct field, enter the percentage for calculating finance charges 
when statements are generated. 

If this field is set to 0.00%, the system default finance charge rate is used (as defined with the 
Credit/Defaults preferences. The system default rate is used unless you enter a different rate in the 
Monthly Finance Charge Pct field or select the Never calculate finance charges check box. 

Note The finance charge is the rate used each time finance charges are calculated when you 
generate statements. It is not an annual rate. 

 After the account has some history, additional information is displayed on the Credit/Tax 
Control tab: Finance Charges YTD shows the total amount of finance charges posted to the 
account in the current year; and Current Balance shows the total amount owed to you by this 
customer, including merchandise charges or POS charges. 

4. In a franchise situation, select the Royalty Exempt check box if jobs for the account are not subject 
to royalty payments. (Ignore this check box if royalty payments do not apply to you.) The check box 
is always displayed but can only be selected or cleared by a member of the owner or system admin 
access groups. 

Note Individual invoices can be flagged as royalty exempt (or non-exempt) in the Totals section of 
Invoice/Estimate Summary tab. 

5. If the account uses standard corporate-wide pricing, select the National Pricing check box. If the 
account uses specialized pricing, leave the check box cleared. 

6. If you want to give the account a discount (or want to markup invoices for the account), under 
Discount, do one of the following: 

• Select Percent and enter a discount as a positive percentage and a markup as a negative 
percentage. This discount (or markup) is applied each time you create an invoice for the 
customer. 
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• Select Dollars and enter a discount in dollars. This fixed discount is applied each time you 
create an invoice for the customer. 

Note If you want the discount to be a one-time discount, select the One-time discount check 
box. For example, you may want to offer a special deal to first-time customers, or you 
may want to promote a new service. 

 When you create an invoice for the account, and a one-time discount was specified, 
you are asked if want to apply the discount. If you click No, the discount remains in 
the customer account. If you click Yes, the discount amount is applied to the invoice 
and cleared from the Credit/Tax Control tab. 

7. Under Tax Setup:  

If the account is subject to sales tax: 

a) In the Tax Table field, select the tax table you want to use for the account. The tax table 
is set up in Table Editor > Data List. This tax table is known as the parent tax table and is 
automatically used on invoices for the account unless you change it at the invoice level. In 
addition, the parent tax table is used by default for charge definitions, unless you select a 
different tax table (in the Preset Info section). 

b) In the Tax Code field, select a tax code to categorize the sale. (A tax code results in a 
separate line in the tax detail report for the same tax table to identify the organization that 
is levying the tax. Use Table Editor to maintain your tax codes.) 

c) In the Resale # field, enter the customer’s license number. This number is included on 
documents created for the account. 

If the account is tax exempt: 

a) In the Resale # field, enter the account’s tax exemption ID. This ID is included on 
documents created for the account. 

b) In the Certificate Expires field, enter the date (if any) the account tax exempt certificate 
expires. 

c) Select the Tax Exempt check box so that no sales tax is applied to the account. 

Settings Tab 
Use the Settings tab in the account window to control or modify how the account is used throughout PrintSmith 
Vision. 
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1. In the Business Type Code field, enter a SIC code or ABC code to classify the account. (For 

example, the Customer List report can be sorted by business type.) 

2. In the Ship Via field, select a default shipping method for the customer. 

3. In the PO Number field, enter the purchase order number if one is required; it will be included on 
all new invoices. 

4. In the Default Invoice and Default Estimate fields, select the invoice and estimate formats to 
use by default when creating invoices or estimates for the account. PrintSmith Vision supplies 
some standard formats, but you can also create custom ones. 

5. Select or clear the following check boxes: 

• PO required on Invoice 

Select this check box if the account requires a purchase order. When the check box is selected, 
you are warned to enter a purchase order number when you create an invoice, but the invoice is 
still created even if you do not enter the number. The invoice cannot be picked up until you enter a 
PO number, however. Also, until you enter a PO number, the warning is displayed when an 
estimate is converted to an invoice, as well as each time the invoice is opened. 

• Do NOT generate statements 

Select this check box if you do not want statements generated automatically for the account. (You 
can still generate a statement for any account by selecting the account.) This option is useful for 
sub-accounts of a master billing account that do not require their own statements. 

• Account is commissioned 

Select this check box if commissions are paid on sales for the account. You can use this 
information in custom commission reports. 

• Always file originals 

Select this check box so that invoices for the account indicate that you are saving files provided by 
the customer (typically artwork). You can change this setting when you create an invoice. 

6. Select the Invoice and Job Templates. 
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A template contains the complete specification of an order or of a job that you can re-use over and over 
again without having to re-enter all the details. You can create a template based on any invoice, 
estimate, or job. 

Use the Templates section to associate invoice or job templates with an account, so they are available 
when you want to create an invoice, estimate, or job for the account. This allows you to have templates 
specific to this customer readily available. 

• To associate an Invoice Template, click the + Add icon and the Templates window opens listing all 
the estimating and invoice templates. Select all the templates you want to associate with the 
account. When you are creating an invoice for that customer, these templates will be available as 
options. Entering the account name in the Name column header will then only display those 
templates that have been set up for that account. 

• For Job Templates, follow the same procedure as invoice template. When you are creating an 
invoice or estimate from a job template, all the estimate and invoice templates are displayed. 
Entering the account name in the Name column header will then only display those job templates 
that have been set up for that account. 

7. In the Security level of this account field, enter a security level to prevent access to the account 
by users whose security level is lower. If a user’s access level is lower than that specified here in 
the Security level of this account field, the user cannot use the AR (Account Receivable) > 
Accounts, AR (Account Receivable) > Post Payments, and History > Account History 
windows, but can still select an account for an estimate or invoice. 

Marketing Tab 
Use the Marketing tab in the Account window to record background information about the customer that can, for 
example, help you design promotional mailings or otherwise track customer data. 

 
Note Several fields on the Marketing tab are related to tables you maintain with Table Editor. You may want 

to review and edit these tables before starting to enter information on this tab because you can 
customize what is entered in some of the fields.  

 Any required fields – as specified in the Mandatory Fields preferences – are outlined in red.  
1. Under Company: 

a) Indicate if the account is for a Customer or Prospect. If a customer cannot be changed 
to a prospect, these selections are unavailable, as in the figure above. (For example, you 
cannot convert a customer to a prospect if the customer has a balance or pending 
invoices.) 

b) If the account is for a person rather than a business, select the Personal Account check 
box.  

c) In the Number of Employees field, enter the number of employees in the company to 
help you target companies based on their size. 

d) In the Annual Revenue field, enter the annual amount of revenue of the account or the 
annual target you expect from the account. This information can help target companies 
based on their revenue stream. 

e) In the Business Type field, select the kind of work done by the company. This 
information is stored in the Business Type table which you can change with Table Editor. 
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2. Under Marketing Dates, enter up to five dates for any purpose, for example, Followup or 
Birthday. 

Note The labels of the five fields under Marketing Dates are stored in the Marketing Date Labels 
table and are initially named User 1 through User 5. Use Table Editor to change these labels 
to suit your purposes. Any changes you make to the field labels are also reflected on the 
Marketing tab in the Contact window. 

3. Under Marketing Tags, provide further information about the account. Note the following: 

• The Lead Source fields both use data from the same table (named Lead Source). Use Table 
Editor to change what this table includes. 

• Eight User tables are available for customization. You can use Table Editor to change the 
name of a User table (which will change the label of the corresponding marketing tag field) and 
to edit the contents of a table. You can enter data in the table, so users can select it in the 
field, and you can also allow users to enter data directly in the field. 

 Note Any changes you make to the user tables are also reflected on the Marketing tab in the 
Contact window. 

4. Under Custom Data, enter further information about the account, for example, its web site or LinkedIn 
URL. 

Tip The Custom Data fields are text fields that can be used for any purpose (up to 255 characters 
per field). The labels of the fields shown in the figure below are the default labels, but you can 
change these to anything you want by editing the Account Custom Labels table with Table 
Editor. (You can edit the records in the Account Custom Labels table, but you cannot delete 
or add records.) 

Sales Info 
The Sales Info section in the customer dashboard contains sales statistics.  

When you first set up an account, the Sales Info section will not include any sales statistics as you can see in this 
figure. 

 
As you do business with the customer, information will become available over time, and you can view that 
information here. You can update the customer’s statistics and perform an instant aging of the account. 
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Under Current Outstanding, review the account balances as of the last aging. The chart on the right will reflect 
these balances. You can update these balances at any time by clicking Age Now. The current date is used as 
the aging base date.  

The pie chart shows the customer’s aging. 

 
Other information under Current Outstanding includes: 

• POS Charges - The outstanding balance of cash register transactions charged to the account. Use AR 
(Account Receivable) > Post POS Charges to convert this balance to an open item. 

• Current Outstanding - The total amount (including merchandise charges) owed to you by the 
customer. 

The next section displays the sales statistics for the account.  

 
• The total sales volume for the account this month, this year, and last year are listed. 

• You can update these balances at any time by clicking Age Now. The current date is used as the aging 
base date.  

• Typically, customer sales statistics are updated as part of a monthly closeout, but if you want to do this 
manually, click Update Customer Statistics. 

• Quotes Vs Orders – The ratio of estimates to orders. This helps to identify accounts for which you 
are continually entering estimates but rarely getting jobs. The number of estimates may not be 
exact. PrintSmith Vision counts an estimate only when you save it. If the account is in use in 
another window or by another user, it is not counted. An estimate is also not counted if you change 
the account on an existing estimate. 
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• Estimate Won Vs Lost - The ratio of estimates that were won (you got the business) to estimates that 
were lost. PrintSmith Vision tracks this information automatically.  

• Review the Sales Ranking to compare the sales volume of the account to other accounts. For a rank to 
be available, you must run and save the Account Ranking report. The sales ranking is based on the last 
time you ran the report. 

Another chart shows the sales trend for different periods. You can choose to the order trend for 1 month, 3 
months, 6 months, or 1 year. If you hold your cursor over a period, it will display the total number of orders 
and sales during that period. 

 

Sales Dates 
The Sales Dates section displays additional historical data about the account: 

 

Name Description 

Created The date the account was created in PrintSmith Vision. 

Total Orders The number of orders placed for the account. 

Last Billed The date a statement was last generated for the account. 

Last Payment The date the last payment was received for the account and 
recorded with AR (Account Receivable) > Post Payments. 

Last Aged The date the account was last aged. 
Last Invoice The date the last invoice was created. 

Last Estimate The date the last estimate was created. 
First Invoice The date the first invoice was created. 
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First Estimate The date the first estimate was created.   

Customer Account Options  
After you save the account, following options become available on the Accounts window: 

 

Master Account  
When you create sub-accounts, you link them to the master account. A master account is created like any other 
account; nothing in the account settings identify it as a master account. 

1. If you are creating a sub-account for a customer with centralized payables (known as a master account 
in PrintSmith), click the Master Account icon on the Accounts window.  

 
The Master Account Selection window opens. 

 
2. In the Account drop-down field, select the central payables account and click Save.  

The master account must already exist and cannot be a sub-account that is already linked to a master 
account. 

 
Now the sub-account displays the associated master account. 

Add Charges to Jobs or Invoice/Estimate 
Under Add Charges you can select charges to apply as predefined charges to invoices and estimates created for 
the account and/or to jobs created for the account.  

The way you use charges can make a big difference in how well PrintSmith Vision works for you. You normally 
attach charges to either a job or a document (estimate or invoice). Using this option, you can attach charges to a 
job or document created for the specific customer. 
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To add the charges: 

1. In the Account window, if you want to add the charges to the invoice/estimate created for this 
customer, click Add Charges to Invoice and Estimate. If you want to add the charges to the jobs 
created for this customer, click Add Charges to Job. 

The Charge Selector window opens. 

2. Find and select the charge that you want to assign to the customer. 

3. Click Add and then click Done. 

 

Add Notes 
Use Notes to enter notes that are displayed in different contexts. 

 
Important  These notes are all designed for small amounts of text (up to 255 characters). They are not for  

lengthy messages or for record keeping; use the Log window instead. 
1. Click the Add Notes icon in the Account window. The Notes window opens. 

2. In the Enter Account selection notice field, enter a note for one of two purposes: 

• To notify your users of something special about the account whenever the account is selected 
for a document. 

• To place these notes in the Special Instructions field of a document. 

When you select an account for an estimate or invoice (or copy a document for the account), a 
window opens displaying this notice and asks if you want the text copied to the Special 
Instructions field. 

3. In the Notes to insert in each job field, enter the text that you want automatically copied to job 
ticket notes whenever a new job is created for the account. (This text is not copied to job ticket 
notes for existing jobs for the account.) For example, you may have a customer for whom you will 
not start production unless a proof was signed, or to whom you always return the artwork. If you 
enter this information in the Notes to insert in each job field, the note is automatically included 
on the job ticket. 

4. In the Notice to place on statements field, enter the text that you want to include on statements 
generated for the account. For example, you can enter text to customize collection notices for an 
account or to remind a customer of upcoming repeat orders.  

5. Click Add.  
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Log 
Use the Log option to record your interactions with the customer, flag items for follow-up, indicate that an issue 
is complete (resolved), and review information in the log. 

In addition to information, you enter directly on the Log tab in the Customer window, the following are logged 
automatically: 

• Documents e-mailed to the customer from the Invoice, Estimate, Cash Register, Post Payments, 
Journal Entry, and Generate Statements windows are logged automatically on the Log tab if you 
configured e-mail logging in your E-Mail preferences.  

• Any information that is entered in the Notify Customer window is logged automatically.  

Tip The Notify Customer window can be opened by clicking a Notify button in these windows in PrintSmith 
Vision: Pending Documents, Work in Progress, Post Payments, and Journal Entry. 

For step on how to enter details in the Notify Customer window, see “Logging interactions in the Notify Customer 
window”. 

 
In the Notify Customer window, for activities you can select how far back you want to see by selecting 30, 90, 
180 days, or all. To print the entire log for the customer, click Print Log. 

Web 
If you are using eFlow based MDSF Integration, the Customer Account window also includes a Web option. For 
more information, see the section “Register Accounts and Contacts to Market Direct StoreFront”. 

Importing Accounts 
In addition to creating accounts as described above, you can import information about both customers and 
prospects. As the result of an import, new accounts are created.  

Account import file format  
To import customers or prospects successfully, your import file must be in the correct format. Follow these rules:  

• The import file must be a comma-delimited (CSV) text file. You may have account data stored in an 
application that can export data into a CSV file. Otherwise, you can create a CSV file using Microsoft® 
Excel® .  

Important  The delimiters used in the CSV file must match what is specified in the Default CSV 
Separator and Default CSV Quote Character fields in your International preferences. If 
these fields are blank in the International preferences, the CSV field separator defaults to 
comma (,) and the quote character used to enclose text strings defaults to double-quote 
(“).  



Accounts | User Guide • 137 

 

 

• For fields to be mapped correctly, they must be in the correct order.  

• If information is not available for a particular field, leave it blank in the import file. (Otherwise, data will 
shift over to the wrong field.)  

• The file format for customers and prospects is identical – you specify what kind of account you are 
importing (customer or prospect) during the import procedure. 

Fields in import file  
The fields in the file must be in the order as in the Sample CSV Template.  

Import procedure  
Once you have your import file set up as described above, you can import your accounts into PrintSmith Vision.  

1. In the Accounts window, click Import Customers.  

2. Depending on whether you are importing or updating customers, contacts or prospects, click Import 
Customers, Import Prospects, Import Contact, Update Customer, or Update Prospects. 

Note  Do not use Import Customers or Import Prospects if you are updating previously imported 
customers or prospects.  

3. Browse to your import file and click Open. 

4. Click Next to map the fields.  The mapping is automatically done for any fields in the database with the 
same name as those in the CSV file. Fields that do not match will remain in the Drag to Target to map 
section. You have to manually map if you want to use those fields. 

5. Click Next. Review the imported accounts. 

6. Click Import All. 

7. Select Done. 

 

Deleting Accounts 
You can delete a prospect account at any time if you think the prospect will never turn into a customer. You can 
delete a customer account only if the customer does not have an open balance and there are no estimates or 
invoices on the pending list for the customer. 

Note You can restore a deleted account as long as you know the number of an invoice or estimate that was 
created for the account. 

To restore a deleted account: 

If an account was deleted, but invoices or estimates were created for the account before you deleted it, you can 
rebuild the account history from an invoice or estimate and recover almost all the customer information. 

1. Select any invoice or estimate that was created for the deleted account. 

2. In the Invoice Summary tab, click  Create Customer Acct from. The restoration can take 
several minutes depending on the size of your database. 

3. The account is restored using the name and address information in the document except that the 
account name is Recovered acct #xx, where xx is the account number. It is placed at the beginning 
of the Customer list or Prospect list (if restored from an estimate) in the Accounts list window. 

4. Select the account, specify the account type and credit limit, and correct the name. 

5. If necessary, change a prospect to a customer by selecting Customer on the Marketing tab of that 
prospect. 
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6. Save the account. 

The recovered account has its full history, account information, and sales statistics. 

Adding Contacts to Accounts or Prospects 
To be used in PrintSmith Vision, a contact must be associated with an account. Add contacts to an account in 
any of these ways: 

In the Account window 
1. Click Accounts in the Quick Access panel. 

2. In the Accounts list window, click the account to which you want to add a contact. 

3. On the Contact & Address tab, provide information about the contact in the Invoice Contact 
section. 

4. Click Save. 

In the Contact window 
1. Click Contacts in the Quick Access panel. The Contacts list window opens. 

2. Click +Create Contact. The Create Contact window opens. 

3. In the Account Name, select an account for the contact, enter the contact information, and click Save. 
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Contacts 
Contacts are the people associated with an account, for example, those who receive statements or invoices or to 
whom you send promotional mailings. An account may have a sing le contact or may have many; it depends on 
the account. 

Although you can enter some contact information while working with a customer account, you may want to enter 
additional information about contacts or create additional contacts, perhaps with different addresses. In addition, 
some information – as specified in the Mandatory Fields preferences – may be required. (Required fields are 
outlined in red.) 

Understanding the Contacts Window 
You can access the contacts window by clicking Contacts in the Quick Access panel or select Accounting > AR 
(Account Receivable) > Contacts. 

 
• You can create and edit contacts independently of a customer account as long as you eventually 

associate them with an account. 

• Each contact is color coded to indicate if the parent is an account, parent is a prospect, or no parent is 
assigned. 

• A default account is identified by the symbol . 

• To open a contact, select the contact and click the contact name. You can customize the columns to be 
displayed in the list using the Customize List option. 

• Use the search fields in the header column to filter the contacts. 

• Selecting one or more contacts using the check box to the left of the account number enables you to 
delete multiple contacts or sync them with MDSF. Contacts that have been synced with MDSF can be 
identified by the globe symbol to the left of the check box.  

Creating Contacts 
You can create and edit contacts independently of a customer account as long as you eventually associate them 
with an account. 

1. Click Contacts in the Quick Access panel (or select Accounting > AR (Account Receivable) > 
Contacts). The Contacts picker/list window opens.  

2. Click + Create Contact. The Create Contact window opens.  

(After you save a contact, the window title changes to the contact number and name.) 

Tip  You can also create new contacts from the Accounts window by clicking the Add Contacts 
button on the Contact Address tab. 
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3. To assign contact to an account, select the Account Name. 

4. If necessary, in the Sales Rep field, select the sales representative associated with the contact. This 
overrides the sales representative assigned to the account. (Use Table Editor to maintain the list of 
representatives in the Sales Rep table.)  

5. If the contact is for a person rather than a business account, select the Personal Account check box. 
This setting helps you segregate personal accounts for targeted mailings. 

Note  Contact type is for MDSF. 
6. Click the Contact Address tab to enter or edit basic information about the contact. See the sections 

below for more information. 

7. Click the Marketing tab to provide information that is useful in targeting marketing materials to the 
contact. See the sections below for more information. 

8. If you are using integrated credit card processing in PrintSmith Vision, use the Credit Info tab to save 
credit card information for the contact. For information, see the guide PrintSmith Vision - Secure Credit 
Card Processing. 

9. Enter MDSF name for this contact. 

10. Click Save to save the contact. 

 
The contact number is assigned automatically when you save a new contact, and which you cannot 
change. 

11. Repeat this process for each contact. 

Contact Address Tab 
Use the Contact Address tab in the Contact window to enter all key contact information. If you e-mail documents 
to customers, be sure to include an e-mail address for all contacts. The communication address for the contact is 
highlighted in red to indicate it is required. 

1. Under Contact Details section, enter information about the contact and click Done.  

Notes Any required fields – as specified in the Mandatory Field preferences – are outlined in red. 
 You can use Table Editor to maintain the information in the Prefix, Suffix, and Job Title tables.   

2. Select the Use Contact Address check box if you want to use the contact address instead of the 
account address when you select the contact for estimates or invoices.  
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When you select this check box, the Communication Address Edit icon becomes available next the 
check box.  

 
3. Click Edit to provide the address for communication. 

4. A contact may have many shipping addresses. You can select a shipping address at various points 
when creating jobs for the account, for example, in the Account Info window or on the delivery ticket. 
Under Shipping Address, manage the shipping addresses for the contact as follows: 

• To add a shipping address, click +Add New. Complete the Shipping Address window and click 
Save. The address is then listed under Shipping Address (as shown in the figure below). 

 
• To edit a shipping address, select it under Shipping Address and click Edit.  

• To remove a shipping address, select it under Shipping Address and click Delete. 

Marketing Tab 
Use the Marketing tab to provide information about a contact to help you with promotional mailings aimed at 
particular contacts. This tab is similar to the Marketing tab for a customer account but applies to a contact. 

Note Several fields on the Marketing tab are related to tables you maintain with Table Editor. If you did not 
already do so when setting up accounts, you may want to review and edit these tables before starting to 
enter information on this tab. 

1. Under Marketing Tags, provide further information about the contact. Note the following: 

• The Lead Source fields both use data from the same table (named Lead Source). Use Table 
Editor to change what this table includes. 

• Eight User tables are available for customization. You can use Table Editor to change the 
name of a User table (which will change the label of the corresponding marketing tag field) 
and to edit the contents of a table. For example, the figure below shows several renamed user 
tables: Common Interest, Likes, Type of Work, Sport Interest, and Mailer Type. You can enter 
data in the table, so users can select it in the field and you can also allow users to enter data 
directly in the field. 

2. Under Marketing Dates, enter up to five dates for any purpose, for example, Anniversary or 
Birthday. 

Note  The labels of the five fields under Marketing Dates are stored in the Marketing Date Labels 
table and are initially named User 1 through User 5. If you did not already do so when setting 
up accounts, use Table Editor to change these labels to suit your purposes.  

 Any changes you make to the user tables are also reflected on the Marketing tab in the 
Customer window. 

Credit Info Tab 
If you are using integrated credit card processing in PrintSmith Vision, use the Credit Info tab in the Contact 
window to save credit card information for a contact.  

1. In the USA ePay section, enter the name of the Card Holder.  
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2. Click the Add Card icon to add the credit card details. This opens Credit Card Payment Form. 

 
3. Enter the information about the credit card and click Save Card. A message from USA ePay that the 

transaction was successful is displayed. On the Credit Info tab, the card holder’s name and last four 
digits of the account numbers are displayed. 

For more information, see the PrintSmith Vision Credit Card Integration Guide. You can delete the card 
information by selecting the Delete icon. 

Web Tab  
If you are using eFlow based MDSF Integration, the Contact window also includes a Web button. For 
information, see the PrintSmith Vision – MarketDirect StoreFront Integration Guide. 

Importing Contacts  
In addition to creating contacts as described earlier, you can import information about contacts. As the result of 
an import, new contacts are created. If you re-import previously imported contacts, they are updated if any 
information changed. 

Note the following while setting your import file: 

• If an account is specified for the contact in the import file, the contact is added to that account. 

• If no account is specified in the import file, a new contact is created, but you must associate it with an 
account later. (Contact must always be associated with an account.) You can associate the contact with 
an account in the Contact window. 

The procedure to import contacts is similar to that of importing customer accounts. For more information, see 
Importing Accounts. 

Editing Contacts 
You can edit the contacts for an account. For example, you may want to change an address or log your 
interactions with the contact. 

1. Click Contacts in the Quick Access panel (or select AR (Account Receivable) > Contacts). The 
Contacts list window opens. 

2. Find and open the contact you want to edit and select Edit Contact Details icon to change the 
contact information. Then click Done. 

3. Make your changes on the tabs. Note the following: 

• A <default contact> serves as both the shipping and billing contact. If nothing is displayed, 
the contact is assigned to an account but is neither the shipping nor the billing contact. 

• You can change the account to which the contact is assigned for any type of contact except 
the default contact. You can only change the default contact for an account on the Contact & 
Address tab in the Customer window.  

4. Click Save. 

Deleting Contacts 
You can delete a contact only if the contact is not in use in the system or is not the default contact for an 
account. 
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1. In the Quick Access panel, click Contacts (or select AR (Account Receivable) > Contacts). The 
Contacts list window opens. 

2. Find and select the contact you want to delete. 

3. Click the Delete button and then click Yes to confirm the deletion. 
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History 
Account History 

The Account History window provides a historical record of all accounting activity for a customer or prospect, and 
is a powerful tool for managing your business. For example, you can use the history to answer specific questions 
about payments, determine when a particular order was placed, examine the unpaid (open) invoices on the 
account, print a detailed account activity report, and open an old invoice so you can copy it (and re-use it).  

You can access Account History from the Quick Access panel or by selecting History > Account History. In 
the Account History window, then choose the Customer account for which you want to view all the historical 
records. 

 
The columns in the Account History window include the following: 

Name  Description 

Posted The date that the entry was posted to the account history. Entries are displayed in 
the order in which they were posted. To reverse the order, click the column header. 

Document # The number of the invoice posted to the account. 
Title A description of the document. For invoices, this is the invoice title. For payments, 

the description is generated by PrintSmith Vision when the document is posted.  
Total The amount of the document when it was originally posted. The total is underlined if 

there was a deposit on an invoice. 

Contact Name The default contact for this customer. 
Paid on For invoices and journal entries, the date a payment was last applied to that item. 

For payments, the date is blank. 

Ref # For invoices and journal entries, the check number or credit card reference 
(authorization) number. 

PO# The purchase order number, if any. 
User  The name of the user. 

Sales Rep The name of the Sales Rep associated with this account. 

Balance Due The current balance due on the item. Negative amounts are credit balances that 
were not applied to a debit (invoice or debit memos). 
Items with no balance due were paid off or fully applied (payments and credit 
memos). 

Expense Code Expense Code field is used if you are integrated with Market Direct Store Front and an 
accounting code was used as the payment method. 
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The records are displayed in the order of the document number. Change the order in which information is 
displayed by clicking a column header. For example, if you want to see the information sorted by date posted, 
click Posted. You can also resize columns to see more or less information.  

You can further search for specific transactions by using the column headers. For the date range columns,  click 
on the starting date and the ending date, and then click the Select button. 

By default, the Account History window lists all types of history, but to narrow the list, change the selection in the 
History Type field. For example, you can choose to list just Payment or Invoice. 

To look at the records in different ways, especially in terms of periods of time, select one of the options in the 
Period drop-down field. The options for Period are: 

Name  Description 

All Starts with the first item posted to the account. 

First Open Starts with the first open (unpaid) item and continues to the end of the 
list. (The history shows all items after the first open item. This is 
generally more useful in checking on payment status than AR 
(Account Receivable) > Post Payments, which shows only open 
items.) 

This Month Starts with the first item in the current month. 

Prior Month Starts with the first item in the previous month. 

This Qtr Starts with the first item in the current quarter. 

This Year Starts with the first item in the current year. 

Last Year Starts with the first item last year. 

Account History Options 
For each record in the list, clicking the three-dot ellipsis displays different options depending on the type of 
transaction. For invoices, the options are Open in new tab, Notify Customer, Properties, or Print Invoice. For the 
other transactions, the only option is Properties.  

 

Open in New Tab  
This option opens the estimate/invoice in a new tab for any modification or review. The document opens in the 
Invoice or Estimate window. 

Notify Customer  
You can click Notify Customer to look up contact information for a customer, log the interaction you have with 
the customer, and optionally indicate that follow-up is required. 

Properties  
This option opens the History Details window to view more information about a particular item in history. If 
necessary, in the Description field, enter a different name (title) for the document. Properties window also lists 
the jobs that make up the document. 
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Print Invoice  
You can print the contents of the invoice from the Account History window. 

Editing Information 
You can only edit the Title for any transaction and the Purchase Order number for invoices. Select the edit icon 

 displayed in the row for the record you want to make your changes. 

Re-use (Copying) an Invoice 
If you did a particular job for a customer in the past, and the customer needs the same job done again, you can 
copy an invoice from the customer’s account history to a new invoice (or estimate) instead of having to create 
one from the beginning.  

1. Select History > Account History.  

2. In the Account History window, choose the customer account for which you created the 
invoice. 

3. Find the invoice you want to re-use and click the Document #. 

The Invoice window opens in a locked state.  

4. Go to the Invoice Summary tab, click the Copy icon, and then click Copy to New Invoice to 
create a new invoice based on the old invoice. You can also select Copy to New Estimate. 

The documents in account history are “locked” since they form part of the audit trail PrintSmith Vision maintains. 
All details in the document are retained, however, and you can copy these documents to new estimates or 
invoices. You can update the pricing with the latest prices when you copy a document, but all of the descriptive 
information and notes you made on the job (the location and condition of the artwork, special pricing instructions, 
and so on) are retained. 

When you copy a document from history, PrintSmith Vision keeps track of the source document. For example, 
the old document number is displayed in the document window and printed on job tickets. If you file artwork by 
document number, and get a repeat order, the job ticket has the old document number so you can locate the 
artwork. 

Analyze the Sales History for an Account  
Do one of the following:  

• To analyze the entire sales history of the account, click the Analyze Account button.  

• To analyze certain records in account history, select them in the Account History window and then click 
the Analyze Selection button.  
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This generates a report with Sales Breakdown, Receipts Summary, and Production Data information and opens 
it in a preview window. 

Estimating History 
The Estimate History provides a record of the estimate activity for each customer or prospect. Use the Estimate 
History window to answer questions about past estimates, to determine when a particular estimate was entered, 
to see whether an order was won or lost, or to open an old estimate and re-use its information in a new estimate 
or invoice. 

You can access Estimating History from the Quick Access panel or by selecting History > Estimating History. 

  
The Estimate History window displays all the historical estimates, and you can select a specific account for which 
you want to see estimate history. 

The columns in the Estimate History window include the following: 

Name Description 

Account The account under which the estimate was created. 

Estimate # The number of the estimate. 

Created The date that the estimate was created. 

Title A description of the estimate.  

Total The amount of the estimate. 

Status The won/lost/neutral status of the estimate. 

Invoice # The invoice number if the estimate was converted to an 
invoice (because the customer accepted the job). 

Off Pending The date the estimate was removed from the pending list. 

Reason The reason the estimate was lost. 

You can further filter the estimates by the Period the estimate was created. The options for time period are: All, 
this month, prior month, this quarter, this year or last year.  
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To change the order in which information is displayed, click a column header. For example, if you want to see the 
information sorted by date created, click Created. You can also resize columns to see more or less information.  

You can further search for specific estimate by using the column headers. For the date range columns,  click on 
the starting date and the ending date, and then click the Select button. 

The total estimates, estimates won, estimates lost, and estimates that are neutral are displayed at the top of the 
Estimate History window. Each box displays two numbers: the first represents the total of that category and the 
latter is the total of all estimates in history for each category.  

 
The colors representing to each category is displayed along the left of the records to help identify the category 
for each estimate. 

When you hover over the estimate Title in the list, the full title of the estimate is displayed. You can edit the title 
by clicking the Edit icon. This clears the current title and provides a field to enter a new title. 

 

Estimate History Options 
For each record in the list, clicking the three-dot ellipsis displays different options. The options are: 

• Open in new tab -- opens the selected estimate in a new window. 

• Notify customer – opens the window to log the information to notify customer. 

• Estimate notes – enables you to add notes about that estimate such as to explain unusual 
features or explain why an estimate was lost. You can identify if there are notes for an estimate by 
the icon to the left of the check box. 

 
• Download as CSV - Select this to download the entire estimate history list as a CSV (Excel) file. 

Changing the Status of an Estimate 
Normally, the status (Won, Lost, or Neutral) of an estimate is determined by the system, but you may need 
to change the status yourself. For example, if a customer decides to go ahead with an order after all, you 
can change the status of an estimate to Won. Also, if you created several estimates for a job, but only used 
one of them, you would typically set the status of the unused estimates to Neutral (since they were neither 
won nor lost).  

To change the status of an estimate, select it in the Estimate History window and then select Won, Lost, or 
Neutral in the Status field. 
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To keep accurate won/lost records, keep the following in mind: 

• When you convert an estimate on the pending list to an invoice, the original estimate is placed in 
history and considered Won. When you copy an estimate to an invoice, the original estimate 
remains in the pending list and is not put into the estimate history (and is therefore not considered 
won or lost). For this reason, PrintSmith Vision recommends you use Convert to Invoice option 
and not Copy to New Invoice option (available in the Estimate Summary tab) when changing an 
estimate to an invoice. 

• When an estimate is converted to an invoice, the winning invoice number is recorded in the 
historical estimate and included in history. If you open a historical estimate that was won, the 
Estimate Summary tab shows the number of the invoice to which the estimate was converted. 

• If you convert a previously lost estimate to an invoice, the status of the estimate is changed to 
Won in estimate history. You can only convert an estimate to Won once. 

• If you make a mistake and want to discard the estimate, void it. A voided estimate does not affect 
the won/lost ratio and is not recorded in estimate history. 

Re-use (Copying) an Estimate 
If you want to re-use an estimate, you can copy an estimate from the customer’s estimate history to a new 
estimate (or invoice) instead of having to create one from the beginning. 

1. Select Reports > Estimate History.  

2. In the Estimate History window, choose and click the Estimate # number that  you want to re-use. 

The Estimate window opens in a locked state.  

3. Go to the Estimate Summary tab, click the Copy icon, and then click Copy to New Estimate to 
create a new estimate based on the old estimate. You can also select Copy to New Invoice. 

When you copy a document from history, PrintSmith Vision keeps track of the source document. For example, 
the old document number is displayed in the document window and printed on job tickets.  

PO History 
The PO History window enables you to review the purchase orders that were created for all the suppliers. You 
can also create, open, print, or delete purchase orders while reviewing the purchase order history. The PO 
History window lists the completed purchase orders and the current status of the purchase order. 

You can access PO History from the Quick Access panel or by selecting History > PO History. 
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The PO History window displays the purchase orders for all the vendors, and you can select a specific vendor for 
which you want to see purchase orders placed. 

The columns in the PO History window include the following: 

Name Description 

Vendor Name The vendor for which the purchase order was created. 

PO # The number of the purchase order. 

Document # The date that the estimate was created. 

Description A description of the purchase order.  

Buyer The person to contact about the purchase. 

Date 
Required 

The date when you want the item(s) in the purchase order. 

Status The status of the purchase order. 

Do any of the following:  

• To see completed as well as active purchase orders, select the Show Completed check box. 
Completed purchase orders are displayed in green.  

• If the list is long, enter criteria in the filter field of column headers to narrow down the list. You can filter 
the purchase orders by vendors and/or status. For the date range column, click on the starting date and 
the ending date, and then click the Select button. 

• To change the sort order, click a column heading. For example, if you want to see the information 
sorted by purchase order number, click PO #.  

• Adjust column widths so you can see more or less information. For example, you may want to expand 
the Description column so you can see longer descriptions.  

Note  This description comes from the Description field in the Purchase Order window. Here you 
can see how detail in the description helps to identify a particular purchase order.  

To review or edit a purchase order, click PO # number. This open that purchase order and you can edit 
or change the status of a line or the entire purchase order.  You can change the Required by Date. 

• To print a purchase order, click the three-dot ellipsis in the row of the purchase order that you want to 
print and click Print.  

• To delete a purchase order, select it, click the Delete icon, and confirm the deletion. (Be sure you no 
longer need the purchase order before you delete it.) 

• To print a purchase order, click the three-dot ellipsis in the row of the purchase order that  you want 
to print and click Print. You can print a purchase order from the PO History window or from within the 
Purchase Order window. 

• You can edit the shipping address from PO History window by opening the purchase order and then 
editing the shipping address. 

• To mark a purchase order as complete, select the purchase order from the list and then click the Mark 
As Complete button.  
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• To create a generic purchase order that is not related to an invoice, click the icon. This opens 
Purchase Order window. 

1. Select the Vendor and enter the Required by Date. 

2. Enter the buyer information and description. 

3. Click the + Add new line item icon and complete the information on what you are ordering. 

Note The PO type is now Generic. 
4. Click Add and then click Save to save the purchase order. 

 
You can edit, mark as complete, or delete a line item in a purchase order.  

 

Duplicate PO 
If you want to re-use a purchase order, you can create a duplicate purchase order instead of having to create 
one from the beginning. 

1. Select Reports > PO History.  

2. In the PO History window, click the three-dot ellipsis in the row of the purchase order that  you 
want to re-use. 

 
3. Click Duplicate PO. The Purchase Order window opens, and enter the information and save it.  

You can create a duplicate purchase order from the PO History window or from within the Purchase 
Order window. 
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When you create a duplicate purchase order, PrintSmith Vision keeps track of the source purchase 
order and displays the Source PO #. You can access the source purchase order by clicking the link. 
Also, the purchase order retains the shipping address from the original purchase order. 
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 Journal Entries 
A journal entry is a new transaction that counteracts or reverses the original transaction. Journal entries result in 
debit or credit memos. They are used to adjust the total due on an invoice, add or remove tax from an invoice 
after posting, write off bad debts, adjust account balances, and so on. 

A debit memo has positive totals, and can be paid (with cash, checks, and so on). When paid (with AR (Account 
Receivable) > Post Payments), a debit memo is treated as a receipt. A debit memo is closed when it is paid.  

A credit memo has negative totals. Its effect is similar to making a payment except that no money is involved. 
When a credit memo is applied to an invoice, it simply reduces the amount the customer owes you and does not 
affect receipts. If you refund a credit memo, receipts may be affected depending on the refund method. A credit 
memo is closed when it is fully applied to invoices or debit memos. When you create a journal entry, it 
immediately changes the sales information and the AR balance. 

General Procedure for Making Journal Entries 
This section provides general information about making journal entries and some examples of particular types of 
journal entries. 

1. Select Accounting > AR (Account Receivable) > Journal Entry. The Journal Entry window 
opens. 

Tip In situations where you need to adjust a locked invoice, you can open the Journal Entry 
window directly from the Post Payments window. 

2. Complete the top section of the Journal Entry window: 

a. Depending on what you need to do, select an account in the Customer field and enter the 
number of the invoice you want to adjust. In the case of an invoice, the account to which the 
invoice was posted is displayed, and a reversing entry for the invoice is set up. If all you want 
to do is write off an invoice, just click Update & Post. 

b. If you want to print a credit memo for the journal entry (for example, to give to a customer to 
show that you credited the account), leave the Print Document option selected. The credit 
memo will be printed after you click Update & Post. 

c. If you want to e-mail the credit memo, select the E-Mail option.  

d. Select the Customize E-mail option to customize your email. 

3. Leave the Affect Sales option selected so that sales totals are updated as a result of the journal entry. 

Warning  A journal entry that does not affect sales can unbalance your books. The only time you 
should clear the Affect Sales check box is while entering beginning balances when first 
setting up the system, for a job the customer refuses at pickup, or if a customer’s check 
does not clear. If you are not sure whether sales should be affected, consult an accountant 
to learn if your sales need to be reduced, or if a deduction should be taken at tax time. 

4. Leave the Update Customer Statistics option selected so that the customer’s sales statistics are 
adjusted when you post the journal entry. This is intended primarily as a means of adjusting total 
sales when you write off an invoice.  

5. Review and/or change the distribution amounts (journal entry details) and the memo totals. 

Each distribution amount is added to the Sub-Total and the Tax Sub fields unless you override the 
Tax Sub amount. Sales tax is recalculated after each change. When Tax Sub does not equal Sub-
Total, they are shown as overrides, and changes that you make in the detail fields do not change 
Tax Sub. You can either remove the override from the Tax Sub field by deleting it (PrintSmith 
Vision then synchronizes Tax Sub with Sub-Total) or you can manually adjust Tax or Tax Sub. 

Note If you change Tax Sub so that it differs from Sub-Total, distribution amounts that you enter 
subsequently will update Sub-Total but not Tax Sub. Both Tax Sub and Tax are shown as 
overrides. This is useful when backward calculation does not generate exactly the amount you 
need, or when only part of the journal entry is taxable. 

You can ignore the distribution amounts and enter amounts in the totals section directly. If you enter an 
amount in the Sub-Total, Total, or New Balance fields, the rest of the memo is calculated backwards. 
This is useful if you already know what you want the end result to be. 



154 • Productivity Suite | PrintSmith Vision User Guide 

 

 

For example, if a customer has a balance of 72.46, and you want to write off the entire balance, you can 
enter 0 in the New Balance field, and a memo is generated to arrive at that balance. In this case, the 
total amount of the memo is 72.46 (a credit memo). If the Taxable check box is selected, the system 
calculates the subtotal needed to generate a taxable amount that, when taxed and added together, 
equals 72.46. If the tax rate was 6%, the subtotal would be 68.36 and the tax 4.10. If the Taxable check 
box is cleared, the subtotal is the same as the total. 

6. The Description field includes some default text; change it if necessary. This description is used 
in account history and in credit memos. 

7. If you contact the customer whose information you are viewing in the Journal Entry window, log 
the interaction and, if necessary, indicate that follow-up is required: 

a. Click the Notify Customer icon. The Notify Customer window opens. 

b. Complete the Notify Customer window. 

8. In the Sales Rep field, select a sales representative if the journal entry affects the commissions 
earned by that sales representative. 

9. In the Comments field, enter a detailed explanation of the reason for the journal entry, for 
example, Bad check. The comment is included in printed credit memos. 

10. To change all positive numbers to negative numbers and all negative numbers to positive ones, 
click Reverse. For example, if you receive a bad check, you do not want to remove the record, but 
you do want to add back the debt to the customer’s account. 

11. To zero all fields in a journal entry that are not related to taxes, click Only Tax. Typically, this 
button is used when adjusting (adding or removing) tax from an invoice. Everything is zeroed 
except Tax Sub, Tax, and Total. 

12. To write off a percentage of some known amount, enter a percentage in the field to the right of the 
Calc Adjustment button, and then click Calc Adjustment. 

13. When the journal entry is set up the way you want, click Update & Post. 

14. If you initiated the journal entry from the Post Payments window, you automatically return to the Post 
Payments window where the original entry and the journal entry are automatically selected and ready 
to be posted. Click Update & Post to apply one to the other. 

Originating journal entries from the Post Payments window 
When you need to adjust invoices that are locked because you already performed a closeout, you can simplify 
the steps in making a journal entry by starting the process from the Post Payments window. 

1. In the Post Payments window, select an account. 

2. Select the invoice you need to adjust and select Journal Entry from the options icon. The 
Journal Entry window opens, and information from the selected invoice is displayed in negative 
format, ready to be adjusted. 

3. Make the necessary adjustments and click Update & Post. For examples of the types of 
adjustments you may want to make, see “Journal entry examples”. 

4. After you click Update & Post in the Journal Entry window, the journal entry is added to the Post 
Payments window which re-opens automatically. Both the original invoice and journal entry are 
selected and ready to be posted. Click Update & Post to apply one to the other. 

You can print and email the credit memo. If you want to email you have the option of the standard email template 
of you can customize the email template. 

E-mailing Credit Memos 
When you post journal entries, you can e-mail the credit memo for the posted journal entry (and/or print the credit 
memo). In addition: 

• The invoice contacts for your accounts must have e-mail addresses. 

• The E-Mail option must be selected in the Journal Entry window before you post the journal entry. 
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When you e-mail a credit memo from the Journal Entry window, it is sent directly (you cannot review it 
before it is sent). By default, the credit memo is sent to the contact for the invoice or the invoice contact for 
the account. 

If the Credit Memo log text field in the E-Mail preferences includes text, e-mailed credit memos are logged in the 
customer account (on the Log section). 

If the Credit Memo log text field in the E-Mail preferences is blank, e-mailed credit memos are not logged. 

If the Use log text for subject and file name option is selected in the E-Mail preferences, the Credit Memo log 
text is also used for the subject of the e-mails and the name of the PDF attachment (the statement). If the Use 
log text for subject and file name check box is cleared, the subject and file name follow the default 
conventions. 

Journal Entry Examples 
This section provides some examples of journal entries. 

Tip Remember that if you are creating a journal entry for a locked invoice, you can initiate the process from 
the Post Payments window as described in “Originating journal entries from the Post Payments 
window”. 

Writing off an invoice as un-collectable 
If a customer refuses a job, you must write off the invoice. The invoice still remains in the customer’s account 
history but is taken care of from an accounting perspective. 

1. In the Journal Entry window, enter the number of the invoice to be canceled. A reversing entry for 
the invoice is created. 

2. Make sure the Update Customer Statistics option is selected. 

3. Click Update & Post. 

4. Select AR (Account Receivable) > Post Payments and then select the account with the bad 
invoice. 

5. Select the invoice and click Auto Apply. 

6. Click Post Payment. 

Tip To avoid basing a new invoice on the bad (refused) invoice, ePS recommends that you enter a note 
about the invoice in the account history to clarify it was a bad invoice. 

Writing off an entire account balance as un-collectable 
If a customer goes out of business, you must write off the entire account balance. 

1. In the Journal Entry window, select the account you want to write off. 

2. Clear the Affect Sales option. 

3. Enter 0 in the New Balance field. If the Taxable option is selected, the entire amount due is treated 
as taxable sales. You must manually calculate the taxable amount if only part of the balance is 
taxable. 

4. Enter an appropriate description and click Update & Post. The journal entry is posted. At this 
point, sales are adjusted, a negative adjustment to new charges is made, and the account balance 
is 0.00. There are still open items, however, which you should “pay” off with the journal entry you 
just created. 

5. Select AR (Account Receivable) > Post Payments and select the account you are writing off. 
There may be several open items. The last open item is a journal entry, the one you just created. 

6. Click Auto Apply to select all of the open items. 

7. Click Post Payment. The account balance is unchanged, but there are no longer any open 
items. 
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Handling a bad check 
If the customer gave you a bad check, you must make a journal entry to add back the debt to the customer’s 
account. 

1. In the Journal Entry window, enter the invoice number for which you got the bad check. 

2. Clear the Affect Sales option since you did not sell the job. 

3. Click Reverse to turn all the negative amounts to positive ones (because you need to add them 
back as what the customer still owes you). 

4. Click Update & Post. 

Discounting a percentage of an invoice 
If a customer is unhappy with a job, you may want to maintain a good relationship with the customer by 
discounting the invoice by some percentage, for example, 10%. If a closeout was already performed, you must 
make a journal entry to account for the discount. 

1. In the Journal Entry window, enter the number of the invoice you want to discount. 

2. In the Calculate field, enter a percentage, for example, 10. 

3. Click Calc Adjustment, and all the amounts change to 10% of the original amounts. 

4. Click Update & Post. 

5. In the Post Payments window, select the account and then the memo item you just created and 
then click Post Payment. 

Note  The invoice in account history will continue to show the original amounts. 

Giving a dollar discount 
If a customer is unhappy with a job, you may want to maintain a good relationship with the customer by giving a 
fixed amount back (rather than a percentage as shown above). 

1. In the Journal Entry window, enter the number of the invoice you want to discount. 

2. Select the sales category from which you want to take the money and enter the amount as a 
negative number in the Adjustments column. 

3. Delete the entries in all the other sales categories (so they are blank). 

4. Click Calc Adjustment, and the amounts reflect the fixed amount you applied as a discount. 

5. Click Update & Post. 

6. In the Post Payments window, select the account and then the memo item you just created and 
then click Post Payment. 

Removing tax from a posted invoice 
If you learn after a closeout that an invoice was taxed when it should have been tax exempt, you must make a 
journal entry to remove the tax. This also corrects your taxable sales and non-taxable sales. 

1. In the Journal Entry window, enter the number of the invoice to be adjusted. 

2. Click Only Tax. All of the details are cleared except for Tax Sub and the rest of the totals. Tax 
Sub is a special number used strictly for calculating tax. With Sub-Total set to 0.00, the only real 
amount is the tax. 

3. Click Update & Post. A credit memo is created. 

4. In the Post Payments window, select the account and then the credit memo item you just created 
and then click Post Payment. 
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Adding tax to a posted invoice 
If you learn after a closeout that an invoice was not taxed when it should have been, you must make a journal 
entry to add the tax. This also adjusts your taxable sales and non-taxable sales. 

Note This procedure assumes that the document was made tax-exempt the recommended way. If you 
marked each item in the invoice as not taxable, you must manually calculate the tax amount before 
using this procedure. 

1. In the Journal Entry window, enter the number of the invoice to be adjusted. 

2. The invoice was not taxable, so the Taxable option should be cleared. If there were items in the 
invoice that are taxable, there will be an amount in the Tax Sub field. Select the Taxable option to 
calculate the tax based on the document’s tax table. 

3. Click Only Tax. All of the details are cleared except for Tax Sub and Tax. Tax Sub is used strictly 
for calculating tax. With Sub-Total set to 0.00, the only real amount is the tax. 

4. Click Reverse. This changes the journal entry into a debit memo. All the amounts become 
positive. 

5. Click Post. Tax Sub is added to taxable sales. On the receipts side, Tax is added to tax on sales 
and to new charges. 

6. In the Post Payments window, select the account and the debit memo you just created and then 
click Post Payment. 

Issuing a refund 
Suppose that you overcharged a customer in a cash register transaction, the customer paid, and you performed 
a daily closeout. If the customer returns and requests a refund, you must issue a credit memo and then refund 
the amount. 

1. In the Journal Entry window, select the account to be used for issuing the credit. An “In House” 
account is useful for these types of transactions. 

2. Enter the amount of the refund as a negative number in the Total field. If the Taxable option is 
selected, the Tax Sub and Tax are calculated. 

3. Click Update & Post. A credit memo is posted to the account. This takes care of adjusting sales 
and tax on sales, but cash is not yet affected. 

4. Select AR (Account Receivable) > Post Payments and select the account. The credit you just 
posted will be at the end of the list of open items. 

5. Select the credit memo. 

6. Select the type of refund in the Remainder field (on account, return cash, and so on). This 
indicates that the entire credit memo is to be returned to the customer and identifies how it is 
being returned. 

7. Click Post Payment. The amount of the credit memo is removed from the cash drawer. 

Adjusting sales categories 
If you discover that a charge was posted to the wrong sales category, you must create a zero-balance journal 
entry that moves the amount to the correct sales category. ePS recommends that you create an “in house” 
account to use for these types of transactions to avoid cluttering up customer histories with housekeeping journal 
entries. If you do not want to create a customer account for this type of transaction, you can use the walk-in 
account. For example, if $100 was charged to the HP 5000 sales category instead of the VUTEk sales category, 
you would make the following journal entry: 

1. In the Journal Entry window, select the “in house” Account to use for the transaction. 

2. Enter -100 in the HP 5000 field, and enter 100 in the VUTEk field. 

3. Click Update & Post. A zero-balance journal entry is recorded. 

The sales report shows this as a $100.00 decrease in the HP 5000 sales category and a $100.00 increase in the 
VUTEk category, with no other effect on sales.  
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Register Tape 
PrintSmith Vision keeps a detailed record of all transactions for each sale’s “day” on an electronic register tape. 
A sales day ends when you perform a closeout, and a new tape is started. The register tape records significant 
events such as deposits, document voids, posted payments, finance charges, and journal entries. When you 
post transactions in the Cash Register window, they are recorded on the register tape. 

If you are using line-item taxation and a transaction involved more than one tax table, all the tax tables are listed 
in square brackets, but the Tax amount is the total tax (the amount is not broken down on the register tape). 

Finding transactions  
Events recorded in the register tape consist of a transaction “header” followed by one or more transaction details. 
Because register tapes can get very long, you can use the Advanced Search option to locate transactions.  

1. In the Register Tape window, click the Advanced Search option.  

2. Enter your search criteria in the various fields and click the Search button.  

 
3. To do a different search, click Clear. 

Voiding Entries on Register Tape 
Occasionally, people make mistakes: they select the wrong invoice for posting, enter a check as cash, and so 
on. Sometimes a customer may change his or her mind about a purchase or ask for a refund. When this 
happens, you want to be able to correct the problem quickly. In PrintSmith Vision, you can adjust your 
accounting records in two ways: you can make a journal entry, or you can void the transaction on the register 
tape. Whenever possible, ePS recommends that you void the transaction on the register tape. 

After you perform a closeout, the register tape for that period is locked. As a result, you should review the tape to 
determine if any transactions need to be voided before performing a closeout. It is much easier to void the 
transaction before the closeout than to create a journal entry afterwards. A journal entry does not cancel the 
transaction; it creates a new transaction that counteracts or reverses the original transaction. A journal entry can 
sometimes be difficult to set up and it is subject to the same kind of errors as the original transaction. 

When you void a transaction, on the other hand, a new transaction is not created except to record the void itself. 
For example, if you void an invoice pickup transaction, the invoice is removed from the account history and 
placed back in the pending invoice list just as though it had never been picked up. 

Voids are not allowed in a few situations: 

• Deposit entries. To remove a deposit, open the invoice and use Invoice > Deposit Entry to zero 
out all the deposit information. 

• Invoice cancellations. Once an invoice is canceled, the data in the invoice is gone – there is no 
way to recover it, so no way to void a cancellation. 

• Voided entries. You cannot void an entry that was already voided, or an entry that records a 
void. 

• Invoices or payments that were already paid or applied in a later transaction. PrintSmith Vision 
will notify you of the problem and identify the entry that is at fault. For example, if you pick up an 
invoice and later use AR (Account Receivable) > Post Payments and apply the payment, you 
cannot void the invoice pick up until you void the payment. 

• POS charges. You cannot void charges that were posted using Accounting > AR (Account 
Receivable) > Post POS Charges. 

Note You can only void the transactions if you have permission to do so. 
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To void a transaction 

1. Select Accounting > AR (Account Receivable) > Register Tape. The Register Tape window opens. 

2. Select the transaction you want to void and then the Void button will be active. 

 
3. Click Void, if you have permission. 

4. You can print the register tape by clicking the Print button. 

Once the transaction has been voided it will have a line drawn through it and a new entry will be added that a 
transaction has been voided. This is the recommended way to correct mistakes; once a closeout takes place, 
you must make journal entries to correct mistakes. 

 

Opening Old Tapes 
As part of a daily closeout, the register tape for that period is archived and locked, and a new tape is started. You 
can click the Old Tape button to open register tapes from previous closeouts (identified by date). While you can 
review and print any tape, you cannot void entries in old tapes because they are locked after a daily closeout. 
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Closeout 
A closeout in PrintSmith Vision is the process of summarizing the sales and accounting activity for a day or 
month. 

What do “daily” and “monthly” mean? 

Daily Closeout 
Despite the name, how you define “daily” is up to you. You pick the frequency. 

• Daily does not need to correspond to a 24-hour calendar day. 

• The period represented by a daily closeout can span several days, e.g., every Wednesday. 

• More than one daily closeout can be performed during a 24-hour period. 

Monthly Closeout 
Despite its name, a monthly closeout can be run at any time, but typically you would do this at the end of a 
calendar month. The monthly closeout just summarizes the daily closeouts. 

What to avoid: 

• The longer the period between daily closeouts, the harder it can be to track down discrepancies – 
the volume of transactions will be higher. 

• The period represented by a daily closeout should never span the end of the month, e.g., if a daily 
closeout was run on April 28, do not run the next one on May 2 – this will distort your monthly 
figures. 

Manual vs. Automatic Closeouts 
Closeouts are typically performed manually (as described below), but you can also automate the process. 
For information and recommendations about automatic closeouts. 

Note Auto closeouts do not allow for a review of detail reports. 

Manual closeouts 
Closeout checklist: 

1. Post POS charges 

2. Start daily closeout: new vs. append. 

3. (Optional) Productivity data. 

4. Balance cash drawer. 

5. Look at sales summary. 

6. Verify sales summary report against invoice pickups, payments, journal entries, and tax summary. 

7. Run daily closeout. 

8. As needed, run monthly closeout. 

Details of these tasks follow. 

Task 1: Post POS charges 
If you charged any cash register transactions to accounts, post those charges before starting a closeout: 

1. Select Accounting > AR (Account Receivable) > Post POS Charges. 

2. Select the options you want (for example, Print Summary Report) and click Confirm. 
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Task 2: Start daily closeout 
1. Select Accounting > AR (Account Receivable) > Closeout. 

2. Select Trial closeout or Daily closeout. ePS strongly recommends you always run a trial closeout 
before doing a “real” closeout – this gives you the opportunity to review various closeout reports 
and correct any discrepancies if necessary.  

Trial closeout also allows you to just select the reports you want to see by selecting Quick Trial 
Closeout. If the Quick Trial Closeout checkbox is not selected, then the rest of the closeout 
process is the same for Trail or Daily. 

  
3. Select one of the following: 

• New Closeout for Today – always select this unless you are doing more than one closeout 
during the same calendar day. 

• Append to Previous Day – select only if you are performing more than one closeout during 
the same calendar day (this can be useful if you have multiple shifts and want to close out 
each shift). 

4. Click Start. 

You have the option to capture productivity data. There are four steps to the closeout process. 

a. Productivity Data (Optional) 

b. Balance Cash Drawer 

c. Review Sales Summary 

d. Verify Reports 

5. Then click Finish Closeout. 

Task 3: (Optional) Enter productivity data  
You can complete the Productivity Data window if you want to track productivity statistics and click Next Step. 
This information is not required.  
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• Square feet in Store: your square footage. This is used to calculate sales per square feet.  

• Number of Workers: the number of employees. This is used to calculate sales per employee.  

• Press Hours Worked: the number of billable hours for all your printers.  

• Other Production Hours: other direct labor hours such as setup and finishing.  

• All Other Hours: other hours worked that are not related to production. This would normally include 
sales and supervisory hours. 

Task 4: Balance the cash drawer 
The process of balancing the cash drawer is the single most important verification procedure you perform in 
PrintSmith Vision. Never finish a closeout if the Balance Cash Drawer window has unexplained discrepancies. 

• Count cash 

Count all the cash you have on hand. This amount should match what is shown in the Cash in Drawer field. 

PrintSmith Vision automatically subtracts the amount in the Change Fund field from the amount in the Cash in 
Drawer field and displays the total cash to deposit in the Cash to Deposit field. This amount is also shown on the 
right side of the window, so all the deposit totals are in line. 

Note You cannot finish a closeout if Change Fund is larger than Cash in Drawer. Since Change Fund is the 
amount of cash held out of the deposit, you cannot have more in the drawer than you actually have. 
You must make sure the change fund does not exceed the cash in the drawer. 

Common problem: 

You have less in the Cash in Drawer field than is shown in the Change Fund field. 

A returned deposit almost always causes this problem. If you return a deposit made with a check that was 
posted on a previous day, the check is no longer in the cash drawer. When this happens, PrintSmith Vision 
issues a cash refund because it no longer has the check to return to the customer. Often, you will have 
issued a business check for the refund, and this causes the discrepancy. 

A discrepancy can also occur if you entered a check while posting payments for more than the total 
selected for payment and did not apply the remainder to the account. In this case, PrintSmith Vision issues 
a cash refund to the customer instead of crediting the remainder to the account. 

Solution: 

Review the register tape to find the problem and correct it. Look for Refund - CASH in transaction records 
on the register tape. 

• Count checks and drafts 

Checks and drafts are shown in the deposit item list (on the left side of the Balance Cash Drawer window) in the same 
order as they were posted. 

• Verify that each item in the list matches an actual check. (Alternatively, add up all the checks 
on hand and compare this to the amount shown for Checks in the Balance Cash Drawer 
window.) 

• If you have checks on hold or on automatic release, keep them separate so they are not part 
of your verification. 

• Handle refund checks 

When posting payments, you can issue refunds by writing a check. In this situation, only half of the 
transaction is completed in PrintSmith Vision. The check itself is not written in PrintSmith Vision so the 
record of a refund check in PrintSmith Vision is just a reminder that a check must be written to complete the 
transaction. 

• Count credit cards 

Credit cards are slightly different from checks and drafts. Typically, the credit card processing system 
issues a summary report with transaction counts and totals for each type of card.  

Note Credit card transactions that are on hold are not included in this window. Keep these transactions 
separate. 



Closeout | User Guide • 163 

 

 

• Add checks 

Added checks are placed at the end of the list in the Balance Cash Drawer window with the word Add in 
the Status column. 

• Change checks in deposits 

You can change the reference number or amount for a check if necessary (by selecting a check in the 
Balance Cash Drawer window and clicking Change Check in Deposit). 

Warning: A change to the reference number or amount of a deposit affects only the deposit ticket, and almost 
always results in a variance in your daily sales report unless offset by a change in cash. ePS 
strongly recommends you fix the transaction that caused the problem rather than change the check. 

• Hold or release checks 

To place a check on hold or to release a check so it is included in the deposit, select the check in the Balance 
Cash Drawer window and click Hold/Release Check. Items on hold have Hold in the Status column. They are 
not included in the deposit total on the deposit ticket. On subsequent closeouts, they are included in Items on 
Hold. 

Correct discrepancies 
If there are any discrepancies, identify them and fix the problems before continuing with the closeout. Click 
Cancel Closeout in the Balance Cash Drawer window to cancel the closeout. 

Typically, once you identify an incorrect transaction, you must use AR (Account Receivable) > Register Tape 
to find and void the transaction and then you must re-enter the transaction correctly. 

Note Always void the most recent transactions first.  
When trying to identify discrepancies, watch out for: 

• The amount on a deposit item differs from the amount in PrintSmith Vision. Always fix this 
situation. Find the transaction on the register tape and void it. Then enter the transaction again 
with the correct amount. Although you can modify the reference number or amount of any 
transaction, avoid doing this because it almost always introduces accounting errors. 

• Payment type totals do not match. If the total of all payment types in PrintSmith Vision does 
not match all of the payments in the cash drawer, payments of the wrong type were probably 
entered. For example, if cash is over $100 and checks are under $100, a payment was probably 
recorded as cash instead of being recorded as a check. To fix this problem, identify the faulty 
payment, void it, and re-enter it as the correct type of payment. ePS strongly recommends that 
you always fix this type of problem to maintain a strong audit trail. 

• Extra check, credit card, or draft in hand - You probably forgot to post a payment in PrintSmith 
Vision or forgot to enter a deposit on an invoice. If one of the other payment types is too high, a 
payment or deposit may have been entered with the wrong payment type. Look for a 
transaction with a different payment type that matches the amount on the check or draft. Void the 
transaction and re-enter it with the correct payment information. If it is a deposit, open the 
affected invoice, change the type of the deposit, and save the document. 

• Extra check or draft in PrintSmith Vision. If all the other payment type totals are correct, a 
payment was made that should not have been made. The information in the list of deposit 
items will help to identify the incorrect transaction. Most of the time, this is a pickup or POS 
charge that was paid for in PrintSmith Vision when it should have been charged to the customer’s 
account. Void the transaction and then charge it to the customer account. 

• Cash in hand is too high. Unless this is your very first closeout, and beginning cash was not 
entered in the Change Fund field, you probably forgot to enter a payment or a deposit. 

• Cash in hand is too low - If cash or credit cards are correct, you probably entered a cash 
payment in the cash register that should have been a charge or entered a cash deposit when one 
was not made. Alternatively, you entered the wrong payment amount. If cash or credit cards do 
not match, find those mistakes first. If cash is still off, look for the mistakes in cash transactions. 
Void the incorrect transaction and re-enter it. 
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Task 5: Review sales summary  
After you click Next Step in the Balance Cash Drawer window, the Review Sales Summary window opens. This 
includes the A/R Balance – this is the original balance (from the last closeout) minus payment plus new charges 
adjusted by any journal entries.  

Note  Although you can review the contents of this window, it is more important to compare the contents of 
certain reports during a trial closeout. See the next task.  

Task 6: Verify reports  
PrintSmith Vision strongly recommends you always run a trial closeout before doing a “real” closeout – this gives 
you the opportunity to review various closeout reports and correct any discrepancies if necessary. 

After you click Next Step in the Sales Summary window, the Verify Reports window opens. At a minimum, 
select the following reports:  

• Sales Summary  

• Invoice Pickups  

• Payments  

• Journal Entries  

• Tax Summary  

Verify the Sales Summary report against the Invoice Pickups, Payments, Journal Entries, and Tax Summary 
reports. If you find discrepancies, correct them. If everything is correct, continue to the daily closeout. 

Only on the daily closeout you have the option to verify the closeout tax detail and tax summary data. To activate 
this feature, go to Preferences > Settings > HTML View and check the Enable Discrepancy check button in 
Closeout box. A new button will be displayed in the Closeout window as Verify Closeout Data. 

Important  A warning is displayed that it is recommended to start this process during your non-business 
hours because it will take some time depending upon the size of transactions. Please make sure 
tax elements and rates are matching in all current tax tables. 

After running Verify Closeout Data, a message is displayed that the closeout data is done, and you should check 
the Tax Detail and Tax Summary Reports. 

Task 7: Perform a real daily closeout 
If you find no discrepancies when analyzing the reports generated from a trial closeout, click Finish Closeout. 
The closeout does the following:  

• Adds an entry to the register tape indicating that a closeout was performed.  

• Archives the current register tape and creates a new register tape. The archived tape is locked so it 
cannot be changed, but you can click Old Tape to review an archived tape. 

• Resets the cash drawer. Cash is set to the amount in the Change Fund field. Checks are set to reflect 
any checks on hold. Credit cards are zeroed. AR balance is unchanged. 

• Updates the daily sales summary. This summary includes information about new invoices and invoice 
pickups, as well as tax details. The reports that you selected open in a preview window, from which you 
can print them. 

• Saves a copy of the deposit ticket. See the Deposit Ticket section. 

Task 8: Perform a monthly closeout  
A monthly closeout provides a summary of the sales for a calendar month and updates customer sales statistics 
and account histories. The system automatically figures out which month needs to be closed out next and 
informs you what it is going to do. You do not have to enter anything except the optional productivity data.  

Although typically you will perform a monthly closeout at the end of a month, you can do so at any time. If a 
closeout was already done during the current month, PrintSmith Vision updates the monthly sales figures instead 
of starting a new month.  

To perform a monthly closeout: 



Closeout | User Guide • 165 

 

 

1. Select Accounting > AR (Account Receivable) > Closeout. 

2. In the Closeout window, click the Monthly Closeout tab and then click the +Month Closeout button.  

3. Before starting the closeout, PrintSmith Vision informs you what period is being closed out. Click Start 
to review the productivity information and change it if necessary. 

 
Note  If you have selected the Capture Productivity Data option, clicking Start opens the Productivity 

Data window. 
4. When the Monthly Sales window opens, review the information and then click Next Step.  

5. In the Verify Reports window, select the reports you want to print. Click Finish Closeout to complete 
the monthly closeout.  

6. The reports that you selected open in a preview window from where you can print them.  

7. When the closeout is finished, you are asked if you want to update account history with sales statistics. 
Click Yes if this is the “final” closeout for the month. 

Tip  Updating sales statistics can be time-consuming so you can skip this step if you know this is not the last 
closeout for the month. 

Automatic closeouts 
Instead of performing daily or monthly closeouts manually, you can have closeouts performed automatically – 
without any user interaction – at a time of your choice. 

Before you begin: important recommendations and notes 
• Monthly closeouts: PrintSmith Vision recommends doing automatic monthly closeouts to ensure 

your monthly totals are captured at month’s end. For example, if you are travelling, or if the end 
of the month falls on a weekend or holiday, an automatic monthly closeout ensures the closeout 
always takes place. 

• Daily closeouts: PrintSmith Vision does not recommend automatic daily closeouts for normal use 
because you have no opportunity to balance the cash drawer by counting cash or credit cards, 
reviewing deposits, and so on. In general, manual daily closeouts are recommended. Automatic 
daily closeouts can be useful, however, if you cannot always be there to perform the closeout 
manually but want to make sure the closeout takes place regularly. 

Note An automatic daily closeout will take place only if the register tape has items on it. If you 
perform manual daily closeouts on most days, and the register tape is empty, automatic 
closeouts will not take place on those days. 

If the system finds discrepancies in the cash drawer during an automatic daily closeout, the closeout will fail, and 
you will need to perform a daily closeout manually to correct the problem(s). For this reason, if you frequently 
correct discrepancies in the cash drawer during manual daily closeouts, automatic closeouts are not a good 
solution for you. 

Activating automatic closeouts 
To take advantage of automatic closeouts, you must activate them in the PrintSmith Vision Closeout 
preferences. 

1. Select Preferences > Settings. 

2. Under Accounting, select Closeouts. 
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3. Select the Activate Auto Closeout checkbox. 

4. To perform daily closeouts automatically, select the Perform daily closeout automatically 
check box and then select a Time of Day. (The default time is 20:00.) 

5. To perform monthly closeouts automatically, select the Perform monthly closeout 
automatically check box and then select a Time of Day. (The default time is 23:00.) 
Automated monthly closeouts always take place on the last day of the month. 

6. To ensure some members of your organization are informed if a closeout fails or is 
interrupted, enter: 

• Failure Notification E-Mail Addresses (separated by ;) 

• Subject Line of e-mail that is sent 

• Body Text of e-mail that is sent 

Important For e-mail to be sent, you must have e-mail enabled and configured in PrintSmith 
Vision. For information, see “E-Mail preferences”. 

7. Click Save. 

The daily and/or monthly closeouts will now take place automatically at the time you specified. 

Closeout warnings 
Users who are logged into PrintSmith Vision are given a 15-minute warning that an automatic closeout is about 
to begin so they can finish their work and log out. If they remain logged in, their session is suspended until the 
closeout is done. 

In addition, if users try to log in while a closeout is taking place, they will be prevented from doing so. 

Automatic daily closeouts 
Note the following about automatic daily closeouts: 

• A daily closeout will only take place if the register tape has items on it. 

• If a daily closeout already occurred on a calendar day (typically due to a manual closeout), the 
automatic daily closeout will be appended to the previous closeout. 

• If the system finds discrepancies in the cash drawer during an automatic daily closeout, the 
closeout will fail, and you will need to perform a daily closeout manually to correct the problem(s). 

Automatic monthly closeouts 
An automatic monthly closeout will take place only if the register tape is empty. If it is not empty, the system 
automatically performs a daily closeout before the monthly closeout. 

Status of automatic closeouts 
A history of all your automated closeouts is available under History in the Closeout preferences. Here you can 
see what type of closeout was performed, when it was performed, and whether it was successful. 

1. Select Preferences > Settings. 

2. Under Accounting, select  Closeouts. 

3. Check the History section.  

In addition, if a closeout failed, and you specified one or more Failure Notification E-Mail Addresses in the 
Closeout preferences (and have e-mail enabled and configured in PrintSmith Vision), those users will be notified 
by e-mail. Typically, they will need to correct problems by performing a manual daily closeout. 

Closeout reports 
No closeout reports are printed when an automatic daily or monthly closeout takes place. 
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Deposit Ticket 
1. To print a deposit ticket after a closeout is done, Select Accounting > AR (Account Receivable) 

> Closeout. 

2. Select a deposit ticket (identified by the date of the closeout). You can also select records. 

 
3. After you select the records, click the Print Deposit Ticket button to generate a report that 

includes a Daily Deposit Record for each of the deposit tickets you selected.  

Your report is  generated. 
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Register Accounts and Contacts to MarketDirect StoreFront 
Understanding the Relationship Between Accounts, Contacts, and 
MDSF 

A customer account in PrintSmith Vision is equivalent to a company in MarketDirect StoreFront. 

Contacts in PrintSmith Vision are equivalent to users in MarketDirect StoreFront. The users, also known as 
buyers, place orders on the MarketDirect StoreFront website. 

Information about accounts and contacts when sent from PrintSmith Vision to MarketDirect StoreFront is known 
as registering accounts and contacts. If you update a company or user in MarketDirect StoreFront, the 
corresponding account or contact is updated in PrintSmith Vision.  

Note that if you delete a company or user in MarketDirect StoreFront, the corresponding account or contact 
remains in PrintSmith with no indication it is no longer present in Market Direct StoreFront. 

Note If you make changes to an account or contact in PrintSmith Vision after the account or contact is 
registered, the changes are sent to MarketDirect StoreFront automatically. 

Registering accounts and contacts to MDSF 
Before you can register a contact as a buyer in MarketDirect StoreFront, the contact must have an e-mail 
address and a MDSF username defined in PrintSmith Vision. 

Before you can register an account as a company in Market Direct StoreFront, the account must have at least 
one contact with an e-mail address and MDSF username defined. 

You can register accounts and contacts in different ways, but in all cases, you must first make sure that contacts 
have e-mail addresses and MDSF usernames. 

Method 1: Register a contact and automatically register the account 
Start by going through your accounts and identifying those contacts you want to register as buyers for the 
account (this is often all the contacts). When you register a contact, the contact’s account is also automatically 
registered (if not already registered). 

1. For each account you want to register in MarketDirect StoreFront as a company, do the following: 

a. Click Accounts in the Quick Access panel (or select Accounting > AR (Account Receivable) 
> Accounts). 

b. In the Accounts picker window, click the Account Name column to open the account. 

c. On the Contact & Address tab, in the Contact List field, select a contact you want to be a 
buyer in MarketDirect StoreFront and click the Open Invoice Contact icon. 

  
The Contact window opens. 

Tips  You can also open a contact by clicking Contacts in the Quick Access panel and selecting a 
contact in the Contact picker window (contacts are always identified by their accounts). If you 
are creating a new contact, you must save the contact before you can register the contact. 
The contact must also be associated with an account. 
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2. In the MDSF User Name field, enter a unique name. The contact will use this name to log into the 
MarketDirect StoreFront site. 

  
3. Click the Web button. 

Note  If the name is not unique, you have an option to use the e-mail address as the username. 
Then, click Yes or No. 

If you click No, enter a different name, and click the Web button again. 

4. After you click the Web button, a message informs you that registration was initiated, and that the 
contact will be e-mailed login information after the registration is complete. 

 
After registration is complete: 

• The contact is registered as a user in MarketDirect StoreFront. 

• The contact receives an e-mail with a link to the MarketDirect StoreFront site, and a username 
and password. After first logging in, the user will be forced to change the password. 

• The account with which the contact is associated is also registered in MarketDirect StoreFront 
(unless it was already registered) 

Important Never add, edit, or delete a company in MarketDirect StoreFront because that 
information is not sent to PrintSmith Vision. Companies (meaning accounts) must 
always be managed from PrintSmith Vision. 

Or click the Web button in the Contacts window: 

• Use the Update Contact button to update the contact information in MarketDirect StoreFront if 
it changes. 

• The Last Registration Date and Registration Status are updated. 

• Then the Unregister Contact button becomes available. You can use this if you no longer 
want the contact to be a user in MarketDirect StoreFront. 
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Method 2: Register individual accounts and their contacts 
You can also register an account from the Accounts window, as long as the default invoice contact for the 
account has an e-mail address and MDSF user name defined. If the account has other contacts that you want to 
register as users in MarketDirect StoreFront, they must also have an e-mail address and MDSF user name 
defined. 

1. Click Accounts in the Quick Access panel (or select AR (Account Receivable) > Accounts). 

2. In the Accounts picker window, click the account name you want to register. 

3. Click the Web button and then, confirm if you want to register default contacts. 

a. Click Yes to register default contact(s) or No to select specific contacts if the account has 
multiple contacts. If you clicked Yes, registration is initiated. 

b. If you clicked No, in the Customer’s Contacts List window, select the check boxes of the 
contacts you want to register as users in MarketDirect StoreFront and then click Select 
Contact(s). 

Note If a contact is missing a MDSF User Name or E-mail, you will not be able to register the 
contact without providing the missing information. 

You can then provide the missing information in Account contact list, click in the field under the MDSF 
User Name and E-mail columns to edit the information. 

   
4. A message informs you that registration was initiated, and that the contacts will be emailed login 

information after registration is complete, click OK to continue. 

 
After registration is complete, as with the first method of registering accounts and contacts, both a company and 
user(s) are created in MarketDirect StoreFront. The information under the Web button is updated, and the 
contacts receive an email with login information. 

 

Method 3: Register multiple accounts in one step 
If the default invoice contacts for accounts you want to register in MarketDirect StoreFront already have an e- 
mail address and MDSF user name defined, you can register all the accounts and all their default invoice 
contacts in one step. 
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Important  When you register several accounts in one step, only the default invoice contacts for the accounts 
are registered as users in MarketDirect StoreFront. If an account has multiple contacts that you 
want to register, either register the account as described for Method 2 above or register the 
contacts individually from the Web tab in the Contact window as described for Method 1. 

1. Click Accounts in the Quick Access panel (or select AR (Account Receivable) > Accounts). 

2. In the Account picker window, select the check boxes of the accounts you want to register. 

If the default invoice contact for an account is missing a MDSF user name or Email ID, you are 
notified, and will not be able to register the account until the contact has a MDSF User Name (on 
the Web tab in the Contact window). 

 
3. Click Register Account. 

 
4. After you click Register Account, a message informs you that registration was initiated, and that 

the contacts will be e-mailed login information after registration is complete. 

 
After registration is complete, the accounts will have Globe icon next to check box in the Account picker window. 

If you have a long list of accounts, you can enable MDSF Register toggle in the Account picker window to see all 
the accounts that are registered with MarketDirect StoreFront. 
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Updating accounts and contacts 
If you change some information about an account or contact that is already registered, the information is sent to 
MarketDirect StoreFront automatically to update the corresponding company or user in MarketDirect StoreFront. 

Some changes to an account, however, for example, to the address, are not automatically updated for a contact 
that uses the address. In this case update the contact manually as described below. 

1. Open the account or contact in PrintSmith Vision and click the Web button in the Account or 
Contact window. 

2. Click Update Account or Update Contact depending on what you are updating. 

 

Unregistering accounts and contacts 
If you want to delete a particular company or user in MarketDirect StoreFront, you must unregister the account or 
contact in PrintSmith Vision. The account or contact will still exist in PrintSmith Vision, but the corresponding 
company or user will be deleted in MarketDirect StoreFront. 

When you unregister an account, no contacts (users) associated with the account can place orders in 
MarketDirect StoreFront. When you unregister a contact, that person can no longer place orders in MarketDirect 
StoreFront. 

Important   Never delete a company or user in MarketDirect StoreFront because that information is not sent 
to PrintSmith Vision. Companies (meaning accounts) and users (contacts) must always be 
removed from MarketDirect StoreFront by being unregistered in PrintSmith Vision. 

1. In PrintSmith Vision, open the account or contact you want to unregister (delete from MarketDirect 
StoreFront). 

2. Click the Web button in the Account or Contact window. 

3. Click Unregister Account or Unregister Contact depending on what you are deleting. 

 

The company or user is then removed from MarketDirect StoreFront. 
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Import Stock 
Importing Stock Catalogs 

In addition to entering stock definitions, you can import stock definitions and update prices from an electronic 
price catalog from a vendor, as long as the import file meets certain requirements as described below.  

While importing the stock definitions, you can also update the stocks based on Product ID of the stock. The 
Product ID for a stock is an internal ID number and can be identified from the Stock Definitions page. You can 
have the option to import the stock definitions either by the Vendor Name or Product Id of the stock. 

Stock Import File Format 
• To import stock definitions successfully, the import file must be in the correct format. 

• The file must be a comma-delimited (CSV) text file. 

Important  The delimiters used in the CSV file must match what is specified in the Default CSV 
Separator and Default CSV Quote Character fields in your International preferences. To 
set the International preferences, go to Configuration > Preferences > Settings > 
International. If these fields are blank in the International preferences, the CSV field 
separator defaults to comma (,) and the quote character used to enclose text strings 
defaults to double-quote (“), which are the standard delimiters in the U.S. In other 
countries, different delimiters are used and can be specified in the International 
preferences. 

• The following fields are mandatory and if they are not filled in, then the import will not be 
successful. The mandatory fields are marked with an asterisk * on the mapping screen. 

Mandatory fields if you are importing by the Vendor Name: 

• Vendor Name 

• Unique Stock ID 

• Stock Name 

Mandatory fields if you are importing by the Product Id: 

• Stock Name 

• Product Id 

• Stock On Hand 

Note  Stock On Hand is a mandatory field only when the Update Inventory Stock option is 
selected in Import Settings. 

In addition, if you do not have a vendor listed or the Product Id column is blank, then a new stock is 
created. 

• Each stock must have a unique ID (stock ID). If you do not know or have a stock ID, you must 
obtain it or make one up and enter the ID in the import file for the stock to be imported correctly. 

• By default, column E of the stock import file includes a text corresponding to a stock group, 
e.g., S= sheet, R = roll (see “Fields in import file” below). If you want to use a different character for 
a stock group, you can use Table Editor to edit the Stock Group table and enter an uppercase 
letter in the Key (Alpha) column for a particular stock group. During a stock import, if the character 
in column E of the import file matches a value in the Key (Alpha) column in the Stock Group table, 
the stock is assigned to that stock group. Otherwise, the stock import uses the standard values as 
described for column E in the table below. 

• If any information about the stock is not available or does not apply, leave the field blank in the 
import file. (Otherwise, data will shift over to the wrong field.) 

• For a stock definition to be updated, the stock number and vendor name in the import file must 
match exactly what is already in PrintSmith Vision. 
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• The following fields must not have decimal formatting, or they will be imported as 0: Costing 
units, Bracket 1-6 qualifier for the HTML version) Lot count, and Carton count. 

Fields in the Import file 
The fields in the import file should be as listed below. 

Note To help you keep track of the fields, the first column in the table below has column letters 
(corresponding to columns in a spreadsheet). These are just to help you verify that all the necessary 
fields are in the import file.  

You can download a sample CSV file to view the format. 

Column headers 
 

Col Field Value 

A Vendor name The name of the vendor (up to 70 characters). If not supplied, 
the name in the Default vendor name field on the Preview tab 
in the Import Stock Catalog window is used instead. Vendor 
name is required for price updates of existing stock definitions. 

B Unique stock ID (Required) A unique vendor stock ID (up to 40 characters) 

C Parent sheet size The parent sheet size in decimal format (no fractions), for 
example, 8.5x11.00. 

D Stock name The name of the stock (up to 70 characters). 

E Stock group The stock group: 
S-Sheet R-Roll 
E-Envelope C-Carbonless O-Other 
If this field is blank, this defaults to S (sheet). 
If, however, the Stock Group table includes a Key (Alpha) 
value that is used in the import file, the stock is associated with 
that stock group. 

F Costing units The costing units – the quantity in which the stock is priced. 
(This must not have decimal formatting, or it will be imported 
as 0.) 

G Basis weight The basis weight of the stock. 
H M weight The M weight (weight of 1000 sheets) of the stock. 

I Caliper The caliper or thickness of the stock. 

J Envelope size The size of the envelope. (An entry must exist in the 
Dimension table for each envelope size.) Only applicable if unit 
description (in column E) is set to E. If blank, sheet size is 
used. 

K Bracket 1 pricing The first bracket pricing (see the Settings tab in the Import 
Stock Catalog window). 

L Bracket 2 pricing The second bracket pricing. 

M Bracket 3 pricing The third bracket pricing. 

N Bracket 4 pricing The fourth bracket pricing. 

O Bracket 5 pricing The fifth bracket pricing. 
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R Bracket 2 qualifier Quantity break for pricing in bracket 2 (in sheets). (This must 
not have decimal formatting, or it will be imported as 0.) 

S Bracket 3 qualifier Quantity break for pricing in bracket 3 (in sheets). (This must 
not have decimal formatting, or it will be imported as 0.) 

T Bracket 4 qualifier Quantity break for pricing in bracket 4 (in sheets). (This must 
not have decimal formatting, or it will be imported as 0.) 

U Bracket 5 qualifier Quantity break for pricing in bracket 5 (in sheets). (This must 
not have decimal formatting, or it will be imported as 0.) 

V Bracket 6 qualifier Quantity break for pricing in Bracket 6 (in sheets). (This must 
not have decimal formatting, or it will be imported as 0.) 

W Color The stock color, up to 30 characters. (You must supply either 
this or a generic color.) If the color is not currently in the Stock 
Colors table, it is added to the table. 

X Generic color A generic color (up to 30 characters) as defined in the Generic 
Colors table. (You must supply either this or a stock color.) If 
the color is not currently in the Generic Colors table, it is added 
to the table. 

Y Product finish The finish (dull, gloss, and so on), up to 20 characters. This is 
added to the product name. 

Z Carbonless parts The number of carbonless parts. Only applicable if the unit 
description (in column E) is set to C. 

AA Price expiration date Date in mm/dd/yyyy format after which the price is no longer 
valid. 

AB Not used Not used 

AC Lot count Minimum order quantity (lot count). (This must not have 
decimal formatting, or it will be imported as 0.) 

AD Carton count Number of sheets per carton. (This must not have decimal 
formatting, or it will be imported as 0.) 

AE Stock type The numeric stock type ID as defined in the PrintSmith Basic 
Sizes table: 
1 = Business Papers 
2 = Book Papers  
3 = Cover Papers  
4 = Index 
5 = Tag Board 
6 = Blanks 
7 = Vellum Bristol 
9 = Blotter 
10 = Label 
11 = Newsprint 
If you leave the stock type blank, but provide the basic size 
(next field), the system looks up the stock type in the Basic 
Sizes table. 

AF Basic size The basic size in decimal format (no fractions), for example, 
25.5x28.5. 

P Bracket 6 pricing The sixth bracket pricing 

Q Bracket 1 qualifier Quantity break for pricing in bracket 1 (in sheets). (This must 
not have decimal formatting, or it will be imported as 0.) 
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AG Metric size A setting that indicates if the stock is metric: Y or N. 

AH Product coating A setting that indicates if and how stock is coated: 
0 = Not coated 
1 = Coated one side 
2 = Coated two sides 

AI Grade The numeric ID of a grade as defined in the PrintSmith Stock 
Grade table. 

AJ Percentage The percentage of recycled matter, for example, 10% or .10. 
AK Type of 

management 
The type of forest management (up to 70 characters) from 
the PrintSmith Stock Forest Management table, for example, 
Green Seal Certified. If not found in the table, it is added to 
table. 

AL FSC Certified A setting that indicates if the stock is FSC certified: 
Y or N (or 1 or 0) 

AM SFI Certified A setting that indicates if the stock is SFI certified: 
Y or N (or 1 or 0) 

AN Green Seal Certified A setting that indicates if the stock is Green Seal 
certified: Y or N (or 1 or 0) 

AO Normal Run Size The normal run size for this material. 

AP MDSF Display Name The name that is displayed for this stock in MDSF. 

AQ MDSF gsm Weight The gsm weight for this stock as displayed in MDSF. 

AR MDSF Media Type The media type for this stock as displayed in MDSF. For 
example, envelope, letterhead, Plain paper. 

AS MDSF Media Weight 
Description 

The media weight description as displayed in MDSF. For 
example, Bond (20 pound)/75 gsm. 

AT MDSF Media ID The ID number as displayed in MDSF. You can only 
allow them to enter the new unique stock ID. 

AU New Unique Stock 
ID/Product Id 

If the vendor changes the stock ID then this column allows 
them to enter the new unique stock ID. The Product Id of the 
stock. 

AV Stock On Hand The amount of stock that is currently in inventory. 

AW Inventory Update A setting that indicates if the inventory stock is to be 
updated: Y or N. 

AX Stock Method The stock method: 
S-Sheet  
E-Envelope  
LF – Large Format 
R - Rolls 
RS – Rigid Substrate 
 

Note If the file to be imported does not follow the mapping listed above, you can change the mapping using 
the import program prior to uploading.  

Import of Large-Format and Rigid Substrate stock definitions  
You can import Large-Format and Rigid Substrate stock definitions into PrintSmith Vision using the Import 
Stock functionality. Import of Large-Format and Rigid Substrate stocks is based on Stock Method that is 
defined in the stock definition. 
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To support the import of all stock types, use the Stock Method column in the sample CSV template. The 
column Stock Method (AX) of the stock import file should include uppercase letters corresponding to a 
stock method, e.g., LF  = Large-Format, RG = Rigid Substrate as shown in the table below. During a stock 
import, depending on the characters in column Stock Method of the import file, the stock is assigned to that stock 
method. 

The following table lists the stock methods and their corresponding abbreviations to be used in the Stock Method 
column: 

Abbreviation Stock Method Type 

S Sheet 
E Envelopes 
LF Large Format 
R Rolls 
RG Rigid Substrate  

To enable you to import the stock definitions using the existing stock catalog, the Import Stock functionality also 
supports Stock Method derived from Stock Group. The stock groups supported are Sheet, Roll, Envelope, and 
Carbonless. The same stock catalog can be updated to include the large format and rigid substrate stock 
definitions. 

• For Sheet, Envelopes and Rolls stocks, if the Stock Method column is blank, then the stock is assigned 
based on the Stock Group. 

• For Large Format and Rigid Substrate stocks, if the Stock Method column is blank, then the stock is 
assigned to Sheet Stock. 

Important  You must use only the abbreviation of the stock type in the Stock Method column. 
If an incorrect abbreviation is used in the Stock Method column while importing the stocks, an error message is 
displayed as shown below and those stocks will not be imported. 

 
Clicking Yes in the error message downloads a Failed_uploadfilename.csv file. You can open this file to view 
the stocks that could not be imported and the reason for the error. If the Verify each stock check box was 
selected in the Import Stock window, you will be asked to confirm – for each stock being imported – whether you 
want to save the changes made to the stock definition. However, this confirmation message will not be displayed 
for stocks that failed to import and an error message is displayed. 

  
The PSV_Stock Definition Export.rpt also includes the Stock Method column. 

Manually Mapping to MDSF  
Manual mapping is used when you have a stock in the plant but may not want that stock listed in MarketDirect 
Store Front (MDSF). Manual mapping allows you to link the stock in the plant to the stock in MDSF for pricing 
only. You can manually map to MDSF stock using the following two options: 

• Manual mapping through Stock Definitions 
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• Manual mapping through Import 

Manual Mapping through Stock Definitions 
You can manually map the stock through the Stock Definitions window. 

1. In PrintSmith Vision, select Pricing > Stock Definitions.  

2. In the Stock List window, find and click the stock you want to map to MSDF stock.  

3. In the Stock Definitions window, click the Web tab.  

4. In the MDSF Media ID field, enter the Media ID from an item that is already registered in MDSF. 

By entering an ID in the MDSF Media ID field, you are mapping the stock to an existing MDSF stock for 
pricing. Since the pricing is controlled from MDSF, the stock in the plant that is mapped to a MDSF 
stock will have the same pricing plan as the MDSF stock.  

 
5. Click the Register Stock button. 

Now, a message is displayed indicating that the manual mapping of stock with MarketDirect StoreFront 
media is saved successfully. 

Important  You cannot use the same MDSF stock for more than one mapped stock. 
Manual Mapping through Import 
You can manually map the stock during the Import process by using the MDSF Media ID column. You can enter 
the ID number of an existing MDSF item in the MDSF Media ID column, and it will be manually mapped during 
the import process. You can only manually map items that have not been automatically assigned an ID by the 
system, those cannot be changed. If the item has already been manually mapped and there is an MDSF ID in 
the field, you can change to a different MDSF ID number. 

Note  If you export a CSV file from the database, there will be a column named Manually Mapped. That is for 
information only and is not used for import. You do not have to remove that column; it will just be 
ignored during the import. 

Import Procedure 
Warning A large catalog from a vendor may take some time to import. For example, 15000 stocks typically 

take about 2 hours to import. Consider doing the import at night. 
1. Make sure you have an import file from a vendor (or have set up an import file yourself). 

2. Select Pricing > Import Stock. The Import Stock Catalog window opens. 

3. In the Import by CSV file section, click the Upload Files button to locate and upload the file with the 
stock data you want to import. Alternatively, you can drag and drop the file to upload. 
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4. On the Import Settings section, specify the import criteria:  

• Select the Verify each stock check box if you want to be asked – for each stock being 
imported – whether you want to create a new stock definition or update an existing stock 
definition. This can take a long time if the import file includes many records. 

• Select the Metric check box to import metric information. This automatically selects the Metric 
check box in the stock definition, too. 

• Select the Full update, not just prices check box so that all information about existing stock 
is updated when you click Update Prices, not just prices. For example, if the name of the stock 
changed, it will be updated. If this is unchecked, then only the prices are updated. 

• Select the No broken cartons check box to set the Min. Order field in the stock definition to 
the value of the lot count when importing stock. 

Note If you select the No Broken Cartons check box, after the stock import, the Charge 
Customer for Entire Order check box is automatically selected on the Specification 
and Pricing tab in the Stock Definitions window. 

• Select the Update Inventory Stock check box to update the inventory stock while 
importing the stock. This will update the Stock On Hand field in the Inventory tab of the 
Stock Definitions page. 

Note  If you want to update the Stock On Hand field in the Inventory tab, you have to set 
the Inventory Update column to True in the import file and select the Update 
Inventory Stock check box. 

5. For Import By, select one of the following: 

• Select Vendor Name if you want to import the stock based on vendor name. 

• Select Product Id if you want to import the stock based on the Product Id. 

6. Under Adjust Price Brackets By section, do the following: 

• Select Percent if you want to change the bracket price being imported by a percentage. 

Select Amount if you want to change it by a fixed dollar amount. Increase the price by entering 
a positive percentage or amount or decrease the price by entering a negative percentage or 
amount. 

• Select the check boxes of the price brackets (Price 1 through Price 6) you want to adjust. If 
you select just one bracket, for example, Price 4, the stock cost is placed in the first price 
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column in the stock definition. If you select two brackets, for example, Price 1 and Price 3, the 
bracket for price 3 would also be imported into the price 2 column. 

7. Click Next. This takes you to the Stock Catalog Mapping page. 

 

Mapping the Import File 
After selecting the file to import and the settings for the import, the next step is mapping the fields. 

1. In the Stock Catalog Mapping section, the mapping is automatically done for any fields in the 
database with the same name as those in the CSV file. Fields that do not match will remain in the Drag 
to Target to map section. You have to manually map if you want to use those fields. 

 
Once that is done, you will see a sample of the data in the source CSV. After mapping the fields, you 
can save mapping for future uploads.  

2. Enter a name in the field under the Import Rule section and click Save Rule to the save the mapping 
catalog. 

If you have previously saved mapping rules, you can select it from the dropdown. 
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3. Click Manage Rules to view a list of saved mapping rules. 

 
4. Click the Un-Map All button to unmap the entire import rule. You can un-map individual items by 

selecting  for that target field.  

5. Select  to drag a field and move it to a different map location. 

6. Enable Show Unmapped option to list only those fields that are not mapped. You can then map with 
the fields (if available) in the Drag to Target to map section. 

7. Click Next. This opens the Stock Catalog Preview page. 

Note The source items identified with an asterisk * are mandatory and must be mapped in order for the CSV 
file to be properly imported. 

 

Important   If you do not map a source item but there is data in that field in the database, the data for that item 
will not be changed. 

Previewing Import Data 
After mapping the fields, the next step is to preview what will be imported. 

1. The Stock Catalog Preview page displays all of the mapped columns and the data. 

Review the records that will be imported (you can scroll both horizontally and vertically to check the 
data). Typically, especially if you set up the import file yourself, you want to check that data is being 
mapped to the correct fields. 

 
2. To start the import, click one of the following:  
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• Price Update to use the import file to update existing stock definitions. The stock definitions that 
need updating are identified by vendor name and stock number (Stock # in the Stock Definitions 
window. Both must match exactly for a stock to be updated. If a new stock is in the import file, it is 
not added to the PrintSmith Vision stock definitions.  

•  Import All to use the import file to create new stock definitions as well as update existing ones.  

3. If you selected the Verify each stock check box on the Import Settings section, for each stock, click 
Yes to save the changes made to the stock definition.  

Next, the Stock Import Results page opens. This report only displays some of the basic information 
and not all of the column data. 

 
You will be notified when the process is complete. 

4. Click Start Over if you have other imports. 

Tip  To exit the Import Stock page and continue with other functions, click the menu panel or the Menu List. 

Export Report 
The PSV_Stock Definition Export All Records.rpt report is added to the Report Manager that includes all the 
fields to import the stock and update the inventory stock. You can export the appropriate report, make changes, 
and then use the report to upload your changes.  

 
If the report is not visible in the Custom list: 

1. Navigate to Reports > Report Manager. 
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2. Click the +Add button to see a list of available custom reports. 

3. In the Add Reports to Custom window, select the report you want and click on the Add button. 
The report will be added to the custom list.  

  

To update the inventory stock and add a new stock using Import Stock 

While importing the stock definitions you can update the inventory stock and add a new stock using Import Stock 
in one go.  

1. Navigate to Pricing > Import Stock. The Import Stock Catalog window opens. 

2. In the Import by CSV file section, download the Sample CSV Template. 

3. In the SampleStockImport.csv that you have downloaded, update the value for the inventory stock in 
the Stock On Hand column.  If you want to create a new stock through stock import, leave the Product 
Id as blank. 

In the example below, Stock On Hand is updated to 250 for the stock with Product Id as 8833. Also, a 
new stock has to be added with the name 69#Label Cover. 

 
4. In the Import by CSV file section, upload the Sample CSV files. 

5. On the Import Settings section, specify the import criteria:  

• Select the Update Inventory Stock check box to update the inventory stock while importing 
the stock. This will update the Stock On Hand field in the Inventory tab of the Stock Definitions 
page. 

Note The Stock on Hand field will be updated based on the Inventory Update field value. 
6. For Import By, select Product Id to import the stock based on the Product Id. 
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7. Under Adjust Price Brackets By section, do one of the following: 

• Select Percent if you want to change the bracket price being imported by a percentage. 

• Select Amount if you want to change it by a fixed dollar amount.  

8. Select the check boxes of the price brackets (Price 1 through Price 6) you want to adjust. Click Next. 
This takes you to the Stock Catalog Mapping page. 

9. In Stock Catalog Mapping section, mapping is automatically done for any fields in the database with 
the same name as those in the CSV file. If the fields do not match, manually map by dragging the field 
to a target field. 

 
10. Click Next. This opens the Stock Catalog Preview page. 

The Stock Catalog Preview page displays all of the mapped columns and the updated inventory stock 
data. 

11. To start the import, click Import All to use the import file to create a new stock definition as well as 
update an existing one.  

For the stock with Product ID as 8833, the Inventory tab of the Stock Definition window displays the 
updated value of inventory stock. 

 
Also, the Stock Definition window has added a new stock with the name 69#Label Cover. 
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Stock Definition 
Stock is a key part of your business and an important factor in pricing jobs. Stock is typically paper but can also 
include other materials such as rigid substrates or rolls of vinyl. Through stock definitions you provide information 
about the pricing and size of the stock you use for jobs, and the equipment on which you normally use the stock. 
When you select stock for a job, the information from the stock definition is used automatically by PrintSmith 
Vision to estimate and price the job.  

If you keep paper in stock, you can track inventory and have the system automatically identify stock that needs 
re-ordering when the quantity in inventory drops below a certain level. 

Stock List Window 
You manage the information about your stocks and substrates in the Stock Definitions window. To open this 
window, click Stock Definitions in the Quick Access panel (or select Pricing > Stock Definitions.) The Stock List 
window opens first. When you select a specific stock, the Stock Definitions window opens. 

Selecting Stock Definition from the Quick Access panel will take you to the Stock List window. The Stock List 
page displays all the stock definitions alphabetically by name. You can find and select stocks in the Stock List 
window. 

 
Using the Stock List Window  

• Click the Customize List icon to control which columns to display in the Stock List window. In 
addition, you can enable or disable the status icons such as Inventory, Stock Expiry, and Price Expiry. 
The Last Used option displays the date on which an invoice containing the specific stock was picked up. 

 
• The Inventory option lets you know if the stock that is kept in inventory. This is identified 

on the Inventory tab for each individual stock. There are two colors for this icon. If the icon 
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is green, then the available status of the stock is positive. If the icon is red, then the 
available quantity is negative. This means that while the stock is an inventory stock, there 
is more stock allocated to jobs than there is stock on hand in inventory. 

• Stock Expiry is the date that the stock will expire. It is also identified on the Inventory tab. 

• Price Expiry is the date the price for the stock will expire. It is set up on the Pricing tab. 

 
• On the Stock List window, if the icon is grayed out, hovering over it will display a message related to the 

icon for the specific stock.  

 
• Sort by a different column, for example, Size or Vendor by clicking the title of the column. To reverse the 

sort order, click the column heading again.  

• Resize columns to fit more or less columns in the window. 

• Use the field in the column header to specify criteria for finding the stock you want. The list of stocks 
automatically adjusts to include just the stocks that meet the criteria you entered. For example: 

• To find stock in a particular group (for example, paper or envelopes), select it in the Group 
field.  

Note  The selected Group is saved so it remains the same each time the Stock List 
window opens.  

• To find stocks by name, enter any part of the name in the Name field: ardor in the Name field 
will list all Ardor stocks as shown in the figure below; bond in the Name field lets you find all 
bond stocks.  

• To list all stocks with a smooth finish, select Smooth in the Finish field. 

• To clear the search results, click Clear All Filters icon. 

• Use the Advanced Filter option to narrow and customize your search results to find exactly what you 
want based on the entered criteria. You can search by size, weight, CWT, price, quantity on hand, or roll 
width. Enter the information for the range of stocks you want to display and then click the Apply & 
Search button.  
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• You can also sort by Stock Method using the dropdown field. 

 
• Use the toggle buttons to view only the Inventory Stock, MDSF Registered, or MDSF Non Registered 

stock. 

• Click the three-dots ellipsis to Edit Stock, Duplicate Stock, Sync with MDSF, or Delete Stock. When you 
select Duplicate Stock, the new stock name will be as the original but with the text Copy appended to 
the stock name. You can save as is or you can edit the new stock and then save. 

 
• Select any stock to perform functions such as Sync with MDSF, Unregister with MDSF, Change Price, 

Add Charges, or Delete Stocks. 

 
Note  After sync with MDSF you will need to manually refresh the screen. 

• Click the Create Stock button to open the Stock Definition window. You must enter a stock name 
before saving the new entry. Clicking on the stock name in the Stock List window will take you to the 
Stock Definition window where you can view and edit the information about that stock. 

Stock Definition Window 
You manage the information about your stocks and substrates in the Stock Definitions window. To open this 
window, click Stock Definition in the Quick Access panel (or select Pricing > Stock Definition.) The Stock List 
window opens first, followed by the Stock Definition window. 

Note If PrintSmith Vision is integrated with Fiery, a Fiery Paper Catalog tab is available. If PrintSmith Vision is 
integrated with Market Direct StoreFront, a Web tab is available. 

General Information about a Stock 
The Stock Definitions window displays general information about the stock at the top of the window followed by 
the standard tabs – Specification, Pricing, Definitions, Inventory, and Web.  
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First enter the general information about the stock: 

1. In the Stock Definitions window, enter a description of the stock in the Name field. Limit the name to a 
description since there are separate fields for weight, color, finish, and size. 

2. In the Stock Group field, select a group for the stock, for example, Paper or Envelopes. 

3. In the Stock Method, select the type of stock you are adding: Envelope, Sheet Stock, Roll Stock, Large 
Format, or Rigid Substrate. Your selection affects the fields that are displayed on the tabs in the Stock 
Definitions window. 

4. Select the Metric option to use the metric system for measurements. When the Metric option is 
selected, the M weight and basic size fields are removed from the stock definition and the thickness 
measurement is changed to microns (one millionth of a meter). 

5. Last Updated shows the date the stock definition was last changed in any way. Last Price Change 
shows the date the last change was made that affected the pricing of the stock. Last Used shows the 
date on which the stock used in an invoice was picked up 

Specification Tab 
Some of the fields will change depending on if the Metric check box is selected and the type of stock you are 
adding.  

 
1. In the Stock Definitions window, click the Specification tab. 

2. In the Vendor field, select the vendor of the stock. If you purchase the same stock from multiple 
vendors, create a stock definition for each vendor. (Use Table Editor to maintain your vendors in the 
Vendor table.) 

3. In the Stock # field, enter the part number used to order this stock from the vendor. 

4. In the Class field use the dropdown to select the appropriate class. 

5. In the Weight field, enter the basic weight of a stock. This field is used to calculate the M Weight and 
Carton Weight of the stock (on the Specification and Pricing tab as described below). If the weight is 
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part of the stock name, ePS recommends removing it from the name and entering it only in this field. If 
you are using Metric system, then this field is labeled GSM and you would enter that information. 

6. In the Stock Type field, select a category of paper from the dropdown. For example, Business Papers 
or Book Papers. In the non-metric stocks, this information is critical because it determines the Basic 
Size that is displayed. This size is used to calculate both the M Weight and the CWT price. (Stock types 
are stored in the Basic Sizes table. Generally, you should not modify this table unless you are certain of 
the changes you are making. This table already includes all the common stock types and associated 
sizes.) 

7. For non-metric stock you will see Basic Size. It is not editable but displays the basic size based on the 
stock type selected. This field is not visible for Metric stock. 

8. In the Parent Size field, enter the size of the stock/substrate you purchased from the vendor. You can 
separate two numbers by /, for example, 17/28, and this is automatically displayed as 17 x 28. 

9. In the Roll Width field, enter the width of the entire roll you purchased from the vendor. This field is 
applicable for Roll Stock and Large Format stock methods. 

10. In the Normal Run Size field, specify the most common run size when you create a job using this stock 
definition. The number of sheets that can be cut out of the selected parent sheet is then automatically 
calculated. If you do not specify a run size, the system assumes it is the same size as the parent size. 

11. In the Stock Colors field, enter or select the color of the stock. This should be the full “mill” color. For 
example, if the mill color of white paper is Avon Brilliant, enter that in the Stock Colors field rather than 
just White. If you enter a color that is not in the Stock Colors table, you are asked whether you want to 
add it. (Use Table Editor to maintain colors in the Stock Colors table.) 

12. If necessary, select a color in the Generic Colors field. When you enter or select a color in the Stock 
Colors field, PrintSmith Vision looks for a matching generic color in the Stock Colors table. For example, 
Avon Brilliant has a generic color of White. If PrintSmith Vision does not find a generic color, it asks you 
to select one, and then updates both the Stock Colors table and the stock definition with your selection. 

13. In the Finish field, select a texture such as Linen or Laid. (Use Table Editor to maintain these finishes 
in the Stock Finish table.) 

14. In the Grade field, select the brightness of the stock such as #1 Coated, #1, #2, #3, and so on. (Use 
Table Editor to maintain grades in the Stock Grade table.) 

15. Enter the Thickness of the stock and select a unit of measurement: Caliper, Points, Mils, Thous, 
Plies, Microns, or Millimeters. Microns and millimeters are used for metric stocks while the other types 
of units are interchangeable and are used for certain types of stocks as follows: 

Name Description 

Caliper Caliper is the thickness of a paper measured in thousandths of an inch, 
traditionally applied to most printing papers which are between 0.001 
and 0.008 inch thick. 

Microns A micron is one millionth of a meter and is a unit of thickness for metric 
stocks. 

Points One point is the equivalent of 0.001 inch, traditionally used to indicate 
heavy card stock such as coated covers. For example, 12 point cover is 
0.012 inch thick (12 points x 0.001inches). 

Thous One thou is equal to 1/1000th of an inch. 

Mils One mil is equal to one thou. 

Plies Plies are traditionally used to indicate the thickness of card or chipboard. 
A sheet of 6-ply board is 0.024 inch thick. (Multiply the ply value by 3 
and add 6 to that result.) 

Millimeters A millimeter is one thousandth of a meter and is a unit of thickness for 
metric stocks. 

M weight is displayed and calculated from the basic size, parent size, and weight. 
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16. In the Coated field, select None if the stock is not coated, select 1 for stock coated on one side or 2 
for stock coated on two sides. 

17. In the Sheets/Carton field, enter the number of sheets of the parent size in a single carton. You 
can also use this field to specify the number of parent sheets in a skid.  

Note  When the Stock Type is correctly selected or the stock is a metric size, and the basis 
weight is known, the M weight can be calculated. The M weight is then used to determine 
the weight of a carton (or skid), which is displayed in the Carton Weight field. The 
formula for calculating the carton weight is: 

 
These two fields define the order information for a particular stock. The carton weight for 1,000 
sheets equals the M weight. If the carton holds only 500 sheets, the carton weight is half that 
amount. 

18. In the Roll Weight field, enter the weight of an entire roll. After you enter the minimum weight of a roll 
you will sell in the Min. Order (Weight) field, PrintSmith Vision calculates the minimum number of rolls 
this represents and displays it in the Rolls/Order field. This field is available only for Roll Stock and 
Large Format stock methods. 

19. In the Min. Order field, if stock can be ordered in any quantity, enter 1. If the stock has a 
minimum order, such as a ream that can only be ordered in sets of 500, enter this quantity. For 
example, enter 500 for a ream. This ensures that the stock order and job ticket correctly reflect the 
amount of stock to be ordered. In addition, it allows you to pass on to your customer the cost for 
ordering more stock than needed for a job. 

For example, if a job requires 200 sheets and the minimum order for the stock is 250, the customer 
is charged for purchasing 250 sheets. Although the number of sheets purchased is greater than 
needed for the job, the production charges are based on the number of sheets used in the job, not 
the full quantity purchased. 

• For the Roll Stock method, in the Min. Order (Weight) field, if stock can be ordered in any 
quantity, enter 1. Otherwise, enter the minimum weight of the roll stock that you will sell at one 
time. 

• For the Large Format stock method, in the Min. Order (Length) field, if the stock can be ordered 
in any length, enter 1. Otherwise, enter the minimum length of the stock that you will sell. 

• For the Rigid Substrate stock method, in the Min. Order field, if the substrate can be ordered in 
any length, enter 1. Otherwise, enter the minimum size in square units that you will sell at one time, 
for example, 864 for a 24 x 36 sheet. 

20. Select the Charge Customer for Entire Order check box to add the cost of the entire stock order 
to the stock charge for the job. This cost is marked up in the usual manner, but the additional 
sheets are not included in the charge for printing or copying. For example, if the minimum purchase 
is 250 sheets, the stock cost reflects this. 

21. In the Cut/100 field, enter the cut charge for each 100 parent sheets. This charge is added to the 
stock cost and is useful when the vendor charges for cutting parent sheets to the size you 
entered in the Parent Size field on the Specification tab. The cut charge includes estimated 
waste and is added to the cost of the stock after the stock is marked up. The cut charge itself is not 
marked up. 

Tip For best results, add a pre-press cutting charge to the stock definition instead of using the 
Cut/100 field; a charge more effectively calculates the number of cuts and lifts that are 
needed. 

22. In the Min Cut Chg. field, enter a minimum charge for cutting. (Use this in conjunction with the Cut/100 
field.) If no cutting charge is specified, the minimum is added to the stock for all quantities. 

23. In the Forest Management field, select the type of forest management used for this stock: FSC Mixed, 
FSC Pure, Green Seal Certified, or SFI Participant. (These selections are defined in the Stock Forest 
Management table, which you can edit with Table Editor.) 

24. In the PCW Recycled % field, enter the percentage of recycled post consumer waste in the stock. 
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25. Select the check boxes for the type of certification the stock has received: FSC Certified, SFI Certified, 
and/or Green Seal Certified. 

Tip You can set preferences to specify what kind of chain of custody information is included on 
your job tickets and invoices. 

Pricing Tab 
Use the Pricing tab in the Stock Definitions window to specify the pricing for the stock when it is used in jobs. 
Some fields on the Pricing tab apply to all types of stock; others depend on the type of stock you are adding, for 
example, sheet stock versus roll stock. The procedures that follow explain what different types of stock require. 

The Pricing tab is the same for metric and non-metric stocks. 

 
1. In the Qty Adjustment section, provide a “price table” for the stock with costs and markups for various 

quantities: 

a. In the Costing Units field, for Envelope and Sheet Stock methods, enter the quantity in which 
the stock is priced. Usually this is 1,000 since most sheet stock is priced in lots of 1,000. 
Envelopes often come 500 to a box so are priced that way.  

• For the Roll Stock method, in the Costing Units (weight) field, enter the weight by which the 
roll stock is priced, for example, 100 pounds. 

• For the Large Format and Rigid Substrate stock methods, in the Costing Units (square 
area) field, enter the square area by which you are costing. For example, 864 inches for a 
substrate that is 24 inches by 36 inches. 

b. In the # Sheets/Set field, enter the number of sheets that make up a “set” of the stock. 

For example, if you have a 3-part carbonless stock, enter 3 in this field. The system can then 
automatically make the correct calculations based on the number of sheets in a set. 

c. Select the Costing in Sets check box to indicate that the cost entered is for sets, not individual 
sheets. The setting of this check box automatically changes the cost of the stock.  

For example, a 2- part carbonless set is priced at $200.00 per 1000 sets when the Cost is in Sets 
check box is selected. If the check box is cleared, the price changes to $100.00, because the 
price is now based on half as many sheets. The pricing for the stock is handled correctly 
regardless of the setting you choose. ePS recommends setting it to match the way each of your 
vendors specifies the stock. 

d. In the Price Expires field, enter an expiration date for the price, if necessary. This information 
may be automatically provided when you import stock prices from a stock vendor. The date tells 
you whether the price shown in the stock definition is valid. If the price has expired, you receive a 
warning message that the price has expired, but you can still use the stock. 

e. In the Qty Breaks column in the table, enter the maximum quantity of parent sheets for 
each row in the price table. For example, if you enter 1000, 5000, and 10000 in the first 
three rows, the first row is used for the stock cost and markup for quantities up to and 
including 1000. The second row is used for quantities from 1001 to 5000. The third column is 
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used for quantities greater than 5000. If a row does not include a quantity, the system 
assumes you are not using that column. 

• For the Roll Stock method, enter maximum weights for costing and markup purposes.  

• For the Large Format stock method, enter the maximum areas of the large format stock for 
costing and markup purposes. PrintSmith Vision uses this information for the stock cost and 
markup for areas up to and including the area you specify in each row. 

f. In the Cost column, enter your costs for a particular quantity in the Qty Breaks column, 
taking into account the Costing Units you specified. 

g. In the CWT (Hundred Weight Price) column, enter the cost for 100 pounds of paper 
regardless of size. CWT pricing is a convenient way to compare paper prices for different 
stocks in different sizes. Although there is some variation within a given stock family for 
different size stocks, the CWT price is generally similar. You can enter a cost in either a 
CWT field or a Cost field, and the other field is calculated provided there is sufficient 
information available in the stock definition to make the calculation. (In order to calculate 
the CWT price, the Basic Size and Weight must be entered and be correct. The Basic 
Size is controlled by the Stock Type you selected.) 

h. In the Markup column, enter the amount to mark up the stock above your cost. If the 
markup in the first row is not overridden (overrides are shown in underlined italic), this is the 
standard stock markup defined in your Stocks and Sizes preferences. 

Normally, you do not need to alter the standard stock markup in the first row. Only change it if 
you want a particular stock to be marked up differently from the standard stock markup you 
specified in your Stocks and Sizes preferences. Enter a markup rate in row 2 through 6 
when the markup you want to use is different from that in the first row. Leave the markup 
fields empty across the columns unless the rates in row 2 through 6 are different from the 
first. 

Note If you change the standard stock markup in your Stocks and Sizes preferences, you 
will change the markup for all stock definitions except those which you overrode. 

i. In the List/M column, enter an additional price per thousand sheets to use with the list job 
pricing method because list pricing does not factor in the stock cost when generating a 
price. The amount (plus or minus) entered in this field is divided by 1000 and multiplied by 
the quantity ordered and added to the price of the job.  

For example, a price schedule is used for a stock that costs $10.00 per thousand. You want 
to use it for a stock that costs $11.00 per thousand. If you enter 1.00 in the List/M field, 
$1.00 is added to each thousand ordered. 

2. In the Pricing for Blank Sheets section: 

a. Blank sheet pricing is used for jobs based on the Blank method. The pricing is automatically 
calculated and is based on the blank stock markup in your Stocks and Sizes preferences 
and the cost of the stock as specified in the Cost column. If necessary, change these prices 
and/or the quantities. 

b. Select the Auto Calculate Blank Stock check box to ensure that blank stock pricing is 
automatically updated if costs change. If you do not want prices calculated automatically, 
clear this check box. 

Note  ePS recommends that you select the Auto Calculate Blank Stock check box unless 
you have very specific pricing targets for blank stock that do not depend on the stock 
cost. 

3. In the Comments section, enter any other notes about the stock. 

Definitions Tab 
The Definitions tab is the same for both metric and non-metric stocks. 
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1. In the Select Press field, select the press you want to use with the stock. If you do not want a 

preset press for the stock, select <use default press>. 

When you select a stock for a job, and the stock has a preset press, the press is assigned to the 
job, along with any charges that are part of the press definition. If you select a stock definition 
without a preset press, the default press definition is used for the job. 

Note PrintSmith Vision is designed so that you can use press definitions to define your 
production environments. If you know a stock is always used in a particular production 
environment, you can create a press definition and preset the press for each stock 
definition to which it applies. Envelopes are a good example of stock that requires a 
particular production environment. 

2. In the Select Schedule field, select the list price schedule you want to use for the stock. List price 
schedules apply only to jobs based on the List method. You create the schedules using Pricing > 
List Price Schedule.  

3. In the Adjust Digital Matrix & Select Default section: 

a. In the B&W field, enter the amount to add to the digital matrix price of the selected stock 
if the Stock Price is field in the Digital Definitions window is set to from Copier 1 in Stock 
Definition. To preset a B&W digital definition for the stock, select it instead of <use 
default digital>. 

b. In the Default Color field, enter the amount to add to the digital matrix price of the 
selected stock if the Stock Price is field in the Digital Definitions window is set to from 
Copier 2 in Stock Definition. To preset a color digital definition for the stock, select it 
instead of <use default digital>. 

c. In the Large Format field, enter the amount to add to the square area of the digital 
matrix unit price for the selected stock if the Stock Price is field in the Digital Definitions 
window is set to from Copier 3 in Stock Definition. To preset a large format digital 
definition for the stock, select it instead of <use default digital>. 

Note When a stock with a preset digital definition is selected for a job, this digital definition 
is used for the job, along with any charges that are attached to the digital definition. 

To remove a preset digital definition, select <use default digital>. 

Inventory Tab 
Use the Inventory tab in the Stock Definitions window to track stock inventory. You can track inventory for any 
type of stock. When you first start using PrintSmith Vision, you may need to enter initial inventory information, but 
after that, the inventory is tracked automatically and the contents of fields such as Stock on Hand, On Order, and 
Committed are automatically updated. In addition, once some history exists for the stock, the inventory 
transactions (starting with the most recent) are listed under Inventory History.  

The Inventory tab is the same for both metric and non-metric stocks. 
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1. Select the Stock is Standard Inventory Item check box to activate the fields on the Inventory 

tab. 

2. In the Stock on Hand field, enter the amount of stock that is currently in inventory. 

For large format stock, this is the linear length, not the total area. 

3. If some stock is already committed to current jobs, enter the amount in the Committed field. 
Normally, committed stock is automatically calculated. As stock is selected and assigned to a job, 
the number in the Committed field increases. 

Note Stock that was selected for a job before the stock was defined as a standard inventory 
item is not included in the committed inventory count. 

 As the system tracks committed stock, it shows the difference between what is on hand 
and what is committed in the Available field. You cannot edit this field. You can also see 
inventory activity under Inventory History. 

4. If you are just starting out, in the On Order field, enter the amount of stock that is currently 
ordered. After that, as you record your orders with PrintSmith Vision with Reports > Order Stock, 
the amount is entered for you automatically. For more information, see Order Stock. 

5. In the Target Level field, enter the amount of stock you always want to keep in inventory. 

6. In the Reorder Point field, enter the “trigger-point” at which new stock should be ordered. 

7. In the Min. Order Qty. field, enter the minimum amount that can be ordered at one time. If the 
amount that is ordered should always be in even quantities, select the Even increments, like 
ream size check box. 

8. In the Stock Expires field, enter the expiration date of the stock, i f applicable. When the field is 
blank, the stock never expires. 

9. If applicable, in the Bin Location field, enter an identifier for the place where the stock is stored. 

10. If the stock is a shell item (for example, business card masters that are imprinted at a later date), 
select the Shell Item check box. 

Large-Format inventory stock calculation based on Linear Length  
For Large-Format stock definitions, the inventory stock calculation is based on the linear length of the stock, not 
the total square area. Inventory of Roll stock is measured based on the linear length. Length can be in any unit of 
measurement such as inches, meter, feet, and so on. The value that is entered in the Stock on Hand field is the 
length of large-format stock that is currently in inventory. 
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Note that the inventory stock calculation for large-format and signage jobs is based on the length. So, the 
consumption of inventory stock for large-format stocks is also calculated on the linear length of the stock. The 
Committed value for the inventory stock used in a job is calculated as the Cutoff length multiplied by Total Copy 
plus Wastage. 

Fiery Paper Catalog Tab 
In addition to the automatic media mapping that the system performs when you add a Fiery device, individual 
stocks in PrintSmith can be mapped to a media in the paper catalog on a particular Fiery device. If you have 
multiple Fiery devices, you can quickly map the same stock to more than one Fiery device. 

The Fiery Paper Catalog tab is the same for both metric and non-metric stocks. 

 
1. In the Stock List window, select the stock you want to map to media in a Fiery catalog. 

2. Click the Fiery Paper Catalog tab. 

3. In the Fiery Devices field, select the Fiery device on which you plan to use this stock. (This is the 
physical equipment as defined in the Production Copiers table in PrintSmith Vis ion.) 

4. In the Paper Catalog section, select the media to which you want to map the PrintSmith Vision 
stock. 

The stock name will show next to the Fiery Devices field and you can also hover over the mapped 
item area and the mapped stock will be displayed. 

Note You can use all of the column headers to filter the list of displayed items. 
5. If you have multiple Fiery devices, repeat steps 3 and 4 to map the current stock definition to a 

stock in the paper catalog on a different Fiery device. (You can have different mappings on 
different devices.) 

6. Click Save on the toolbar of the Stock Definitions window. 

7. To remove the mapping from the selected Fiery device, click the Remove Mapping button to the 
left of the fiery device that also shows the mapped material. 

8. If you have mapped to multiple Fiery devices and want to remove the mapping from all of the 
devices use the Remove All Mapping button on the right of the window. 

Tip Always click Synchronize Media after you make a change in PrintSmith Vision that may 
affect mapping. 

The Show All button is turned off by default. When it is off only the unmapped stocks will be 
displayed. If you enable it, all stocks for that device will be displayed, which can then be mapped 
or unmapped. 

Web Tab 
The Web tab is available if PrintSmith Vision is integrated with MarketDirect StoreFront. 
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Registering Stocks in Market Direct StoreFront 

You can fully control the stocks that are available to buyers when they are placing orders in Market Direct 
StoreFront. You should always define stocks in PrintSmith Vision and send information about them to Market 
Direct StoreFront. As with accounts and contacts, this process is known as registering stocks. In Market Direct 
StoreFront, stocks are known as media. 

Note Market Direct StoreFront comes with some pre-defined media. Typically, you should delete the 
media before registering the stocks from PrintSmith Vision so the only media in Market Direct 
StoreFront are mapped to stocks in PrintSmith Vision. 

The registered stocks must then be priced in Market Direct StoreFront – which always controls the pricing. (You 
should still price stocks in PrintSmith for non-Market Direct StoreFront orders, but this pricing is ignored for 
Market Direct StoreFront orders.) 

With the exception of pricing, information about stocks is always controlled from PrintSmith Vision – the 
information is sent from PrintSmith Vision to Market Direct StoreFront. Information about stocks (known as media 
in Market Direct StoreFront) is never sent from Market Direct StoreFront to PrintSmith Vision. For example, if you 
create media in Market Direct StoreFront, no corresponding stock is created in PrintSmith Vision. Likewise, if you 
update media in Market Direct StoreFront, the corresponding stock definition is not updated in PrintSmith Vision. 
As a result, avoid creating or updating media in Market Direct StoreFront. 

When stocks are registered, PrintSmith Vision sends the name, size, and color of the stock to Market Direct 
StoreFront. 

When a Market Direct StoreFront order comes into PrintSmith Vision and includes a registered stock, the stock is 
“recognized.” For example, costing information is available. In addition, with the exception of stock for special 
pages, if the stock is inventoried, inventory is adjusted. 

You can register (send) stocks in two ways:  

• Register multiple stocks at the same time.  

• Register stocks individually. 

Important  For stock to be registered in Market Direct StoreFront, the stock definition must include a 
Color, Weight, Thickness and a Normal Run Size in the Specification tab of the Stock 
Definitions window. 

Method 1: Register multiple stocks at a time 
You can register multiple stocks at a time from the Stock List window. 

1. In PrintSmith Vision, click Stock Definition in the Quick Access panel (or select Pricing > Stock 
Definition). 

2. Select the check boxes of the stocks you want to register. 

If you select a stock that has missing information in the required field, an orange exclamation point will 
appear indicating that the required information is missing. Edit the stock to include the missing 
information. (You cannot register the stock without this.) 

 
When you click Sync with MDSF for such a stock, the following error message is displayed.  
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Important  When you are using Metric stock and enter the weight in the Specification tab, you enter 
it as gsm and the weight will be shown as gsm in the Web tab. But if you are not using 
Metric and you enter the weight in the Specification tab as pounds, it will not display as 
pounds in the Web tab. You have to manually enter the weight for non- metric stock on 
the Web tab. That field accepts both gsm and pounds. 

3. Click the Sync with MDSF button. 

 
A message indicates that the registration has started. 

 
A new icon also indicates that the registration is in process. 

 
After the stocks are registered, a green check mark is displayed in the MDSF column in the Stock List 
window and the Registered icon is displayed. 

 
4. In Market Direct StoreFront, the stocks are now listed in the Media Catalog. Price the media in 

Market Direct StoreFront and add it to ticket templates. 

Note Very occasionally a stock may not be registered (perhaps due to a network issue).  
Method 2: Register one stock at a time 
You can also register stocks as media in Market Direct StoreFront one at a time from the Stock List window or 
the Stock Definition window. 

1. In PrintSmith Vision, click Stock Definition in the Quick Access panel (or select Pricing > Stock 
Definition). 

2. In the Stock List window, do one of the following: 

• To register a stock from the Stock List window, click the three-dot ellipsis for the stock that you 
want to register in Market Direct StoreFront, and then select Sync with MDSF. 

  
• To register a stock from the Stock Definition window, find and select the stock that you want to 

register in Market Direct StoreFront, and click that stock. The Stock Definition window for that 
stock opens. 

a. In the Stock Definitions window, click the Web tab. 

b. Click Register Stock. 
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A message informs that the registration has started. After the stock is registered, the Last 
Registration Date is updated and the Register Stock button changes to Update Stock. 

 
c. In Market Direct StoreFront, the stock is now listed in the media catalog. Price the media 

in Market Direct StoreFront and add it to ticket templates.  

Note  Very occasionally a stock may not be registered (perhaps due to a network issue).  
Price media and add to ticket templates 
After you register stocks as media in Market Direct StoreFront, they are listed in the Market Direct StoreFront 
media catalog. (PrintSmith Vision sends the name of the stock, its size, and its color to Market Direct 
StoreFront.) 

Note If you did not delete the pre-supplied media in Market Direct StoreFront, you can recognize your 
registered stocks in the Market Direct StoreFront media catalog by their ID – they will all have an ID 
numbered in the hundred thousands, for example, 100009 or 100014. 

You must now price the media in Market Direct StoreFront and add media to ticket templates. 

The price you set for the media is what buyers pay, and this price overrides the price of the associated stock 
defined in PrintSmith Vision. 

In Market Direct StoreFront, the recommended way to price media is by editing a price sheet (although you can 
price media individually). Go to Administration > Pricing, open a price sheet, select Media in the View By field, 
and then edit a group of related media to add prices. For information about price sheets in Market Direct 
StoreFront, see the online Help in Market Direct StoreFront when on the Administration tab. 

Tip  Click  to open Help in Market Direct StoreFront.  
After the media is priced, you can add the selected media to the ticket templates. When a ticket template is 
associated with a product in Market Direct StoreFront, buyers ordering that product will be able to choose the 
media specified in the ticket template. For information about creating ticket templates and products, see the 
online Help in Market Direct StoreFront when on the Administration tab. 

Updating Stocks 

If you change some information about a stock in PrintSmith Vision, you can update the corresponding media in 
Market Direct StoreFront. 

Important   With the exception of pricing, never edit mapped media in Market Direct StoreFront 
because that information is not sent to PrintSmith Vision. Stocks must always be 
managed from PrintSmith Vision. 

1. After you make changes to a stock in PrintSmith Vision, click the Web tab in the Stock Definitions 
window. 

2. Under MDSF Info, click Update Stock. 
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Unregistering Stocks 

If you want to delete a particular media in Market Direct StoreFront, you must unregister the stock definition in 
PrintSmith Vision. The stock definition will still exist in PrintSmith Vision, but the corresponding media will be 
deleted in Market Direct StoreFront. 

When you unregister stock, it is no longer available as a selection to buyers placing orders in Market Direct 
StoreFront. 

Important   Never delete a mapped media in Market Direct StoreFront (one that you registered from 
PrintSmith Vision) because that information is not sent to PrintSmith Vision. Media (meaning 
stocks) must always be unregistered in PrintSmith Vision, so they are deleted in Market Direct 
StoreFront. 

You can unregister stocks either from the Stock List window or the Stock Definitions window. 

To unregister stocks from the Stock List window 
1. In PrintSmith Vision, click Stock Definitions in the Quick Access panel. 

2. In the Stock List window, select the check boxes of registered stocks (ones with green icon next to the 
stock. 

3. Click Unregister with MDSF. 

 

To unregister a stock from the Stock Definitions window 
1. In PrintSmith Vision, click Stock Definitions in the Quick Access panel. 

2. From the Stock List window, open the registered stock definition you want to unregister. (These stock 
definitions have a green icon next to the stock). 

3. In the Stock Definitions window, click the Web tab. 

4. Under MDSF Info, click Unregister Stock. 
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Charge Definitions 
Charge definitions are a key part of the pricing system. A charge can be defined for any activity that takes place 
before printing (for example, design, platemaking, or proofs) or after printing (for example, cutting, folding, 
padding, or mailing). Anything that makes up the jobs you sell and that is not part of the production printing 
process can have a charge associated with it. 

Charges in PrintSmith Vision are organized into groups known as commands. Within a command, charges are 
further grouped by categories. 

Charge Definitions Window 
You can manage all the charges in the Charge Definitions window. To open this window, click Charge 
Definitions in the Quick Access panel or select Pricing > Charge Definitions. The Charge Definitions  window 
will open. You can expand and collapse the contents of the pane by clicking the arrows to the left of the 
commands and categories.  

 
• PrintSmith Vision includes five named charge commands: Pre-Press, Bindery, Markups/Discounts, 

Mailing Services, and Large Format Finishing. You can rename these to better describe your 
business. Another five “empty” commands are available for your use as your business requires. You can 
place any charge definition under any of the pre-supplied commands, but ePS recommends you 
group them as follows: 

• Pre-Press. For any charges related to preparing a job for production. For example, preflight, plates, 
typesetting, design, and proofs. 

• Bindery. For any charges associated with finishing a job, such as post press cutting, folding, 
scoring, drilling, stitching, padding, gathering, book assembly, packaging, and so on. 

• Markups/Discounts. For any charge that reflects a markup or discount. For example, a rush 
charge or 15% price adjustment. 

• Mailing Services. For charges related to mailing the final products. 

• Large Format Finishing. For charges related to large format work. For example, lamination, 
grommets, and so on. 

• Commands, Categories, and Charges are listed in the Charge Definitions window. You can expand and 
collapse the contents of the pane by clicking the arrow next to the Command. 

• You can rename any charge command. If you want to use one of the “EMPTY” commands, you should 
first rename it so the name identifies the type of charges it will contain. To rename, hover over the 
charge and click the edit icon. Then enter a name and press the tab key to save the name. 
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• When setting up your category headers, make it as easy as possible to locate the charges they 

contain. For example, list the categories in the same order as you perform the associated activities (so 
the category list serves as a checklist), alphabetize the category list, or place frequently used 
categories at the top of the list so they are faster to select. The organization is up to you. You can 
change the order by dragging the category icon and dropping it at the desired location. 

 
Also try to avoid having too many categories that contain only one or two charges. Instead, consolidate 
similar charges in one category. 

• You can also create and edit charges. 

Creating a Charge  
Each charge is based on a particular method which is designed to handle certain types of pricing situations. 
PrintSmith Vision includes several charge methods. 

1. In the Charge Definitions window, select the category where you want to add the charge or select a 
charge in that category. 

2. Click the three dots ellipsis and then Create Charge. A row is added for the new charge. Click 
<untitled> to add the new charge. The Edit Charge Definition window opens. 

        
3. In the Edit Charge Definition window, complete the following: 

• In the Charge field, enter a name for the new charge. The name should make it clear to your 
estimators what the charge does, for example, Preflight, Computer Time, or Paper Plates. 

• In the Sales Category field, select the category where the dollars associated with the charge 
should go, for example, Prepress.  

• In the Production Location field, select the location where the charge applies, for example, for a 
prepress charge, you may want to select Prepress. (Use Table Editor to maintain these locations in 
the Production Locations table.)  

• In the Production Code field, select the type of product you are creating. (Use Table Editor to 
maintain product codes in the Products table.) 
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• Select a Cost Center field for the charge if you are using PrintSmith Scheduler. For information 
about creating cost centers, see the PrintSmith Vision Scheduler User Guide. If you are not using 
Scheduler, this field will remain blank. 

4. To specify the pricing and other charge settings, use the Pricing tab. 

5. To use a price list with the charge, use the Price List tab.  

6. To add a waste chart to the charge to account for run-time spoilage, use the Waste Chart tab.  

7. To specify your costs for charges, use the Costing tab. 

8. Click Save to save the charge definition. 

 

Pricing Tab 
1. In the Method field of the Pricing tab, select the pricing method you want to use. This is a key part of a 

Charge Definition. 

 

Method Description 

Job Aware Select if you want the price calculated automatically based on job 
quantities and specifications. (This is the most commonly used pricing 
method.) 

Markup Select to mark up (or discount) all or part of a job or an entire invoice by a 
specific factor. 

Flat Rate Select to add a fixed amount to a job. For example, $5 for delivery. 
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Always Ask Select if the quantity is not known ahead of time and the estimator has to 
provide it. (You can, however, preset a common quantity to make data 
entry easier.) 

Price List Select if you want a price looked up in a table based on the specified 
quantity. (A price list must be created and attached to the charge.) 

Rate List Select if you want a unit rate looked up in a table based on the specified 
quantity. This rate is then multiplied by the quantity to generate the 
price. (A rate list must be created and attached to the charge.) 

Cutting 
Charge 

Select for prepress and finishing cut charges. 

Ink Charge Select to calculate the ink price based on the percentage of coverage. 
Shipping 

Charge 
Select to charge for deliveries based on the weight of a job. Fold Select to 
calculate pricing for folding and include a graphic of a fold style. 

Linear Select to calculate pricing based on the linear edge (perimeter) of a sheet. 
Estimators can select which edge(s) they want to use when they add the 
charge. 

Square Area Select to calculate pricing based on the square area of the run or finish 
size (100% coverage is assumed). 

2. In the Quantity field, select the type of quantity that applies to the pricing method you selected. 

The Quantity field in the Charge Definitions window has several possible settings. Not all of the 
selections are available with each charge pricing method. A change to the setting of the Quantity field 
affects how quantities are entered when the charge is used but does not directly change the price.  

After you select an option from the Quantity field, you have to enter the corresponding values in 
the Preset Info section. 

 

Quantity Description 

Quantity This is the most common selection in the Quantity field and is appropriate 
for many kinds of charges except for markup and flat rate charges, or 
charges that are time-based such as consulting or design. The quantity 
that you enter when you add the charge is multiplied by the rate specified 
in the charge definition. (For job aware charges, the quantity is calculated 
automatically so you do not enter it.) 

Time This is useful for charges where the price is based on hourly rates. Time 
requires estimators to enter a start and stop time when they use the 
charge. 
If you enter both a start and stop time, the “quantity” is the difference 
between the two. If you enter only one time,  PrintSmith Vision assumes 
this is the total time. The quantity displayed for the job is always in “clock” 
hours. 

None This is used for flat rate charges or for always ask charges where quantity 
is irrelevant. 

Number of 
Sets 

This is used when you need estimators to provide a multiplier, for 
example, the number of cuts. 

No of Sets 
and Setup 

This is identical to Number of Sets, except that the setup charge is added 
to each set (not once as for Number of Sets). 
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3. In the Pricing Type field, a charge can be based either on Cost Plus pricing (you mark up your costs) 
or Piece Pricing (you specify the rate you want to charge): 

  
• Cost Plus - Select Cost Plus and specify your costs in the Costing tab. Then in the Markup field of 

the Pricing tab, enter the markup percentage that you want to add to the calculated costs.  

 
Cost Plus pricing is based on the actual costs to purchase, set up, and maintain the charge, as 
defined in the Costing tab for the charge. When you select Cost Plus, you define a Markup 
percentage that “floats” with the costs. For example, if you enter 1.2 in the Markup field, the unit 
price is calculated by marking up your costs by 20%. If your costs change, the markup is 
automatically applied to the new costs, so you continue to make a profit. The amount in the Sale 
Price per Unit  field includes the markup. (Cost Plus is not available for markup charges.) 

• Piece Pricing - Select Piece Pricing and optionally specify your costs so you can determine what 
your piece rate should be. Then, select the Rate option, and enter your rate. (Costs for piece 
pricing are not required but help you price accurately.) 

Unlike in Cost Plus pricing where the price is automatically calculated according to your costs and 
markup percentage, in Piece Pricing, you must define your own rates. Several settings affect 
piece pricing. If an option is selected, its corresponding field is used for pricing. Rate is always 
needed for piece pricing except when a price list or rate list is used. 

 
Use the Piece Pricing fields as follows:  

• Enable the Set up option to add a setup charge to the standard price. As a result, the basic 
pricing formula is modified to (quantity x rate) + setup = price.  

• Enable the Rate option and enter the rate. When the rate is for a quantity other than 1, you 
must specify the unit quantity. To enter a rate such as 12.00 per thousand, enter 12 in the 
Rate field and 1000 in the Rate In Sets field.  

• Enable the Material option if you need more than one rate to price an item correctly. Normally, 
this would only occur in a job aware charge where two different Material In Sets are needed. 
Otherwise, you should simply add the rates together and enter them in the Rate field.  

Note  Always use Material in conjunction with Rate. If there is only one rate, it should 
always be Rate. Never use Material instead of Rate. 

• Adjustable sets - If you select the Adjustable sets option, estimators can change the set size 
when they use the charge. This option should be cleared most of the time. 



Charge Definitions | User Guide • 205 

 

 

• Adjustable rate - If you select the Adjustable rate option, estimators can change the rate 
when they use the charge. 

• Adjustable material - You would rarely select the Adjustable material because a material 
rate is very unusual. Like Adjustable rate, it allows estimators to change the material rate when 
they use the charge. (You should only specify a material rate in the unusual case where you 
need more than one rate and more than one quantity.) 

Select values in job to be used in calculating price 
In this section of the Pricing tab, for some types of charges you can choose one or more (or none) additional 
factors in the job to be considered in determining the charge. 

 
• Select either Ordered (for ordered quantity in job) or Press quantities (for sheets running through the 

printer), or neither (N/A).  

• Multiply by Colors or Sides, or neither (N/A).  

• Multiply by Sheets (number of originals or versions specified in the job) or Signatures (the number of 
different run sheets or sheets/up), or neither (N/A).  

• Select x Up to multiply by the number of sheets (up) produced from the run size, / Up to divide by the 
number of sheets (up) produced from the run size, or neither (N/A).  

Adjustable Up: The Adjustable Up option is available when you use multiply or divide up to calculate any charge 
that is automatically calculated. If you select the Adjustable Up option, you can change the number up within the 
job itself if necessary. 

Selecting Other Charge Settings in Pricing Tab 
Many additional settings are available in the Charge Definitions window for handling special circumstances and 
enforcing how a particular charge is used. Use this section as a reference to those settings. 

 
• No overrides - If you select the No overrides option in the Charge Definitions window, nobody can 

override the quantity or price in the charge. A change to the quantity is treated as an override in job 
aware charges because PrintSmith Vision generates the quantity automatically. 

• Do not discount - If you select the Do not discount option, charges (for example, postage or shipping) 
are not affected by customer and charge discounts.  

• Excluded from workflow - If you use Tracker or Scheduler, select the Excluded from workflow option 
in the Charge Definitions window if the charge (for example, postage or boxes) does not require labor 
and is therefore not a step in the production workflow. The charge is then not displayed in Tracker and 
is not scheduled. 

• Tracker Pre-Production - If you use Tracker, select the Tracker Pre-Production option in the Charge 
Definitions window to indicate that the work associated with the charge (for example, design) takes 
place before the job is released to production 

• Hide price only - If you select the Hide price only option in the Charge Definitions window, the price is 
hidden in the invoice, but the charge description is still shown. This is different from the Hide charge in 
printouts. 

• Hide charge in printouts - Not all charges need to be included in the printed invoice or estimate. To 
exclude a charge from printed documents, select the Hide charge in printouts option in the Charge 
Definitions window.  
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• Bindery Operation - This option applies only to cutting charges where more than one original is 
typically processed (cut) at the same time. Select this option to provide more accurate pricing when the 
number ordered is less than the set size, and there are multiple originals. 

• Ignore global price changes - This option is for excluding a charge from global pricing updates which 
is an option in the Press Definition windows. 

• Do not allow purchase order - This option is for preventing a purchase order from being raised for the 
charge. For example, unless the charge is for something like ink that you might purchase from a 
supplier or for something like design work that you always outsource, you would select the Do not allow 
purchase order option. In this case, when the charge is added to a job, you will be unable to raise a 
purchase order for it. 

• Finished - This option is used if pricing for the charge is incomplete. In this case, ? is displayed in the 
Total column in the document window for the charge.  

• Taxable - Each line item on a document can be marked as taxable or nontaxable. Select this option to 
pre-set the tax status of the charge. This option should be cleared only for those charges that are never 
taxed.  

• Brokered - Select this option to identify a charge that is sent out for production. In this case, B is 
displayed in the Total column in the document window. (The B is never printed on documents, 
however.) 

• Display Quantity - Select this option to include the quantity on the invoice. 

• Hidden - Select this option to hide the charge in the printed document. 

• Fixed Spoilage - The amount in the Fixed Spoilage field represents the amount of waste you expect to 
generate during setup for  the finishing process. (This field is not available for all types of charges.) You 
can also use waste charts to calculate run-time spoilage.  

• Min Charge - A minimum charge guarantees that the price generated for the charge is never below the 
minimum entered in  this field. 

• Min Time - In charges where the Quantity field is set to Time, you can also use Min Time to set the 
shortest possible time allowed. For example, you may want to charge for at least 15 minutes of 
computer time. 

Defining Preset Info in Pricing Tab 
Each charge definition has some preset information. For example, PrintSmith Vision includes a set of generic 
labels for each field where estimators enter information when adding the charge to a job, for example, quantity. 
Because these labels are generic, they may not match the terminology that your staff uses.  

 

1. In the Charge Definitions window, click the up-arrow at the bottom of the window. The Preset 
Info section opens. 

2. If necessary, in the Description field, change the description of the charge. (This defaults to the name 
of the charge.) If you change the description, the name of the charge is unaffected.  

3. In the Notes field, enter additional notes about the charge. For example, instructions on how to use the 
charge, or information for the production staff.  

4. Select the Show option if you want the contents of the Notes field added to the description in the 
document. Clear this option if the Notes field has information intended for production personnel (and is 
therefore not intended for customers).  
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5. If a charge typically has a common quantity, enter it in the Quantity field so that estimators do not need 
to enter it. A preset quantity does not, however, prevent an estimator from entering a different quantity.  

6. If you are using line-item taxation, the Preset Info section includes a Tax Table field. Either leave this 
set to Use Parent Tax Table or select the tax table you want to associate with the charge. 

7. Change the labels of any fields listed in the bottom part of the window. These are the fields users see 
when adding charges to jobs.  

8. Changes you make to preset information are not permanent until you click Save in the Charge 
Definitions window. 

Price List Tab  
In a price list, the system looks up a quantity to obtain the total price for that quantity. For example, the price for a 
quantity of 50 might be $10 and for a quantity of 100 might be $18. 

In a rate list, the system looks up a unit price and multiplies it by the quantity to derive the price. For example, the 
unit price for a quantity of 1 to 50 might be .10, but for a quantity of 51 to 100 might be .08. The quantity in the 
job is used to obtain the unit price which is then multiplied by the quantity. 

Charges based on the price list or rate list pricing methods require a price or rate list, but you can add a price or 
rate list to any charge, even if the pricing method does not require one. 

In the Charge Definitions window, you use the Price List tab to create, delete, and assign price or rate lists. A 
price or rate list can be shared by any number of charges.  

Creating price and rate lists  
Although you can create a price or rate list for a specific charge definition, you can associate the same list with 
several charge definitions. If you are creating a price or rate list for a single charge, ePS recommends that you 
use the name of the charge as the name of the list. Also, avoid having lists with the same name because this 
makes it very difficult to figure out which price or rate list to select for a charge.  

 
You can copy an existing price list and then modify it. The procedure for creating a price list and a rate list is very 
similar. 

1. Click the Price List tab in the Charge Definitions window.  

2. In the Price List tab, click the Add New icon to the right of the window. 

3. In the Title field, enter a name for the price list, for example, Hooks or Suction Cups. If the price list is 
for a specific charge, ePS recommends that you use the same name as the charge. 
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4. Select Currency in the Amount is field if you want to enter a price for each quantity in the price list; 
select Percentage if you want to enter a percentage for each quantity. The Percentage option is 
typically used for setting up a markup or discount table. 

5. Select the Interpolate option if you want intermediate prices calculated for quantities that fall between 
the quantity breakpoints in your price list. For example, if the price for 500 is $50 and the price for 1,000 
is $45, the interpolated price for 750 would be $47.50. Without interpolation it would be $50. 

6. Select the Use as Rate List option if you want the table as a rate list. 

7. To exclude a price list from being updated when you update price lists globally, select the Ignore 
Global Price changes option.  

8. To ensure that items over a certain quantity have a price associated with them, select the Last line is 
additional qty option and then enter this quantity and price in the last line (shaded). Otherwise, 
quantities greater than your final quantity will be free. 

9. Enter the quantities and prices/rates (or percentages) in the Quantity and Price/Rate columns: 

• Enter at least two different quantity and price/rate combinations. Enter the quantities 
sequentially so the smallest quantity is first in the list. As the quantity increases, the price/unit 
rate amount typically decreases. 

• If you selected the Last line is additional qty option, be sure to enter a price in the last line of 
the table. Otherwise, quantities greater than your final quantity will be free. 

• To add more rows to the price/rate list, click Add new element icon on the left. 

• To remove a row from the price/rate list, click the Delete icon at the end of the row. 

10. Click Save Price Table. The price list is automatically assigned to the current charge definition. 

Waste Chart Tab 
As part of an accurate estimating process, you need to estimate waste and spoilage. If you generate a fixed 
amount of waste during the setup associated with a bindery charge, you can specify it in the Fixed Spoilage 
field in the Main tab of the Charge Definitions window. (This field is not available for all types of charges.) You 
can also define waste charts for runtime spoilage and assign them to charges. Different types of charges may 
have different spoilage characteristics so you may need several waste charts, although different charges can 
share the same waste chart. 

You can create as many waste charts as you like, but you can assign the same waste chart to more than one 
charge definition. You manage waste charts and assign them to charge definitions. Once a waste chart is 
assigned to a charge definition, the name of the waste chart is displayed in the Select Waste Chart Field of the 
Waste Chart tab. 

For more details about creating a waste chart, see the “Waste Chart Tab” section in Press Definitions. 

Costing Tab 
Costing is the process of identifying your costs associated with a charge. For example, setup, material, labor, 
and so on. Only by understanding your costs can you price charges accurately and do so in a way that gives you 
a profit margin. 
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1. In the Charge Definitions window, click a charge definition. 

2. In the Edit Charge Definitions window, click the Costing tab. 

3. In the Costing Method field, select No Cost, 100% Cost, Unit Cost, or Time and Materials. Different 
fields and buttons become available depending on your selection. 

• Use No Cost for a markup charge such as a shop minimum where you have no costs. No further 
information is required. 

• Use 100% Cost for a charge such as postage for which you need to pass on the full cost. No 
further information is required. 

• Use Unit Cost if there is no internal labor associated with the item. There may be a setup cost with 
an outside vendor. For example, if you send out work for laminating or die cutting. You can either 
specify a unit cost or define a rate list, so the cost varies according to quantity. 

• Time and Materials is the most common costing method since many charges involve both material 
and time costs (labor). 

Notes  Always click Preset Info after you select Number of Sets in the Quantity field to check 
that the default quantity is 1 (or the most commonly used quantity). This ensures that a 
price is generated when the charge is first selected. If the quantity is set to 0, no price is 
generated until a quantity is entered. 

 Costing is not required for piece pricing (although it is highly recommended) but is 
required for cost plus pricing. In cost plus pricing, you provide the markup you want to 
apply to your costs, and PrintSmith Vision calculates the price automatically. 

4. Complete the fields in the Costing tab as described for the different costing methods and then click 
Save on the Edit Charge Definitions window. 

To specify a straight unit cost 
1. If a setup cost is associated with the charge, in the Costing tab, select Unit Cost in the Costing 

Method field. 

2. Enter the setup cost in the Setup Cost field. 

3. In the Unit Cost field, enter the expense associated with one piece, for example, one suction cup. 
(What makes up a “unit” depends on the charge you are costing.) 

To use or set up a rate list to define unit cost 
1. In the Costing tab, select Unit Cost in the Costing Method field. 
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2. Select the Use as Rate List option. 

3. In the Select Rate Table field, do one of the following: 

• To use an existing rate list, choose it. The name of the selected rate list is displayed in the Title 
field in the Costing tab and Unit Cost is automatically set to Variable. 

• To create a new rate list, click Add New and complete steps as described in “Creating price and 
rate list”. Keep in mind that in a rate table you define the cost per unit for particular quantities. This 
unit cost is then multiplied by the quantity to come up with the total cost. 

To use Time and Materials method 
Time and Materials is the most common costing method since many charges involve both material and time 
costs (labor). 

1. In the Costing tab, select Time and Material in the Costing Method field. 

2. If there is a one-time material cost (it applies only once for the whole job), enter it in the Fixed Materials 
field. 

3. In the Unit Materials field, enter the cost of the material per piece, for example, 3.50 per plate. 

4. In the Labor Rate field, enter the hourly labor cost associated with the charge, for example, 50.00. 

5. If setup time is involved, enter the number of minutes in the Setup (minutes) field, for example, 5 
minutes. 

6. In the Pieces/Hour field, enter the number of units you typically produce in an hour, for example, 12 
plates per hour. (You can enter a decimal in this field.) 

 
7. If you have a charge like folding or sewing where the process may get faster as quantities increase, you 

can use a speed table to vary the unit labor cost based on run quantity and speed. Select or create a 
speed table. The process is the same as for press definitions. 

Note  After you complete steps 1 through 5, the Total unit cost is displayed. This is a summary of 
the labor and material rates. If you are using Cost Plus for pricing, the total unit cost is also the 
basis for calculating the Sales Price per Unit. 
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Press Definition 
Press definitions in PrintSmith Vision provide pricing information for your presses based on the type of work 
you perform on a particular press. 

While you may have only a few presses in your shop, you typically perform several different types of work on 
each press. Each type of work that requires different pricing should be represented by a press definition with its 
own pricing characteristics. The more press definitions you create, the easier it is for your estimators to select the 
correct definition for a quote.  

Understanding the Press Definitions Window  
You manage all the pricing definitions for your presses in the Press Definitions window. To open this window, 
click Press Definitions in the Quick Access panel (or select Pricing > Press Definitions). The Press 
Definitions page opens.  

Within Press Definition, you have four options for printers: Offset, Web, B&W/Color, and Large Format. 
Each tab in the Press Definition displays corresponding presses alphabetically by name. You can duplicate an 
existing press definition to keep some changes and enter new settings or create a new press definition. 

 

Creating Press Definitions 
You can create a new press definition by clicking +Create Press Definition in the Press Definitions window. 
The New Press Definition page opens. 

The fastest way to set up your press definitions is to create a few “standard” definitions and then copy and 
adapt these definitions. To copy a press definition, click the three dots in the far-left column and select 
Duplicate. In the New Press Definition page, you can make quick changes to the definition settings. For 
example, changing the definition name, production location, and machine name. Within the definition you set a 
labor rate, labor markup, speed table, waste chart, and target pricing. Charges you want added to every job 
using that definition can be attached directly to the definition. 

1. In the Quick Access panel, click Press Definitions (or select Pricing > Press Definitions). The Press 
Definitions window opens. Click +Create Press Definition to start a new definition. 

2. Provide general information about the press definition: 

3. In the Name field of the New Press Definition page, enter a name to identify the definition. 

4. When you have more than one definition for the same press, enter a number in the Machine ID 
field to identify the press. The Work In Progress report uses this ID to sort jobs by the press on 
which they are produced rather than by the press definition that was selected for the job. 

5. In the Machine Name field, select the name of the press for which you are creating a definition. 

6. In the Output Description field, enter the description of this printing process as you want it to 
appear on invoices and job tickets, for example, printed or reproduced. 

7. If you use Tracker, select a location in the Production Location field. If you use Scheduler, 
select a Cost Center for the press definition. 

8.  In the Paper Style field, leave Sheet-Fed (Printing) selected for offset printing or select Roll-Fed 
for printing on a web press.  
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9. Enable the Costing Press option so that if a job is run on this press when another less expensive 
press is unavailable, the costing amount is based on this press definition used in conjunction 
with the Tracker module. 

 
To review the price list for the press definition when a particular stock is selected, click Stock Price List and 
select a stock. To review the price list without stock being factored in, click Press Price List. These price lists 
are useful when first setting up and testing your system. 

Main Tab 
 You provide the details for a Sheet-Fed or Roll-Fed press definition in the Press Definitions window. 

1. Click the Main tab in the Press Definitions window. 

2. Provide information about Paper Size: 

• In the Max field, enter the largest sheet size (including bleeds) that you want to allow to be run. For 
example, if your press definition is for Text 8.5 x 11/14 1C Normal Coverage, your maximum paper 
size might be 10 x 15. 

• In the Min field, enter the smallest sheet size you want to allow, for example, 3.5 x 5.5. 

• For Roll-Fed definition, in the Max Roll Width and Min Roll Width fields, enter the largest and 
smallest widths you want to allow for the press definition. 

3. Provide information about Labor: 

• In the Rate field, enter the hourly cost of running the press. This number is very important in 
terms of determining whether you are making money. The labor rate should be “fully 
burdened”, which means that it should include the cost of labor and the cost of the press, as 
well as any overhead.  

• In the Markup field, enter the markup you want to apply to the rate you entered in the Rate 
field. For example, a markup of 1.2 means you want to make a profit of 20% when this press 
definition is used. 

• In the Min (mins) field, enter the fewest minutes for which you want to charge on short jobs. 
For example, if you set Minimum Labor to 20 minutes, and a job takes 8 minutes, the customer is 
still charged for 20 minutes. 

4. Provide information about Setup:  

• In the Minutes field, enter the number of minutes it typically takes to prepare the press for the 
first run of the day including the first color.  

• For multi-pass jobs, in the Additional Run field, enter the time in minutes to get ready for an 
additional run (plate change and so on). This is always less than the initial setup. 

5. Provide information about Washup:  

• To specify a fixed cost for washup, enter it in the Fee field. Because no time is associated 
with this fee, it is not included in the estimate. As a result, ePS recommends that you leave the 
Fee field blank and complete the Minutes/Pass (per wash) and Time/Fountain fields instead.  

• The value in the Minutes/Pass (per wash) field is a one-time charge per pass and the 
Time/Fountain is multiplied by the number of washes (specified in the job). 

6. Provide information about Heads:  

• In the # Heads field, enter a number corresponding to the number of colors associated with the 
press definition (not the number of actual print heads on the press). For example, if the press 
definition is for one-color work, enter 1 in this field.  
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• For multi-color runs, in the Setup Add’l Head field, enter the time in minutes to set up 
additional heads. This is always less than the initial setup specified in the Setup (Minutes) 
field. 

7. Provide information about Additional Signatures:  

• For jobs with more than one signature (such as booklets), in the Setup field, enter the time in 
minutes for additional signatures after the initial make-ready. For example, if initial make-
ready takes 5 minutes, additional signatures may take 3 minutes.  

• For multi-color jobs with more than one signature, in the Add’l Head field, enter the time in 
minutes to set up additional heads. 

8. In the Fixed Waste field, enter the number of sheets of setup (make ready) spoilage you 
anticipate. 

9. In the Grip Edge/Gap field, enter the amount of space required on one feed edge of the run sheet for 
the press to pick up the paper. If you leave this field blank, the value set in your Paper Calculator 
preferences is used. 

10. In the Work & Turn 2 Side Setup field, enter the value. This involves printing on the front and back 
running two up. The effect is to double the length of each run while reducing setup time, as well as to 
cut the number of plates in half. 

• For a Roll-Fed press definition, in the Cutoff Length field, enter the circumference of the physical 
cylinder. 

11. Enter a value in the Avg. Impressions/Hour field, for example, 5000. This is a flat rate so is not as 
accurate as a speed table where speed varies with run length. 

Note When you add a speed table to a press definition, the Avg. Impressions/Hour field is 
automatically set to variable because the impressions per hour depend on the length of the 
job as defined in the speed table. 

12. If the definition is for a perfecting press (which prints both sides of the paper in one pass through the 
press), select the Perfector check box. When this check box is selected, additional passes are 
calculated only if the total number of passes exceeds the number of heads available. In this case, 1/1 (1 
color front and back) is priced the same as 2/0 (2 colors front, 0 on the back). Likewise, on a 4-head 
press, 4/0, 3/1, and 2/2 are all priced the same way. 

13. Add Charges (for example, ink or plate charges) to the press definition. 

Charges can be attached to definitions in the Charges column. The preset charges make it possible to 
generate complex quotes quickly and consistently. The key is to add charges to a press definition that 
will make sense to the person creating the estimate. You can add a minimal set of charges and leave it 
to users to add any additional charges or you can add a larger set of charges and have users remove 
those that do not apply to a particular job. 
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Speed Table Tab 
Generally, the longer the run, the closer a press gets to its rated speed since there are fewer stops for 
adjustment on a long run once the job is running properly. On long runs, each piece is therefore cheaper to 
produce. ePS recommends that you create a speed table for each of your press definitions to account for the 
speed of the press based on the length of runs and type of work being performed.  

1. Click the Speed Table tab in the Press Definitions window. 

2. Click the Add New icon to the right of the window. 

3. In the Title field, enter a name for the speed table. ePS recommends making this the same as the name 
of the press definition for which you are defining the speed table.  

4. Enable the Interpolate option so that intermediate values are calculated if the actual run length does 
not exactly match a run length in the table.  

Suppose the first entry in the speed table has a run length of 500 with a speed of 6,000, and the next 
entry has a run length of 1,000 and a speed of 6,100. For a run of 750, the interpolated speed would be 
6,050. If the Interpolate option is not selected, the speed jumps to the next entry with no intermediate 
values. This can result in undesirably low pricing for run lengths that are just higher than a run length in 
the table. ePS recommends that you always select the Interpolate option.  

5. Enter a value in the first cell in the Run Length column. Press the TAB key to move to the Speed 
column and enter that value.  

As you enter values, the graph on the right provides a visual depiction of the speed table.  

6. As you complete the speed table, keep the following in mind:  

• Specify at least two run length and speed combinations.  

• Make sure the run lengths are sequential with the smallest run length at the top of the list. The 
maximum run length does not need to be the largest one you will run. When the run length in the 
job is larger than the largest value in the speed table, the last speed in the table is used.  

• As the run length increases, increase the press speed, thus reducing the unit labor cost on longer 
runs.  

Note Although normally the press speed should increase at higher run lengths, it can also 
decrease. For example, you may want to reduce the speed when the run length reaches 
the point when the press usually has to be reloaded.  

• To add more rows to the speed table, click the Add new element icon.  

 
• To remove a row from the speed table, click the Delete Row icon displayed at the end of the row. 

7. Click Save Speed Table.  

• When you create a speed table, it is automatically assigned to the current press definition. You can 
change the speed table that is assigned to a press definition by selecting a speed table you want to 
assign from the Select Speed Table drop-down field. 

• To edit a speed table, select the speed table you want to review or edit from the Select Speed 
Table drop-down field. Make your changes and click Save Speed Table. Click the Revert button to 
revert your changes. 

Note  Keep in mind that if a speed table is used by more than one press definition, any changes 
you make affect those press definitions, too. 

• To copy a speed table, click the Duplicate icon. Make any necessary changes to the speed table 
and click Save Speed Table. The speed table is automatically assigned to the current press 
definition. 

• To remove a speed table from a press definition so that it is without a speed table, click Clear (x 
symbol) in the Select Speed Table field. 
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• To delete a speed table, click the Delete icon on the right of the window. 

  

Waste Chart Tab 
A press definition can have setup spoilage specified in the Fixed Waste field of the Main tab, but for run spoilage 
you must use waste charts. Each type of press may have different spoilage characteristics so you may want to 
define individual waste charts for your press definitions, although they can also share waste charts.  

You can create as many waste charts as you like, but you can assign the same waste chart to more than one 
press definition. You manage waste charts and assign them to press definitions. Once a waste chart is assigned 
to a press definition, the name of the waste chart is displayed in the Select Waste Chart Field of the Waste 
Chart tab. 

1. Click the Waste Chart tab in the Press Definitions window. 

2. Click the Add New icon to the right of the window. 

3. In the Title field, enter a name for the waste chart. ePS recommends that you name waste charts in a 
way that identifies their characteristics, for example, Heavy Waste. 

4. Select the Interpolate option so that intermediate values are calculated if the run length being looked 
up does not exactly match a run length in the waste chart. The result is a smooth curve. 

5. Complete the Run Length and Spoilage columns. 

Make sure the run length increases from top to bottom and the spoilage percentage decreases in small 
increments. The maximum run length does not need to be the largest you will ever run. When the 
quantity in the job is larger than the largest value in the waste chart, the last percentage in the chart is 
used. 

As you enter values, the graph on the left is updated. Move the pointer over the curve to see the run 
length and spoilage at particular points on the graph. 

6. After you finish entering all the spoilage values, click Save Waste Chart. The name of the waste chart 
is displayed in the Select Waste Chart field. 

Similar to a speed table, you can edit, copy (duplicate), remove, or delete a waste chart.  



216 • Productivity Suite | PrintSmith Vision User Guide 

 

 

 

Target Pricing Tab 
Target pricing involves setting up variable discounts or markups while remaining both profitable and competitive. 
Although typically you want to maintain a high level of profitability, you may sometimes want to lower your profit 
to remain competitive. Target Pricing is designed to allow you to adjust your regular pricing as needed to remain 
competitive in your market. In the Target Pricing tab, you can set up the quantities you want, and PrintSmith will 
show your current pricing based on the header parameters and what you have set up in the definition. You can 
then either override the prices or adjust the markup amounts so as to refine your sell prices as needed. As your 
costs increase or market conditions change, you can adjust your Target Pricing accordingly. When you define 
Target Pricing for a press definition and then use that press definition for a job, the price is looked up in the 
Target Pricing table associated with the press definition. 

1. Click the Target Pricing tab in the Press Definitions window.  

2. The Stock Picker window opens. To check pricing with a particular stock, select the stock; otherwise, 
close the Stock Picker window. (You do not have to select a stock, but it is easier to determine pricing 
targets when all the necessary pricing factors are included.)  

3. In the Target Pricing tab, review the pricing and make changes to the target pricing. 

If you make changes but do not want to keep them, click Revert. This will restore the target pricing that 
was last saved. 

4. When done, click Save to save the target pricing. 

• When you review the pricing, keep in mind that what is shown as profit is the difference between your 
estimated costs and the calculated price based on your specifications. To the extent that you identified 
all your costs accurately, the profit is generally accurate, but actual profits can only be reasonably 
determined from a Profit and Loss Statement over a period such as a month, quarter, or year.  

• The five columns to the right of the Quantity column are: 

Columns Description 

One Color One 
Side 

One color on the front with nothing on the back. 

One Color Both 
Sides 

One color on the front and one color on the back. 

Multi-Color One 
Side 

More than one color on the front and none on the back. 

Multi-Color Both 
Sides 

More than one color on the front and at least one color on the back. 

Process Color Four or more colors on the front. 



Press Definition | User Guide • 217 

 

 

Process Color 
Both Sides 

Four or more colors on the front and at least one color on the back. 

• The prices are color-coded:  

Color Description 

Black Identifies the original values calculated by PrintSmith. 
Green Identifies a changed value that results in a higher profit than before. 

Blue Identifies a changed value that is still profitable although less so than 
before.  

Red  Identifies a value that is not profitable. 

• For a different perspective on the prices, select one of the following in the drop-down field on the left: 

 View Description 

Target (Default view) Initially shows the prices that PrintSmith Vision 
automatically calculated for different combinations of quantities, colors, 
and sides. After you make changes, they are reflected here. 

Target Factor Shows the multipliers used to adjust the price up or down. The standard 
target factor calculated by PrintSmith is 1. A factor that is less than 1 
decreases the price of a job while a factor greater than one increases it.  

Standard Shows the original calculated prices.  
 

Estimated Profit Shows your profits at various quantities.  
 

Est Profit Pct Shows your profits as percentages. 
 

Costs Shows your estimated costs 
 

• Select the Interpolate option, if you want intermediate values calculated when the actual quantity does 
not exactly match a quantity in the target pricing table. 

• Select the Ignore Charges option if you do not want the pricing of the charges that you added to the 
press definition to be changed by your target pricing (especially if you are discounting). The target 
pricing then affects just the printing. 

• Select the Use Press Count option if you want to use the actual number of sheets that go through the 
press for calculating pricing instead of the quantity ordered. 

• Select the Ignore Washup Charges option if you do not want washup charges to be affected by your 
target pricing. 

• Select the Ignore Stock option if you do not want stock charges to be affected by your target pricing. 
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About Digital Definitions 
Digital definitions provide pricing information about your large format and digital printers (B&W/Color and Large 
Format). You may own only one or two digital and large format printers but perform different types of activities on 
those printers. Each activity that requires different pricing would be represented by a digital definition with its own 
pricing characteristics. 

Large Format definitions are for printers that produce banners, signs, vehicle wraps, etc. These definitions are 
similar to standard digital definitions but have the option to price by area and use both roll and rigid substrates. 

Creating Digital Definitions 
When you start out, you must create your digital definitions from scratch, but if you later need to create similar 
definitions, you can copy existing ones and adapt them. 

1. Select Pricing > Press Definitions. The Press Definitions window opens.  

2. To create a B&W/Color and Large Format press definition, click the B&W/Color or Large Format tab 
and then click the Create Digital Definition button. The New Digital Definition window opens. 

3. Complete the following fields: 

a. In the Name field, enter a name to identify the definition.  

b. In the Machine Name field, select the name of the printer for which you are creating a definition.  

c. In the Output Description field, enter a description for the process used, as you want it included 
on job tickets and invoices, for example, Running – Copy or Digitally printed. 

d. In the Production Location field, select the location that corresponds to the process you are 
defining. (Use Table Editor to maintain these locations in the Production Locations table.) For 
information about Tracker, see the PrintSmith Vision - Tracker User Guide. 

e. Select a Cost Center for the digital definition. For information about Scheduler and cost centers, 
see the PrintSmith Vision - Scheduler User Guide. 

f. If PrintSmith Vision is integrated with Fiery, see PrintSmith Vision - Fiery Integration Guide for 
information about the Fiery Device option. 

g. In the Sales Cat field, select a sales category for tracking the sales from jobs priced with this 
definition. Sales categories in PrintSmith Vision classify your sales so that you can see how much 
you sold in different areas of your business.  



Press Definition | User Guide • 219 

 

 

Tip You will obtain more useful information if you define sales categories for each of your 
printers. You can then see how different printers are used.  

h. When you have more than one definition for the same machine, enter a number (1 to 255) in the ID 
field to identify the machine. The Work In Progress report uses this ID to sort jobs by the machine 
on which they are produced rather than by the digital definition that was selected for the job. So, for 
example, if you have five definitions for your Canon printer, enter the same number in the ID field in 
each of these digital definitions. 

i. For Printer Type, select the B&W or Color options. (You can select both the B&W and Color check 
boxes if the printer handles both types of printing.)  

For a large format press definition, the Large Format check box is selected. 

Note  When you create B&W jobs, the only printers you can select are those with Printer 
Typeset to B&W. Similarly, for large format jobs, only large-format printers can be 
selected. 

j. Select the Costing Copier option so that if a job is moved to a different piece of equipment, the 
selected equipment is used for costing. 

4. To review the price list for the digital definition when a particular stock is selected, click Stock Price 
List and select a stock. To review the price list without stock being factored in, click Digital Price List. 
These price lists are useful when first setting up and testing your system. 

5. The Main tab is where you will enter the details for pricing, cost, and size.  

• In the Method field, select the pricing method you want to use. This is a key part of a digital 
definition. For information about the different pricing methods available, see “Pricing Methods for 
Digital Definitions”. For some pricing methods you must also set up a matrix table of quantities and 
prices. 

• In each digital definition you must decide how to charge for the second side. The Price 2 Sided By 
field enables you to set how two-sided jobs are priced. For more information, see “Pricing two-sided 
jobs”. 

• To charge more for the second side by multiplying the rate for the first side by a set factor, select 
using Side 2 Factor in the Price 2 Sided by field and then enter the multiplier in the Side 2 Factor 
field. For example, 1.3 to multiply the first side rate by 30%. 

• In the Stock Price is field, select the option to indicate whether stock is included in the pricing and 
how it is calculated. For more information, see “Handling stock pricing”. 

• In the Stock Markup field, one set of stock markups for copy jobs and another for printing jobs. For 
example, your standard stock markup (in the stock definition) for printing jobs may be 50% (1.5), 
but you may want to markup stock for copy jobs by only 20% (1.2). In this case, you would enter 
1.2 in the Stock Markup field and enable the Use Digital Stock Markup option. 

• If you have variable stock costs, and want to add a single markup on top, enter it in the Copy 
Markup field. 

• All the large format pricing methods and three of the B&W/color pricing methods are based on 
matrix tables. These pricing methods require you to enter data in a table to define quantity 
breakpoints and unit prices. Different types of Matrix Tables are available. The most common is 
“copy cost” for obtaining a unit price, but you can also use a matrix to specify volume-based 
discounts, to do stepped pricing, or to define markups to use in addition to the machine cost per 
copy (or square unit for large format jobs). See “Setting up a matrix table” for more information. 

• Decide how to charge for the second side in each digital definition and how to account for stock 
prices. To calculate your costs so that you can establish profitable prices, complete the Cost 
section.  

6. If spoilage or waste is associated with the process you are defining, and you want to use a waste chart, 
click the Waste Chart tab. The process of assigning and creating waste charts is the same as for 
charges. For more information, see Providing Costing Information. 

7. Each digital definition can include “preset” charges. For example, you may want to include RIP or 
finishing charges. When you select a digital definition for a job, any preset charges are automatically 
included, too. To attach charges to the definition, click the Add/Remove Charges icon to the right. 
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8. For the Large Format definitions, you have an option to add the ink prices based on the percentage of 

coverage. Use the Ink Prices tab to create the ink pricing list. 

Note  The Ink Prices tab is available only if Signage is enabled in the Pricing Method preference 
settings. 

 

 
9. Click the Save button. 

Ink Prices Tab 
The Ink Prices tab enables you to specify the ink price based on the percentage of coverage. The ink coverage 
option is useful in estimating how much you could charge for ink used in a job. The coverage options are Lite, 
Medium, and Heavy. You can add specific prices to a custom ink set, which can be used for multiple devices. 
The ink charge for a Signage job will be the amount of ink used in a job. In a job, the ink charge is estimated 
based on the cost per square unit and coverage value.  
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Note The Ink charge is applicable only for Signage job. 
When you define ink pricing based on coverage for a press definition and add ink charges for a job, the price is 
looked up in the Ink Prices table associated with the press definition. 

 
To create the ink pricing list based on coverage percentage: 

1. In the Ink Prices tab of a large format press definition, click  to add an ink price set for a color. 
This adds a new row in the grid. 

2. Enter a name for this ink price list in the Title field. 

3. In the grid, specify the Color and the standard Cost per square unit for this ink color. For example: 
Color is Black and Cost per sq unit is 0.0003. 

4. Enter the percentage value of the ink cost that is to be applied for various coverages – Heavy, Medium, 
and Lite. In the above example, the ink pricing for medium coverage of white color is 0.0003*0.70. 

5. Click the Add new element icon to add another color and specify the ink cost along with the 
percentage of coverage. 

6. Click Save Ink Price list to save the ink pricing list. You can use this ink price list on other large format 
definitions. 

Pricing Methods for Digital Definitions 
The pricing method that you select for a digital definition controls how PrintSmith Vision calculates the price of 
jobs that are based on the definition. The pricing method is therefore a key part of the digital definition. 

The pricing methods that you can select depend on your Printer Type selection in the Digital Definitions page.  

• For B&W and/or Color, five methods are available, three of which are matrix style.  

• For Large Format, five matrix-style methods are available.  

The matrix style methods involve tables of quantities and prices that you set up. 

B&W and Color Pricing Methods 
If the Printer Type field in the Digital Definitions window is set to B&W and/or Color, you can select one of the 
following pricing methods in the Method field: 

• Flat rate 

• Copies and originals 

• Copies per original 

• Total of all copies (most commonly used pricing method for B&W and Color jobs) 
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After you select the Pricing Method, make your two-sided pricing and stock pricing selections as described in 
“Pricing two-sided jobs” and in “Handling stock pricing”. 

Flat rate 
In this method, the rate per copy is always the same regardless of quantity: 1 copy has the same unit price as a 
million copies, and printing 100 copies of 1 original is the same as printing 1 copy of 100 originals. This may be 
useful for pricing on a convenient copier, but it is difficult to be competitive with this type of pricing. 

After you select Flat rate in the Method field, in the Rate/Copy field, enter what you want to charge per 
copy, for example, .1 (10 cents). 

 

Copies and originals 
In this matrix-based method, the number of copies in the job is used to find the copy price based on the number 
of originals, for example, 100 copies of 25 originals may be 0.0038 per copy. 

After you select Copies and originals in the Method field, create a matrix table as described in “Setting up a 
matrix table”. The table may have extra columns for a second side depending on how you decided to price 
the second side. 

 

Copies per original 
In this matrix-based method, the rate is based on the number of copies per original.  
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After you select Copies per Original in the Method field, create a matrix table as described in “Setting up a 
matrix table”. The table may have extra columns for a second side depending on how you decided to price 
the second side. 

 

Total of all copies 
In this matrix-based method (the most popular for copy jobs), the total number of copies in the job is used 
to find the unit price in the matrix, which is then multiplied by the number of copies in the job. For example, 
if the job is for 10 copies of 10 originals, the total number of copies is 100 so the price per copy is 
advantageous to your customers. 

After you select Total of all Copies in the Method field, create a matrix table as described in “Setting up a matrix 
table”. The table may have extra columns for a second side depending on how you decided to price the 
second side. 

Large Format Pricing Methods 
If the Printer Type field in the Digital Definitions window is set to Large Format, you can select one of the 
following matrix-style pricing methods in the Method field: 

• Square area and originals  

• Total of square area (most commonly used pricing method for large format) 

• Square area and copies  

• Square area per copy 

• Quantity and square area 
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Square area and originals 
In this method, the total square area of a job is used to find the unit price in the matrix table based on the number 
of pieces (originals). 

After you select Square Area and Originals in the Method field, make your two-sided pricing and stock 
pricing selections as described in “Pricing two-sided jobs” and in “Handling stock pricing”. Then create a matrix 
table as described in “Setting up a matrix table”. The table may have extra columns for a second side 
depending on how you decided to price the second side. 

 

Total of square area 
In this method (the one most commonly used for large-format work), the total square area of the job is used to 
find the unit price in the matrix table, which is then multiplied by the number of units in the job. 

After you select Total of square area in the Method field, make your two-sided pricing and stock pricing 
selections as described in “Pricing two-sided jobs” and in “Handling stock pricing”. Then create a matrix table 
as described in “Setting up a matrix table”. The table may have extra columns for a second side depending on 
how you decided to price the second side. 
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Square area and copies 
In this method, the total square area and the number of copies being produced are used to obtain a unit 
price from the matrix table. 

After you select Square area and copies in the Method field, make your two-sided pricing and stock pricing 
selections as described in “Pricing two-sided jobs” and in “Handling stock pricing”. Then create a matrix table 
as described in “Setting up a matrix table”. The table may have extra columns for a second side depending on 
how you decided to price the second side. 

 
Square area per copy 
In this method, the number of copies is used to obtain a price per square unit from the matrix table. 

After you select Square area per copy in the Method field, make your two-sided pricing and stock pricing 
selections as described in “Pricing two-sided jobs” and in “Handling stock pricing”. Then create a matrix table 
as described in “Setting up a matrix table”. The table may have extra columns for a second side depending on 
how you decided to price the second side. 
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Quantity and Square area 
In this pricing method, the total square area of a job is used to find the unit price in a matrix table based on the 
quantity ordered. Quantity and Square Area pricing method is available only for Large Format definitions and 
used in both Signage and Large Format job methods. The job price is calculated as: 

Job price = (Quantity x Unit price) + Any additional charge 

After you select Quantity and Square area in the Method field, do the following: 

1. Make your two-sided pricing and stock pricing selections as described in “Pricing two-sided jobs” and 
in “Handling stock pricing”. 

2. Create a matrix table as described in “Setting up a matrix table”.  

 
In figure below, for a 3’ x 5’ banner that translates to 36 x 60 inches, the square area is 36 x 60 = 2160 sq 
inches. Using the matrix, the unit price for one item is $80. Similarly, the unit price when the quantity is increased 
to 5 is $75 and the Job Price is calculated as 5 x 75 = $375. 
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When using the Quantity and Square area pricing method, only the following methods are supported for Price 2 
Sided By field (Duplex printing).  

• Not Changing Price 

• Using side 2 Factor 

Pricing Two-Sided Jobs 
The Price 2 Sided by field controls how two-sided jobs are priced. In each digital definition you must decide how 
to charge for the second side. 

  
In the Price 2 Sided by field: select one of the following: 

• To not charge for the second side, select not changing price. In this case there is no difference in 
price between one-sided and two-sided work. 

• To use the same rate for the second side as for the first side and to add the stock cost just once 
(not once for each side), select using first rate side. 

• To establish varying rates for the second side, select using second rate side. The matrix table for 
the pricing method you selected will now have more columns to account for the second side 
pricing.  

• To treat the second side as an additional quantity (by doubling the number of originals before 
looking up the price), select counting as more originals. In this case 100 two-sided copies are 
priced the same as 200 one- sided copies. This is the most popular method for two -sided pricing. 

• To charge more for the second side by multiplying the rate for the first side by a set factor, select 
using Side 2 Factor in the Price 2 Sided by field and then enter the multiplier in the Side 2 
Factor field, for example, 1.3 to multiply the first side rate by 30%. 
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Note  Not all the selections are available for all pricing methods.  

Handling Stock Pricing 
As part of each digital definition, you must indicate whether stock is included in the pricing and how it is 
calculated. 

 
You can handle stock pricing in these ways: 

• Exclude it from pricing. 

• Add a marked-up stock cost to the price. 

• Add a specific price for the stock to copy/unit price. 

Tip If you have variable stock costs, and want to add a single markup on top, enter it in the Copy Markup 
field. 

Excluding stock from the price 
If you want the cost of the stock selected for the job to be ignored in the pricing calculations, select 
included in Rate in the Stock Price is field. 

Adding marked up stock cost to price 
Do one of the following: 

• If you want to add the cost of the stock to the rate per copy (or square unit in the case of large 
format jobs) and mark up the stock using the markup in the stock definition, select marked up 
Stock Cost in the Stock Price is field. 

• If you want to add the cost of the stock but use a markup that is different from that in the stock 
definition: 

1. Select marked up Stock Cost in the Stock Price is field. 

2. Enable the Use Digital Stock Markup option. 

3. Enter a value in the Stock Markup field. 

This lets you have one set of stock markups for copy jobs and another for printing jobs. For example, your 
standard stock markup (in the stock definition) for printing jobs may be 50% (1.5), but you may want to mark up 
stock for copy jobs by only 20% (1.2). In this case you would enter 1.2 in the Stock Markup field and select the 
Use Digital Stock Markup option. 

Adding a specific price for stock 
If you want to add a specific price for the stock to the price per copy (or per square unit), you must first add the 
price to your stock definition and then indicate in your digital definitions that you want to use this price. 

1. For B&W digital definitions: 

a. In the Stock Definitions window, click the Definitions tab.  

b. In the B&W field, enter the stock price. For example, to add 4 cents to the price of a 
copy, enter .04. 

c. Save the stock definition. 
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2. In the Digital Definitions window, in the Stock Price is field, select from Copier 1 in Stock Definition. 

3. If the digital definition is for color printers, repeat the steps above but enter the stock price in the Default 
Color field on the Definitions tab of Stock Definitions window and select from Copier 2 in Stock 
Definition in the Stock Price is field of the Digital Definition window. 

4. If the digital definition is for large format printers, enter the stock price in the Large Format field on the 
Definitions tab of Stock Definitions window and then select from Copier 3 in Stock Definition in the 
Digital Definitions window to add the stock price to the price per square unit. 

Setting up a Matrix Table 
All the large format pricing methods and three of the B&W/color pricing methods are based on matrix tables. 
These pricing methods require you to enter data in a table to define quantity breakpoints and unit prices. 

Different types of matrix tables are available. The most common is “copy cost” for obtaining a unit price, but you 
can also use a matrix to specify volume-based discounts, to do stepped pricing, or to define markups to use in 
addition to the machine cost per copy (or square unit for large format jobs). 

To set up a matrix table 

1. After you select the type of pricing method you want to use, select the type of matrix you want to 
set up from the Matrix Options drop-down field: 

 
• Matrix is Copy Cost for a table of quantities and prices to determine the sell price as 

quantities increase. This is the most common type of matrix. 

• Matrix is Discount Table if you want to start with a base rate and then provide discounts as 
quantities increase. 

• Matrix is Step Table if you want to step through a range of unit prices and add them up 
according to the quantity in the job. For example, if you defined breakpoints at 100 for .06, 
200 for .05, and 300 for .04, and the quantity to price is 250, the prices are calculated as 
follows: 100 at .06 (6.00), 100 at .05 (5.00), and 50 at .04 (2.00). It then adds all three results 
together: 6.00+ 5.00+2.00 = 13.00. A step table for a large format definition works the same 
way except that your quantities are in square units such as 144, 576, and 1296. 

• Matrix is Markup Table if you want to define markups to add on top of the machine cost per 
copy (or per square unit for large format definitions) based on different quantities. 
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Tip B&W on the Definitions tab in the stock definition corresponds to the copier 1 selection 
in the Stock Price is field in the digital definition; Color corresponds to copier 2; and 
Large Format corresponds to copier 3. 

2. For large format definitions, in the Square Area Options field, select Square Area from Run Size 
or Square Area from Finished Size depending on whether you want to charge for any unused 
area (run size) or just the finished job. 

3. Leave the Interpolate Matrix Values option selected so that intermediate unit prices between 
breakpoints in the table are calculated when the amount being looked up does not exactly match 
an amount in the table. (This is usually better for you since it avoids the situation where an 
amount is just above a breakpoint and therefore gets the breakpoint price. With interpolation, the 
price changes are much smaller and more accurately reflect quantities ordered.) 

4. Click Edit Matrix to open the matrix table. 

5. Enter all the quantities for which you need to account and the corresponding copy or unit prices.  

6. If you selected using second rate side in the Price 2 Sided By field, the matrix table includes 
additional columns for the second side. Enter the price per side in each column. For example, if 
you decide to charge 15 cents for a one-sided copy but want to charge 22 cents for two -sided 
copies, the price in the 2 Sided column should be .11 (11 cents) because that is the price per side 
for a two-sided copy. 

7. When your matrix table is done, click OK to save it. 

  

Providing Costing Information 
ePS recommends that you provide some information about your costs in the Cost section of the Digital 
Definitions window. You can then make sure that your prices are higher than your costs so that you are making a 
profit.  

1. In the Copies/Minute field, enter the average number of copies that the printer produces in a 
minute.  

For a large format definition, this is Length/Minute – the average number of units such as inches 
or centimeters that advance through the printer in a minute. 

2. In the Monthly Burden Rate, enter the amount of your overhead carried by this equipment. 

3. In the Monthly Labor field, enter the monthly labor rate associated with the equipment. Use an 
average if several employees work on the equipment. 

4. In the Click Cost field, enter the cost per impression. 
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5. In the Open Days/Year, enter the number of days you are open for business. 

6. In the Open Hours/Day field, enter the number of regularly scheduled hours your business is open. 
This should include scheduled overtime and second shifts. 

7. Ignore the Labor/Copy field; the Monthly Labor field provides more accurate information. If the 
definition is for a copier, and toner and developer (or other consumables) are not part of your 
overhead, enter the additional charges per copy in the Toner/Copy and Developer/Copy fields. 
(Otherwise, ignore these fields.) 

8. Leave the Copy Markup field set to 1 unless you want to add a markup to the Machine Cost per Copy 
(for B&W and color definitions) or Machine Cost per Sq. Unit (for large format definitions). For 
example, to mark up the cost by 30%, enter 1.3. 

9. In the Monthly Payment field, enter your monthly payment for the equipment. If you own the 
equipment, enter what you would anticipate paying to replace the equipment. 

10. In the Monthly Maintenance field, enter your monthly maintenance charge (if any). If you do your own 
maintenance, enter a reasonable periodic charge for your costs to maintain the equipment. 

11. If you are using Tracker, in the Hourly Costing Rate field, enter the cost per hour for 
running the machine (including overhead). For information about Tracker, see the 
PrintSmith Vision - Tracker User Guide. 

12. In the % Time in Use field, enter the estimated percentage of time the equipment is usually in use. 
For example, if you are open for 8 hours a day and the machine is usually in use for 2 hours, enter 
25%. 

 
Using the information you provided, PrintSmith Vision calculates the Machine Cost per Copy for 
B&W and color definitions or Machine Cost per Sq. Unit for large format definitions. 

13. In the Maximum Size and Minimum Size fields of Size section, enter the largest and smallest 
sizes that you want to handle with the definition. (These do not have to be the sizes that the 
equipment can handle.) 

For large format definitions, complete the Maximum Width and Minimum Width fields – the 
largest and smallest widths of substrates handled with this definition. 

Selecting Default Digital Definitions 
You should select the most commonly used digital definition for each printer type (B&W, color, and large format) 
as your default definition for that type of printer. When you then create a B&W job, for example, the default B&W 
digital definition is automatically used unless the selected stock has a different definition assigned to it. You can 
always change the assigned printer when you are creating a job. If you do not select a default definition for a 
particular type of printer, the first definition of that type in the list is used. 

To select your default digital definitions: 

1. In the Press Definitions window, select the B&W digital definition you want to use as the default for 
printing B&W jobs.  
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2. Enable the option in the Default column. 

 
3. Repeat steps for your color and large format digital definitions.  
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Ordering Stock 
PrintSmith Vision includes several features to help you order stock and track what you ordered. You can keep 
track of all the stocks that need to be ordered, as well as keep track of placed and received stock orders. You 
can also create purchase orders for your stock orders. When an order is received, inventories for the stock are 
automatically adjusted (if you track inventory for the stock). 

Understanding the Order Stock window 
You record information about the stock that you need to order in the Order Stock window. To open this window, 
select Reports > Order Stock. There are two tabs on this page: To Order and Stock Order. 

Tip If you are creating a job for an invoice, and the job requires stock to be ordered, you can click Special 
Order Stock in the Job window. When you save the invoice, the stock order is recorded, based on the 
job specifications. 

To Order Tab 
The To Order tab has the Pending List Items and Low Inventory sections. 

The Pending List Items tab displays items that are not part of your inventory. When an invoice is created for 
stock that is not part of your inventory that stock will automatically be added to this list. You can use the columns 
across the top to select the stock that you want to order. The check box in the table header will select all items. 

  
The Low Inventory tab displays the stocks with low inventory. 

 

Recording the stock that needs to be ordered 
When you are ordering stock, you may want to: 

• Order stock for a particular invoice and job. 

• Order a particular stock that is in inventory and has an available quantity that is negative.  

Ordering stock for a particular invoice and job 

If you want to order stock for a particular invoice and job, you must know the invoice number and job number (if 
the invoice includes more than one job). For a multi-part job, you must also know the part of the job for which you 
want to order stock. 

1. Select Reports > Order Stock. The Order Stock – To Order tab opens.  

In the Pending List Items tab, you can use the search fields across the table header to find the invoice 
and job for which you want to order stock. You can either use the Invoice/Job# field to search or you 
can search by the stock name. 
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Note  The Order Quantity is automatically calculated by PrintSmith Vision based on the job 
specifications. 

2. Select the stocks you want to order. 

3. Click the + Order button. The stock will now be displayed under the Stock Order tab to review the 
stock orders that need to be placed, create purchase orders, indicate orders were placed, or indicate 
orders were received so that stock inventories are updated.  

Ordering inventory stock 

PrintSmith Vision tracks the inventory stock and identifies it as a low stock if the quantity on hand is less than the 
quantity committed. 

1. Select Reports > Order Stock. The Order Stock – To Order tab opens.  

2. Click the Low Inventory tab. 

Note The ordered quantity will be displayed based on the quantity needed to fill all commitments, 
target level, and reorder quantity. 

You can use the column headers to refine your search for the stock. 

3. Select the inventory stock(s) to be ordered and click + Order. The stock will now be displayed in the 
Stock Order tab.  

Stock Order Tab 
After identifying the stock to be ordered, the stock will now be displayed in the Stock Order tab. You can then 
review the orders that need to be placed from the Stock Order tab.  

 

Reviewing and Managing Stock Orders 
After you record your stock orders, you can review the orders that need to be placed in the Stock Order tab. At 
this point you can do the following: 

• Create purchase orders for the stock by selecting the Purchase Order button.  

• Manually order the stock using the Manual Order button if you do not create purchase orders.  

• Manually enter information for special order stock using the + Select Stock button. 

Placing Stock Orders 

The stock orders you recorded in the Order Stock window (Reports > Order Stock) are listed in the Stock Order 
tab where you can keep track of which orders have been placed and received. Here, you can also create 
purchase orders for the stock you are ordering. 

1. Select Reports > Order Stock > Stock Order.  

2. In the Stock Order tab, select the Hide Previously Ordered Stocks check box to hide stocks 
for which you already placed orders. Doing so makes it easier to see which stocks still need 
orders placed for them. 

3. To edit a stock order item: 

a. Select the Edit Order Stock option from the three-dot ellipsis.  
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The Edit Order Stock window opens. 

  
If the Allow modification to stock order option is selected, then all of the fields except Roll width 
and Roll weight can be edited. If it is not checked, then only the Vendor, Stock Number, Order 
Quantity, Stock #, PO# and Delivery Date fields can be edited. 

b. Make your changes (for example, change the order quantity) and click Save. The change is 
reflected in the Stock Order window. 

4. To remove a stock order item, select it and click Delete. 

5. To create a purchase order for an item, select it and click Purchase Order.  

6. To produce a report for each vendor (to facilitate tracking by vendor): 

a. Use the Print drop down to select Each Vendor or Consolidate. 

b. Click Print Report. 

 

Manually Ordering Stock 

If you do not need or want a purchase order, then you can manually place an order for such stocks. 

1. Select Reports > Order Stock > Stock Order.  

2. In the Stock Order tab, select the stock for which you want to manually order by checking the box next 
to the stock. 

3. Click the Manual Order button. 
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A message indicates that the manual order was raised. 

 
Then, an icon is highlighted next to the stock to identify that stock as manually ordered. 

 

Creating a Purchase Order for Stock 

It is recommended that you create purchase orders for stock from the Stock Order window (Reports > Stock 
Order). Once you complete a purchase order for stock, the Stock Order window is automatically updated and the 
stock inventory (if tracking stock inventory) is adjusted. 

1. Select Reports > Order Stock > Stock Order.  

2. In the Stock Order tab, select the stock for which you want to create a purchase order by 
checking the box next to the item. 

3. Click the Purchase Order button. The Purchase Order window opens. 

If the stock is for a specific invoice, its number is automatically entered in the Document# field. 
The Quantity and Unit Price values come from the stock definition; Quantity defaults to the 
Costing Units for the stock, but this can be changed. Description identifies the stock the same 
way as it is identified in a job (with the size, color, and weight included). 

 
4. Complete the fields in the Purchase Order window: 

a. PrintSmith Vision automatically assigns unique numbers to purchase orders, but if you want to 
enter a particular number or change the numbering sequence, enter the number in the PO# 
*New* field. (When you save, print, or e-mail a purchase order, and you manually assigned a 
number, PrintSmith Vision asks if you want to start a new numbering sequence starting from 
the number you entered.) 

 
The first PO# field is for a prefix and the third field is for a suffix. If a prefix or suffix was defined 
in the PO Settings preferences, it is displayed. If the PO Settings preferences allow a prefix or 
suffix to be edited, then you can edit or add a prefix. 

b. From the Vendor dropdown list, select the vendor/supplier you want to use for the item.  

c. In the Required By Date field, enter the date when you want the item(s) in the purchase order. 
Optionally enter a Time. 
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d. To provide the supplier with information about the person to contact about the purchase, 
select a Buyer. 

Note   Be sure to select a buyer because this also identifies who created the PO in other 
parts of PrintSmith Vision. 

e. In the Description field on the right, enter a general explanation of the entire purchase 
order. This description is included on purchase orders and is also used to identify the 
purchase order in purchase order history.  Details are very useful here. 

5. To review or edit the line item on the purchase order (for example, to change the quantity), click the 
three-dot ellipsis and select the Edit Item icon. The Purchase Order Line Item – Item#1 window 
opens. 

 
6. Do any of the following as necessary in the Purchase Order Line Item window and then click 

Update: 

• For stock or generic purchase orders, you can specify a customer account for the item you 
are purchasing.  

• If the Item Code field is blank or if you want to specify the ID of the item you are ordering 
(for example, the stock number from the supplier’s catalog), enter this ID in the Item Code 
field. 

• Change the Item Name to match the way the supplier names the item. 

• If necessary, correct the Total Quantity. (Unit Price for stock usually does not require 
changing.) 

• Enter or change the Line Item Description (required) and/or enter an Additional Line 
Item Description. 

 

7. Click  in the Purchase Order window to purchase another item of the same type from this 
supplier. Complete the fields in the Purchase Order Line Item- Item#2 window (which will have 
blank fields) and click Add. 
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8. To remove a line item from a purchase order, select it in the Purchase Order window, click the three-dot 
ellipsis and select Delete Item. 

9. Click Save in the Purchase Order window to save the purchase order.  

 
An icon next to the stock will be highlighted to show that the stock was order using a purchase order. 

Receiving Stock Orders 
How received stock is recorded depends on whether you create purchase orders for stock from the Stock Order 
window or not. 

When purchase orders are not created from the Stock Order window 

If your company does not create purchase orders for stock from the Stock Order window, complete these steps 
to indicate the stock was received: 

1. If the complete order for a stock was received, select the stock (using the check box next to the 
stock) in the Stock Order window and click the Order Received button. 

Tip If the orders were received for all the stocks listed, click Select All and then click Order 
Received. 

After you click Order Received, the value in the Received column is the same as that in the 
Quantity (ordered) column. Also, if you track inventory for the stock, the information on the 
Inventory tab in the Stock Definitions window is updated for a stock order for a particular invoice. 

2. If part of the stock order was received: 

a. Select the stock in the Stock Order window and click Partial Order Received. The 
Partial Order Received window opens. 
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b. Enter the quantity received and click Save. 

The quantity received is displayed in the Received Qty column. Also, if you track inventory for 
the stock, the information on the Inventory tab in the Stock Definitions window is updated. 

When purchase orders are created from the Stock Order window 

If your company creates purchase orders for stock from the Stock Order window (as described in “Creating a 
purchase order for stock”), when you edit the purchase order to indicate that it is complete (the stock was 
received), the Stock Order window gets updated automatically. 

For example, 

• If you enter a value in the Partial Received field in the Purchase Order Line Item window, the Received 
Qty column in the Stock Order window is automatically updated with this value. 

• If you select the Mark As Complete check box in the Purchase Order Line Item window, the Received 
Qty column in the Stock Order window is automatically updated with the full ordered quantity. 
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Change Price 
Sometimes you may want to adjust your prices either up or down. For example, changed market conditions may 
require you to be more competitive through lower prices, or increased costs may require higher prices, so you 
are still making a profit. 

Instead of adjusting the prices of items one-by-one, you can do the following: 

• Change prices for all stocks or for selected stocks. 

• Change prices for all press definitions, digital definitions, charges (including price lists), and/or list 
price schedules. 

Accessing Change Price 
Change Price can be done in multiple ways. In PrintSmith Vision, you can access the Change Prices option 
from the following windows: 

• Stock Definitions 

• Charge Definitions 

• Press Definitions 

• List Price Schedules 

Whenever you select the Change Price option, all the fields that are impacted by the update in price are listed in 
the Change Prices window as highlighted in image below: 

 
When you update the prices, PrintSmith Vision takes a backup of the price fields that have changed. PrintSmith 
Vision keeps a maximum of 5 backups and when the total number of backups reaches 5, the system 
automatically deletes the oldest backup. This gives an opportunity to reverse the price update. 

Important  When you update the price of each stock, automatic backup is not performed during price change. 

Restoring Prices 
Restore Prices provides an option to restore the prices back from previous backups. 

To restore the prices: 

1. Click the Restore Prices button in the window where you did a price change and want to restore the 
prices. The Change Prices Backup opens. 
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2. Select the previous backup to which you want to restore the price change and click Restore Prices. 

  
3. Click Yes to confirm the restore the prices from backup. 

Notes  Only Owner and System Admin groups have permission to use the Restore Price option. 
 If a backup is not available, you cannot restore the prices.  

Updating Stock Prices 
Instead of individually adjusting stock prices, you can change prices for all stocks, a group of stocks, stocks from 
a particular vendor, or stocks with prices older than a certain date. You can also control how the stock prices are 
changed: by manually entering a new price for each stock, automatically updating the stocks by a percentage, or 
automatically updating the stocks by adding a fixed amount to the price. 

1. Select Pricing > Stock Definition. The Stock List window opens. 

2. Select the stocks for which you want to change the price and click Change Prices. Then do any of the 
following: 

 

• If you want to enter a new price for each selected stock manually, select the Enter each stock 
price option.  
Selecting Enter each stock price, displays the following window: 
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Enter a new price for the first stock and click Update to continue to the next stock. Use the right 
arrow at the top-right corner to skip updating the stock and move to the next stock. 

Important  When you update the price of each stock, automatic backup is not performed during 
price change. 

• If you want to update the price for all the selected stocks at once, select the Auto update stock(s) 
options. 

Selecting Auto update stock(s), displays the following window:  

  

Indicate how you want to change the selected stocks: 

• By Amount: Add a fixed amount to each stock or subtract it from each stock. (Enter a negative 
number to decrease the price.) 

• By Percentage: Increase or decrease the price of each stock by a given percentage. (Enter a 
negative number to decrease the price.)  

• If you want the system to stop before updating the stock price so you can modify, confirm the 
update, or skip the change, select the Confirm each change option.  

Note  When you select the Confirm each change option, automatic backup is not 
performed during price change. 

3. If you want the pricing of blank stock recalculated based on the default blank stock markup in the 
Stocks and Sizes preferences, select the Re-calculate blank stock prices option. This will affect only 
those stocks that have the Auto Calculate Blank Stock check box selected (on the Pricing tab in the 
Stock Definitions window). 
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4. If you want the Adjust Digital Matrix & Select Default values (on the Definitions tab in the Stock 
Definitions window) adjusted by the same percentage as the stock, select the Auto adjust digital 
prices option. 

5. Click Update to start the price update process. 

6. If you selected the Confirm each change option, the Auto Update Stocks window displays the first 
stock that meets the criteria you specified, its current price and new prices. Click the right arrow at the 
top-right corner of the window to skip the stock and continue to the next stock. 

 
• Click Update to accept the new price and continue to the next stock. 

• Click Update All to accept the new price for all the stocks. 

7. Use the Restore Prices button on the Stock Lists window to reverse the price update. 

Updating Other Pricing 
In addition to updating stock prices, you may want to update the prices of all your press definitions, list price 
schedules, and/or charges and price lists by a particular percentage. You can either decrease or increase 
pricing. 

To update the prices of Charges: 

1. Select Pricing > Charge Definitions. 

2. Click the Change Prices button. The Change Prices for Charges window opens. 

3. In the Update All Charges by (%) field, enter the percentage by which you want to change prices. A 
positive number increases prices; a negative number decreases them. 
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4. If you also want to update price lists, select the Include Price List check box. 

5. Click OK to start the update and then click Yes to confirm that you understand the effects of the update. 

 
You will see the progress bar indicating the number of charges you are updating. 

 
6. When the update is completed, a message informs you that you have an opportunity to reverse the 

update. Click OK to continue.  
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PrintSmith Vision takes a backup during the price update, thereby providing an option to restore it back 
from the previous backups. 

7. Back in the Charge Definitions window, click Restore Prices to reverse the update. The Change 
Prices Backup opens. 

8. Select the previous backup to which you want to restore the price change and click Restore Prices. 

 
9. Click Yes to confirm the reversal of the update. 

To update the prices of Press Definitions: 

1. Select Pricing > Charge Definitions. The Press Definitions window opens. 

2. Select the tab (Offset, Web, B&W/Color, or Large Format) where you want to update the prices. 

3. Click the Change Prices button in the selected tab. The Change Prices window opens. 

Note Change Price is applicable to all the definitions in the selected tab. Individual definitions in a 
selected tab cannot be updated.   

4. In the Update (%) field, enter the percentage by which you want to change prices. A positive number 
increases prices; a negative number decreases them. 
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5. If you also want to apply the change to the matrix tables, select the Include Digital Matrix check box. 
(Discount and markup tables are not affected.)  

6. If you want the costing data to remain the same (for example, Monthly Payment, Monthly Maintenance, 
Labor/Copy, and so on), leave the Skip Costing Data check box selected. (Typically, you will not be 
updating all your costs by a fixed percentage.) 

7. Click OK to start the update and then click Yes to confirm that you understand the effects of the update. 

The rest of the steps are like that of the Charge Definitions.  

To update the prices of the List Price Schedule: 

1. Select Pricing > List Price Schedule.  

2. Click the Change Prices button in the List Price Schedule window. The Change List Price Prices 
window opens. 

3. To update the pricing in all your list price schedules, enter a percentage in the Update All List Price 
Schedules (%) field. A positive number increases prices; a negative number decreases them. 

 
4. Click OK to start the update, and then click Yes to confirm that you understand the effects of the 

update. 

The rest of the steps are like that of the Charge Definitions.  

Report Manager 
Report Manager is a separately licensed tool that is fully integrated with PrintSmith Vision and available from the 
Reports menu. You can use Report Manager to do the following: 

• Replace one of the standard PrintSmith Vision reports with one of your own reports. 

• Add and run custom reports. 

Important  If you plan to customize PrintSmith reports or create custom reports yourself, you must 
use i-net Designer.  

 In customer-hosted installations, i-net Designer must already be installed as described in 
the PrintSmith Vision - Installation and Upgrade Guide. In ePS-hosted installations, i-net 
Designer and other required components must already be installed and configured. 

• Download reports to a client computer and upload them to the PrintSmith Vision server (where all 
reports are stored). 

• Export data from a custom report. 

• Schedule custom reports. 

ePS-Hosted vs. Customer-Hosted Installations 
When editing or creating reports with i -net Designer, the procedure is somewhat different when PrintSmith 
Vision is ePS-hosted versus customer-hosted. 
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ePS-hosted Installations 
When PrintSmith Vision is hosted by ePS, you cannot edit or create reports with i-net Designer directly on the 
PrintSmith Vision server. Instead, you must install i -net Designer and other required components (such as 
Postgres and a demo database) on a client computer. 

You can then download reports from the PrintSmith Vision server to the client computer, edit the reports with i - 
net Designer, and upload the changed (or new) reports back to the server. 

Customer-hosted Installations 
When you are hosting PrintSmith Vision, you can work directly with report (.rpt) files in this folder on the 
PrintSmith Vision server: 

• Windows: C:\Program Files (x86)\EFI\PrintSmith\PrintSmith Reports\Crystalclear Reports 
12.1\reportRepository 

• Macintosh: Applications/EFI/PrintSmith/PrintSmith Reports/Crystalclear Reports 12.1/reportRepository 

Tip If PrintSmith Vision is customer-hosted, but you want to work on reports locally on a client computer 
(instead of on the PrintSmith Vision server), you can download report files from the PrintSmith Vision 
server, edit them, and then upload the changed reports to the server (so they are available to all users).  

Understanding the Report Manager Window 
• In the Report Manage window, you can view all the reports, list scheduled reports, or use the Category 

drop-down to view reports belonging to a category. 

 
•  For non-custom reports, you can override or download report. 

 
• For custom reports, you can print and export, set a schedule, download or remove the report from the 

Custom list. 
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• For custom reports, you can display only the scheduled reports, add a report to the Custom list, send 
the reports to your FTP site, upload report to repository and access them from there. 

 

Document Preferences 
In PrintSmith Vision, the information that makes up printed estimates and invoices comes from two sources: a 
set of document preferences and a report file (.rpt). 

Use the Document Preferences tab to control what to include in the invoice or estimate. For example, you can 
control whether your invoices include PO numbers, customer account numbers, date wanted, or prices for 
charges. 

Note  Document preferences define the format of a document, so the terms document preferences,  document 
format, and form are sometimes used interchangeably. 

Use the report to control the layout and appearance of the invoice or estimate (as well as some of its contents). 

PrintSmith Vision includes some pre-defined formats and associated reports that you can adapt to your needs. 
(For example, the Default Invoice format is associated with PSV_DefaultInvoice.rpt.) ePS recommends that 
you try these formats and then make any necessary adjustments. Alternatively, you can use the supplied formats 
as a starting point for new formats you create. 

Editing or Creating Document Preferences 
This section explains how to edit the settings for a particular document format or how to create a new format. A 
new format is based on an existing format so the procedure is identical except for step 3 below. 

1. In the Report Manager window, click the Document Preferences tab. 

  
2. To change the settings of an existing format: 

a. Under the Format Name column, click the format you want to edit. The Document 
Preferences window opens. 

The Page tab control the contents of the entire page. For information, see Page Tab. 
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Note  The Default Credit Memo format is just a variation of an estimate or invoice format. 
It is not for credit memos for journal entries.  

b. If you want to change the name of the format, edit it in the Format Name field. (This name is 
the way the format is identified elsewhere in PrintSmith Vision, for example, when selecting a 
format for an estimate or invoice.) 

c. The Associated Report field displays the name of the report file that is associated with the 
format. Unless you customized your invoices or estimates, leave this field as it is. 

Note  If you are selecting settings for credit memos, the Associated Report field is not 
displayed. 

3. To create a new format: 

a. Select a format type by clicking either the Invoice/Estimate or Credit Memo button. 

b. In the Format Name field of the Page tab, enter a name for your new format. (This name is the 
way the format is  identified elsewhere in PrintSmith Vision, for example, when selecting a 
format for an estimate or  invoice.) 

 
The Page tab control the contents of the entire page. For more information, see Page Tab. 

c. In the Associated Report field, select the name of the report file that you want to associate 
with the format. Unless you customized your invoices or estimates, leave this field as it    is. 

4. Click the Header tab to control the contents of the top of the document. For more information, see 
Header Tab. 

5. Click the Body tab to control the information that is included in the main part of the document. For   more 
information, see Body Tab. 

6. Click the Footer tab to control the contents of the bottom of the document. For more information, see  
Footer Tab. 

7. Click the Text tab to include a store name and/or message in the document. For more information, see  
Text Tab. 

8. Use the Upload/Download tab to upload and download report files when customizing documents. 

Note  When you select Credit Memo, some fields on the tabs are unavailable because they do not 
apply to credit memos. 

9. Click Save to save your changes. 

Page Tab in Document Preferences 
Use the Page tab in the Document Preferences window to control aspects of the entire page. 

1. Click the Page tab in the Document Preferences window. 
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2. Select or clear the following check boxes: 

• Print form image 

Select this check box to print an image of a form in addition to the data that fills out the form. 
Usually,  you will want to pre-print your document forms. PrintSmith Vision has several built-in 
images of the forms, however, that are supplied as part of the system. 

• Print document type 

Select this check box to identify the kind of document being printed (for example, Invoice, 
Estimate, or Memo), which eliminates the need for different forms for different types of documents. 
If you are also printing a form image, be sure to pick an image that does not contain a document 
type to avoid double printing it. You can also substitute the name of the format for the document 
type by selecting the Format name is document type check box. 

• Print custom order number 

Select this check box to include the suffix and/or prefix of the estimate or invoice number. This 
setting  does not apply to credit memos. (You define suffixes and prefixes with Order Number 
Format preferences: Preferences > Settings > Accounting > Order Number Format.) 

• Print store address 

Select this check box to include the store name and address that is defined on the Text tab in the 
Document Preferences window. 

• Add amount due line 

Select this check box to print the amount due, less deposits and payments, after the invoice total. 
This setting does not apply to credit memos. 

• Remove shipping line 

Select this check box to remove the shipping line from the document totals section.  

• Remove tax line 

Select this check box to remove the tax line from the document totals. Only select this if you are 
setting  up the system to hide the tax in individual line items. 

• Print tax name from table 

Select this check box to include the descriptive text for tax elements in the document. A tax table 
can include different tax rates that can each have a separate description. This is the text that is 
included in  the document. This feature is usually used in conjunction with Print total descriptions 
on the Footer tab. 

Print tax name from table is also useful when you must show more than one tax. When multiple 
tax lines are defined for the document and multiple tax elements are defined for the tax table, 
PrintSmith Vision tries to put all of the tax lines in the footer. If there are not enough lines available, 
it puts the extra lines in the body of the invoice just above the subtotal along with the descriptive 
text from the tax table. 
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• Print standard text in remarks 

Select this check box to print the standard text defined on the Text tab in the Document 
Preferences window. For example, you can include a marketing or seasonal message. (This 
standard text is unique to each document format.) 

• Hide alternate currency 

If you are using alternate currency, select this check box to hide alternate currencies. (This setting 
applies only if you defined an alternate currency.) 

• Format name is document type 

Select this check box to use the name of the format on the document instead of one of the 
PrintSmith Vision document types. For example, you can define a format named Packing List, use 
a built-in form image  that has no name in the image, and then select the Format name is 
document type and Print document type check boxes. When documents are printed using this 
format, Packing List is printed on them instead of Invoice or Estimate. 

Header Tab of Document Preferences 
Use the Header tab in the Document Preferences window to control the contents of the top of the document. 

1. Click the Header tab in the Document Preferences window. 

 
2. Select the Use Invoice address check box to print the invoice address from the customer account. To 

also include the delivery address, select the Use Delivery address check box. These settings do not 
apply to credit memos. 

3. Select the Use Statement address check box to print the statement address from the customer 
account. If the Use Invoice address check box is cleared, you can select the Use Master Billing 
address check box to use the address of the master account instead of the customer address. These 
settings do not apply to credit memos. 

4. Select either “Attn” first line or “Attn” last line to indicate whether the name of the contact person or 
department should be placed at the top or bottom of each address block. 

5. Select the Postal Bar Code top or Postal Bar Code bottom check box to indicate whether the postal 
bar code from the zip code of the address is placed at the top or the bottom of each address block.  

6. Select or clear the following check boxes: 

• Show phone number 

Select this check box to print the phone number at the bottom of each address block. 

• Show FAX number 

Select this check box to print the FAX number at the bottom of each address block. 

• Show E-Mail address 
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Select this check box to print the e-mail address at the bottom of each address block. 

• Show PO number 

Select this check box to include the PO number in the document. Normally, this check box should 
be  selected. This setting does not apply to credit memos. 

• Show reprint number 

Each time a document is printed, PrintSmith Vision keeps track of the number of times the 
document was printed. Select the Show reprint number check box if you want to include the 
number of times that the document was printed just below the document number. This setting does 
not apply to credit memos. 

• Show account number 

Select this check box to print the customer account number on the document. This setting does not 
apply to credit memos. 

• Show external ref. no. 

Select this check box to print the customer’s external reference number on the document. This 
setting  does not apply to credit memos. 

• Show company ID 

Select this check box to print the ID that identifies your company. The company ID and its label are 
set  with your Company preferences (Preferences > Settings > System > Company). This setting 
does not  apply to credit memos. 

• Show Web Reference 

If you handle Web orders (for example, from MDSF), select this check box to include the  reference 
number from a Web order. This setting does not apply to credit memos. 

7. All documents must have a date. Select one of the following: 

• Use Order date  

To print the date the document was ordered. (The order date can be changed in a document.) 

• Use Today’s or Pickup date  

To print the date the invoice was picked up or to print today’s date if a pickup date is unavailable. 

• Use Today’s date  

To always print the current date on the document. 

Body Tab of Document Preferences 
Use the Body tab in the Document Preferences window to control the information that is included in the main part 
of the document. 

1. Click the Body tab in the Document Preferences window. 
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2. Select the Show description check box to include job descriptions and notes in the document. 

Normally, this check box is always selected. 

3. Select the Show stock check box to include a description of the stock. When the Show stock check 
box is selected, four additional check boxes are available to control what the stock description includes: 

• Hide original count  

Select this check box to remove originals from the stock description. 

• Hide number up  

Select this check box to remove the up count from the stock description. 

•  Hide color count  

Select this check box to hide all references to colors in the stock description.  

• Add folded size  

Select this check box to add the folded size to the job data displayed. 

Note  If all three Hide check boxes are selected, only the stock name is printed. The Show stock 
settings do not apply to credit memos. 

4. Select or hide the following check boxes: 

• Show prices 

Select this check box to print the total for all line items that would otherwise show a price. If 
selected, no prices are printed for any line items. Only totals for the entire document are shown. 

Note  You can use the Show prices check box together with the No Totals check box on the 
Footer tab to set up a format for packing lists that contains only descriptive information 
without any prices. 

• Hide multi-part jobs 

Select this check box to automatically hide all jobs that are part of a multi-part job, except for the 
main (control) job. The prices of all hidden jobs are included in the main job price. This setting does 
not apply to credit memos. 

• Hide multi-part job prices 

Select this check box to hide the prices on multi-part jobs and show the entire total in the main job. 
Use  this to show all the parts of a multi-part job without breaking out the prices for each part. This 
setting does not apply to credit memos. 

• Show M price in unit column 

Select this check box to print the unit price multiplied by 1000 in the unit column. Otherwise, the 
unit price is printed. This setting does not apply to credit memos. 

• Hide charges 
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Select this check box to hide all job level charges. Invoice level charges (charges that are not part 
of a  job) are handled differently – they can only be hidden if they are markups. The price for each 
hidden charge is added to the job price. 

• Hide charge prices 

Select this check box to hide the prices, but not the quantity and description of all job level charges. 
The price is added to the price shown for the job to which the charge belongs. If the charge would 
otherwise  be hidden because it was manually hidden, or the Hide charges check box is selected, 
the charge is hidden. 

• Hide job markups 

Select this check box to hide markup charges for a job. The total of the hidden charges is added to 
the  job price. This setting does not apply to credit memos. 

• Hide invoice markup 

Select this check box to hide all invoice-level markup charges. The markup amount is added 
proportionally to all prices that are printed. This setting does not apply to credit memos. 

• Hide cust discount 

Select this check box to hide the customer discount by adding it proportionally to each line item that 
shows a price. This setting does not apply to credit memos. 

When hiding customer discounts, you may want to consider not showing detailed prices to avoid 
problems with accumulated rounding errors.  

• Hide tax in line items 

Select this check box to add the tax to the price of each line item that has a price. Use this as part 
of a  system-wide setup that adds the tax to all calculated prices. 

 Note This feature is intended primarily for international use.  
• Adjust qty for overs 

The Overs/Unders field in the Job window allows you to enter an amount by which the delivered 
quantity differs from the amount originally ordered thus adjusting the price. Select the Adjust qty 
for overs check box so that the quantity shown on the printed document matches the quantity that 
was delivered to the customer. This setting does not apply to credit memos. 

Note The Adjust qty for overs check box does not affect the overs/unders calculated on the 
unit price for the quantity ordered, just what is shown in the document. 

• Hide quantity 

Select this check box to remove all job quantities from the document. This setting does not apply to 
credit memos. 

• Show tracking bar code 

Select this check box to include the tracking bar code (if using Tracker) in the document. This 
setting does not apply to credit memos. 

Footer Tab of Document Preferences 
Use the Footer tab in the Document Preferences window to control the contents of the bottom of the document. 

1. Click the Footer tab in the Document Preferences window. 
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2. Select or clear the following check boxes: 

• Show notify type 

Select this check box to print the shipping method that was requested. This setting does not apply 
to  credit memos. 

• Show date notified 

Select this check box to print the date the customer was contacted. (This date is updated via the 
Notify Customer option in the Pending Documents window.) This setting does not apply to credit 
memos. 

• Show date wanted 

Select this check box to print the date the customer wanted the order. This setting does not apply 
to  credit memos. 

• Show proof date 

Select this check box to print the proof date. This setting does not apply to credit memos. 

• Show file original 

If the File originals option is selected in the Invoice Summary tab, select the Show file original 
check box to print File Originals. This setting does not apply to credit memos. 

• Show COD/Charge 

Select this check box to indicate whether the customer is allowed to charge the order or must pay 
upon delivery. Either Charge or COD is printed in the remarks block. This setting does not apply to 
credit memos. 

• Show sales rep 

Select this check box to print the name of the sales representative assigned to the document. 

• Add Deposit Total 

Select this check box to add a deposit line in the Document totals box instead of displaying the 
information in the Deposit box. This setting does not apply to credit memos. 

• Show remarks 

If special instructions are entered in the Invoice Summary tab, select this check box to include 
these instructions in the document. 

• Show payment due date 

Select this check box to include the payment due date (DATE DUE) below AMOUNT DUE in the 
totals section. (This setting does not apply to credit memos.) 

• Show payment due 
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Select this check box to print the amount due. This setting does not apply to credit memos. 

• Subtotal multi-page 

Select this check box if you want to print the subtotal on each page at the bottom of the total block 
if the  document has multiple pages. 

• No totals 

Select this check box to prevent any total from being printed in the document. Generally, select this 
check box only for estimates. This feature is useful if you are producing multiple quotes for the 
same job  by duplicating them. 

• Print total descriptions 

Select this check box so that PrintSmith Vision supplies the text for Sub-Total, Tax, Total, and so 
on, and the  text can be removed from the pre-printed form. This setting does not apply to credit 
memos. 

• Show Taken By 

Select this check box to print the name of the person who took the order. This setting does not 
apply to credit memos. 

• Show title 

Select this check box to print the description (name) of the document. This is the same description 
that  is shown in account history. This setting does not apply to credit memos. 

• Print tax ledger 

The Print tax ledger check box and the Print tax table names/codes, Print tax rates, and Print tax 
references check boxes apply only if you are using line-item taxation and want to include tax 
breakdowns in your documents.  

• Select the Print tax ledger check box so the document at a minimum includes the amount 
being  taxed for each tax table, as well as the tax amount. 

• Select the Print tax table names/codes check box to include the abbreviated names of tax 
tables (and codes if using) in the document. (If you associated the format with a TaxDetails 
report, the names will be included in the Tax column; if you associated the format with a 
TaxLedger report, the  names will be included in the tax ledger in the bottom left corner of the 
document.) 

• Select the Print tax rates check box to include tax rates in the tax ledger section of the 
document. (This check box does not apply if you associated the format with a TaxDetails 
report.) 

• Select the Print tax references to include a tax reference (legend) in the Tax column and the 
tax ledger section of the document. (This check box does not apply if you associated the 
format with a Ta Details report.) 

Text Tab of Document Preferences 
Use the Text tab in the Document Preferences window to specify two pieces of text: 

• Store information (this applies to all document formats). 

• Standard text that can be used for greetings, reminders, and so on (this can be different for each 
document format). 

To provide text for documents 

1. Click the Text tab in the Document Preferences window. 
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2. In the Store name to print on invoice field, enter the text that is printed at the top of the document 

when the Print store address check box is selected on the Page tab in the Document Preferences 
window. If you do not enter any text in the Store name to print on invoice field, the text is taken 
from  your Company preferences. 

Note Keep in mind that this store name text applies to all document formats.  
3. In the Standard Text to put in remarks block field, enter the text you want printed at the bottom 

of the  remarks block of the document if the Print standard text in remarks check box is selected 
on the Page tab in the Document Preferences window. Examples of standard text might include 
Thank you for your order or Happy Holidays. (The standard text can be different for each 
document format.) 

Upload/Download Tab of Document Preferences  
In PrintSmith Vision, upload the report file you edited and download the report file you want to edit. 

1. Select Document Preferences in Report Manager. 

2. Click the Upload/Download tab. 

3. Do any of the following: 

a. Select the report you want to edit and click Download. The file is placed in your default 
Downloads folder. Then use i-net Designer to edit the report. 

b. Click Upload and select your file. (Its name cannot begin with PSV_.)  

Using Document Preferences 
Once you have formats that you like for estimates and invoices, set a default format for both estimates and 
invoices in the Estimator Printing preferences. The default format is then automatically selected in the Format 
drop-down list in the Estimate or Invoice Summary tab, but you can always select a different format there if 
necessary. 

Overriding a Standard Report with Your Own Version 
If you want one of the standard PrintSmith Vision reports to include different information, you can edit a copy of 
the report with i-net Designer and then use Report Manager to override the standard report with your version. 
This version will then be available in PrintSmith Vision wherever the original PrintSmith Vision report was 
available. 

“Reports” in PrintSmith Vision include purchase orders, and job tickets, as well as traditional reports. To find out 
which reports you can override with your own, select Reports > Report Manager and check the listed reports for 
each Category (for example, System or Pricing). 

To override a standard report with your own version: 
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Note ePS strongly recommends that you always leave the original version of a report file in case you want to 
revert to it. 

1. If PrintSmith Vision is ePS-hosted: 

a. Download the report from the server. 

b. Start i-net Designer and select File > Open to open the report you downloaded. 

c. Select File > Save As and enter a name for your version of the report (it cannot begin with 
PSV_).  

• If PrintSmith Vision is customer-hosted: 

a. If you want to edit the report on a client computer, download the report from the server 
and rename it. 

b. Start i-net Designer from the shortcut on the desktop (Windows) or from the dock 
(Macintosh). 

c. If you are working on a client computer, select File > Open and locate the copy of the 
report (the one you downloaded and renamed). 

2. Edit the report and then save your changes. 

3. In PrintSmith Vision, select Reports > Report Manager. The Report Manager window opens. 

4. Select a Category and then select the report you want to override. 

5. Click the three-dot ellipsis in the row of the report and click Override. 

 
If you have already uploaded your customized report (.rpt) file to the PrintSmith Vision server, click 
Override from server. Then select the uploaded report from the list that is displayed. 

6. Locate your customized report (.rpt) file and click Open. 

The name of your report file is now displayed in the Report File Name column. 

 
Your report will now run whenever you use the same method that you used to run the original PrintSmith Vision  
report.  

Tips If you want to revert back to the default report (as supplied by PrintSmith Vision), select the report and 
click the three-dots ellipsis and click Remove. 

If you already overrode a report, but have a different version you want to use, first remove the report you 
previously supplied (which restores the default report supplied by PrintSmith Vision) and then override the 
PrintSmith Vision report with your latest version. 
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Adding and Printing Custom Reports 
You can also use i-net Designer to create custom reports. You then add the custom reports to Report Manager 
and run them from there. 

Tip ePS has created numerous custom reports for your use. Before creating your own, check the Custom 
category in Report Manager to see what already exists. Also click Add when the Custom category is 
displayed to see if new custom reports are available to be added. 

1. Use i-net Designer to create a custom report. 

2. If PrintSmith Vision is ePS-hosted, upload the report to the PrintSmith Vision server. 

Tip If PrintSmith Vision is customer-hosted, but you created a custom report locally (on a client 
computer), you must upload it to the PrintSmith Vision server. 

3. Add the custom report to Report Manager: 

a. In PrintSmith Vision, select Reports > Report Manager. 

b. In the Category field, select Custom. The Report Manager window now includes some 
additional buttons and fields. All custom reports that are available (including those 
supplied by ePS – identified by PSV_ prefix) are listed in the left pane. 

c. Click the Add button. 

 
d.  In the Add Reports to Custom window that opens, find your custom report, and click 

Add. 

 
4. The report is now listed in the Report Manager window. 

Note To remove a custom report from Report Manager, click the three-dots ellipsis in the row of the 
report and then click Remove from Custom. (The report itself is not deleted.) 



260 • Productivity Suite | PrintSmith Vision User Guide 

 

 

5. To run the report: 

a. Click the three-dots ellipsis in the row of the report that you want to print and then click Print 
and Export. 

 
b. A report may include search rules, which are criteria such as dates to control what a 

report includes. 

If a report contains search rules, a window opens showing the search fields, for example, 
a range of dates. (If no search rules were defined, the report is just generated.) 

 
c. Enter a value in the When field is fields using the specified format (for example, mm-dd-

yyyy for a date). 

The following date shortcuts are available for date fields so you can avoid entering specific 
dates. (These shortcuts are case-sensitive.) 

Short-
cut 

Description 

/D/ Current date 
/YD/ Yesterday’s date 
/SW/ Week starting date 
/EW/ Week ending date 

/LSW/ Last week’s starting date 
/LEW/ Last week’s ending date 
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/SM/ Month starting date 
/EM/ Month ending date 

/LSM/ Last month’s starting date 
/LEM/ Last month’s ending date 

/SY/ Standard year starting date 
(Jan 1) 

/EY/ Standard year ending date 
(Dec 31) 

/LSY/ Last year’s starting date 
/LEY/ Last year’s ending date 
/BSY/ Business year starting date ** 
/BEY/ Business year ending date ** 

/LBSY/ Last business year’s starting 
date ** 

/LBEY/ Last business year’s ending 
date ** 

** The business year start and end dates are based on the fiscal year specified in your 
Business Calendar preferences. 

d. Click Print. The report opens in a preview window from which you can print it. 

Note Custom reports that you add to Report Manager can only be run from Report Manager. 

Downloading and Uploading Reports 
If you want to customize documents and reports, and PrintSmith Vision is ePS-hosted, you must use Report 
Manager both to download report files from the PrintSmith Vision server and to upload them to the server. 

If PrintSmith Vision is customer-hosted, you do not need to download or upload reports unless you want to work 
with reports on a client computer. In this case, you must use Report Manager both to download report files from 
the PrintSmith Vision server and to upload them to the server. 

Important This section just describes how to download and upload report files – how to get them from and to 
the PrintSmith Vision server. You must then use i-net Designer to edit the reports. 

Downloading Report Files from Server 
When you download report files from the PrintSmith Vision server, they are placed in your default Downloads 
folder. 

Tip The location of the Downloads folder is specified in your browser settings. For example, in Chrome, this 
is one of the advanced settings; in Firefox it is one of the general options. 
1. In PrintSmith Vision, select Reports > Report Manager. 

Report Manager opens and lists all the report files that are available. 

2. Click the three-dots ellipsis in the row of the report that you want to download. 

3. Click the Download option. 
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The file is now available in your Downloads folder 

Uploading Report Files to Server 
After you finish working on a report that you downloaded or after you create a new custom report, you must 
upload it to the PrintSmith Vision server if it is ePS-hosted or if it is customer-hosted, but you are working on a 
client computer. (If PrintSmith is customer-hosted and you work on reports on the server, you can just copy the 
files to the appropriate repository on the PrintSmith Vision server.) 

Note You cannot upload a report file which has a PSV_ prefix as part of the name. This is reserved for reports 
supplied by ePS. 

  

1. In PrintSmith Vision, select Reports > Report Manager. The Report Manager window opens 
and lists all the report files. 

2. Click the Upload icon to upload. 

 
3. Locate the report file you want to upload and cl ick Open. The system confirms the upload. 

4. Depending on the type of report you uploaded, complete any additional steps. For example: 

• If this is a custom report you are adding to Report Manager, select the Custom 
category, click the +Add button and select the report. You will then be able to run the 
report. (Until you add it, the report cannot be run.) 

• If you are replacing a standard report with one of your own, see “Overriding a Standard 
Report with Your Own Version”. 

Exporting Data from a Custom Report 
When you add a custom report to Report Manager, you can export data from the report to a text file. You can 
then import this data into other applications, for example, a Microsoft® Excel® spreadsheet. Just like when 
printing reports, you can apply search rules to the data that is exported. 

When you export a report, the resulting text file is formatted according to what is specified in the Default CSV 
Separator and Default CSV Quote Character fields in your International preferences. If these fields are blank in 
the International preferences, the CSV field separator defaults to comma (,) and the quote character used to 
enclose text strings defaults to double-quote (“), which are the standard delimiters in the U.S. In other countries, 
different delimiters are used and can be specified in the International preferences field and text delimiters 
specified in your International preferences. In addition, numeric data that is exported from reports is formatted 
according to the Decimal Delimiter and Thousands Delimiter specified in your Numbers preferences. 

To export data from a custom report 

1. In PrintSmith Vision, select Reports > Report Manager. The Report Manager window opens 

2. In the Category column, select Custom. 

3. Click the three-dots ellipsis in the row of the custom report you want to export. 

4. Click Print and Export. 
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If the report has search rules, a window opens where you can identify the date range for the 
report or account ID.  

You also select the file format. 

 
5. Click Export to export the data. 

Scheduling Custom Reports 
You can schedule custom reports from Report Manager. The reports can run at a time and frequency of your 
choice, and they can be generated as PDF files for printing and/or as CSV (Excel) files. By scheduling reports, 
you ensure that they run automatically and regularly without you having to remember to run them. 

1. In PrintSmith Vision, select Reports > Report Manager. The Report Manager window opens 

2. In the Category column, select Custom. 

3. Click the three-dots ellipsis in the row of the custom report you want to set a schedule. 

4. Select Schedule. 

The Set Schedule window opens where you can select the frequency for the report. 

 
5. Select one of these frequencies for the report: 

• Select Daily and a Time to run the report every day at a particular time, for example, at 17:00. 



264 • Productivity Suite | PrintSmith Vision User Guide 

 

 

• Select Weekly, a Day of week, and a Time to run the report every week on a particular day 
and at a particular time, for example, every Friday at 19:00. 

• Select Monthly and one or more of the following: 

• The Beginning check box and a Time to run the report on the first day of the month at a 
particular time, for example, 19:00. 

• The Ending check box and a Time to run the report on the last day of the month at a 
particular time, for example, 19:00. 

• A Day of the month and a Time to run the report on a particular day of the month at a 
particular time, for example, the 15th day of the month at 19:00. 

Note If you select more than one Monthly setting (as shown in the figure below), the 
Time is always the same. 

• Select Selected Days, the days you want, and a Time to run the report on particular days of 
the week at a particular time, for example, on Wednesday and Friday at 17:00. (This is useful 
for reports you want to run more than once a week.) 

• Select Selected Hours and the hours you want to run the report, for example, 1 AM and 7 PM. 
(This is useful for reports you want to run more than once a day.) 

6. If a report has search fields, in the When field is column, enter the criteria you want to use to 
include data in the report.  

7. Select the Export as PDF check box to save the report as a PDF file and/or select the Export as 
CSV check box to save the report as a CSV (Excel) file. 

8. Click Schedule. 

After you schedule a report, an icon in green indicates its scheduled status in the list of custom reports 
so you can quickly see what you already scheduled. 

 
The report will also be displayed in the Scheduled Report list. 

Once reports are being generated according to the schedule you set, from Report Manager you can: 

• Download reports. 

• Delete any reports you no longer need. For example, if you run some reports daily, you will quickly 
have many versions of the reports so you may want to delete older versions. 

• Change the schedule. 

To download or delete reports that were generated 

1. In the Report Manager window, select Custom in the Category column. 

2. Click the Show Scheduled Reports option. 

The scheduled reports that were generated to date are listed. 

Note If a report is scheduled but has not run yet, it will not be listed in this window until it has run.  
3. To find a particular report, use the search fields in each column header. 

4. If you run certain reports frequently, and no longer need older versions, delete it by clicking the 
three-dots ellipsis in row and selecting Remove from Custom. 

5. Click Download to download the report.  
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To change the schedule 

You can change the schedule for a report. For example, you may want to change the frequency at which the 
report runs, change search field criteria such as the range of dates included in the report, or indicate that you 
want to export the report to a CSV file instead of (or in addition to) having the report in PDF format. You can also 
unschedule the report altogether. 

1. In the Report Manager window, select Custom in the Category column. 

2. Click the three-dots ellipsis in row of the report you want to reschedule and click Change 
Schedule. 

3. Adjust the schedule as necessary, for example, change the frequency at which the report is 
generated or change search field criteria. 

Note To unschedule the report, select No Schedule in the Repeats field. Alternatively, you can 
click Delete Schedule to remove the schedule and also remove all the reports that were 
generated to date. 

4. To review your changes, click Preview. 

Note  When you save a file, it is automatically saved in your Downloads folder. 
5. Click Change Schedule. 

If you want to use your FTP site for reports 
If you have an FTP site and want reports made available on the site, you should configure the FTP site before 
you start scheduling reports. 

1. In the Report Manager window, select Custom in the Category column. 

2. Click the (S)FTP button. The Set Up FTP for Scheduled Reports window opens. 

  
3. Complete the fields: 

• FTP Host name: host name of the FTP server 

• FTP Port number: port number on which the FTP server is running 

• User Name: username to access the FTP server 

• Password: password to access the FTP server 

• FTP Path: if report files should be uploaded to the root folder of FTP server, leave this field 
blank; otherwise, enter the path to a specific folder using / (forward slash) as a delimiter 
between folder names. 

If you use SFTP site, select the SFTP option and complete the fields. 

4. Click Save. 
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Re-Order List Report 
You can enter a re-order date in the Invoice Summary tab for any invoice. You can then track your re-orders 
during a specified period with the Re-Order List report. 

Note If you copy an order from history, the system automatically calculates its re-order dates.  
1. Select Reports > Reorder List. The Re-Order List window opens. 

2. In the Start Date field, enter the beginning date for which you want to see re-orders.  

4. In the End Date field, enter the ending date or leave the field blank to include all re-orders after the start 
date.  

 
5. Click OK. The Re-Order List report opens in a preview window. 

 

Account Ranking 
The Account Ranking report lists accounts in order by different criteria, for example, by balance, number of 
orders, or sales. You can save these rankings, so they are available elsewhere in PrintSmith, for example, on the 
Sales Info section in the Accounts window (AR (Account Receivable) > Accounts). 

1. Select Reports > Account Ranking. The Account Ranking window opens. 
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2. In the Rank Accounts By drop-down field, select the way you want to see the accounts ordered: 

Balance, Sales current month, Sales current year, Sales prior year, Number orders, Sales by 
sales category, Sales by date range, or Sales by category and date. 

 
3. If Rank Accounts By is set to Sales by sales category or Sales by category and date, in the 

Limit to Sales Category field, select the sales category for the report. (The sales categories 
come from your preferences: Preferences > Accounting > Sales Categories.) 

4. If Rank Accounts By is set to Sales by date or Sales by category and date, under Date Range, 
enter the dates for the ranking in the From and To fields. 

5. Under Include Accounts, select the type of account to include in the ranking: Customer, 
Prospect, or both. 

6. If you want to save more than one ranking based on different criteria, click Rank Storage, and 
select a Custom ranking. You can save up to six different custom rankings. 

7. After you specify all the ranking criteria, click Run Ranking to generate the results. 

8. Sort the ranking results by clicking the column headers. 

9. To print the report, click Print. 

Note Account ranking will be saved and printed when the print button is clicked. 
10. To save the account ranking (so it is reflected in customer account records): 

a. Click Save. 

b. Click Yes to confirm. 

You can then see the ranking in the Sales Info section of the Accounts window. 
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Customer List 
The Customer List report provides information about your customers and/or prospects, for example, addresses, 
account settings, and balance summaries. 

 
To run the Customer List report: 

1. In the PrintSmith Vision, click Reports > Customer List. The Customer List window opens. 

2. In the Customer List drop-down field, select the type of report that you want to generate. 

Note As you change your selections in the Customer List window, the report is immediately 
updated to reflect the changes. 

There are several variations of the Customer List report that are available. 

• Balance Summary for a summary of the current account balances for all customers. 

• Sales Summary for a summary of the sales amounts and average orders for each account by 
month and year. 

• Address List for the invoice and statement addresses for each account. 

• Posting Dates for a report on the various dates that PrintSmith Vision uses to track accounts, for 
example, estimate date and payment date. 

• Account Profile for a summary of some key settings for each account, for example, type and 
credit limit. The Account Profile report includes the following information: 

Resale - Shows the resale ID (if any). Accounts with a resale ID are not charged sales tax. 

Bus Type - Shows the type of business the account represents. 

Table - Shows the name of the tax table that is assigned to the account. 

Type - Shows the type of the account, for example, charge. 

PO Req - Indicates whether a PO is required on invoices for the account. 

Bill - Indicates whether a statement is generated for the account. 

CR Limit - If a credit limit was specifically set for the account, shows the amount of that limit. 
Default means that the system-wide credit limit is used. 

Disc% - Shows any automatic discount percentage specified for the account. 

Interest - Shows the rate used to calculate finance charges on statements. Default means 
that the system- wide rate is used. None means that no finance charge is ever calculated on 
the account. A percentage indicates the rate that is specified for the account. 

• Sales Rank Month for a report on the sales volume and relative standing of each account in the 
current month. A monthly closeout updates these statistics. 

• Sales Rank Year for a report on the sales volume and relative standing of each account for the 
current year. 

• Collection Follow-up for information that is useful for calling customers about their outstanding 
balances. 

3. In the Sort by field, select the way you want to sort the report: 
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• Account Name The name of the account. 

• Account Number The number of the account. 

• Account Status The status of the account (for example, current or past due). 

• Business Type The code that you can enter in the customer account (on the Settings tab) to 
categorize accounts, for example, SIC code or ABC method of ranking. 

• Account Type The type of account, for example, cash only or charge. 

• Sales per Month The sales for the account by month. ePS recommends that you sort this way 
after running a monthly closeout; otherwise, the monthly sales figures may not be correct. This 
is also useful for running a Sales Rank Month report. 

• Sales per Year The sales for each account by year. (This is useful for running a Sales Rank 
Year report.) 

• Sales Rep The sales representative. Balance The current balance, with the account with the 
highest balance shown first. (This is useful when running a Balance Summary report. 

4. To see the history for an account, click the account number or name in the list. The Account or Prospect 
window opens. 

5. Use the Include Customers and Prospect options to filter the list based on accounts and prospects.  

6. Click Download as CSV to save the report as a CSV (Excel) file. 
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Account Utility 
Account Aging 

The purpose of account aging is to determine the status of customer accounts and warn you of accounts 
that may need collection action. An accurate gauge of your receivables is essential to running a healthy 
business. 

When PrintSmith Vision ages an account, it looks at all of the open debits (money owed to you) as well as 
all open credits (money you owe to the customer or did not yet apply to a debit) to determine how long the 
customer has owed you money and when you last received a payment from the customer. Using this 
information, PrintSmith Vision adjusts the account status according to rules that you set. 

You can age accounts when you generate statements (Accounting > AR (Account Receivable) > Account 
Utility), but you can also do so without generating statements as described here. 

Procedure for Aging Accounts 
1. Select Accounting > AR (Account Receivable) > Account Utility. The Account Utility window 

opens. From this window you can generate statements age accounts. To age without generating 
statements, select as shown below: 

 
The Aging window opens. 

 
2. The Closing Date field is automatically set to the current date. Change it if necessary. This is the 

date that PrintSmith Vision uses to determine the aging status of accounts. Except for credits, 
open items with posting dates later than this date are ignored in the aging process. 

3. Use the Output tab to control how each account is handled during the aging process.  

4. Click the Accounting tab to define how aging is performed and what to do about changing the 
customer account status as a result of aging. 

5. Click the Reports tab to generate a summary report of aging. 

6. Click OK to initiate the aging process. 

7. If you selected the Pause after each option on the Output tab, information about each account is 
displayed. If you also selected Ask before changing status on the Accounting tab, click Yes or 
No to change the status of the account based on the aging. 

Note To cancel the aging procedure, close the window (by clicking X). 
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8. If you chose to generate a report, a preview window opens. Click to print the report. 

Output Tab for Account Aging 
Use the Output tab in the Aging window to control how each account is handled during the aging process. 

1. Select the Age master billing accounts option to age a master billing account and all its sub-accounts 
as a single account. 

Note The aging summary on the Sales Info section in the Customer Account window shows aging 
amounts that can be considerably higher than the account balance because the summary 
includes the amounts for all the sub- accounts. This is normal. 

2. If you selected the Age master billing accounts option, select the Skip sub-accounts option so 
that sub-accounts are not aged (based on the assumption that the master account is responsible 
for payment). 

3. Select the Pause after each option so that PrintSmith Vision stops after each account so you can 
review the results. 

4. Select the Include zero balance accounts option to include all accounts, regardless of balance, in 
the aging report. 

Accounting Tab for Account Aging 
Use the Accounting tab in the Aging window to define how aging is performed and what to do about changing 
the account status as a result of aging. 

 
Note The aging period preferences (Preferences > Settings > Accounting > Aging Periods) also define aging 

rules. 
1. Select one of the following to control whether the account status is changed: 

• Always change account status so the account status is automatically changed based on 
your aging rules. 

• Ask before changing status so you can review the aging totals, the old status, and the 
proposed status in a summary window and decide if you want to update the account status. 

• Never change account status if you never want the account status changed. 

2. Select one of the following to determine which date is used to calculate the account status: 

• Status from Posting Date to use the date of the oldest open debit to determine the account 
status when aging is performed. 

• Status from Payment Date to use the date of the last payment received (as well as the status 
of each open item with a partial payment) to determine the account status. 

3. Select or clear the following options: 

• Freeze after 90 days 

Normally, the proposed account status is Current, Past Due, or Delinquent. Select this to 
freeze the account status if there are open items older than the oldest aging period (by default 
this is 90 days). When an account is frozen, you can only post payments to the account – no 
further work can be accepted for the account. 

• Unfreeze after 90 days 
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Select this so the status of a frozen account is automatically changed after 90 days if payment 
is made. (You can also change this status manually on the Credit Control tab in the Customer 
window.) 

•  Mark inactive accounts 

Select this to identify inactive accounts. An account is considered inactive if nothing was 
posted to the account for the inactivity period specified in your preferences (Preferences > 
Settings > Accounting > Credit/Defaults). When you see which accounts are inactive, you may 
want to contact the customers and find out the reason for the inactivity. 

• Inactive account to prospect 

Select this to reclassify inactive customer accounts as prospect accounts. When this option is 
selected, and you perform an account aging, all inactive accounts are converted to prospect 
accounts. 

Caution Use this feature with care. You cannot easily reverse changes to account classification 
(customer to prospect). Also, this feature does not consider how long a customer has 
been inactive; it simply changes all inactive customers to prospects. 

Reports Tab for Account Aging 
Use the Reports tab in the Aging window to control whether a summary report of the aging is printed, control the 
detail it includes, and indicate whether you want to save the report for future reference. 

 
1. Select the Print summary report option to generate a summary report after the aging is 

complete. 

2. If the Print summary report option is selected, select or clear any of the following options: 

• Detailed report 

Select this to include in the report the details of each open item in the account within the aging 
period specified by the closing date. 

• Add collection information 

Select this to include the sales representative, contact name, phone number, last payment 
date, and amount in the report. This information makes the report more valuable as a 
collection tool. 

• Alternate lines in aging columns 

If the amounts in the report are very large some of the amounts may creep into adjoining 
columns and make the report unreadable. Select this to print every other amount on alternate 
lines. (Alternate lines can make the report much longer.) 

3. The account aging report is not saved automatically. To save the report so you can reprint it later, 
select the Save report option. The report is named Account Aging followed by the date you 
performed the aging. 

Reprinting Account Aging Reports 
If you choose to generate an account aging report and also selected the Save report option on the 
Reports tab in the Aging window, a copy of the report is saved so that you can reprint it later if necessary. 
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A saved report is named Account Aging followed by the date you generated the statements, for example, 
Account Aging – 04-12-2022. 

To reprint a saved account aging report 

1. In the Account Utility window, select the Aging and Statement Reports icon. 

 
The Reports window opens. 

 
2. Select the report you want to reprint. 

3. Click Open. The report opens in a preview window from which you can print it. 

Verifying Accounts Receivable 
In the Account Utility window, figure out the reason if the Account Balance is greater than Total Open Invoices 
for a customer account. The Balance in Account is taken from the customer account and Total Open Invoices 
is the sum of all the open invoices for the account. 

Examine the account history (History > Account History) to see if an invoice was not posted.  

Important Although you can click Fix in the Account Utility window to replace the account balance with the 
total of the open items, you should always try to figure what is causing the discrepancy. Contact 
PrintSmith Vision Support if necessary. 

  
If you want to update the aging totals stored in a customer account so they match the balance in the account, 
click Age Now.  
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Generating Statements 
Statements are optional but are an extremely important part of Accounts Receivable. You can review the status 
of accounts by aging them and apply finance charges as necessary. Typically, you generate statements at 
regular intervals (such as monthly) so that you can let customers know of their outstanding balances. 

You can either print or e-mail statements.  

Tip You can add your logo to printed or e-mailed statements (or make other minor formatting changes). You 
can print statements in two currencies if the Use alternate currency system preference is selected 
(Preferences > Settings > System > Alternate Currency). 

If you want to include accounts with zero balance, enable the Include Zero Balance Account option in the 
Account Utility window. 

 

General Procedure for Generating Statements 
1. Select Accounting > (AR) Accounts Receivable > Account Utility. Then click the Generate 

Statements button. The Generate Statements window opens. The top and bottom sections of this 
window include general information. Tabs in the window let you control what the statements 
include. 

 
Note If you are printing statements instead of e-mailing them, the Email button at the bottom of the 

window changes to Print. (You can control whether statements are printed or e-mailed on the 
Reports tab.) 

2. Complete the general information in the top section of the window: 

a. The Closing Date field defaults to the current date; this is the date shown on the statement. 
PrintSmith Vision ignores all open debit items with posting dates after the closing date. Open 
credit items after the closing date are also not included on the statement but are considered in 
the calculation of the aging status and finance charges since these are based on account 
balance. If necessary, enter a different date. 

b. The Payment Date field shows the due date of the payment. If necessary, change the date or 
remove it so the date is not included in the statement. 
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c. Enable the Calculate Finance Charge option if you want PrintSmith Vision to calculate 
finance charges. (Then make some further choices on the Accounting tab about how you 
want the charges calculated; see “Accounting tab for Statements”.) 

Notes PrintSmith Vision determines the rate used for the finance charge by first looking at the 
customer account. If Never calculate finance charges is selected (on the Credit/Tax 
Control tab in the customer Account window), no finance charge is calculated for the 
account. If the account has a special finance rate defined, the rate from the account is 
used. Otherwise, the system default rate is used from your PrintSmith preferences 
(Preferences > Settings > Accounting > Credit/Defaults). When you generate a master 
billing statement, sub-account settings for finance charges are ignored; only the master 
account settings are considered. 

When finance charges are posted, an entry is made on the register tape. If you discover an 
account was charged a finance charge in error, void the transaction before doing a closeout. 

d. If you enabled the Calculate Finance Charge option, select or clear any of the following 
options to further refine how the finance charge is calculated: 

• Only apply to items past due 

Select this so that only past due items are subject to finance charges. If the option is 
cleared, all open debits are subject to finance charges. 

• Apply outstanding credits 

Select this so that any outstanding credits are subtracted before a finance charge is 
calculated. The credits are applied based on aging. Suppose that today you post a 
payment for $100 dollars without applying it to a debit and generate statements. If the 
delinquent aging total is $50 and the past due amount is $25, the credit is applied to 
the delinquent amount reducing it to 0. The remaining credit amount of $50 is then 
applied to the past due amount also reducing it to 0. The end result is a proposed 
account status of Current. If, however, the Apply outstanding credits check box is 
cleared, the account in this example would have a proposed status of Delinquent 
because the outstanding credit would not have been used to adjust the old debit. 
Normally, you would leave the Apply outstanding credits check box selected. 

• Calculate only once per month 

Select this so that PrintSmith Vision checks when the last finance charge was posted 
to the account and only generates a finance charge if the statement date is in a 
different calendar month. 

Notes A month in this context is a calendar month, not an elapsed month, and the closing 
date, not the current date, is used to determine the calendar month. 

 The date a sub-account last had finance charges posted is ignored when you generate 
a master billing statement. 

e. Select accounts for statements in one of these ways: 

• To generate statements for all your accounts, select All. Every account is then processed. 

• To generate statements for selected accounts, click Selected Accounts. After you click 
Print, Preview, or Email, you can then select the accounts you want from the Account 
Selection window. 

• To generate statements for a range of accounts, enter the text with which you want to 
begin to select accounts in the From field and the text with which you want to end in the 
To field. For example, if you enter a in the From field and az in the To field, statements are 
printed starting with the first account whose name starts with a through the last account 
whose name starts with az. If you leave the From field blank, the statements start with the 
first account. If you leave the To field blank, statements stop with the last account. If you 
leave both To and From blank, this is the same as selecting All. 

3. Click the Output tab to further refine the criteria for selecting accounts and control what is 
included on the statements. For information, see below. 
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4. Click the Accounting tab to define how aging is performed, what to do about changing the 
customer account status as a result of aging, and how to handle finance charges.  

5. Click the Addressing tab to determine the format of the address and the information that is 
included on the statement besides the accounting information. 

6. Click the Reports tab to control whether a statement summary report is printed, control the 
detail it includes, and indicate whether you want to save the report for future reference.  

7. Click the Form Layout tab to control how your printed or e-mailed statements look.  

8. In the Message to print on each statement field, enter a message (such as a seasonal or 
marketing message) that you want to include on all printed statements. You must enter a 
message each time you run statements as this text is not saved. 

Note  If you are using preprinted forms, put them in the printer before step 9. 
9. If you want to print or e-mail the statements without previewing them, click Print or Email at 

the bottom of the Generate Statements window. (Printing versus e-mailing is controlled on 
the Reports tab.) Otherwise, click Preview to review the statements and decide whether you 
want to generate them.  

Note If you chose Selected Accounts, the Account Selection window opens after you click 
Preview, Print, or Email. You can select multiple accounts using the Select button. 

10. If you chose to have a summary report printed, you are warned to change the paper in the 
printer to plain paper. Click OK to print the report or Cancel to continue without printing. 

Output Tab for Statements 
Use the Output tab in the Generate Statements window to control which accounts are selected for statements 
and what is included on the statements. 

  
1. If you have master accounts in your system: 

a. Enable the Create master billing statements option to generate a consolidated statement 
that includes the statement items for the master account as well as a breakdown of items for 
all its sub-accounts. 

b. If you selected Create master billing statements, select one of the following: 

• Only Master Billing Accounts to ignore all accounts except those that are used for 
master billing. This is useful if you do not normally generate statements at all, but you 
have master billing accounts and want to send statements only to those accounts. 

• Skip Sub Accounts so that sub-accounts do not also receive a statement. (This is what 
you would typically select when creating statements for master billing accounts.) 

• Additional Sub Accounts to generate statements for sub-accounts as well as master 
accounts. Use this only if you want to send “informational” statements to sub-accounts, 
and the recipients understand their purpose. If a sub-account is specifically marked not to 
have statements generated (on the Settings tab in the customer Account window), no 
statement is generated for the account even if Additional Sub Accounts is selected. 

2. Select the Skip accounts with current status option to send statements only to those customers 
with balances due (as aged from the posting date). 

Note  When you age from the posting date, the account status is determined by the posting date of 
the oldest open item. 
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3. Select the Skip accounts with current balance option to send statements only to those 
customers with past due balances as aged from the date of the last payment. When you age 
from the last payment date, an account may have open items that are several years old and still 
be current if a payment was recently sent. 

4. Select or clear the following options: 

• Show new payments 

Select to include all payments made since the last statement as well as all open items. 

• Show aging amounts 

Select to include an aging summary on the statement that shows the totals for each of the four 
aging categories (for example, current, 30 days, 60 days, or 90 days). 

• Show aging titles 

Clear if you use pre-printed forms with pre-printed aging category titles. The only advantage to 
printing the titles is that if you change aging periods (for example, change 30 days to 45 days), 
these changes are reflected in the aging titles. 

• Show reminders 

Select to include predefined reminder notices on the statement. You control the text of these 
reminders with preferences (Preferences > Settings > Accounting > Aging Periods). 

• Show customer statement notes 

Select to include the statement note defined for the customer account on the statement. You enter 
this text using the Add Notes icon in the customer Account window. 

Accounting Tab for Statements 
Use the Accounting tab in the Generate Statements window to define how aging is performed, what to do about 
changing the customer account status as a result of aging, and how to handle finance charges. 

Note The finance charge rate for the whole system is set in your preferences (Preferences > Settings > 
Accounting > Credit/Defaults). You can override this rate for individual accounts on the Credit Control 
tab in the Customer window. 

The purpose of account aging is to determine the status of the account and warn you of accounts that may need 
collection action. An accurate gauge of the state of your AR is essential to running a healthy business. 

 
When PrintSmith Vision ages an account, it looks at all of the open debits (money owed to you) as well as all 
open credits (money you owe to the customer or did not yet apply to a debit) to determine how long the customer 
has owed you money and when you last received a payment from the customer. Based on this information, 
PrintSmith Vision adjusts the account status according to the rules that you set in this window and with your 
aging period preferences (Preferences > Settings > Accounting > Aging Periods). 

1. Select one of the following to control whether the account status is changed: 

• Always change account status so the account status is automatically changed based on 
your aging rules. 

• Ask before changing status so you can review the aging totals, the old status, and the 
proposed status in a summary window and decide if you want to update the account status. 

• Never change account status so the account status remains unchanged. 

2. Select one of the following to determine which date is used for the account status: 



278 • Productivity Suite | PrintSmith Vision User Guide 

 

 

• Status from Posting Date so the date of the oldest open debit is used to determine the 
proposed account status. 

• Status from Payment Date so the date of the last payment received is used to determine the 
proposed account status. This also affects the aging report because a partial payment on an 
open item ages that item based on the payment date. 

3. Select or clear the following options: 

• Freeze after 90 days 

Normally, the proposed account status is Current, Past Due, or Delinquent. Select this to 
freeze the account status if there are open items older than the oldest aging period (by default 
this is 90 days). When an account is frozen, you can only post payments to the account (AR 
(Account Receivable) > Post Payments) – no further work can be accepted for the account. 

• Unfreeze after 90 days 

Select this so the status of a frozen account is automatically changed after 90 days if payment 
is made. (You can also change this status manually on the Credit/Tax Control tab in the 
customer Account window.) 

• Mark inactive accounts 

Select this to identify inactive accounts. An account is considered inactive if nothing was 
posted to the account for the inactive period specified in your preferences (Preferences > 
Settings > Accounting > Credit/Defaults). When you see which accounts are inactive, you may 
want to contact the customers and find out the reason for the inactivity. 

• Inactive account to prospect 

Select this to reclassify inactive customer accounts as prospect accounts. When this check 
box is selected, and you generate statements or perform an account aging, all inactive 
accounts are converted to prospect accounts. 

Caution Use this feature with care. You cannot easily reverse changes to account classification. Also, 
this feature does not consider how long a customer has been inactive; it changes all inactive 
customers to prospects. 

Addressing Tab for Statements 
Use the Addressing tab in the Generate Statements window to determine the address and related information 
that are included on the statement besides the accounting information. 

 
1. Either select Use Statement Address to use an account’s statement address on the statement or 

select Use Invoice Address to use an account’s invoice address. 

Important  If you are e-mailing statements, this selection determines whether the e-mail address for 
the statement contact or for the invoice contact is used. Make sure your accounts include 
e-mail addresses for the statement and invoice contacts. 

2. Select or clear the following options: 

• Show Account Number 

Select this to include the customer account number on the statement. On statements that use 
payment stubs at the top or bottom, the account number is placed in the billing summary 
section. The size of this section is adjusted as necessary. If the reference number is also 
included, it is combined with the customer account number in the same block. 
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• Show Reference Number 

Select this to include the customer’s external reference number on the statement. On 
statements that use payment stubs at the top or bottom, the number is placed in the billing 
summary section. The size of this section is adjusted as necessary. If the account number is 
also displayed, it is combined with the reference number in the same block. 

• Show Sales Representative 

Select this to add the name of the sales representative to the statement. On statement forms using 
payment stubs at the top or bottom, the name is placed in the billing summary section. The size of 
this section is adjusted as necessary. 

3. In the Attention is field, indicate where you want the “Attn” line printed on statements: on top or 
on bottom of the address block, or not shown. 

4. In the Postal bar code is field, indicate where you want the bar code printed on statements: on 
top or on bottom of the address block, or not shown. 

Reports Tab for Statements 
Use the Reports tab in the Generate Statements window to control whether statements are printed or e-mailed, 
as well as whether a statement summary report is printed. At a minimum, this report includes the name and 
aging totals for each account for which a statement was generated, but you can control the detail it includes. You 
can also save the report for future reference. (You can only reprint a report if you save it.) 

  
1. Select either Print Statement or Email Statement. Depending on your selection, the button at the 

bottom of the window will be Print or Email. 

Note If you are e-mailing statements, your accounts must include e-mail addresses for the invoice 
or statement contacts (depending whether you selected Use Statement Address or Use 
Invoice Address on the Addressing tab in the Generate Statements window). 

2. Enter the from address for the email in the Email “from” Address field. 

3. Select the Print summary report option to generate the summary report after statements are 
generated. (If printing statements, PrintSmith Vision waits for statements to finish printing so you 
can insert plain paper into the printer.) 

4. If the Print summary report option is enabled, select or clear the following options: 

• Detailed report 

Select this to include the details of each open item in the report. 

• Alternate lines in aging columns 

If the amounts in a statement are very large some of the amounts may creep into adjoining 
columns and make the report unreadable. Select this to print every other amount on alternate lines. 
(Alternate lines can make the report much longer.) 

• Add collection information 

Select this to include the sales representative, contact name, phone number, last payment date, 
and amount in the report. This information makes the report more valuable as a collection tool. 
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5. The statement summary report is not saved automatically. To save the report so you can reprint it 
later, select the Save report option. 

Form Layout Tab for Statements 
Use the Form Layout tab in the Generate Statements window to control how your printed or e-mailed 
statements look. You can either use a pre-printed form or have PrintSmith Vision generate a form for you. If you 
want to add a logo to your printed or e-mailed statements, see “Customizing Your Statements” below. 

 
Note Printed and e-mailed statements must be customized separately. 

  

1. Select one of the following: 

• Use pre-printed form if you use pre-printed statement forms. ePS generally recommends that 
you pre-print your statement forms for the best presentation and fastest printing. 

• Generate detailed form if you want PrintSmith Vision to generate the statement form. 

• Generate basic form if you want PrintSmith Vision to generate a stripped -down version of the 
form. This form may be more suitable for some low-resolution printers. It can also be useful for 
filling out a pre-printed shell. 

2. Select one of the following: 

• Standard format for a letter format, which may be suitable for printing on your standard 
letterhead. 

• Remittance advice on right for a format similar to the standard format except that it includes 
a tear-off remittance area on the right side of the form. (This compresses the line-item 
information.) 

• Payment stub on top for a form that includes a tear-off payment stub at the top that is 
designed to be placed (along with the check) in a remittance envelope with a window. 

• Payment stub on bottom for a form that includes a tear-off payment stub at the bottom that 
is designed to be placed (along with the check) in a remittance envelope with a window. 

3. For details about Associated Report and Associated E-mail Report fields, see “Download a 
PrintSmith Vision statement report file”. 

Customizing Your Statements 
You may want to customize your statements by including a logo or making other formatting changes. Printed 
statements and e-mailed statements must be customized separately, although the general procedure is identical: 

• Download one of the PrintSmith Vision supplied statements (in the form of an .rpt file). Separate .rpt 
files are available for printed versus e-mailed statements. 

Important  Because printed and e-mailed statements are based on different report (.rpt) files supplied 
by PrintSmith Vision, you must customize them separately. For example, you cannot 
customize the report file for printed statements and use it for e-mailed statements. 

• Use i-net Designer to edit a copy of the statement report you downloaded (for example, add your logo). 
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Note In customer-hosted installations, i-net Designer must already be installed as described in the 
PrintSmith Vision - Installation and Upgrade Guide. In ePS-hosted installations, i-net Designer 
and other required components must already be installed and configured as described in the 
PrintSmith Vision - ePS-Hosted Guide. 

• Override the PrintSmith Vision supplied statement with your own version. 

Details of these procedures follow. 

Download a PrintSmith Vision Statement Report File 
PrintSmith Vision includes different .rpt files for printed statements and e-mailed statements. These 
correspond to different combinations of options on the Format Layout tab in the Generate Statements 
window. The names of the reports that correspond to the options you select are displayed in the 
Associated Report and Associated E-Mail Report fields.  

For example, for printed statements, if you select Use pre-printed form and Standard Format, 
PSV_Statement.rpt is displayed in the Associated Report field. For e-mailed statements, 
PSV_StatementEmail.rpt is displayed in the Associated E-Mail Report field. 

Note If you already customized printed statements, and now want to e-mail statements, you must 
download PSV_StatementEmail.rpt and customize it. You cannot use the report you customized 
for printed statements. 

In customer-hosted installations of PrintSmith Vision, both the standard and custom statement report files 
are saved in a repository folder on the PrintSmith Vision server.  

For Windows this is C:\Program Files (x86)\EFI\PrintSmith\PrintSmith Reports\Crystalclear Reports 
12.1\reportRepository and for Macintosh this is Applications/EFI/PrintSmith/PrintSmith 
Reports/Crystalclear Reports 12.1\reportRepository. 

1. In PrintSmith, select Accounting > (AR) Accounts Receivable > Account Utility. Then click the 
Generate Statements button on the Accounts Utility window. 

2. Click the Form Layout tab. 

3. Select the form layout options you want in your statements. 

4. Click Download icon in the Associated Report field or Associated E-Mail Report field. The report 
identified in the Associated Report or Associated E-Mail Report field is placed in your default 
Downloads folder. 

 
Tip The location of the Downloads folder is specified in your browser settings. For example, in Chrome, it is 

one of the advanced settings; in Firefox it is one of the general options. 

Customize the Statement Report with i-net Designer 
1. Start i-net Designer from the shortcut on the desktop (Windows) or from the dock (Macintosh). 

2. Select File > Open, navigate to your Downloads folder and select the statement .rpt file that you 
downloaded (for example, PSV_Statement.rpt). 

3. Select File > Save As and enter a name for the report. (This cannot begin with PSV_.) 

Tip To identify your report more easily, consider using a prefix (such as the initials of your 
company name) in the report name, for example, AT_Statement.rpt. 

4. Use the red descriptive text to identify the section of the statement that you need to modify. (This 
text is not printed on the statements.) For example, in the figure below, you can see that the Page 
Header–c section is what you need to modify if you are using standard remittance. 

5. Add your logo to the statement: 

a. If necessary, move some fields around (see step 6) to make room for the logo. 
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b. Click on the toolbar (or select Insert > Image) and browse to your logo. 

c. Position the logo where you want it. 
 

 
6. If you want to move fields around either to make room for the logo or to display information in a 

different order, click and drag a field. To move two (or more) fields at the same time, click one 
field, press and hold CTRL, and click the second field. Then drag from the center of one of the 
fields – the other field will follow so they are lined up. 

7. To change the font, point size, or justification of a field, select the text you want to change and 
make your change using the toolbar. 

8. After you finish making changes, click Save on the toolbar (or select File > Save).  

You must now override the ePS-supplied statement with your customized version. 

Override PrintSmith Vision Statement Report with Customized Version 
1. In PrintSmith Vision, select Accounting > (AR) Accounts Receivable > Account Utility. Then 

click the Generate Statements button in the Account Utility window. 

2. Click the Form Layout tab. 

3. Click the Override icon for the Associated Report field or Associated E-Mail Report field. 
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4. Locate the statement report you just customized. 

Note You cannot use the same customized report for printed and e-mailed statements. The report 
you upload must be based on the appropriate report supplied by PrintSmith Vision (for 
example, PSV_Statement.rpt or PSV_StatementEmail.rpt). 

5. Click Yes to confirm the override. 

Tip  If you change your mind about the report you selected, click Delete for the Associated Report 
field or Associated E-Mail Report field. The Associated Report or Associated E-Mail Report 
will revert back to the original ePS statement report file, for example, PSV_Statement.rpt . You 
can then repeat steps 1 to 5 above to override this with another custom statement.  

When you next generate statements, they will be included your customizations. 

Previewing Statements 
After you define the settings for your statements in the General Statements window, you can preview the 
statements and decide whether you want to print or e-mail them. 

1. In the Generate Statements window, click Preview. 

2. After you click Preview, each account (that meets the criteria you specified) opens in a window so 
you can decide how to handle the statement for the account. 

Note If you chose Selected Accounts, the Account Selection window opens after you click 
Preview. You can select all the accounts for which you want to generate statements (by using 
Select button). Then click Proceed. 

3. If a finance charge was calculated, it is displayed below the status information as well as in the 
item list (in red). To eliminate the finance charge from the statement, click Remove Finance 
Charge. After you remove a finance charge, the button changes to Restore Finance Charge so 
you can restore the finance charge if necessary. (Finance charges are not posted until you click 
Print or Print Remaining.) 

 
4. Click one of the following:  

• Print Remaining or E-Mail Remaining to print or e-mail the rest of the statements without 
continuing to review them one by one. If printing, the statements will open in a preview 
window from which you can print them. If e-mailing, the statements are sent automatically. 

• Print or E-Mail to accept the statement. After you finish reviewing the remaining statements, 
the printed statements will open in a preview window from which you can print them. E-mailed 
statements are sent automatically. 

• Skip to not generate a statement for the account and continue to the next account. 
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• Stop to stop reviewing statements for any other accounts, stop generating statements, and 
open a print preview window for those statements that you already accepted (by clicking 
Print). 

E-mailing Statements 
For statements to be e-mailed, e-mail must be configured in Preferences > Settings > System > E-mail and 
select the appropriate options. As part of this configuration, be sure to define the e-mail body on the Statement 
tab in the E-Mail Template window (Configuration > Email Template). 

In addition, make sure all your accounts have e-mail addresses specified for the invoice and statement contacts. 

To e-mail statements 

1. In PrintSmith Vision, select Accounting > (AR) Accounts Receivable > Account Utility. Then click 
the Generate Statements button in the Account Utility window. 

2. Click the Addressing tab and select Use Statement address or Use Invoice address. This 
selection determines whether the invoice or statement contact e-mail address is used when 
statements are e-mailed. 

3. Click the Reports tab and select Email Statement. 

4. Click the Form Layout tab and customize the e-mail report used for statements. 

Note If you already customized your printed statements, you must repeat the process for e-mailed 
statements. E-mailed statements are based on a different report supplied by PrintSmith 
Vision. You cannot re-use the report you customized for printed statements. 

5. Make other selections in the Generate Statements window as necessary and then click Email. 

Note  If you chose Selected Accounts, the Account Selection window opens. Select the accounts 
and click Proceed. 

A message informs you when the e-mails have been sent. 

When statements are e-mailed, they are automatically logged in System Monitor (Configuration > System 
Monitor > E- Mail Status) with the Email Type of the e-mail identified as Statements. 

If the Statement Log Text field in the E-Mail preferences is blank, the e-mails are not logged on the Log 
section in the customer account but are still logged in System Monitor. 

If the Use log text for subject and file name check box is selected in the E-Mail preferences, the 
Statement log text is also used for the subject of the e-mails and the name of the PDF attachment (the 
statement). 

Reprinting Statement Reports 
If you choose to generate a statement report and also selected the Save report option on the Reports tab 
in the Generate Statements window, a copy of the report is saved so that you can reprint it later if 
necessary. 

A saved report is named Statements followed by the date you generated the statements, for example, 
Statements – 04-08-2022. 

To reprint a saved statement report 

1. In the Account Utility window, click the Aging and Statement Reports icon. The Reports window 
opens. 
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2. Enable the Show Generate Statement Reports option to list the statement reports. 

3. Select the report you want to reprint. 

4. Click Open. The report opens in a preview window from which you can print it. 
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Post POS Charges 
When you charge small jobs to a customer account in the Cash Register, these POS charges accumulate in a 
merchandise charge balance for the account. PrintSmith Vision tracks these charge transactions separately to 
avoid cluttering up the account history with many small transactions. The merchandise charge balance is part of 
the account balance and is considered a taxable receipt, but is not a normal receivable, and cannot be paid until 
you post the POS charges. 

PrintSmith Vision recommends that once a month, before generating regular statements, you post the entire 
balance of these POS charges to Accounts Receivable as a single entry. Once posted, these charges can be 
billed on a statement, and can be paid just like any other open item. 

To post POS charges: 

1. Select Accounting > AR (Account Receivable) > Post POS Charges. The Post POS Charges 
window opens. 

 
2. Select or clear the following options: 

• Preview before Posting: Select this if you want to review the details of the POS charges 
account by account. If the option is cleared, the POS charges are automatically posted to an 
account, and PrintSmith Vision proceeds to the next account without stopping 

• Print Statements: Select this to generate a statement for each account with an outstanding 
POS charge balance. The statement, however, is only for POS charges, and cannot be rerun. 

• Print Summary Report: Select this to generate a summary report of the POS charges that were 
posted. 

3. Click Confirm. 

4. If you selected the Preview before Posting option, a window opens for each account with an 
outstanding POS charge balance. Do one of the following: 

• To post the balances and print statements for all the remaining accounts with POS charge 
balances, click Print Remaining.  

• To post the balance and print the statement for the currently displayed account, click Print.  

• To not post the balance for the account, click Skip. 

• To stop posting balances for all remaining accounts with POS charge balances, click Stop. 
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Templates 
Template List 

The Templates List window displays all the existing templates. The list includes Invoice, Estimated, Job, 
and Product templates. Product templates are handled differently, see Web Product Templates for more 
information. 

You can narrow the search to just a type of template by selecting the appropriate icon across the top of the 
page or you can choose to view all templates. 

  
Note The quantity of templates in the All Types tab does not include the number of product templates. 

Invoice, Estimate, and Job templates are all handled the same way. You have the same filtering options 
and the same processes. You can filter these templates by using any of the column headers and the 
program will filter the templates. Using the three-dots ellipsis, you can duplicate or delete the template. 
From this window you can create Template Categories. 

Template Category 
When you click the Template Categories button in the Templates List window, a list of the categories is 
displayed. Here you can search for a specific category using the columns at the top. You can also delete or 
duplicate the categories by clicking the three-dots ellipsis. As with other column headers, you can search or 
sort the information.  

  
You can create a new category by selecting the + Category button. This opens the Create a Template 
Category window where you can add a category. You can add an image to the category or a layout. If you 
select Do not show in template when creating a new template category, that category will only be 
available with Web Products but not with invoice, estimate and job templates. If you do not select this check 
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box while creating Template category, that category will be available with Web products, invoice, estimate 
and job templates. 

Note Flex Categories that are associated with Web Product will not get carried forward to HTML. 

 

Web Product Templates 
Web Product Templates are created and mapped to Market Direct StoreFront products. When your 
customer places an order for a product, the mapped template becomes the job information for that product 
and the invoice is placed in Pending Documents. 

Web products can also be used for Four51 integration, API integration, and MDSF integration. For these 
integrations, Map to MDSF option is available. 

 
When eFlow based MDSF integration is enabled, the Product list displays the Product Name, SKU#, 
Category, Status, Date modified, and the MDSF Product Name columns. 

From this window, you can select a Category for the template. The Status is displayed if a Product is linked 
to a template.  

You can edit the Product details. To edit Product, click the Product Name.  

The Edit Product window opens and displays other options depending on the status of the product. If the 
product is not linked to a template, then you can either select a template from the library or set a new 
template. If the product already has a template, then the Select from Library and Set New Template 
buttons are disabled. You can review the information or use Map to MDSF to map PrintSmith Vision 
product with MDSF products. 
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Note You can map more than one MDSF product(s) to the same PrintSmith Vision web product, but only one 
job can be linked to a web product. 

The SKU number is automatically generated. The SKU number consists of fixed prefixes and a number making it 
and is incremented with each new SKU. The program will also not allow duplicate SKUs. Using the product name 
and SKU, you have the choice to add a template from the library or create a new template to link to the product. 

To link a template to a product you can Select from Library or Set New Product.  

• When you click Select from Library, a list of the existing templates is displayed. You can select from 
Job, Estimate, or Invoice templates. If you select Job Templates, a list of job templates is displayed. If 
you select Estimate or Invoice templates, enter the appropriate estimate or invoice number and then 
click Proceed. 

• When you click Set New Product, the Job Template window opens where you can create the template 
by entering the job information just as you would for any new job. See “Creating a New Job” for more 
information. 

If you choose to use a template from the library, you have an option to select a template from the Job Template 
list, or from Invoices or Estimates. 

1. When Job Template is selected, you can add an existing template from Job Template List for the Web 
Product. 

2. When Invoice is selected, you can search invoices with an invoice number and select job from the 
invoice to add an existing template for the web product. 

3. When Estimate is selected, you can search estimates with an estimate number and select job from 
estimate to add as template for web product. 

Note  If an invoice/estimate contains multiple jobs, the user will be able to select only one job for the 
job template. 

4. To add template to Web Product, select templates or job from the list and click on Add. 

5. To edit the template, select the Edit icon in the template row and modify the template in the Job 
Template window. Then save it. 

6. To delete the template associated with Web Product, click the Delete icon in the template row. 

If you choose to create a new template, the template creation page opens where you enter the job information for 
the template. After you complete all the fields, save the template and the product. 

Tip After you associate a template with a Web Product, you can later edit the template (by clicking Edit 
template) or remove it altogether (by clicking Remove template). 

From the Edit Product window, you can map the MDSF product with the PrintSmith Vision product by 
clicking the Map to MDSF button. This opens the MDSF Products window listing the MDSF products at the 
bottom section. You can map the specific MDSF products by checking the box in the bottom section. The product 
is then removed from the bottom section and moved to the top section to indicate that the product has been 
mapped.  
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Email Templates 
Use the E-Mail preferences to configure your e-mail account with PrintSmith Vision so that you can e-mail 
various documents, for example, estimates, invoices, purchase orders, statements, and credit memos. 

Use the Email Templates window to specify what the body of e-mail includes. By default, the recipient, subject, 
PDF file name, and body in an e-mail message are as follows: 

• Recipients: For a document to be mailed, the default recipient must have an e-mail address 
defined: 

• For estimates and invoices, the default recipient is the invoice contact. 

• For credit memos, the default recipient is the invoice contact. 

• For statements, the default recipient is the account statement contact or invoice contact (depending 
on which is being used for the statements). 

• For purchase orders, the default recipient is the supplier specified in the purchase order. 

• Subject:  The subject of the e-mail is Company Name: Document Type #xxx, for example, 
Vermont SuperPrints: Estimate #323. The company name is taken from the first line (Company) of 
the Address in your Company preferences. 

If, however, you select the Use log text as subject and file name check box in the E-Mail 
preferences, the log text you specify is used for the subject line instead. 

• PDF file name: The name of the PDF attachment is Document Type #xxx.pdf, for example, 
Estimate #234.pdf or Statement #432.pdf. 

If, however, you select the Use log text as subject and file name check box in the E-Mail 
preferences, the log text you specify is used for the file name instead. 

• Body: The body of the e-mail is defined in these E-Mail Templates. 
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To set up the e-mail preference, go to Preferences > Settings > System > Email. 

 

To customize e-mails 

1. Do the following in the E-Mail preferences window: 

a) To allow users to customize certain types of e-mail messages before they are sent, select the 
Customize E-mail fields before sending check box. 

When the Customize E-mail fields before sending check box is selected, each time users 
click the E-Mail button in the Invoice or Estimate window or in the Purchase Order window, 
they can add recipients, change the subject of the e-mail, and edit the body. 

Important The Customize e-mail fields before sending check box does not apply when you e-
mail invoices from the Cash Register or Post Payments window, e-mail credit memos 
from the Journal Entry window, or e-mail statements (AR (Account Receivable) > 
Generate Statements). In these situations, the e-mails are sent without any input from 
users – the e-mails cannot be changed. 

b) To send a copy of the e-mail to the sender, select the Include sender on CC line check box. 

2. Do the following in the E-Mail Templates window: 

For the E-Mail Body, click each tab (Invoice, Estimate, Credit Memo, Statement, and 
Purchase Order) and enter the message you want the e-mail to include. 
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Note  The body specified on the Invoice tab applies to e-mails sent from the Invoice window, 
the Cash Register window (for posted invoices), and the Post Payments window (for paid 
and posted invoices). 

The body of the e-mail can include: 

• Text: Text can be anything you want. For example, depending on the e-mail being sent, you 
may want to include text such as Your invoice is attached or We hope to do business with 
you again. 

Enter the text and use the formatting toolbar to change the font, point size, style, color, and 
justification of text. 

Note  You can only select a font from the list; you cannot add your own fonts to the system. 
Currently extra spaces between characters are not preserved when you send e-mails. 

• Place Holder: Place holders are replaced with actual data when the e-mail is sent. For 
example, [DocumentNumber] is replaced with the number of an invoice or estimate; 
[AccountName] is replaced with the name of the account; [Supplier] is replaced with the 
name of the supplier for purchase orders; and so on. The available choices depend on the 
type of e-mail you are sending. 

[FirstName], [LastName], [JobTitle], [UserName], and [EmailAddress] always come from 
the user definition of the logged-in user so are helpful if you want to identify the user who sent 
the e-mail in the e-mail itself. 

To enter a place holder, select it in the Place Holder drop-down list and click Insert. 

Note  Place holders are always added at the end of the e-mail body, not where the pointer is. 
Once a place holder is added, cut it and paste it where you want it. 

You may want to include text next to some place holders to explain what the data represents, 
for example, precede [DocumentNumber] with Estimate Number or [DocumentTotal] with a 
currency symbol. 

• Images: You can include an image such as your logo in the e-mail. To do so, click Add Image 
and locate and select the graphic you want to use. The name of the image (not the image 
itself) is displayed. 

Note  Make sure the image is the correct size before you add it; you cannot resize images in 
PrintSmith Vision. The image is always added at the end of the e-mail body, not where 
the pointer is. Once it is added, cut the image (meaning IMAGE SOURCE=‘image 
name’) and paste it where you want it. 

• Hyperlinks: To include a hyperlink in the e-mail body: 

• Enter the text for the link. For example, this could be a URL such as http://w3.eps.com/ or text 
such as Click here for more information or Visit the ePS website. You can also hyperlink an 
image such as the Facebook or LinkedIn icon. 

• Select (highlight) the text of the link or name of the image (meaning IMAGE SOURCE= ‘image 
name’). 

• Click the Hyperlink  icon and then enter the URL in the Enter link field.  

The link (text or image) can now be clicked to take you to the specified site. 

3. To see what the e-mail will look like (together with any images you added), click Preview and then 
close the preview window.  (Place holders will be replaced with real data when the e-mail is sent.) 

  

http://w3.eps.com/
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User Definitions 
Each person who uses PrintSmith Vision must have a user definition (profile). This definition establishes a 
username and password for logging into the system, associates the user with an access group, and controls 
some other features such as the user’s ability to change the credit limit for a customer. 

After you define your security set up for access groups, you must define your PrintSmith Vision users. To create 
user definitions: 

1. Select Configuration > Admin > User Definition. 

Note  Although any user can be given access to the User Definitions window, only the pre-defined 
admin user has full use of the window. Specifically, only the admin can change user 
definitions in the Owner and System Admin access groups and only the admin can assign 
users to the Owner and System Admin access groups (or delete users in these groups). 
Unless you are the admin, you cannot change anything in your own user definition. 

2. Click + button to start creating a user. Note that only the Owner access group can add new users. 

 
3. In the User Details section, provide the basic details of the user: 

• Enter the name of the user in the User Name field. The user will need to provide this name when 
logging into PrintSmith Vision.  

• To include the user’s name and title in e-mail messages, complete the First Name, Last Name, 
and Job Title fields. 

4. Set access for the user in the Access Details section: 

• Select an Access Group for the user. The access group controls what the user has permission to 
do in PrintSmith Vision.  

• Enter a number in the Access Level field to control whether the user has access to 
information about customer accounts or history. 

A customer account also has an access level; if the user has an access level lower than that 
set for an account, the user has no access to that account or its history. So, for example, if 
some users should never have access to account information, you could give these users 
access levels of 1 and then make sure that accounts have an access level higher than 1. (The 
security level setting for customer accounts is defined on the Settings tab in the Accounts 
window.) 

5. After you configure e-mail in the E-Mail preferences, complete the e-mail fields: 

• In the Email, Email User Name, and Email Password fields, enter the login credentials for 
the account.   
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This email address is used as the “from” address when the user e-mails documents to customers. If 
no Email is specified, the e-mail address in the Company preferences is used as the “from” address 
instead.  

• When the Multiple domain support option is selected in E-Mail preferences, the User Definitions 
window displays three additional fields for each user record – Application Client ID, Client 
Secret, and Directory Tenant ID.  

In the Application Client ID, Client Secret, and Directory Tenant ID fields, enter the setting values 
from the Azure portal for the second domain from which you want to send emails. For more 
information on these three fields, see the Multiple domain support section in the topic “Set up 
Microsoft Exchange Server mail (New)”. 

6. Unless you are integrated with Market Direct StoreFront, ignore the DSF SSO Token field. 

7. Define a password and password rules to be used when the user logs into PrintSmith Vision: 

a. To enter the password for the user (or change the password of an existing user), click 
Change Password. Passwords are never displayed. Once you give users their username and 
password, they should change their own passwords with User Profile > Change Password. 

b. To force the user to change the password at login, select the Force password change at 
Signon check box. (Once the user changes his or her password, this check box is cleared 
automatically.) 

8. Select or clear the following: 

• Not allowed to override: Select this check box to prevent the user from changing anything 
that is considered an override in PrintSmith Vision or from removing an existing override. 

• Can override credit limit: Select this check box to allow the user to override the credit limit 
when charging items in the cash register and to change the credit limit and discount 
percentage on the Credit/Tax Control tab in the Account window. ePS recommends you 
restrict this feature to managers. 

• Lock sales rep names: Select this check box to prevent the sales representative assigned to 
an account or document from being changed. The user can only assign the sales 
representative if one is not assigned. 

• Can refund on credit card: Select this check box to allow the user to perform refunds on credit 
card transactions. 

• Not allowed to return cash: Select this check box to prevent the user from cashing checks in 
the cash register. A transaction is rejected if the amount of change exceeds the total amount 
of cash 

9. Click Save to save the user definition. 

If you need to change something in a user definition, for example, allow the user to refund credit card 
transactions or force the user to change his or her password at the next login, you can edit the user 
definition by selecting User Name and clicking the Edit button. 

If an employee leaves your company, you can delete the user definition for that employee by clicking 
the Delete icon displayed in each row of the user. 

Security Setup 
The Security Setup window enables you to create access groups that control which PrintSmith Vision features 
members of an access group can use. When you define your users, you assign each user to an access group.  

Three access groups are pre-defined and cannot be changed in any way:  

• Owner – allows access to all PrintSmith Vision features and allows members of the group to create, 
modify, and delete access groups, as well as to manage users in all access groups.  

Note  PrintSmith Vision is shipped with an admin user who is part of the owner group. This admin 
user cannot be deleted by any other user, even other members of the owner group. The 
admin is a “super user.”  
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• System Admin – allows access to all PrintSmith Vision features and allows members of the group to 
create access groups, modify access groups (except for the owner and system admin groups), and 
manage users in other access groups (except for the owner and system admin groups).  

• Minimum – allows access only to those commands needed to get in and out of PrintSmith Vision (Log 
In and Exit).  

ePS recommends that you create additional access groups for employees who work in different areas of 
your business, for example, managers or production staff. 

To create an access group 

The access groups that you set up should allow users to perform their particular jobs using PrintSmith Vision. For 
example, you may want one access group for users who work at the front counter and another access group for 
managers (although you may want to consider the system admin group for those managers who need access to 
the full system). 

Note  Only members of the Owner and System Admin access groups can create access groups 
1. Select Configuration > Admin > Security Setup. The Security Setup window opens. 

2. Select the plus sign (+) to create a new access group. 

3. Enter a name in the Group name column on the left-side. 

4. Select or clear check boxes on the right-side to make commands available or unavailable to 
members of the group. 

 
5. Click Save to save the group.  

You can now assign users to this group from Configuration > Admin > User Definitions. You can 
change the name of an access group, change the permissions included in a group, copy an access 
group, and delete it as long as no users are assigned to the group. 

Batch Print Documents 
You can print a group of invoices without having to open them one by one. If you plan to print batches on a 
regular (daily) basis, PrintSmith Vision recommends you print the batch of invoices before you run your daily 
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closeout. If you try to print the day’s pickups after doing a daily closeout, the list will always be empty as it uses 
the register tape to find new documents, and the tape is restarted after a closeout.  

To print a batch of documents  

1. Select Configuration > Admin > Batch Print Documents. The Batch Print Documents window opens.  

   
2. In the Select Dates field, do one of the following: 

• Select Today’s to print the invoices that were picked up today.  

• Select Other Days if you want to select the dates for which you want to print documents.  

3. In the Select Documents field, do one of the following: 

• Select Invoice Pickups to print the invoices picked up since the last daily closeout. 

• Select New Documents to print the documents created since the last daily closeout.  

4. In the Use Form field, select the format (document preference) you want to use for all the documents in 
the batch.  

5. If you selected New Documents, select the Include Invoices check box to include new invoices in the 
batch and/or select the Include Estimates check box to include new estimates in the batch.  

6. PrintSmith Vision keeps track of which documents were already printed. Select the Skip if already 
printed check box to avoid reprinting documents. If the check box is cleared, PrintSmith asks you 
before it reprints the document.  

7. Click OK. 

Fold Templates 
PrintSmith Vision supplies a set of standard graphics for folding styles. You can change the names of these 
graphics, provide additional descriptions, and make them unavailable for selection by users if they do not apply 
to your business. 

The fold graphics make it clearer to estimators what type of fold is involved when they add a fold charge to a job. 
In addition, the paper cutting diagram that is printed with the job ticket includes the fold style graphic. 

To review and manage the fold templates: 

1. Select Configuration > Admin > Fold Template. The Fold Templates window opens. 
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2. By default, all the fold graphics are active (available as selections to users), but if you have no need of a 

particular graphic, click the Mark as Inactive icon under the fold graphic. The graphic is then outlined in 
red indicating that it is unavailable. 

3. To change the name of a fold graphic or provide more information about a fold graphic (for example, 
to provide some instructions), click the Edit icon and enter the information in the fields provided. 

4. To print a report of the fold graphics, click the Print icon. 

Paper Templates 
If you find that you use the same layouts for many of your jobs, create templates for them to avoid having to 
make the same selections in the Paper Calculator window each time you create a job with the same layout. 

To create and review the paper templates: 

1. Select Configuration > Admin > Paper Template. The Paper Templates window opens and lists 
all the existing templates. 

 
2. Do any of the following: 

• To create a new template, click the New button. The Paper Calculator window opens so you 
can provide the information about the template. After you finish entering the information, click 
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Confirm in the Paper Calculator window. The new template is then displayed in the bottom part of 
the Paper Templates window. 

Tip You can also create paper templates from existing jobs in account or estimate/invoice. 
For example, you can open a job and click Paper Calculator in the Job Details tab. Then 
click Save as Template in the Paper Calculator window, provide a name for the template, 
and click Save. 

• To locate particular templates, enter your search criteria such as the Min and Max values for Finish 
Size, Run Size, or Parent Size. PrintSmith Vision then displays just the templates that meet the 
values you entered. To display all the templates again, click Clear Search. 

• To edit a template, click the template name in the grid. The template opens in the Paper Calculator 
window. Make your changes and click Save. To save as a new template, click Save as Template. 

• To delete a template, select it and click Delete. 
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Delivery Ticket Manager 
You can use Delivery Ticket Manager to create, review, delete, and archive the delivery tickets. You can also use 
Delivery Ticket Manager to create, modify, and customize delivery ticket forms, as well as add brokers. 

You can access the Delivery Ticket Manager window from Configuration > Admin > Delivery Ticket 
Manager.  

Using the Delivery Ticket Manager 
The Delivery Ticket Manager window lists all delivery tickets in the system. Completed deliveries display a blue 
bar on the left most column. Using this window, you can search for tickets, add new tickets, delete tickets, and 
archive tickets. 

Do any of the following when viewing the Delivery Ticket Manager window: 

• To search for a ticket, use the Filter fields in each column header to narrow the list of tickets by Delivery 
Ticket No, Inv/Job (invoice/job number), Accounting, Ship via, Driver, Description, or Delivery Date. 

• To view a delivery ticket, click the delivery ticket number. The ticket opens in the Delivery Ticket 
window.  

• Once a delivery is completed, a blue bar is displayed in the left most column on the Delivery Ticket 
Manager window. To hide completed deliveries and show only those deliveries that are still in process, 
select the Hide Completed Deliveries check box.  

 
• To create a new delivery ticket:  

1. Click the Create button in the Delivery Ticket window. An Invoice List window opens. 

2. Specify what is being delivered by adding invoices and jobs to the delivery ticket. 

  
3. Click Add. The Delivery Ticket window opens, and a ticket number is assigned. Provide 

additional delivery information as described in “Creating Delivery Tickets”. 



300 • Productivity Suite | PrintSmith Vision User Guide 

 

 

4. Click Save.  

• To edit a ticket, click the three-dots ellipsis displayed in the row of the delivery ticket that you want to 
make changes and then click Edit. Click Yes to confirm the deletion. 

 
• To delete a ticket, click the three-dots ellipsis displayed in the row of the delivery ticket that you want to 

delete and then click Delete. Click Yes to confirm the deletion. 

• To archive a delivery ticket so it is removed from the list in the Delivery Ticket Manager window, but left 
in the PrintSmith Vision system, click the three-dots ellipsis displayed in the row of that delivery ticket 
and then Archive. 

Notes You cannot reactivate a delivery ticket once it is archived, but you can view it again through 
the invoice to which it was originally attached.  

 To remove a delivery ticket from both the archive and the system, click Delete instead of 
Archive. 

 Creating Delivery Tickets 
1. Start the process of creating delivery tickets in any of these ways:  

• In the Pending Documents window, select an invoice, click the three-dots ellipsis displayed for 
that item and then click Delivery Ticket.  

• When an invoice is open, in the Invoice Summary tab, click the three-dots ellipsis for the item you 
want to generate a delivery ticket and click Generate Delivery Ticket.  

• Click Create in the Delivery Ticket Manager window. Then select the account and add invoices 
and jobs to the delivery ticket in the Invoice List window. Click Add. See “Using the Delivery Ticket 
Manager” for more information. 

The Delivery Ticket window opens and lists the jobs associated with the invoice.   

2. If necessary, edit the title of the delivery ticket in the Title field. By default, the job description along with 
the order quantity is displayed in the Title field. 

3. In the Description column, you can edit the description of what is being shipped. The description is 
printed on the delivery ticket and on carton labels.  

4. Complete the following fields: 

If you create the delivery ticket from the Pending Documents window or from the Invoice Summary 
tab, the selected invoice/job is automatically included in the delivery ticket. You can add more jobs to 
the delivery ticket by clicking the Add Invoice icon. Then find the invoice and select the job you want on 
the delivery ticket and click Add.  

a. Click the Ship Qty field to change the quantity that was shipped.  

b. If necessary, in the Delivery Date field, change the date.  

c. Select the new location in the Ship Status drop-down field.  

d. If the stock for a job includes a weight, it is displayed in the Weight column. Otherwise, enter a 
weight if applicable. The Total Weight right side of the Delivery Ticket window is then updated. 
(You can enter a different number in the Total Weight field to override the calculated total 
weight.)  
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e. To remove an invoice/job from the delivery ticket, select it and the Delete icon. 

f. To indicate an item was delivered, select the delivery ticket and then select the Mark as 
Shipped check box. Then a blue bar is displayed in the left most column on the Delivery Ticket 
Manager window. 

g. In the Ship via field, select the shipping method. (Use Table Editor to maintain your shipping 
methods in the Ship via table.)  

h. In the Cost field, enter the shipping cost. 

i. In the Tracking ID field, enter the tracking number supplied by the shipper.  

j. If you have a delivery truck in-house and keep track of the drivers, in the Driver field, select 
the name of the driver. (Use Table Editor to enter the names of your drivers in the Driver 
table.)  

k. Select the Allow COD Payment option if payment for the entire job is expected on delivery.  

l. PrintSmith Vision automatically enters a number in the Order # field, based on the first invoice 
on the invoice number. Enter any additional reference numbers, for example, the Customer 
PO #. 

m. In the Comments field, enter any notes about the shipment. 

n. In the Contact Person section that is displayed at the bottom of the Delivery Ticket window, 
select the contact person for the order. (You can leave this blank.) To edit this address, click 
the Edit icon, and make your changes.  

o. If necessary, select a different delivery address in the Delivery Address field. Accounts for 
invoices added to the delivery ticket are available as selections. If you added invoices/jobs 
from multiple companies to the delivery ticket, you must select one delivery address. To edit 
this address, click the Edit icon, and make your changes.  

p. By default, the From address comes from your Company preferences (Configuration > 
Preferences > Settings > System > Company). If you set up other brokers on the Brokers, 
select a different address in the From drop-down field if necessary. To edit this address, click 
the Edit icon, and make your changes.  

Note  Changes that you make to the address information do not affect the saved company, 
broker, account, or contact information.  

q. If the contact person has an e-mail address, it is displayed in the address field when you click 
the Email icon. To enter or edit the e-mail address, select the Other Email check box and 
enter/edit the e-mail address.  

r. To e-mail the delivery ticket to the contact, click Send Email. 

 
Note  Ticket number is assigned after you save the delivery ticket.  

5. Click Save to save the delivery ticket. 
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Printing the Delivery Tickets 
You can select the formats of the delivery ticket and labels, select the contents of labels, and print tickets and 
labels. 

1. In the Delivery Ticket window, click the Format button and select the delivery ticket form you want to 
use. PrintSmith Vision provides a standard form, but you can create your own on the Form Preferences 
tab in the Configurations window of Delivery Ticket Manager. You can also set a form as the default. 
The default form is then automatically selected in the Print Ticket button (but you can always select a 
different format for your delivery tickets before printing them).  

 
2. In the Label field, select a format for your labels or click Define new label format to define a new 

format or click Edit to edit an existing format. The Carton Labels window opens. 

For more information to complete the fields in the Carton Labels window, see “Creating Carton Labels”. 

3. To print the delivery ticket, click Print Ticket; to print carton labels, click Labels. 

Configuring Delivery Tickets 
Using the Configuration window in Delivery Ticket Manager, you can control the information that the delivery 
ticket includes, for example, to/from addresses, delivery date, carton count, and so on. 

PrintSmith Vision includes a standard delivery ticket form, but you can change what this standard form includes, 
as well as create your own forms. The forms you create can then be selected when you create a delivery ticket. 
You also use the Delivery Ticket Manager window to associate a form with a particular delivery ticket report. A 
report lets you customize a form with your logo, for example.  

Using the Configuration window, you can do the following: 

• Use the Form Preferences tab to create customize or edit delivery ticket forms that can be selected 
when printing a delivery ticket. 

• Use the Brokers tab to set up additional brokers that can be selected for deliveries.  

• Use the Upload/Download tab when customizing delivery tickets.  

Form Preferences  
This section provides information about the Form Preferences tab. 

1.  In the Delivery Ticket Manager window, click the Configuration icon. The Configuration window 
opens and contains the Form Preferences, Brokers, and Upload/Download tabs. 

2. By default, the Form Preferences tab displays the Standard Form. 

To add a new delivery ticket form, click the Add icon displayed on the left-side of the window.  

3. In the title field, enter (or edit) the name of the form. 

4. Select the check boxes of the items that you want to include on this delivery ticket form, for example, 
Show Ship Via, Hide Weight, or Show Carton Count and clear the check boxes of any items you do not 
want to include on the form. 

5. By default, forms are associated with the PSV_DeliveryTicket.rpt file – the standard delivery ticket 
supplied by PrintSmith Vision. If you created a custom version of this report and want to use it with this 
form, select the report in the Associated Report field. 

Note You can associate the same customized report with more than one form. This way you can 
have a single report with your logo, but several forms that include different information in 
them. 
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6. To review the contents of the ticket, click the Sample Report Format button. 

7. To save your changes, click Save. 

 
The new form is listed on the left side of the Form Preferences tab and is available for selection in the 
Print Format field in Delivery Ticket Manager so you can print delivery tickets using this format. 

 
8. To edit a delivery ticket form, in the Form Preferences tab, click the Edit icon displayed in the row of the 

form that you want to edit. Similarly, you can click the Delete icon to delete a form. 

9. To set one form as the default form, in the Form Preferences tab, select the Default radio button for the 
delivery ticket form that you want to use as the default. 

 

Brokers 
By default, the “From” address on delivery tickets comes from your Company preferences (Preferences > 
Settings > System > Company), but you can set up additional brokers if necessary. You do so on the Brokers tab 
in the Configuration window. The brokers can then be selected for deliveries.  

You can either create new brokers or add brokers from your existing customer list.  

Note When you create delivery tickets, you can select a broker in the From section at the bottom of the Delivery 
Ticket window. 

Adding a new broker: 

1. Click Delivery Ticket Manager in the Quick Access panel (or select Admin > Delivery Ticket Manager).  

2. Click the Configuration icon in Delivery Ticket Manager and then click the Brokers tab. 

3. Click the + Broker button.  

4. Enter the company name and address in the Invoice Address section.  

5. In the Contact Person section, add a contact for the broker and click Save. 
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The new broker is listed on the left side of the Brokers tab.  

• To add a current customer as a broker, select the customer you want to define as a broker under the 
From Customer drop-down field. Make any necessary changes to the address, contact person, and 
then click Save.  

Note The statement contact in the customer account is automatically added as the broker contact 
• To change the address or contact information for a broker, click the Edit icon in the row for the broker 

you want to edit. Make any necessary changes to the address, contact person, and then click Save. 

Note  If you created a broker from a customer account, and then change information about that 
customer on the Brokers tab, the customer account (AR (Account Receivable) > Accounts) is 
not changed. Similarly, changes made to the customer account are not reflected in the 
Brokers tab. 

• To delete a broker, click the Delete icon in the row for the broker you want to delete. Then click Save. 

Note If you created a broker from a customer account, and then deleted the broker, the customer 
account is not deleted. 

Upload/Download 
You may want to customize your delivery tickets, for example, include your logo on the tickets. 

In PrintSmith Vision, the information that makes up printed delivery tickets comes from two sources: the delivery 
ticket form (as defined in the Configuration window) and a report file (.rpt). The delivery ticket form controls what 
the ticket includes while the report controls the layout and appearance of the ticket as well as some of its 
contents (such as a logo). To edit the report, you must use i-net Designer. You then associate the report with a 
delivery ticket form in the Configuration window of Delivery Ticket Manager. 

The PrintSmith Vision-supplied delivery ticket is named PSV_DeliveryTicket.rpt and is your starting point for 
customizing the delivery ticket. 

The general procedure for customizing the delivery ticket is as follows:  

• In PrintSmith Vision, download PSV_DeliveryTicket.rpt. 

•  Use i-net Designer to edit a copy of the report (for example, add your logo).  

• In PrintSmith Vision, upload your version of the delivery ticket report.  

• In PrintSmith Vision, associate your delivery ticket report with one or more delivery ticket forms. 

To download the report 

In PrintSmith Vision, download the PSV_DeliveryTicket.rpt file:  
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1. Click Delivery Ticket Manager in the Quick Access panel (or select Admin > Delivery Ticket Manager).  

2. Click the Configuration icon in Delivery Ticket Manager and then click the Upload/Download tab. 

3. In the Report file to download field, select PSV_DeliveryTicket.rpt. 

 
4. Click Download.  

The file is placed in your default Downloads folder.  

To customize the delivery ticket report with i-net Designer 

Start i-net Designer and open the downloaded file. Make the necessary changes to the delivery ticket and save 
the file. 

Important If you do not want a field to be included in the delivery ticket, turn off the corresponding setting in 
the Form Preferences tab – do not delete the field from the report. For example, if you do not want 
to show the Customer PO, make sure the Show Customer PO check box is cleared in the Form 
Preferences tab. 

To upload your customized delivery ticket report  

In PrintSmith Vision, upload the report file you edited: 

1. Click the Configuration icon in Delivery Ticket Manager and then click the Upload/Download tab. 

2. Click the Upload icon. 

 
3. Select your file and then click upload. 

 
Note The file name cannot begin with PSV_. 

4. Click Close. 

The final step is to associate your new report file with a delivery ticket form.  

To associate the report with delivery ticket form  

After you create your version of a delivery ticket report, you must associate this report with a delivery ticket form 
so that your logo and/or layout and formatting changes are available in PrintSmith Vision. 

1. Click the Configuration icon in Delivery Ticket Manager and then click the Form Preferences tab. 

2. Select the form you want to associate with the report and click the Edit icon.  

3. Select your delivery ticket report in the Associated Report field. (Your report will not be available as a 
selection if you did not upload it.)  
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4. Change other settings as necessary (to control what is included on the delivery ticket) and click Save. 
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Debug RPC  
When the PrintSmith Vision application is integrated with Fiery or Receipt Printer, you can use the Debug RPC 
option to troubleshoot.  

Note  The Debug RPC option is available only if you have selected Enable debugging of RPC in 
Preferences > Settings > POS > Cash Drawer.  

The Debug RPC window lists following information about RPC server: 

• IP Address - IP Address of the machine on which RPC server is running. 

• Live Threads - Number of active HTTP calls that are waiting for any request. 

• RPC Version - Version of the RPC server. 

Table Editor  
PrintSmith Vision includes numerous tables in which you can enter information specific to your business, for 
example, the names of your presses, the shipping methods you use, your sales representatives, and so on. This 
information can then be selected by users as needed during their work. The information from tables is typically 
available in fields where users select an item from a list.  

You use Table Editor to maintain the contents of tables and control how they are used. Some tables include 
some initial data that you can review and change as necessary; other tables are empty until you enter the data.  

Tables Properties 
Review and Edit Tables 

1. Select Configuration > Table Editor > Data List. The Table Properties window opens. 

2. Select a table and click the Table Name, for example, Sales Rep. 

The Table Editor window now shows the contents of the selected table. The data depends on the type 
of table you are viewing, but each item in a table has a unique, non-editable, sequentially assigned ID, 
which permanently identifies the item. All tables also include a Name column where you can describe 
an individual item (record) in the table. Some tables include additional columns. 

3. Do any of the following while viewing a table: 

• Sort the information in a table. For example, if you sort the names of sales representatives so they 
are in alphabetical order, they will be displayed in that order when users have to select a sales 
representative in a field.  

• Edit information by clicking a column and making your changes. 

• Add new items by clicking the plus sign (+).  An Untitled entry is added to the top of the table. Click 
Untitled and enter a name for the item. (You can then drag the item to another part of the list.) 

• Delete an item by selecting it and clicking the Delete icon. 

4. Define the properties of the table.  

5. Click Save to save your changes. 

Define Table Properties 
The properties of a table include the table title, name, and status settings that controls how the table is used. 

1. Select Configuration > Table Editor > Data List. The Table Properties window opens. 

2. In the Title column, change the name of the table if necessary. 

3. In the Table Status field, select one of the following to control how information is added to the table. 

Status Description 
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Editable You can use Table Editor to add items to the table or remove items 
from it. (Unless a table is locked, you can always add or remove items 
using Table Editor.) 

Locked You cannot add or delete entries in the table or change the status of the 
table. You can, however, edit existing items in the table. 

Add Edit  Any field that relies on this table includes an Edit option. You can click 
Edit to edit the table directly without having to open Table Editor and 
then having to select the table. 

Add Input You can type information into a field, but this information is not added to 
the related table in Table Editor. For example, if you enter the name of 
a sales rep in the Account Info window while creating an estimate, this 
sales rep is saved as part of the estimate, but is not added to the Sales 
Rep table. 

Add Input Edit This combines an Edit option at the end of a list of selections in a field 
with the ability to type your own entries. 

4. In the Sort by column, indicate how you want the records in the table sorted. For example, if you sort 
the Sales Rep table by Name, whenever users need to select a sales rep, they are listed in alphabetical 
order by name. 

Option Description 

Not sorted Items are listed in the order they were entered. 
Table ID Items are sorted by their unique ID (in the first column of the table.) 

Key 
(alphabetically) 

Items are sorted by the alphabetic key (applies only to tables that have 
such a key). 

Key (numerically) Items are sorted by the numeric key (applies only to tables that have 
such a key). 

Name Items are sorted by their name (in the Name column). 

Vendor 
The Vendor window enables you to enter or edit vendor information. To add a vendor, click the plus (+) icon. 

 
Note  You can only add vendors from this window. You must have access to suppliers to edit or add vendors. 
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You can enter contact details and miscellaneous information. You can enter up to 4 contacts in the Contact 
Details section. In the Miscellaneous section, you can enter information about the vendor such as the material 
they supply, tax ID, payment terms, etc. You can also identify when you need to send the vendor a tax 
exemption notice 

Note  You must select the Use in Purchase Order option in order for this vendor to be displayed on the 
vendor list in the Purchase Order window. 

Reasons 
Use the Reasons window to set up reasons for the lost estimates. See Estimate History for more information on 
Reasons. 
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Preferences 
Preferences are a key part of PrintSmith Vision. They control many aspects of the system and its behavior. For 
example, you use preferences to define your business calendar, pricing markups, quantities for price lists, and 
aging periods. 

Preferences are critical to the way your system works so be sure to review all of the preference settings and 
make any necessary changes before you start using PrintSmith Vision. Not all preferences are applicable to your 
business, and many have default settings, but you should consider each preference and its effects. You can 
change preferences at any time. 

To review and set the Preferences: 

1. Select Configuration > Preferences > Settings. 

Preferences are grouped under System, POS, Estimator, and Account. 

 
2. Click a type of preference on the left-side (for example, Behavior or Business Calendar) to display its 

settings on the right side of the window.  

3. Review the settings and make your changes. 

4. Save your settings by clicking Save.  

Settings  

System Preferences 
System preferences, as their name suggests, establish system-level rules, for example, about general behavior, 
company information, numbers, international settings, e-mail configuration, and automated backups. 

Behavior: Use the Behavior preferences to control some of the general ways PrintSmith Vision acts. For 
example, you can choose to suppress some warning messages or force PrintSmith Vision to quit after a 
period of inactivity. 

Company: Use the Company preferences to enter your company information, which is included in some 
documents. For example, some of this information is used as the remittance address in statements, or 
when estimates or invoices are e-mailed. 

Business Calendar: Use the Business Calendar preferences to specify your fiscal year, as well as to set 
workdays. The fiscal year you specify here affects how sales history is reported throughout PrintSmith 
Vision in terms of current and previous years, for example, in the Account History and Account Ranking 
reports, as well as on the Sales Info tab in the Account window, the dashboard, and so on. 

Numbers: Use the Numbers preferences to change some aspects of numeric formatting such as rounding. 
Numbers preferences are also related to localization, for example, the currency symbol or 
decimal/thousands delimiters used in a particular country. These settings are taken from operating system 
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settings on the PrintSmith Vision server so you should not need to change them. For example, if the 
operating system is German, the delimiters will be set appropriately. 

Alternate Currency: Use the Alternate Currency preferences to set up and include another currency on 
invoices, estimates, statements, and receipts. In particular, these preferences support the European 
Union’s standard currency, the Euro. 

International: Set the International preferences if you are located in a country other than the United States 
of America. Although some of these settings are country-specific, in all countries you should indicate the 
unit of measure for ink weight. In addition, if you normally use a character other than a comma (,) to 
separate fields in CSV files (used to import certain kinds of data into PrintSmith Vision), you can specify 
that character here. Likewise, if you do not use double-quotes (“) to delimit text in CSV files you can specify 
that character here. 

E-mail: Use the E-Mail preferences to configure your e-mail account with PrintSmith Vision so that you can 
e-mail various documents, for example, estimates, invoices, purchase orders, statements, and credit 
memos. For more information, see E-Mail Preferences. 

Fiery Media: Set size, recycled percent, thickness, and weight. 

Dashboard: Use the Dashboard preferences to control some aspects of the Dashboard. 

Backup Manager: Use the Backup Manager preferences to schedule daily backups of your PrintSmith 
Vision system or to perform a backup right away (manually). ePS strongly recommends that you back up 
your entire PrintSmith Vision system regularly to avoid losing data critical to your business if a system 
failure (such as a hard disk crash) or some other disaster occurs. Always back up the data to an external 
device or take advantage of a cloud -based backup service. 

Mandatory Field: Use the Mandatory Field preferences to make certain fields required. Users will not be 
able to continue or complete a particular task without providing the required information 

HTML View: Changes the view of different templates. 

Point of Sale (POS) 
Receipt: Use the Receipt preferences to set the header and footer text for receipts as well as the receipt 
numbering and tax option. 

Cash Drawer: Use the Cash Drawer preferences to enable the optional receipt printer and to control aspects of 
receipt printing. The receipt printer – a Star TSP 700ll printer – must be purchased from ePS. 

Cash Register: Use the Cash Register preferences to control the names and purpose of the sales departments 
in the Cash Register window. If your business does a lot of small transactions, you should configure the cash 
register to match the types of transactions for which you do not need to create invoices. 

Estimator 
Estimator Behavior: Use the Estimator Behavior preferences to control some general settings that affect the 
estimating process. For example, you can control whether the parent size of a stock is always used or whether 
the Paper Calculator window opens automatically when you create new jobs. 

Estimator Printing: Use the Estimator Printing preferences to determine if an invoice is closed after the job 
tickets are printed, what the default invoice and estimate formats are, and how the payment due date is 
calculated. 

Paper Calculator: Use the Paper Calculator preferences to enter default settings for the Paper Calculator. 
These defaults can be overridden when working in the Paper Calculator window. 

Paper Calculator Signage: Use the Paper Calculator Signage preferences to enter the default settings for 
Paper Calculator those specific to Signage jobs. These defaults can be overridden when working in the Paper 
Calculator window. 

Note Trim 4 Sides option will be disabled if the Tile value is more than one.  
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Job Ticket: Use the Job Ticket preferences to select a ticket style and decide what to include on job tickets . 

Quantity Break: Use the Quantity Breaks preferences to enter the quantities to use in price lists. These 
quantities serve as break points to determine prices based on a particular quantity ordered. 

Markups: Use the Markups preferences to set the amounts by which you want to mark up outside service jobs 
and merchandise jobs. Markups are based on total costs. The first amount covers costs from zero to the 
specified cost, and the last amount covers anything above the last specified cost. 

Stock and Sizes: Use the Stocks and Sizes preferences to specify settings for in stock, special order, and 
customer stock; provide formatting instructions for stock descriptions in documents; and specify markups for 
blank stock pricing. 

When you have to select a stock while creating an estimate or invoice for the job, you can click the Stock picker 
icon. Normally the stock name is displayed in the search but using the Stock and Sizes preferences, you can 
select what you want to display in that search. You can set up to display the stock name, type and color. 

You can select the information you want to see on the search display and how you want the information divided. 
You can also display the chain of customer for the stock. 

Pricing Method: Use the Pricing Method preferences to select the job pricing methods you want available as 
selections when creating jobs. (Selecting a job pricing method is the first step in creating a new job.) You can 
also change the title (name) of a pricing method to match conventions used at your company. The pricing 
method calculations, however, remain the same even if you change the name of a pricing method. For example, 
if you change Printing to Offset or B&W to Digital B&W, the underlying methods used for calculations remain 
unchanged. 

You can also use these preferences to control whether purchase orders can be generated when a particular 
pricing method is selected for a job. 

Account 
Credit/Defaults: Use the Credit/Defaults preferences to establish credit limits and other defaults for accounts. 

Aging Periods: Use the Aging Periods preferences to define the number of days before an account is past due, 
delinquent, or frozen, as well as provide the notices that are included on statements for accounts that meet these 
criteria. The standard aging periods are 30, 60, and 90 days, but you can change these to suit your business 
needs better. 

Sale Categories: Use the Sales Categories preferences to group your sales for tracking purposes. Typically, you 
want to define sales categories that you can then associate with departments in the cash register and with job 
pricing methods, as well as with your press, digital, and charge definitions. PrintSmith Vision keeps track of sales 
categories by their numeric ID. Once sales are recorded in a category, they stay in that category based on its 
numeric ID, not its name. 

GL Profiles: Use the GL Profiles preferences if you use an external accounting package. With these 
preferences, you define a link to the accounting package, as well as define specific GL account numbers that 
relate to this accounting package. When you perform a closeout, you can export data (from the fields described 
below) in the form of an .IIF file. This file can then be imported to your accounting system. 

Credit Card Info: If you are not using integrated credit card processing in PrintSmith Vision, use the Credit Card 
Info preferences to select the credit cards that you will accept as a payment method in PrintSmith Vision. 
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If you are using integrated credit card processing in PrintSmith Vision (which is licensed separately), use the 
Credit Card Info preferences to configure the connection to the payment gateway. For information, see 
PrintSmith Vision Credit Card Integration Guide. 

Order Number Format: Use the Order Number Format preferences to specify the prefixes and/or suffixes that 
you want to use with invoice and estimate numbers. For example, your company may follow a convention where 
all estimates begin with a location or store number so this information would be your prefix for estimates 

PO Settings: Use the PO Settings preferences to specify a prefix and/or suffix to be used with purchase order 
numbers and to control where in PrintSmith Vision purchase orders can be created. 

Closeouts: Use the Closeouts preferences to schedule closeouts so they occur automatically. 

E-Mail Preferences  
Use the E-Mail preferences to configure your e-mail account with PrintSmith Vision so that you can e-mail 
various documents, for example, estimates, invoices, purchase orders, statements, and credit memos.  

Supported e-mail 
If you are hosting PrintSmith Vision, you have these choices for configuring e-mail: 

• SMTP is a protocol for sending e-mail messages between servers. Gmail, Yahoo, and Outlook/Hotmail 
accounts are all examples of SMTP mail. You can configure this type of e-mail as described in “Set up 
SMTP mail” below. 

• If your organization uses the Microsoft Outlook Exchange Server based on basic or advance 
authentication, you can configure an Outlook Exchange account. See “Set up Microsoft Exchange 
Server mail (Old)” or “Set up Microsoft Exchange Server mail (New)”. 

If ePS is hosting PrintSmith Vision, you have these choices for configuring e-mail: 

• You can take advantage of ePS mailing infrastructure. See “Use ePS mail” below. 

• If your organization uses the Microsoft Outlook Exchange Server based on basic or advance 
authentication, you can configure an Outlook Exchange account. See “Set up Microsoft Exchange 
Server mail (Old)” or “Set up Microsoft Exchange Server mail (New)”. 

Use ePS mail (for ePS-hosted installations) 
If ePS is hosting PrintSmith Vision, you can use the mailing infrastructure of ePS. To do so: 

1. In PrintSmith Vision, navigate to Configuration > Preferences > Settings > System > E-Mail. This 
opens the E-Mail preferences window. 

2. To start the e-mail configuration process, select the Enable E-Mail Settings check box. 

3. Select Use ePS mail (for ePS-hosted installations). 

4. Click Save. 
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Note By default, the “from” address for e-mailed invoices or estimates is the e-mail address specified in your 
Company preferences, unless the user who is e-mailing the documents has an e-mail address specified 
in his or her User Definition. In that case, the user’s e-mail address is used as the “from” address. 

Set up SMTP mail (not for ePS-hosted installations)  
SMTP is a protocol for sending e-mail messages between servers. Gmail, Yahoo, and Outlook/Hotmail accounts 
are all examples of SMTP accounts. If you use SMTP e-mail, follow these instructions to configure your e-mail. 

Note  ePS recommends that you always check with your e-mail provider to obtain some of the information you 
need to configure e-mail. 

1. Navigate to Configuration > Preferences > Settings > System > E-Mail. This opens the E-Mail 
preferences window. 

2. To start the e-mail configuration process, select the Enable E-Mail Settings check box. 

3. Select Set up SMTP mail (not for ePS-hosted installations). 

4. In the SMTP Host field, enter the server name of the third-party account. For example: 

• smtp.gmail.com for a Gmail account 

• smtp.office.365.com for an Outlook account 

• smtp.mail.yahoo.com for a Yahoo account 

• For other types of accounts, check with your provider. 

5. In the SMTP Port field, enter the port number. For Gmail this is 465; for Outlook it is 587. For other 
types of accounts, check with your provider. 

6. For Gmail, Outlook, Hotmail, and Yahoo accounts, select the SMTP Authentication check box. For 
other types of accounts, check with your provider. 

7. If you selected the SMTP Authentication check box, provide your login credentials: 

a) In the User Name field, enter the name you use to log into the e-mail account. For example: 
Test@gmail.com or Test@Outlook.com. 

b) In the SMTP Password field, enter your password for the account. 

Notes  By default, the “from” address for e-mailed invoices or estimates is the e-mail address 
specified here, unless the user who is e-mailing the documents has a valid e-mail address 
specified in his or her User Definition. In that case, the user’s e-mail address is used as the 
“from” address. 

 For Outlook SMTP configuration, when adding a user account in Microsoft 365 admin center, 
ensure multi-factor authentication is disabled and Authenticated SMTP option is selected. 

8. Set the following: 

• Enable TLS Connection 

Select this check box (it must always be selected). 

• Enable SLL Socket 

If SMTP Port is set to 465, select this check box. 

• Trust SMTP Host 

If SMTP Port is set to 587, the Enable TLS Connection check box is selected, and the Enable SLL 
Socket check box is cleared, but when you click Check Connection you get an error message 
about the connection failing due to “Could not convert to TLS,” select the Trust SMTP Host check 
box. 

• Third Party 

By default, if a user has a valid E-Mail and E-Mail Password defined (in his or her user definition), 
the e-mail address in the user definition is used as the “from” address when the user e-mails an 
estimate or invoice. If either the E-Mail or E-Mail Password field in the user definition is blank, and 
the Third Party check box is selected, the e-mail address specified in the User Name field (in these 
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E-Mail preferences) is used as the “from” address when estimates or invoices are e-mailed. If either 
the E-Mail or E-Mail Password field in the user definition is blank, and the Third Party check box is 
not selected, the e-mail address specified in the Company preferences is used as the “from” 
address. 

Note  Gmail servers ignore the setting of the Third Party check box. 
9. Click Check Connection to verify your e-mail is configured correctly. 

10. Click Save. 

The figure below illustrates how you would configure a Gmail account. 

 

Set up Microsoft Exchange Server mail (Old) 
If your company uses Web-based version of Microsoft Outlook Exchange Server (basic authentication), follow 
these instructions to configure an e-mail account. If necessary, contact your IT department for the details you 
must provide. 

1. Navigate to Configuration > Preferences > Settings > System > E-Mail. This opens the E-Mail 
preferences window. 

2. To start the e-mail configuration process, select the Enable E-Mail Settings check box. 

3. Select Set up Microsoft Exchange Server mail (Old), if your company uses a basic authentication 
version of Microsoft Outlook Exchange Server to configure an e-mail account. 

4. In the E-Mail ID field, enter the e-mail address of the account holder. For example, 
Luisa.Gonzales@mycompany.com. Typically, this would be a company representative. 

5. In the Domain field, enter the name of the domain to which the user belongs. 

6. In the User Name and Password fields, enter the login credentials for the account. 

7. In the Exchange Server field, enter the address of your Exchange server. 

8. Click Check Connection to verify your e-mail is configured correctly. 

9. Click Save. 
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Set up Microsoft Exchange Server mail (New) 
This section covers the setup and configuration for Microsoft Outlook integration with PrintSmith Vision using 
Microsoft Graph API, so you can send e-mails from PrintSmith Vision. Microsoft Graph is a REST API that 
enables you to access Microsoft services such as Outlook, Teams, and so on.  

When configuring E-Mail preferences, you should first register the application in Azure and then provide its 
settings values in PrintSmith Vision. 

The following gives a high-level overview of the tasks involved in setting up the Microsoft Outlook and PrintSmith 
Vision integration.  

• Register the application in Azure 

• Obtain application ID and tenant ID 

• Generate client secret ID 

• Set up permission 

• Grant required permissions 

• Configure E-Mail Preferences in PrintSmith Vision 

Task 1: Register the Application 
As the first step to use Outlook in PrintSmith Vision, you must register the PrintSmith Vision application in the 
Azure portal. 

1. Sign-in to https://portal.azure.com/ with administrator access. 

2. From the Welcome page, access the App registrations page by entering “app registration” in the 
search field at the top of the page, and then pressing the Enter key. 

 

https://portal.azure.com/
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3. In the App registrations page, click the New Registration button. 

 
4. In the Register an application page, complete the following: 

• Name: Enter name for this application. 

• Supported account type: Select who can access this application. 

• Select Accounts in any organizational directory (Any Azure AD directory - Multitenant) if 
you want to send e-mails to users with in and outside your organization.  

• Redirect URI (optional): Leave the field as blank. 

5. Click Register. 

 
When the application is successfully registered in Azure Active Directory, the following message is 
displayed: 
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Task 2: Obtain the Application ID and Tenant ID 
After registering the application, take a note of the values for the following two items on the Overview page. This 
value is required when configuring E-mail preferences in PrintSmith Vision. 

• Application (client) ID 

• Directory (tenant) ID 

 
You can hover over the field value to display the copy icon.  
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Task 3: Generate Client Secret ID 
As the next step, you need to generate a client secret for the application. 

1. In the Overview page, click the Client credentials link on the right to generate a secret. 

 
2. In the Client secrets section of the Certificates & secrets page, click New client secret. 

 
3. In Add a client secret, complete the following: 

• Description: Enter a description for the secret. 

• Expires: Select the duration for which the secret is valid. 

Note: You must renew your secret before the expiration date. 
4. Click Add. 

 
5. Copy the client secret value in the Value column. This value is required when configuring E-mail 

preferences in PrintSmith Vision. 

Important  Ensure that you copy the secret value right away, as the secret value is never  
displayed again after you leave this page.  
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Task 4: Set up Permission 
The next step is to configure appropriate API permission for the application. 

1. From the Overview page, click API permissions from the left navigation pane. 

 
2. In the API Permissions page, click the Microsoft Graph link in the Configured permissions section. 

 
3. In the Request API permissions page, click Application permissions. 
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4. In the Select permissions field, enter the name of the permission you want to grant your application. 

For Microsoft Outlook integration, enter Mail in the search field. 

 
5. Under Select permissions, expand Mail, and then select Mail.Send. 
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Note Microsoft Graph's Mail.Send permission requires admin consent. When you have 

administrator access, you can grant admin consent by clicking the Grant admin consent 
button on the API permissions page. 

6. Click Add permissions. 

In the API permissions page, the Configured permissions section lists the permissions that you have requested 
for the application. 

 

Task 5: Grant Required Permissions 
After adding a permission, you must get admin consent so that the application can access Outlook. 

On the API permissions page, if the Status for the permission displays 'Not granted for...', you have to either 
request for admin consent or grant admin consent to the permission depending on your access type. 
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If you are an administrator, to grant admin consent: 

1. In the Configured permissions section of the API permissions page, click Grant admin consent for... 

2. Click Yes to confirm. 

  
After granting consent, the Status for the permission changes to Granted for..., which indicates as 
having consent granted. With this permission a user would have the permission to send emails on 
behalf of every user in the organization. 

 
Note  If you are not an administrator, you have to send a request to the administrator to grant this 

permission for the application. 
Configure Email Preferences in PrintSmith Vision 
After administrator authorizes the permissions, you must have the following values to configure the E-Mail 
preferences in PrintSmith Vision to access Outlook: 

• Application Client ID 

• Directory Tenant ID 

• Client Secret key 

Use the E-Mail preferences to configure your e-mail account with PrintSmith Vision so that you can e-mail 
various documents, for example, estimates, invoices, purchase orders, statements, and credit memos. 
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1. Sign-in to PrintSmith Vision. 

2. Navigate to Configuration > Preferences > Settings > System > E-Mail. This opens the E-Mail 
preferences window. 

3. To start the e-mail configuration process, select the Enable E-Mail Settings check box. 

4. Select Set up Microsoft Exchange Server mail (New), if your company uses the advance 
authentication version of Microsoft Outlook Exchange Server to configure an e-mail account.  

5. In the E-Mail ID field, enter the e-mail address of the account holder or the “from” address to be used 
while sending e-mails. For example, Luisa.Gonzales@mycompany.com or sales@mycompany.com. 

Note By default, the “from” address for e-mailed invoices or estimates is the e-mail address 
specified here (in the E-Mail ID field), unless the user who is e-mailing the documents has a 
valid e-mail address, name, and password specified in his or her User Definition. In that case, 
the user’s e-mail address is used as the “from” address. 

 For multiple domains, the e-mail address specified in the User Definition is used. 
6. Complete the following fields with values you recorded when you registered the application in the Azure 

portal: 

 
• Application Client ID: Enter the Application (client) ID value from the Overview page. See Task 2: 

Obtain application ID and tenant ID. 

• Client Server: Enter that value that was generated in the Certificates & secrets page. See Task 3: 
Generate client secret ID. 

• Directory Tenant ID: Enter the Directory (tenant) ID value from the Overview page. See Task 2: 
Obtain application ID and tenant ID. 

• Authorization URL: https://login.microsoftonline.com/{tenant}/oauth2/v2.0/token. URL to get the 
authorization token, which can used to make subsequent calls to Microsoft Graph. Replace {tenant} 
with the Directory (tenant) ID value from the Azure portal.  

• Graph URL: https://graph.microsoft.com/v1.0. Microsoft Graph URL. 

mailto:Luisa.Gonzales@mycompany.com
mailto:sales@mycompany.com
https://login.microsoftonline.com/%7btenant%7d/oauth2/v2.0/token
https://graph.microsoft.com/v1.0
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7. Click Check Connection to validate the connection. 

If the test was successful, “Connections Successful” message is displayed indicating that your 
connection is configured correctly. 

If the test failed, then edit the configuration details you entered. Verify ID values and check for typos, 
and then continue to test until the connection is successful. 

8. Click Send Test E-mail to validate a successful send using advance authentication. In the Test E-Mail 
window that opens, complete the fields, and then click Submit.  

 
If the test was successful, “Email sent successfully” message is displayed indicating that your email 
account is now using your advance authentication configuration. Verify that the correct email address 
appears in the From address in the received email. 

Note  The Sent Test E-mail button is available only when Set up Microsoft Exchange Server 
mail (New) is selected. 

9. Click Save. 
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Other Settings 
Customize E-mail fields before sending 
If you want to customize certain types of e-mail messages before they are sent, select the Customize E-mail 
fields before sending check box. When the Customize E-mail fields before sending check box is selected, 
each time you click the E-Mail Invoice/Estimate button in the Invoice or Estimate window or in the Purchase 
Order window, you can add recipients, change the subject of the e-mail, and edit the body. 

Use log text for subject and file name 
If you want to use the log text for the subject line of e-mails and the name of the attached PDF file, select the 
Use log text for subject and file name check box. If you select this check box, make sure the log text you enter 
is suitable for all three purposes: log entry, e-mail subject, and name of the PDF file. When the check box is 
cleared, the log text is used just for log entries, and the subject and PDF name follow the default conventions. 
For more information on default conventions, see “Email Template”. 

If the Use log text for subject and file name check box is cleared, the subject and PDF name follow the default 
conventions. They will also follow the default conventions if you select the Use log text for subject and file 
name check box, but leave the log text fields blank. 

Include sender on CC line 
To send a copy of the e-mail to the sender, select the Include sender on CC line check box. 

Multiple domain support 
To enable e-mail set-up for multiple domains, select the Multiple domain support check box. Selecting this 
option allows users to make use of multiple domains.  

Note  The Multiple domain support check box is available only when the Set up Microsoft Exchange 
Server mail (New) option is selected in E-Mail preferences. 

As a prerequisite to use the second domain, the application should be registered in the Azure portal by using the 
second domain. Follow the instructions in Tasks 1 – 5 (Set up Microsoft Exchange Server mail (New)) to get the 
Application Client ID, Client Secret, and Directory Tenant ID values corresponding to the second domain.  

If your organization has multiple email domains and users want to send emails using different domains, then the 
same (second domain) has to be set-up at the user level. You can enter the e-mail credentials for the second 
domain in the User Definitions window. For information about the fields in the User Definitions window, see 
User Definitions. 

When the Multiple domain support option is selected, the User Definitions window displays three additional 
fields for each user record – Application Client ID, Client Secret, and Directory Tenant ID. These fields have 
to filled only for users who want to use the second domain. For example, if in an organization of 50 users, only 4 
users choose to use the multiple domains, then the setting values should be entered only for those 4 users. 

• In the User Definitions window, enter the credentials for the second account in the Email and Email 
User Name fields. 

• In the Application Client ID, Client Secret, and Directory Tenant ID fields, enter the setting values from 
the Azure portal for the second domain from which you want to send emails.  

• The Send Test E-Mail button enables you to verify if a test e-mail was sent. As the second domain is 
configured by a user, the test e-mail is sent to the same user who is doing to set-up. 



Preferences | User Guide • 327 

 

 

 
Note  When you select the Multiple domain support option, this email address (User Definition) is used as 

the “from” address when the user e-mails documents to customers. If no email address is specified, the 
e-mail address in the E-mail preferences is used as the “from” address instead. 

Log e-mails 
When documents are e-mailed from the Cash Register, Post Payments, or Generate Statements window, the e-
mail details are automatically logged in System Monitor (Configuration > System Monitor > E-Mail Status).  

In the Log section of the Accounts window, you can also track the e-mails that are sent from the Invoice, 
Estimate, Cash Register, Post Payments, Journal Entry, and Generate Statements windows. To do so, you must 
enter some text in the log text fields in the E-Mail preferences. This text serves as the log entry which is recorded 
on the Log section. If the Invoice log text field or Estimate log text field is left blank, no logging takes place on the 
Log section in customer accounts. 

To enter e-mail log text 

1. If you want to use the same text for the log entry, e-mail subject, and name of the PDF file, select the 
Use log text for subject and file name check box. 

2. Enter text in each log text field for which you want to log sent e-mails. Note that ^0 serves as a place 
holder. Move the pointer over the info icon  to see what ^0 will be replaced with. For example, an invoice 
number or account number. 

The log text fields correspond to the following: 

• Invoice log text: E-mailed invoices sent from the Invoice window  

• Estimate log text: E-mailed estimates sent from the Estimate window  

• Statement log text: E-mailed statements 

• Cash register log text: Posted invoices e-mailed from the Cash Register window  

• Post Payments log text: Posted invoices e-mailed from the Post Payments window  

• Credit Memo log text: Credit memos e-mailed from the Journal Entry window 

3. By default, Account log type for sent e-mails is set to EMAIL. If you created a different log type (in the 
Customer Log Type table) that you want to use for categorizing e-mail logs, select a different Account 
log type. 

When e-mail is logged, the entries are recorded on the Log section in an account. Each entry includes 
the date the e-mail was sent, the Type of log, and a Comment. The Type is what was selected in the 
Account log type field in the E-Mail preferences, and the text of the Comment comes from the log 
text field in the E-Mail preferences. If a ^0 place holder was included, it is replaced by actual data, for 
example, an invoice number. 

For example, if the Invoice log text field includes Invoice ^0 e-mailed, this will be the Comment on 
the Log section  in a customer account, for example, Invoice 164093 e-mailed. 
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Credit Card Manager 
You can review a list of all credit card transactions and see their status. For example, you may need to research 
a transaction, find a reference number, reprint a receipt, or void a transaction.  

The Credit Card Manager window lists the card transactions that have taken place since the last daily closeout. 
This list includes: 

• Information about the transaction, for example, Charge to card, with the last four digits of the card 
number where applicable.  

• The amount involved.  

• The status, for example, Approved or Declined.  

• The order (invoice) number where applicable.  

• The name of the user who was logged in when the transaction was recorded.  

• Colors are used to identify transactions. 

 
1. Select Configuration > Preferences > Credit Card Manager. The Credit Card Manager window 

opens. This window displays all the transactions made with PrintSmith Vision. The two types of 
payment methods available are: USA ePay and Card Connect.  

2. Do any of the following: 
• Print Receipt: Click this to reprint the receipt for the selected transaction. You can only reprint a 

receipt if you previously printed one from the Cash Register or Post Payments window.  

• Refresh: Click this to update the list.  

• Void: Click this to void the selected transaction.  

• Delete: Click this to delete a transaction that was hung. 

• Include Historic Transactions: Enable this to list all credit card transactions from the past.  
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CardConnect Setup 
If you are using CardConnect® to process your credit card transactions, use the CardConnect Setup window to 
set up the card details. For information on setting up and managing CardConnect®, see the PrintSmith Vision 
Credit Card Integration Guide. 
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System Monitor 
PrintSmith Vision includes some features to help you monitor your system, for example, to check “user events” 
such as successful logins or failed login attempts. 

System Monitor includes the following options: 

• User Sessions  

• User Events 

• E-mail Status 

Access to PrintSmith Vision 
All users must log into PrintSmith Vision. As part of setup, you must define a login account (username and 
password) for each PrintSmith Vision user and decide which PrintSmith Vision features should be available to 
the user. You do this by assigning users to a security access group for the work they perform. 

Before you start defining PrintSmith Vision users, you should establish yourself as the administrator and change 
the admin password supplied by ePS. You should also prevent access to PrintSmith Vision without a password. 
See “Changing Your Password” for more details. 

User Sessions 
Whenever someone logs into PrintSmith Vision, a user session is established. You can see the maximum 
number of user sessions allowed (based on your license), the number of currently active sessions, and the 
names of the users who are currently logged in along with the IP address (of the user’s computer), the time the 
user logged in, and the time the user last performed an activity. 

In addition to reviewing the active sessions, you can terminate a session. For example, if someone closes the 
browser without logging out, or a browser crash, you may run out of licenses because the session for that user is 
still active. In this case you can end a session to free up a license. 

1. Select Configuration > System Monitor > User Sessions. The usernames of all logged in users 
are listed. 

2. If you need to terminate a user session (perhaps because you notice that person is logged in 
multiple times), select that session and click Terminate. 

 

User Events 
You can track actions such as logins and logouts, failed logins, and password changes. Failed logins, for 
example, could indicate an unauthorized user was trying to use the system. The Activate user event logging 
preference (Preferences > System > Behavior) controls whether user events are tracked. 

1. Select Configuration > System Monitor > User Events. 
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2. The User Events window now lists activities such as logins, failed logins, and password changes 

by date and time and username. You can also import CSV to get a detailed report. 

E-Mail Status 
When you e-mail statements or e-mail posted invoices from the Cash Register or Post Payments window, the 
sent e-mail is automatically logged in System Monitor. 

1. Select Configuration > System Monitor > Email Status. 

E-mails are identified by Type: Statements, Post Payments, or Cash Register. For statements, 
the Item Number and Description columns identify the number and name of the customer account; 
for posted invoices e-mailed from the Cash Register or Post Payments window, the Item Number 
and Description columns identify the number and description of the invoice. 

 
2. Do any of the following when reviewing the e-mail logs:  

• By default, the e-mails are listed by Created Date (most recent first). Click a column heading to 
sort the list a different way.  

• To update the list with any recently sent e-mails, click Refresh. 
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Backup Manager Preferences 
Use the Backup Manager preferences to schedule daily backups of your PrintSmith Vision system or to perform 
a backup right away (manually). 

Notes  The Backup Manager preferences apply only to customer-hosted installations of PrintSmith Vision; if 
PrintSmith Vision is ePS-hosted, backups are performed for you automatically. 

  Security permissions control who can set up automated backups and/or perform backups manually. 
ePS strongly recommends that you back up your entire PrintSmith Vision system regularly to avoid losing data 
critical to your business if a system failure (such as a hard disk crash) or some other disaster occurs. Always 
back up the data to an external device or take advantage of a cloud-based backup service. 

When you use Backup Manager, the following are backed up: 

• The PrintSmith Vision database. 

• The Scheduler database if you are licensed to use Scheduler. 

• All standard (ePS-supplied) and custom reports (including estimate and invoice reports). 

• The DigitalAssetsRepository folder that contains all the content files that were uploaded for jobs. 

• The ReportScheduleRepository folder that contains all the scheduled reports that were generated. 

 

Note  ePS recommends configuring Backup Manager on the computer where the PrintSmith Vision server 
resides. 

Set up Preferences for Automated and Manual Backups 
ePS recommends that you take advantage of automated backups to ensure that your backed up data is never 
more than a day old to minimize data loss. 

1. In PrintSmith Vision, navigate to Configuration > Preferences > Settings. 

2. Under the Security section, click Backup Manager. 

3. Select the Enable Automatic Backup Manager checkbox to schedule automated backups. 

4. In the Choose Backup Destination field, enter the full path to the folder where you want the 
backups to be stored.  

Note You must manually enter the path to an existing folder. 
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The following table shows examples of some directory and folder paths. 

System 
Type 

Path Description 

Windows D:\PrintSmith Backups To save the backups in a folder you already created, for 
example, PrintSmith Backups on the D:\ drive. 

Note  This is an example for a single use backup only, 
and not recommended to be used for backups on 
continuous basis.  

Windows C:\Users\username\Desktop 
(where username is your 

Windows user name) 

To save the backups on the desktop. 

Note  This is an example for a single use backup only, 
and not recommended to be used for backups on 
continuous basis. 

Windows E:\PrintSmith Backup To save the backups on external storage devices such 
as USB drive or external hard disk.  

Windows  \\servername\sharedfoldername To save the backups in a shared folder on a network 
drive. 

Mac 
(Macintosh) 

/Users/username/Desktop  
(where username is your user 

name)  

To save the backups on the desktop. 

Note  This is an example for a single use backup only, 
and not recommended to be used for backups on 
continuous basis. 

Mac 
(Macintosh) 

/Users/username/Documents  
(where username is your user 

name) 

To save the backups in the Documents folder. 

Note  This is an example for a single use backup only, 
and not recommended to be used for backups on 
continuous basis.  

Mac 
(Macintosh) 

//servername/sharedfoldername To save the backups in a shared folder on a network 
drive. 

Note For more information on finding the path to a folder on a Macintosh computer, see “Tips for Mac Users”. 
 

Important   It is not recommended to store your backups on the same computer or the same drive where 
PrintSmith Vision resides. 

5. Click Perform Backup Now to manually backup your data. 

• If you do not want to automate your backups, you can back up your data manually at any time. You 
can also back up data manually even if you do automated backups. 

6. Enter the time when the backup should occur automatically in the Time of day to Backup field. 

• By default, backup will occur at 23:00 (11:00 PM) daily. 

Note  Do not enter the time between 23:30 and 01:00 as the system performs internal maintenance 
during this period. 

7. Enter the number of backups that you want to store in the Number of Backups to keep field. 

• By default, the system keeps 7 backups in the backup destination folder that you specified. When 
the total number of backups reaches the number you specify, the system automatically deletes the 
oldest backup. If your database is very large, you may want to limit the number of backups to save 
on the disk space. 

Note  The Number of Backups to keep applies only to automated backups, not for manual ones. You 
must delete manual backups when you no longer need them. 

8. In the Warning Before Backup field, enter time in seconds when logged in users are to be warned of a 
backup before the scheduled time.  
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• Backup Scheduled for displays the date and time when the next automatic backup is scheduled. 

• Last Backup Performed displays the date and time when the last automatic backup was 
performed. 

9. In the Network Folder Access User Details section, enter the login credentials to access the network 
folder. 

• If you have specified a shared network folder in the Choose Backup Destination field, you must 
have read/write or full control access to the network folder.  

• Enter the Domain. 

• Enter the network Username and Password. 

Notes The shared folder can be in the same work group or a different workgroup. In either case, 
Username and Password are required. 

 Typically, the Username and Password would be the admin credentials for the computer 
where the folder resides (not your user credentials. 

• To backup PrintSmith Vision to a network folder on a Windows system, you must enable the SMB 
1.0 file sharing support protocol on the networked machine. To enable the SMB1.0 file share 
protocol, do the following: 

• Open the Control Panel window.  

• Click Programs > Programs and Features > Turn Windows features on and off.  

• Scroll down to SMB 1.0/CIFS File Sharing Support and click the checkbox.  

• Click the expand folder icon () a) and verify the following options are enabled: 

• SMB 1.0/CIFS Automatic Renewal 

• SMB 1.0/CIFS Client 

• SMB 1.0/CIFS Server 

• Click OK.  

 
10. Click Save on the Backup Manager window. 

Important  It is recommended to store your backups on an external storage device or a different 
drive other than where PrintSmith Vision resides.  

 If the backup destination folder is on the same computer where PrintSmith Vision 
resides, always copy the backups to an external device, or take advantage of a cloud-
based backup service. Otherwise, if the hard disk crashes, you will lose your backups 
along with your data. 
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Tips for Mac Users 
If you are not sure how to specify the path to the folder where you want your backups to be saved on your Mac 
system, do the following: 

1. On your Mac, click Finder and right-click the backups folder to display the context menu. 

2. While in the context (right-click) menu, press and hold down the Option key to see the Copy 
“folder name” as Pathname option; it replaces the standard Copy option. 

Example: For a folder named PSV Backup on an external storage device, you will see the context 
menu as shown in the figure below. 

3. Click the Copy “folder name” as Pathname to copy the full path of the folder. 

 
4. In PrintSmith Vision, click the Choose a Backup Destination field in the Backup 

Manager window and press COMMAND+V to paste the path.  

In the example above, you will see the destination path as /Volumes/name_of_drive/PSV Backup. 

What happens to users during a backup? 
If a user is logged into PrintSmith Vision when a backup begins, a window opens with the following warning 
message: 

 
If a user tries to log into PrintSmith Vision when a backup is taking place, the user is prevented from logging in 
and the following message is displayed: 
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Locate Backed up Data 
For each backup (automated or manual), the system creates a folder in the backup destination folder that you 
specified. 

• For automated backups, the folder name is: PrintSmithDataBackup_Auto_date 

Example: PrintSmithDataBackup_Auto_05252021 for the backup that took place on May 25, 2021. 

• For manual backups, the folder name is: PrintSmithDataBackup_Manual_date  

Example: PrintSmithDataBackup_Manual_05262021 for    the backup that took place on May 26, 2021. 

Notes  If more than one backup takes place on the same day, a number is added as a suffix to the 
folder name. For example: PrintSmithDataBackup_Auto_date_1, 
PrintSmithDataBackup_Auto_date_2, and so on. 

 The Number of Backups to keep setting controls the number of automatic backup folders to 
be retained. Older backup folders are automatically deleted. Manual backup folders are not 
tracked or limited – you must delete them manually. 

Each PrintSmithDataBackup folder includes the following: 

• The backed-up PrintSmith Vision database: printsmith_db_date.backup. 

Example: printsmith_db_05272021.backup for a backup performed on May 27, 2021 

• The backed-up Scheduler database (if using Scheduler): scheduler_db_date.backup.  

Example: scheduler_db_05272021.backup for a backup performed on May 27, 2021  

• A PrintSmith Reports\Crystalclear Reports 12.1\invoiceRepository folder with your document 
formats (invoices and estimates). 

• A PrintSmith Reports\Crystalclear Reports 12.1\reportRepository folder with all your reports 
(standard and custom). 

• A DigitalAssetsRepository folder with the content files (digital assets) used for jobs. 

• A ReportScheduleRepository folder with all scheduled reports that were generated (if you use Report 
Manager to schedule custom reports). 

Note If the PrintSmith Data Backup folders reside on the same computer where PrintSmith Vision resides, 
always copy the backup to an external device, or take advantage of a cloud-based backup service. 
Otherwise, if the hard disk crashes, you will lose your backups along with your data. 
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